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3 1. Introducción

Configuración del sistema

Paquete de 
micrófono 

inalámbrico 
UWP-D21 
UWP-D22 
UWP-D26 
(receptor: 
URX-P40)

SMAD-P5 
Adaptador de la 

zapata de 
interfaces múltiples

Receptor de 
micrófono 

inalámbrico 
URX-P03D

Adaptador de la 
zapata de 

interfaces múltiples 
SMAD-P3D

Kit de Adaptador 
de XLR 

XLR-K3M

Luz de vídeo 
HVL-LBPC

Objetivo PL S35
Asa equipada con una zapata MI 
(A-5012-165-) Asa

Módulo del visor

Batería 
BP-GL95B

Adaptador de CA 
AC-DN10A

Unidad de control 
remoto 

RM-30BP/1BP

MPC-2610

Tarjetas de memoria 
CFexpress Tipo B

Adaptador para hombro 
VCT-FSA5

Control remoto de la empuñadura 
GP-VR100

Tarjeta SD

Adaptador de 
montura PL

Objetivo anamórfico 
(montura PL)

Objetivo de fotograma completo 
(montura PL)

Objetivo de montura E

Adaptador de montura A 
LA-EA4 
LA-EA5

ECM-680S*, ECM-678, 
ECM-674, ECM-MS2 
Micrófono
* Se requiere EC-0.5X5F3M

Lector de tarjetas 
CFexpress Tipo B/ 

lector de tarjetas SD

Abrazadera de varilla 
(A-2182-621-) 
Conjunto del soporte del 
micrófono (X-2596-733-) 
Tornillos P2.6×8 (2)  
(7-627-556-98)
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Ubicación y función de los componentes

Lado de interruptores del operador

LOCK
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Sección de la ranura para tarjetas 
CFexpress Tipo B (página 5)

1. Interruptor FOCUS (página 94)

2. Interruptor LOCK
Bloquea el funcionamiento de los botones.
Cuando está bloqueado, los LED de fondo se 
iluminan en color naranja.

3. Dial ND VARIABLE (página 101)

4. Altavoz integrado (página 77)

5. Entrada de aire

[Nota]
No cubra la entrada de aire.

6. Botón MENU (página 30, 35)
Pulse el botón MENU para mostrar la pantalla 
de estado. Mantenga pulsado el botón MENU 
para mostrar la pantalla del menú completo.

Pulse el botón durante la visualización de la 
pantalla de estado o de la pantalla del menú 
completo para volver a la pantalla anterior.

7. Interruptores CH1/CH2 (AUTO/MAN) 
(página 104)

8. Antena Wi-Fi

[Nota]
Es posible que la comunicación por Wi-Fi se vea 
interrumpida si tapa esta parte con la mano o con un 
objeto metálico.

9. Diales AUDIO LEVEL (CH1/CH2) 
(página 104)

10. Botón CLIPS (página 74)
Púlselo para mostrar los clips del soporte de 

reproducción activo en la pantalla de clips 
y para activar la operación de reproducción. 
Púlselo cuando la pantalla de clips se muestre 
para volver a la pantalla de filmación.

11. Indicadores de acceso A/B (página 19)

12. Botón SLOT SELECT (selección de tarjeta 
de memoria CFexpress Tipo B) 
(página 77)

13. Conector de auriculares (minitoma 
estéreo)

Conecte los auriculares para monitorizar el 
audio. Puede monitorizar el audio de entrada 
durante la filmación/grabación y el sonido 
de reproducción durante la reproducción 
(página 77).

14. Ranura para tarjetas Utility SD/indicador 
de acceso (página 21)

15. Micrófono interno (página 104)
Micrófono de narración para grabar el sonido 
ambiental.

16. Botón BACK
Cancela los ajustes de menú y sube un nivel 
en la jerarquía mientras se está visualizando 
el menú. Cancela el proceso en ejecución o los 
procesos pendientes cuando se muestra que 
están en curso.

17. Interruptor de alimentación
Ajústelo en la posición  (ON) para encender 
el equipo. Ajústelo en la posición  (Standby) 
para apagar el equipo.

[Notas]
 • Esta unidad utiliza una cantidad pequeña de 

alimentación en espera aunque la alimentación esté 
apagada. Retire la batería si no se va a utilizar la 
unidad durante un periodo prolongado.

 • Al quitar la batería o la alimentación DC IN, coloque el 
interruptor de alimentación en la posición STANDBY 
y compruebe que el testigo de alimentación no está 
encendido. Si desconecta el aparato con el interruptor 
de alimentación en la posición ON, podría producirse 
un error de funcionamiento en la unidad o en las 
tarjetas de memoria.

18. Testigo de alimentación (página 88)

19. Testigo REC ACTIVE
El testigo se ilumina en verde cuando el botón 
REC está habilitado.

20. Botón/testigo REC (inicio/parada de la 
grabación)

Púlselo para comenzar la grabación, lo que 
enciende el testigo REC. Púlselo para detener 
la grabación, lo que apaga el testigo REC 
(página 88).

21. Testigo ASSIGN 3 (asignable) 
(página 106)

El testigo se ilumina en color naranja cuando 
la función asignada está habilitada o activada 
y permanece apagado cuando está apagada 
(deshabilitada).

22. Dial multifunción (página 106)
Presione cuando vea la imagen en el visor 
para mostrar y utilizar el menú directo.
Gire el dial cuando aparezca un menú en 
el visor para mover el cursor hacia arriba/
abajo para seleccionar elementos o ajustes 
del menú. Pulse para aplicar el elemento 
seleccionado.
Si no se muestra el menú, el dial también 
puede funcionar como dial asignable.

[Consejo]
Por defecto, puede utilizar el dial para ajustar el 
diafragma cuando el objetivo con montura E está 
acoplado.

23. Selector múltiple (pad D de 8 formas y 
botón de aplicar)

Utilícelo para seleccionar un marco de 
reconocimiento del sujeto durante el enfoque 
automático, mover el área de enfoque y 
mover la posición de ampliación durante 
la operación del amplificador de enfoque. 
También se puede utilizar para efectuar 
operaciones de menú cuando el monitor LCD 
se encuentra en modo de monitorización de 
vídeo (página 22).
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[Consejo]
El selector múltiple del control remoto de la 
empuñadura (opcional) y el control remoto LANC 
(opcional) funcionan de manera equivalente a este 
selector múltiple.

24. Botón DISPLAY (visualización de la 
pantalla) (página 23)

25. Botones/testigos 1/2 ASSIGN (asignables) 
(página 106)

El testigo se ilumina en color naranja cuando 
la función asignada está habilitada o activada 
y permanece apagado cuando está apagada 
(deshabilitada).

26. Botones arriba/abajo de ND FILTER 
POSITION//testigo ND CLEAR 
(página 101)

Cuando el filtro ND se establece en CLEAR, el 
testigo ND CLEAR se enciende.

27. Interruptor ND STEP/VARIABLE 
(página 101)

28. Adaptador de montura PL (página 16)

Sección de la ranura para tarjetas 
CFexpress Tipo B (página 19)

Las ranuras para tarjetas CFexpress Tipo B 
están situadas detrás de la tapa.

1

1. Ranuras A/B de CFexpress Tipo B

Lado de conectores

SDI OUT  1

SDI OUT  2
INPUT LINE

MIC
MIC + 48V

TC

OUT
IN

REF

12V

REMOTE GRIP

VF

7

1

INPUT
2

LINE
MIC

MIC + 48V

3 4

13 12 11 10

14

15

1 2

6
5

7

9
8

1. Lámpara indicadora/indicador de 
grabación (página 88)

Se ilumina durante la grabación y parpadea 
cuando la capacidad restante del soporte de 
grabación o de la batería es baja.

2. Conector USB-C (página 81, 85, 
114)

3. Botón/testigo 7 ASSIGN (asignable) 
(página 106)

El testigo se ilumina en color naranja cuando 
la función asignada está habilitada o activada 
y permanece apagado cuando está apagada 
(deshabilitada).

4. Gancho para cinta métrica
El gancho para cinta métrica está situado en 
el mismo plano que el sensor de imagen. Para 
medir la distancia entre la unidad y el sujeto 
de forma precisa, utilice este gancho como 

punto de referencia. Puede unir el extremo 
de la cinta métrica al gancho para medir la 
distancia desde el sujeto.

5. Antena Wi-Fi

[Nota]
Es posible que la comunicación por Wi-Fi se vea 
interrumpida si tapa esta parte con la mano o con un 
objeto metálico.

6. Interruptor INPUT 1 (LINE/MIC/MIC+48V) 
(página 104)

7. Conector INPUT 1 (entrada de audio 1) 
(página 104)

8. Interruptor INPUT 2 (LINE/MIC/MIC+48V) 
(página 104)

9. Conector INPUT 2 (entrada de audio 2) 
(página 104)
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10. Acoplamiento del control remoto de la 
empuñadura

Punto de acoplamiento para el control remoto 
de la empuñadura (opcional).

11. Salida de aire

[Nota]
No cubra la salida de aire.

12. Conector del control remoto de la 
empuñadura

Conéctelo al control remoto de la empuñadura 
(opcional).

13. Conector REMOTE
Conéctelo al accesorio de conector LANC de 
uso general.

14. Interruptor de selección TC/REF IN/OUT 
(página 113)

Cambie la función de los dos conectores del 
lado trasero entre TC IN/REF IN y TC OUT/REF 
OUT.

15. Conector del visor (página 11)

Parte delantera

3

1

3

2

1. Contacto eléctrico del objetivo PL 
(superior)

2. Contacto eléctrico del objetivo PL (lateral)

3. Botón ASSIGN 3 (asignable) (página 106)
La función asignada cambiará entre on/off 
(habilitada/deshabilitada) o se activará cada 
vez que se pulse.
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Parte trasera
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1. Conector HDMI OUT (página 112)

2. Conector SDI OUT 1 (página 112)
Admite la salida 12G-SDI.

3. Conector SDI OUT 2 (página 112)
Admite la salida 3G-SDI.

4. Conector TC IN/TC OUT (entrada/salida de 
código de tiempo) (página 113)

5. Conector REF IN/REF OUT (entrada/salida 
de señal de sincronización)

Utilícelo para una de las aplicaciones 
siguientes, en función del interruptor de 
selección TC/REF IN/OUT.
IN: entrada de una señal de referencia externa 

para utilizar la función Genlock de la 
unidad o bloquear el código de tiempo de 
esta en una fuente externa.

OUT: salida de una señal de sincronización 
para sincronizar dispositivos externos. El 
conector REF OUT emite siempre una señal 
de sincronización HD.

6. Conector de red (RJ-45)
Conéctelo a una red LAN con cable usando 
un cable LAN (no suministrado) para la 
funcionalidad de red estable (página 81).

[Nota]
No se puede usar al mismo tiempo que la Wi-Fi.

7. Conector DC-IN (XLR de 4 terminales) 
(página 14)

Conector DC IN (entrada para el suministro 
de alimentación de CC) (XLR de 4 terminales, 
macho) para suministro de alimentación 
externa a la unidad. Admite tensión de 
entrada de 12 V (de 11 V a 17 V).

N.º Señal

1 GND

2 NC

3 NC

4 12 V (de 11 V a 17 V)

8. Entrada de aire

[Nota]
No cubra la entrada de aire.

9. Lámpara indicadora/indicador de 
grabación

Se ilumina durante la grabación y parpadea 
cuando la capacidad restante del soporte de 
grabación o de la batería es baja.

10. Terminal para la colocación de la batería 
(página 14)

11. Soporte para la batería (página 14)

12. Palanca de desbloqueo de la batería 
(página 14)
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Parte superior

22

1

1. Conector del asa
Conéctelo a un asa (opcional) equipada con 
una zapata MI.

2. Orificios de tornillo para montaje de 
accesorios

Tipo de tornillo: 1/4-20UNC (8)
Tipo de tornillo: 3/8-16UNC (6)
Carrera: 10 mm o menos

Base

1

2

1. Perforaciones de conexión de la placa del 
trípode

Tipo de tornillo: 1/4-20UNC (4)
Tipo de tornillo: 3/8-16UNC (4)
Carrera: 9 mm o menos

2. Entrada de aire

[Nota]
No cubra la entrada de aire.
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Monitor LCD

H&V FLIP

8

9

10

HOME

11

1 32

245

10

6
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9
8

1. Botón ASSIGN 11 (asignable) 
(página 106)

2. Botones ITEM de 1 a 6 (página 26)
Utilícelos para accionar la pantalla Home y la 
pantalla de reproducción.

3. Pestaña de bloqueo de la lupa 
(página 12)

4. Panel táctil
Las operaciones táctiles se pueden 
deshabilitar mediante un botón asignable o 
con el menú (página 10).

5. Interruptor H&V FLIP (ON/OFF)
Cambia la visualización de la pantalla entre 
normal (OFF) y volteada hacia la parte 
superior/inferior/izquierda/derecha (ON).

6. Botón ASSIGN 8 (asignable) (página 106)

7. Botón ASSIGN 9 (asignable) (página 106)

8. Selector múltiple (pad D de 8 formas y 
botón de aplicar)

Utilícelo para controlar el contenido que se 
muestra en el monitor LCD.

9. Botón ASSIGN 10 (asignable) 
(página 106)

10. Botón HOME (página 22)
Púlselo para mostrar la pantalla Home.

[Consejo]
Puede cambiar entre el modo de monitorización de 
vídeo para controlar las distintas operaciones de la 
pantalla de filmación y el modo de visualización de la 
información para comprobar y cambiar los ajustes en la 
pantalla Home.



1. Introducción10

Uso del panel táctil

Precauciones de uso del panel 
táctil

El monitor LCD de la unidad es un panel táctil 
que se controla directamente tocándolo con 
el dedo.
 • El panel táctil está diseñado para tocarse 

ligeramente con el dedo. No presione el 
panel con fuerza ni lo toque con objetos 
afilados o puntiagudos (uña, bolígrafo, 
alfiler, etc.)

 • Es posible que el panel táctil no responda 
si se toca en las siguientes circunstancias. 
También se podría producir un fallo de 
funcionamiento.

 •  Funcionamiento con la punta de las 
uñas de los dedos

 •  Funcionamiento mientras la superficie 
está en contacto con otros objetos

 •  Funcionamiento con una lámina o un 
adhesivo de protección colocados

 •  Funcionamiento con gotas de agua o 
condensación en la pantalla

 •  Funcionamiento con los dedos mojados 
o sudados

Gestos del panel táctil

Pulsar
Toque ligeramente un elemento, como un 
icono o un elemento de menú, con el dedo y 
luego retire el dedo inmediatamente.

Arrastrar
Toque la pantalla y deslice el dedo hasta 
la posición deseada de la pantalla. A 
continuación, retire el dedo.

Desplazar/deslizar
Toque la pantalla y desplace/deslice 
rápidamente el dedo hacia arriba, abajo, 
izquierda o derecha.

[Consejo]
Si el contenido de la pantalla continúa sobresaliendo de 
los bordes de la pantalla, puede arrastrar o desplazar el 
contenido de la pantalla.

Configuración del panel táctil

El funcionamiento del panel táctil se puede 
activar/desactivar mediante Touch Operation 
(página 63) en el menú Technical.
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Colocación del asa y del visor

Colocación del asa

1 Alinee el asa con los cuatro orificios para 
los tornillos situados en la parte frontal o 
trasera del lado superior.

2 Colóquela con la ayuda de los cuatro 
tornillos hexagonales y apriételos con un 
par de apriete de 1,4 N·m con la ayuda de 
una llave hexagonal (3/16 pulgadas).

Extracción del asa

Desatornille los cuatro tornillos hexagonales 
con la ayuda de una llave hexagonal y extraiga 
el asa.

Acople del visor

1 Con el asa colocada en la unidad, gire la 
perilla de bloqueo del brazo del visor en 
el sentido contrario a las agujas del reloj 
para aflojar el brazo y gírelo 180° hacia 
delante.

 [Consejo]
Si la perilla de bloqueo se encuentra en una 
posición que dificulta el giro, sáquela y gírela 
hasta situarla en un ángulo que facilite su control. 
A continuación, vuelva a colocar la perilla de 
bloqueo.

2 Gire la perilla de bloqueo en el sentido de 
las agujas del reloj para fijarlo en su 
posición.

Perilla de 
bloqueo

Brazo
Perno 
hexa-
gonal

 [Nota]
Si la varilla del accesorio de acoplamiento del brazo 
gira en relación con el asa, apriete el perno de la 
cabeza hexagonal (3 mm) en la parte inferior del 
asa con la ayuda de una llave hexagonal (par de 
apriete: 1,6 N m).

3 Coloque el adaptador de montaje del 
visor en la parte posterior del monitor LCD 
y gire la perilla de bloqueo en el sentido 
de las agujas del reloj para fijarlo en su 
posición.
Adaptador de montaje del visor

Perilla de bloqueo

4 Mantenga pulsado el pasador del brazo 
con los dedos, coloque el adaptador de 
montaje del visor en el brazo y gire la 
perilla de bloqueo en el sentido de las 
agujas del reloj para fijarlo en su posición.

Pasador
Perilla de 
bloqueo

Adaptador de 
montaje del visor

 [Nota]
Si el brazo se afloja demasiado al aflojar la perilla 
de bloqueo del accesorio de acoplamiento, ajuste 
el tornillo de bloqueo con una llave hexagonal 
(2,5 mm).

Tornillo de bloqueo

5 Alinee la marca  del conector del visor 
de la unidad con la marca  del enchufe 
del cable del monitor LCD e inserte el 
cable.
Compruebe la orientación para 
asegurarse de que la marca  esté en el 
lado exterior antes de introducirlo.
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6 Pase el cable por los soportes para cables 
(tres puntos).

Soporte del cable

7 Coloque la lupa del visor deslizándola por 
la ranura situada en la parte superior del 
monitor LCD, tal y como se muestra en el 
diagrama.

8 Empuje la lupa del visor en la dirección de 
la flecha para bloquearla.

Extracción de la lupa del visor

Presione el seguro de la lupa del visor, 
levante la lupa para abrirla , mantenga 
pulsada la pestaña de bloqueo del accesorio 
de acoplamiento de la lupa del visor en la 
dirección de la flecha  y deslice la lupa del 
visor en la dirección opuesta a la que la colocó 
para extraerla .

Seguro

Pestaña 
de blo-
queo de 
la lupa

Extracción del visor

1 Saque el cable de los soportes, presione 
el enchufe del conector por ambos lados 
y desconecte el cable.

2 Afloje la perilla de bloqueo del visor y siga 
los pasos del procedimiento de 
acoplamiento del visor en orden inverso 
para extraerlo.

Colocación del visor (cuando no se 
utiliza la lupa del visor)

1 Con el asa colocada en la unidad, gire la 
perilla de bloqueo del brazo en el sentido 
contrario a las agujas del reloj para aflojar 
el brazo y gírelo 180° hacia delante.

2 Gire la perilla de bloqueo en el sentido de 
las agujas del reloj para fijarlo en su 
posición.

Perilla de 
bloqueo

Brazo
Perno 
hexa-
gonal

 [Nota]
Si la varilla del accesorio de acoplamiento del brazo 
gira en relación con el asa, apriete el perno de la 
cabeza hexagonal (3 mm) en la parte inferior del 
asa con la ayuda de una llave hexagonal (par de 
apriete: 1,6 N m).
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3 Coloque el adaptador de montaje del 
visor en la parte lateral del monitor LCD y 
gire la perilla de bloqueo en el sentido de 
las agujas del reloj para fijarlo en su 
posición.

Adaptador de 
montaje del visor

Perilla de bloqueo

4 Mantenga pulsado el pasador del brazo 
con los dedos, coloque el adaptador de 
montaje del visor en el brazo y gire la 
perilla de bloqueo en el sentido de las 
agujas del reloj para fijarlo en su posición.

Pasador Perilla de 
bloqueo

Adaptador de montaje 
del visor

 [Nota]
Si el brazo se afloja demasiado al aflojar la perilla 
de bloqueo del accesorio de acoplamiento, ajuste 
el tornillo de bloqueo con una llave hexagonal 
(2,5 mm).

Tornillo de bloqueo

5 Alinee la marca  del conector del visor 
de la unidad con la marca  del enchufe 
del cable del monitor LCD e inserte el 
cable.
Compruebe la orientación para 
asegurarse de que la marca  esté en el 
lado exterior antes de introducirlo.

6 Pase el cable por los soportes para cables 
(tres puntos).

Soporte del cable

Ejemplo de colocación cuando se utiliza 
el monitor LCD como panel de control

Puede montar el monitor LCD colocando la 
parte lateral del adaptador de montaje del 
visor en el brazo, tal y como se muestra a 
continuación. Esta colocación es práctica 
cuando se utiliza el monitor LCD como panel 
de control.

Adaptador de 
montaje del 
visor
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Fuente de alimentación
Puede utilizar una batería o una fuente de 
alimentación de CA mediante un adaptador 
de CA.
Por su seguridad, utilice sólo las baterías y los 
adaptadores de CA Sony que se enumeran a 
continuación.

Baterías de iones de litio
BP-GL95B

Adaptador de CA
AC-DN10A

Utilización de una batería

Introduzca la batería en el soporte de la 
batería (página 7) del adaptador de la 
batería y, después, muévala hacia abajo hasta 
que encaje.
Para extraerla, mantenga pulsada la palanca 
de desbloqueo de la batería (página 7) 
para desbloquearla y deslícela hacia arriba.

[Notas]
 • Antes de utilizarla, cargue la batería con el cargador 

de batería.
 • Si una batería está caliente justo después de usarla, 

es posible que no se pueda recargar completamente.
 • Quite el adaptador de la batería mientras sujeta la 

unidad con la mano.

Comprobación de la capacidad restante

Cuando la grabación o la reproducción está 
en curso con la batería, se muestran el tiempo 
restante de la batería y la tensión de la batería 
en el monitor LCD.
En la unidad se indica el tiempo restante 
de uso en minutos, calculando el tiempo 
disponible con la batería si el uso continúa al 
mismo nivel de consumo de alimentación.

Si la carga restante de la batería llega a 
ser baja

Si la carga restante de la batería baja hasta un 
nivel determinado durante el funcionamiento, 
el indicador de capacidad restante de la 
batería parpadea y el testigo REC parpadea 
para avisarle.
Si la carga restante disminuye aún más 
hasta un nivel en el que no puede seguir 
funcionando, aparece un mensaje de aviso de 
batería agotada.
Sustituya la batería por una que esté 
completamente cargada.

Cambio de los niveles de advertencia

Para cambiar los niveles, vaya a Technical 
>Camera Battery Alarm (página 65) en el 
menú completo.

Uso de la alimentación de CA 
(alimentación DC IN) 

La unidad funciona con alimentación de CA 
mediante un adaptador de CA de 100 W.
Admite tensión de entrada de 11 V a 17 V.
Si la tensión de entrada se encuentra por 
debajo de los valores establecidos, aparece 
una alarma. Para cambiar los niveles, vaya a 
Technical >Camera DC IN Alarm (página 65) 
en el menú completo.

[Nota]
Al cambiar a una fuente de alimentación DC IN durante 
el funcionamiento de la batería, utilice una fuente de 
alimentación que tenga un rango de tensión de entre 
12 V y 17 V para que el cambio sea más seguro.

Uso conjunto de una batería y de 
una fuente de alimentación DC IN

Siempre que se aplica un suministro de 
alimentación activo utilizando una batería y 
un suministro de alimentación DC IN, se da 
prioridad al segundo.

[Nota]
Cuando se cambia del funcionamiento con batería 
al suministro de alimentación DC IN, es posible que 
la unidad deje de funcionar si se dan las siguientes 
circunstancias.
 • Vibración de los contactos del conector cuando se 

inserta el conector de CC
 • Caída de tensión al cambiar entre fuentes de 

alimentación (más frecuente cuando el consumo de 
energía es alto)
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Ajuste del reloj
Cuando utilice la unidad por primera vez, la 
pantalla de configuración inicial aparecerá 
en el monitor LCD si la alimentación está 
encendida.
Ajuste la fecha y la hora del reloj interno en 
esta pantalla.

Time Zone

El valor muestra la diferencia horaria 
con respecto al UTC (Tiempo Universal 
Coordinado). Cambie el ajuste según sea 
necesario.

[Nota]
Cuando cambia el ajuste Time Zone, el ajuste del reloj 
cambia según la diferencia horaria.

Ajuste de fecha y hora

Gire el dial multifunción (página 4) 
para seleccionar elementos y valores y, a 
continuación, pulse el dial para aplicar la 
selección. Si pulsa el dial cuando el cursor 
se encuentra en “Set”, la pantalla de ajuste 
desaparece y finaliza la configuración del reloj.
Cuando haya desaparecido la pantalla de 
configuración inicial, podrá modificar el ajuste 
Time Zone y los ajustes de fecha y hora desde 
Maintenance > Clock Set (página 70) en el 
menú completo.

[Notas]
 • Si el ajuste del reloj se borra porque la batería 

de reserva se agota al no recibir alimentación 
(funcionamiento sin batería ni conexión DC IN), la 
pantalla de configuración inicial aparecerá la próxima 
vez que encienda la unidad.

 • Cuando se muestre la pantalla de configuración 
inicial, no se podrá realizar ninguna otra operación 
excepto desconectar la alimentación hasta que 
termine los ajustes de la pantalla.

[Consejo]
También puede usar el selector múltiple.
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Para obtener más información sobre los objetivos que 
pueden utilizarse con la unidad, póngase en contacto con 
un representante del servicio de Sony.

[Precaución]
No deje el objetivo orientado directamente 
al sol. La luz directa del sol puede penetrar a 
través del objetivo, enfocarse en la unidad y 
provocar un incendio.

[Notas]
 • Apague la alimentación antes de colocar o quitar el 

objetivo y el adaptador.
 • Los objetivos son componentes de precisión. No 

coloque los objetivos sobre una superficie dejando 
la montura de estos orientada hacia abajo. Acople la 
tapa de la montura del objetivo suministrada.

 • La interfaz del objetivo PL de la unidad está 
configurada con los ajustes predeterminados de 
fábrica para objetivos con conector de tipo Cooke. 
Para usar objetivos que no tienen un conector de 
tipo Cooke, ajuste Technical >Lens >PL-Mt Interface 
Position (página 64) en Off en el menú completo.

Instalación de un objetivo con 
montura PL

1 Retire la tapa de la montura PL de la 
montura del objetivo girando la palanca 
de la montura PL en el sentido contrario a 
las agujas del reloj.

Palanca de  
montura PL

Tapa de 
montura PL

 [Nota]
Gire la palanca de montura PL en el sentido 
contrario a las agujas del reloj hasta la posición del 
tope.

2 Introduzca el objetivo en el soporte 
haciendo coincidir la parte cóncava del 
objetivo con el pasador de posición de la 
parte superior derecha del soporte del 
objetivo.

3 Fije el objetivo sujetándolo y girando la 
palanca de la montura PL en el sentido de 
las agujas del reloj.

 [Nota]
No gire el objetivo cuando esté colocando un 
objetivo con montura PL. Si gira el objetivo, los 
contactos eléctricos del objetivo PL podrían 
doblarse.

Montaje de un objetivo Cooke/i

Haga coincidir los contactos del objetivo con 
los contactos eléctricos del objetivo PL de 
la unidad. En la unidad hay dos conectores 
y puede utilizar cualquiera de ellos. Para 
establecer la posición del conector utilizado, 
vaya a Technical >Lens >PL-Mt Interface 
Position (página 64) en el menú completo.

Extracción del objetivo

1 Mientras sujeta el objetivo por debajo, 
gire la palanca de la montura PL en 
sentido contrario a las agujas del reloj.

2 A continuación, tire del objetivo.

 [Nota]
Si no va a instalar otro objetivo de forma inmediata, 
haga coincidir la parte cóncava de la tapa de la 
montura PL y, a continuación, fíjela girando la 
palanca de la montura PL en el sentido de las 
agujas del reloj.

Ajuste de la distancia focal del 
plano de montaje

La unidad se suministra con el ajuste de 
la distancia focal del plano de montaje 
configurado. Si necesita ajustar la distancia 
focal del plano de montaje, extraiga el plano 
de montura PL y cambie las arandelas por 
otras del grosor adecuado. Puede ajustar 
el grosor en ±0,1 mm en incrementos de 
0,01 mm.

Arandelas

La unidad se suministra con las siguientes 
arandelas:
1 arandela de 0,05 mm (circular)
15 arandelas de 0,01 mm (1/3 de arco)
Las arandelas de 1/3 de arco siempre se 
deben usar como un conjunto de tres 
arandelas. Inserte las arandelas para aumentar 
la distancia focal del plano de montaje. 
La unidad se suministra con el ajuste de 
la distancia focal del plano de montaje 
configurado utilizando los tres tipos de 
arandelas siguientes:
0,10 mm (circular)
0,05 mm (circular)
0,01 mm (1/3 de arco)
Cuando se suministra, se añade un sello que 
muestra el grosor de la arandela.

[Nota]
Al comprobar la distancia focal del plano de montaje, 
espere al menos 10 minutos tras encender la unidad 
antes de hacer el ajuste para conseguir más precisión.
Asimismo, es posible minimizar los errores durante 
el funcionamiento comprobando y ajustando a una 
temperatura medioambiental lo más parecida posible a 
las condiciones reales de filmación.

Ajuste de la distancia focal del plano de 
montaje

1 Retire los seis tornillos Torx y extraiga el 
plano de montura PL.

1

Plano de montura 
PL

2 Afloje los tornillos Phillips de ambos lados 
de los conectores PL (dos puntos) y 
extraiga los conectores PL y las placas de 
los conectores PL.

Montaje de un objetivo y ajuste de la distancia focal del plano de montaje
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3 Fije las arandelas al adaptador del 
montura PL (tres puntos).

33

33
33

22
22

Conectores PL

Placas de los 
conectores PL

Al usar arandelas de 1/3 de arco
Fije las arandelas de manera que tengan 
el mismo grosor en los tres puntos.

Arandelas

Al usar arandelas circulares
Fíjelas a la superficie que tiene marcas 
hacia la parte frontal.

Marcas

Marcas

4 Vuelva a fijar los conectores PL (dos 
puntos) en sus posiciones originales y 
apriete los cuatro tornillos Phillips con un 
par de apriete de 0,18 N m.

5 Vuelva a colocar el plano de montura PL 
en su posición original y apriete los seis 
tornillos Torx con un par de apriete de 
0,35 N m utilizando una llave hexagonal 
T8.

Limpieza del filtro óptico

Para limpiar el filtro óptico, retire primero el 
adaptador. Tenga cuidado al limpiar la parte 
central del adaptador con un paño o con otro 
material para evitar que las fibras se adhieran 
a las superficies. Si se adhieren fibras, 
límpielas con un cepillo suave.

Adaptador

Extracción del adaptador de la 
montura PL

Extraiga el adaptador de la montura PL si 
desea montar un objetivo con montura E en la 
unidad. La conexión/extracción se realiza con 
el lado trasero de la unidad orientado hacia 
abajo.
Afloje los seis tornillos hexagonales (2,5 mm) y 
retire el adaptador de la montura PL.

Adaptador 
de montura 
PL

[Nota]
Al conectar/retirar el adaptador, procure no tocar los 
contactos del conector de la unidad y el adaptador de la 
montura PL.

[Consejo]
La extracción de la batería y la colocación del lado 
trasero de la unidad orientado hacia abajo ofrece 
estabilidad.
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Colocación del adaptador de la montura 
PL

1 Compruebe si la palanca de la montura E 
está en la posición de bloqueado.

Palanca de 
montura E

2 Vuelva a colocar el adaptador de la 
montura PL en su posición original, 
inserte los seis tornillos hexagonales 
(2,5 mm) y apriételos con un par de 
apriete de 0,8 ± 0,12 N m utilizando una 
llave hexagonal (2,5 mm).

Acople de un objetivo de montura E

1 Extraiga el adaptador de la montura PL 
(página 17).

2 Empuje hacia arriba el interruptor de 
bloqueo y gire la palanca de la montura E 
en el sentido de las agujas del reloj para 
liberar el bloqueo.

Palanca de 
montura E

Interruptor 
de bloqueo

3 Alinee las marcas de soporte (color 
blanco) en la unidad y el soporte del 
objetivo y, a continuación, inserte el 
objetivo en el soporte.

4 Fije el objetivo sujetándolo y girando la 
palanca de la montura E en el sentido 
contrario de las agujas del reloj.

 

Marcas de soporte 
(color blanco)

[Nota]
Puede que algunos objetivos con montura E no 
sean compatibles con el control. Use un objetivo 
recomendado.

Para obtener más información sobre los objetivos que 
pueden utilizarse con la unidad, póngase en contacto con 
un representante del servicio de Sony.

Extracción del objetivo

1 Empuje hacia arriba el interruptor de 
bloqueo y gire la palanca de la montura E 
en el sentido de las agujas del reloj para 
liberar el bloqueo.

2 A continuación, tire del objetivo.

 [Nota]
Si no va a instalar otro objetivo de forma inmediata, 
haga coincidir la parte cóncava de la tapa de la 
montura E y, a continuación, fije la tapa de la 
montura E girando la palanca de la montura E en el 
sentido contrario de las agujas del reloj.
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Manipulación de tarjetas de memoria CFexpress Tipo B
Utilice las tarjetas de memoria CFexpress Tipo B de Sony* indicadas en “Soportes de grabación 
recomendados” en la unidad.
Para obtener más información sobre las operaciones con soportes de otros fabricantes, consulte 
las instrucciones de mantenimiento de dichos soportes o la información del fabricante.
* En este documento se denominan “tarjetas CFexpress”.

[Notas]
 • No se pueden usar tarjetas de memoria CFexpress Tipo B con una capacidad de 2 TB o más.
 • No se pueden usar tarjetas de memoria XQD.

Soportes de grabación recomendados

Las condiciones de funcionamiento garantizadas variarán según los ajustes de Rec Format y 
Recording.
Sí: operación admitida
No: no se garantiza un funcionamiento normal

Formato de grabación CFexpress Tipo B (exFAT)

No VPG VPG200 VPG400

XAVC H Intra HQ 8192×4320 No No Sí

7680×4320 No No Sí

XAVC H Intra SQ 8192×4320 No No Sí

7680×4320 No No Sí

XAVC H Long 7680×4320 No Sí Sí

XAVC Intra 4096×2160 No No Sí

3840×2160 No Sí Sí

1920×1080 No Sí Sí

XAVC Long 3840×2160 No Sí Sí

1920×1080 No Sí Sí

X-OCN (LT) 8.6K 17:9 No No Sí

8.6K 16:9 No No Sí

6K 17:9 No No Sí

6K 16:9 No No Sí

5.8K 17:9 No No Sí

5.8K 16:9 No No Sí

X-OCN (LT) 4K 17:9 No No Sí

Introducción de una tarjeta de 
memoria

1 Abra la tapa de soportes de la sección de 
la ranura para tarjetas.

2 Introduzca una tarjeta CFexpress con la 
etiqueta mirando hacia la izquierda.

Etiqueta

El indicador de acceso (página 4) se 
iluminará en rojo y, a continuación, 
cambiará a verde si la tarjeta se puede 
utilizar.

 [Nota]
Si el indicador de acceso parpadea continuamente 
en color rojo y no cambia a verde, apague 
temporalmente la unidad, retire la tarjeta de 
memoria e insértela de nuevo.

3 Cierre la tapa de soportes.

[Notas]
 • La tarjeta de memoria, la ranura de la tarjeta de 

memoria y los datos de imagen de la tarjeta de 
memoria pueden resultar dañados si la tarjeta se 
introduce a la fuerza en la ranura en la orientación 
incorrecta.

 • Cuando grabe en los soportes utilizando ambas 
ranuras de tarjeta CFexpress Tipo B, la A y la B, inserte 
los soportes en las dos ranuras que se recomiendan 
para su funcionamiento con el formato que desea 
grabar.

Extracción de una tarjeta de memoria

Abra la tapa de soportes de la sección de la 
ranura para tarjetas y presione ligeramente la 
tarjeta de memoria para extraerla.

[Notas]
 • Si la unidad está apagada o si se extrae la tarjeta 

de memoria mientras se está accediendo a esta, 
no se podrá garantizar la integridad de los datos 
de la tarjeta. Es posible que se pierdan todos los 
datos grabados en la tarjeta. Además es posible 
que el funcionamiento de la unidad se vea afectado. 
Asegúrese de que el indicador de acceso esté 
siempre iluminado en color verde o apagado antes de 
apagar la unidad o extraer la tarjeta de memoria.

 • Cuando extraiga una tarjeta de memoria 
inmediatamente después de finalizar una grabación, 
es posible que la tarjeta de memoria esté caliente, 
pero esto no significa que haya un problema.

Formateo (inicialización) de 
tarjetas de memoria

Si se introduce una tarjeta de memoria sin 
formatear o formateada con especificaciones 
diferentes, aparecerá en el monitor LCD el 
mensaje “Media Needs to be Formatted”.
Formatee la tarjeta mediante el siguiente 
procedimiento.

1 Seleccione Format Media (página 56) 
en el menú TC/Media del menú completo.

2 Seleccione Media(A) (ranura A) o Media(B) 
(ranura B) y, a continuación, seleccione 
Full Format.
Aparecerá un mensaje de confirmación.

3 Seleccione Execute.
Se mostrará un mensaje durante el 
formateo y el indicador de acceso se 
iluminará en rojo.
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Cuando se haya completado el formateo, 
se mostrará un mensaje de finalización. 
Pulse el dial multifunción para ignorar el 
mensaje.

[Notas]
 • Para maximizar el rendimiento del soporte de 

grabación, ejecute siempre un formato completo 
utilizando la unidad.

 • Al formatear una tarjeta de memoria se borran todos 
los datos, incluidos los archivos de configuración y los 
datos de vídeos grabados.

 • Es posible que aparezcan mensajes durante la 
ejecución dependiendo de la duración del proceso de 
formateo.

Si el formateo no se completa 
correctamente

Las tarjetas de memoria no compatibles con la 
unidad no se podrán formatear.
Se mostrará un mensaje de advertencia. Siga 
las instrucciones para sustituir la tarjeta por 
una tarjeta de memoria compatible.

Utilización de una tarjeta formateada 
con la unidad en la ranura de otro 
dispositivo

En primer lugar, realice una copia de 
seguridad de la tarjeta y, a continuación, 
vuelva a formatear la tarjeta en el dispositivo 
que se va a utilizar.

Comprobación del tiempo de 
grabación restante

Durante la filmación (grabación/en espera), 
puede comprobar la capacidad restante de la 
tarjeta de memoria en cada ranura mediante 
los indicadores de los soportes A/B restantes 
en la pantalla de filmación y en la pantalla 
Home (página 23).
El tiempo de grabación restante se calcula a 
partir de la capacidad restante de los soportes 
en cada ranura y del formato de grabación 
actual, y se mostrará en minutos.

Tiempo de cambio de tarjetas de 
memoria

 • Cuando el tiempo de grabación restante 
total en las dos tarjetas de memoria es 
inferior a 5 minutos, aparece el mensaje 
“Media Near Full”, la lámpara indicadora/
indicador de grabación comienza a 
parpadear y se escucha un pitido (salida de 
auriculares) de advertencia.  
Introduzca algún soporte que disponga de 
espacio.

 • Si continúa grabando hasta que el tiempo 
restante de grabación total llegue a cero, 
el mensaje cambiará a “Media Full” y la 
grabación se detendrá.

[Nota]
En una tarjeta de memoria se pueden grabar hasta 600 
clips aproximadamente.

Restablecimiento de tarjetas de 
memoria

Si, por alguna razón, se produjera un error 
en una tarjeta de memoria, esta debe 
restablecerse antes de usarla.
Si carga una tarjeta de memoria que necesite 
restablecerse, aparecerá un mensaje en el 
monitor LCD en el que se le preguntará si 
desea restablecerla.

Restablecer una tarjeta

Gire el dial multifunción para (página 4) 
seleccionar Execute y, a continuación, pulse el 
dial multifunción.
Se mostrará un mensaje y el estado de avance 
(%) durante el formateo y el indicador de 
acceso se iluminará en rojo.
Cuando termine el restablecimiento, aparecerá 
un mensaje de finalización.

Si falla el restablecimiento

 • No se pueden restablecer las tarjetas de 
memoria donde se haya producido un error. 
Se mostrará un mensaje de advertencia. 
Siga las instrucciones para sustituir la tarjeta 
de memoria.

 • Las tarjetas de memoria en las que se haya 
producido un error pueden volver a usarse 
si se vuelven a formatear.

 • Algunos clips pueden restablecerse, pero 
otros no. Los clips restablecidos pueden 
reproducirse con normalidad.

[Notas]
 • Asegúrese de utilizar esta unidad para restablecer los 

soportes grabados con ella.
 • Es posible que los soportes grabados con un 

dispositivo que no sea esta unidad o con una unidad 
de versión diferente (incluso del mismo modelo) no 
se restablezcan mediante esta unidad.

 • Los clips de menos de 2 segundos no se pueden 
restablecer.

 • Es posible que el soporte restablecido no funcione 
con su rendimiento original. Haga una copia 
de seguridad de todos los clips necesarios y, a 
continuación, ejecute el formato completo antes del 
uso.
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Manipulación de tarjetas Utility SD
La tarjeta UTILITY SD se utiliza para grabar 
proxy y almacenar/cargar configuraciones. 
También se utiliza para actualizaciones futuras 
(actualización de software).

Tarjetas SD compatibles

Tarjetas de memoria SDXC*
Tarjetas de memoria SDHC*
Tarjetas de memoria SD*
* Denominadas “tarjetas SD” en este manual.

[Nota]
Se recomienda Speed Class 10 para el uso de la 
grabación de proxy.

Colocación de una tarjeta SD

Coloque una tarjeta SD en la ranura para 
tarjetas Utility SD (página 4).
El indicador de acceso (página 4) se 
iluminará en rojo y, a continuación, se apagará 
cuando la tarjeta esté lista para su utilización.

Indicador de estado de acceso

Indicador Estado de la ranura

Se ilumina en 
rojo

Accediendo a la tarjeta SD 
(escribiendo/leyendo datos)

Extracción de una tarjeta SD

Presione ligeramente la tarjeta SD y extráigala.

[Notas]
 • Si la unidad está apagada o si se extrae la tarjeta 

de memoria mientras se está accediendo a esta, no 
se podrá garantizar la integridad de los datos de la 
tarjeta. Es posible que se pierdan todos los datos 
grabados en la tarjeta. Asegúrese de que el indicador 
de acceso esté siempre apagado antes de apagar la 
unidad o extraer la tarjeta de memoria.

 • Asegúrese de que la tarjeta de memoria no se salga 
al introducirla o extraerla.

Formateo (inicialización) de una 
tarjeta SD

Las tarjetas SD deben formatearse la primera 
vez que se utilizan en la unidad.
Las tarjetas SD que se van a usar en la unidad 
deben formatearse con la función de formato 
correspondiente de la unidad. Asimismo, 
también será necesario formatear una tarjeta 
SD si aparece un mensaje de advertencia al 
insertarla.
Si una tarjeta SD formateada con un formato 
no compatible se carga en la unidad, 
aparecerá un mensaje de error de coincidencia 
del sistema de archivos.

1 Seleccione Format Media (página 56) 
en el menú TC/Media del menú completo.

2 Seleccione Utility SD y, a continuación, 
seleccione el método de formateo (Full 
Format o Quick Format).
Aparecerá un mensaje de confirmación.
 • Full Format: inicia el soporte por 

completo, incluida la información acerca 
de la gestión de datos y la región de 
datos.

 • Quick Format: inicia solo la información 
acerca de la gestión de datos del 
soporte.

3 Seleccione Execute.
Se mostrará un mensaje durante el 
formateo y el indicador de acceso se 
iluminará en rojo.
Cuando se haya completado el formateo, 
se mostrará un mensaje de finalización. 
Pulse el dial multifunción para ignorar el 
mensaje.

[Nota]
Al formatear una tarjeta SD se eliminan todos sus datos 
y no pueden recuperarse.

Diferencia entre el formateo rápido y el 
formateo completo

Efectúe un formateo completo cuando perciba 
que la velocidad de grabación/lectura de la 
tarjeta es menor o si desea borrar todos los 
datos. El formateo completo tarda más tiempo 
que el formateo rápido porque inicializa todas 
las partes de la tarjeta de memoria.

Para utilizar soportes formateados con 
esta unidad en las ranuras de otros 
dispositivos

Realice una copia de seguridad del soporte y, 
a continuación, formatéelo utilizando el otro 
dispositivo.
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Estructura de la pantalla del monitor LCD
La pantalla del monitor LCD funciona en dos modos que se centran en torno a la pantalla Home: el modo de monitorización de vídeo, que le permite comprobar los ajustes al mismo tiempo que 
monitoriza el vídeo, y el modo de visualización de la información, que le permite comprobar y modificar la información y los ajustes. Puede alternar entre los modos con el botón HOME. La pantalla 
de estado, la pantalla del menú completo, la pantalla de reproducción y la pantalla de clips pueden mostrarse en cada uno de los modos.
Puede alternar entre las pantallas que se muestran en el monitor LCD con el botón HOME, el botón MENU y el botón CLIPS.

Modo de monitorización de vídeo

Pantalla de estado

Pantalla de reproducción Selección de 
clip (repro-

ducción)

Selección 
de clip 

(reproduc-
ción)

Botón CLIPS Botón CLIPS

Pantalla de estado

Pantalla de control de 
reproducción

Pantalla del menú completo

Pantalla de clips

Botón HOME

Pantalla de 
filmación

Pantalla Home

Botón HOME

Botón MENU Botón HOME Botón MENU

Botón CLIPS Botón HOME Botón CLIPS

Botón 
MENU

Botón 
MENU

Botón HOME

Pantalla del menú completo

Pantalla de clips

Modo de visualización de la información

[Consejos]
 • En el modo de monitorización de vídeo, puede emitir la misma pantalla de visualización que el monitor LCD en un monitor externo.
 • El modo de visualización de la información se ha diseñado para el uso del monitor LCD junto con un monitor externo conectado para la salida HDMI. El monitor externo debe colocarse en el lado de interruptores del operador de la 

unidad para la monitorización del vídeo, y el monitor LCD puede colocarse tanto en el lado de interruptores del operador como en el lado de los conectores para configurar los ajustes, según la composición del equipo de filmación. La 
visualización de la pantalla no se puede superponer en la salida SDI excepto cuando el códec esté establecido en X-OCN.
 – Las funciones que se muestran en el monitor LCD se utilizan con el selector múltiple del monitor LCD o con el dial multifunción en el lado de interruptores del operador.
 – Las funciones que se muestran en el monitor externo se utilizan con el selector múltiple en el lado de interruptores del operador. Puede seleccionar un marco de reconocimiento del sujeto, mover el área de enfoque y mover la posición 

del amplificador de enfoque.
 • Para X-OCN, la imagen del índice no se muestra en la pantalla de clips.
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Pantalla de filmación/pantalla de reproducción
En el modo de monitorización de vídeo, el estado y la configuración de la unidad se muestran 
en torno a la imagen en el monitor LCD durante la filmación (grabación/en espera) y la 
reproducción.
En el modo de visualización de la información, es posible que el estado de la unidad y algunos 
ajustes se muestren superpuestos durante la filmación y la reproducción en la imagen de un 
monitor HDMI externo. Establezca previamente la columna Info Disp de la fila HDMI de la pantalla 
de estado Monitoring (página 30) en On.
Puede mostrar/ocultar la información con el botón DISPLAY. Aunque esté oculta, aparecerá 
superpuesta durante las operaciones en el menú directo (página 106).
También puede elegir si desea mostrar u ocultar cada elemento independientemente 
(página 57).
Es posible que los elementos marcados con un asterisco se muestren en un monitor HDMI 
externo en el modo de visualización de la información.

Información mostrada en la pantalla durante la filmación
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54
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1. Indicador de modo de enfoque* 
(página 98)

Significado Pantalla

Modo Focus Hold Focus Hold

Modo MF MF

Modo AF AF

Modo AF de seguimiento en 
tiempo real

AF de reconocimiento del sujeto (AF/ /Only/ )

Significado Pantalla

Icono de detección de 
humanos

Icono de AF solo de 
humanos

Only

Icono de pausa AF1)

1) Aparece durante el funcionamiento del AF cuando 
la operación de AF no puede continuar y se detiene 
temporalmente. El icono desaparece cuando se 
soluciona el motivo por el que se detiene la operación 
de AF; a continuación, la operación de AF se reanuda.

2. Indicador de posición de enfoque*
Muestra la posición de enfoque (solo cuando 
está acoplado un objetivo compatible con 
la función de visualización del ajuste de 
enfoque).

3. Indicador de estado de red* 
(página 25)

Muestra el estado de conexión de red a través 
de un icono.

4. Indicador de carga/indicador de archivos 
restantes* (página 83)

5. Indicador de modo de grabación y de 
estado de la ranura A/B, indicador de 
intervalo de grabación Interval Rec* 
(página 107)

Pantalla Significado

Rec Grabación

Stby Grabación en espera

6. Indicador de estado de Rec Control de 
salida SDI/HDMI* (página 112)

Muestra el estado de salida de la señal de 
control REC.

7. Indicador de capacidad de batería 
restante/tensión de DC IN* (página 14)

8. Indicador de profundidad de campo*

9. Visualización del nombre del aspecto 
(página 92)

10. Indicador de estado de serie UWP-D 
(página 25)

Muestra la intensidad de la señal de nivel RF 
utilizando un icono cuando se conecta un 
dispositivo de la serie UWP-D a la zapata MI 
de un asa (opcional) equipada con una zapata 
MI configurada para la transferencia de audio 
digital.

11. Indicador de área de enfoque* 
(página 95)

Muestra el área de enfoque para el enfoque 
automático.

12. Indicador de la pantalla asistida de 
gamma

En el modo Custom (página 86), muestra 
el estado de asistencia de visualización de 
gamma. La función de la pantalla asistida 
de gamma se puede activar/desactivar 
asignando Gamma Display Assist a un botón 
asignable (página 106).

13. Monitor de señal de vídeo* (página 109)
Muestra una forma de onda, un vectorscopio y 
un histograma.
La línea naranja indica el valor establecido del 
nivel de cebra.
En el modo Cine EI (página 86), el destino 
del monitor y la gama de colores del sistema 
SDI se muestran encima de la pantalla.
Cuando la opción LUT On está seleccionada, 
“Look” se muestra independientemente del 
tipo de LUT que se aplique.
Cuando la opción LUT Off está seleccionada, 
se muestra el valor Color Gamut.

14. Indicador del advertencia del nivel de 
vídeo

15. Pantalla de nombre del clip (página 55)
Muestra el nombre del clip que se está 
grabando o se grabará a continuación.
El nombre del clip parpadea en los siguientes 
casos.
 • Cuando se inserta un nuevo soporte de 

grabación
 • Cuando el último clip del soporte de 

grabación no coincide con el ajuste Clip 
Name Format (página 55) >Camera ID 
o Reel Number en el menú TC/Media del 
menú completo.

16. Indicador de modo de escaneado de la 
cámara (página 86)

17. Indicador de la velocidad de fotogramas a 
cámara lenta y rápida (página 107)
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18. Indicador de formato de grabación 
(velocidad de fotogramas)/formato de 
grabación (códec) (página 46)

Muestra el nombre del formato de grabación 
en las tarjetas de memoria.

19. Indicador de aspecto de grabación 
(página 92)

20. Indicador de nivel de burbuja*
Muestra el nivel horizontal en intervalos de ±1° 
hasta ±15°.

21. Medidor del nivel de audio*
Muestra el nivel de audio de CH1 a CH4.

22. Indicador de modo de balance de blancos 
(página 102)

Pantalla Significado

Modo Auto

 Hold Modo Auto pausado

W:A Modo de Memoria A

W:B Modo de Memoria B

W:C Modo de Memoria C

23. Indicador de obturación (página 101)

Pantalla Significado

Modo Auto

24. Indicador de Base ISO/Base Sensitivity 
(página 100)

En el modo Cine EI (página 86), muestra la 
sensibilidad ISO base establecida usando Base 
ISO/Sensitivity en la pantalla Main Status o 
ISO/Gain/EI >Base ISO en el menú Shooting 
del menú completo.
En el modo Custom (página 86), muestra 
la sensibilidad base establecida usando Base 
ISO/Sensitivity en la pantalla Main Status o 
ISO/Gain/EI >Base Sensitivity en el menú 
Shooting del menú completo.

25. Indicador de bloqueo de código de 
tiempo externo/pantalla de datos sobre 
el tiempo* (página 88)

Muestra “EXT-LK” cuando está bloqueado con 
el código de tiempo de un dispositivo externo.

26. Indicador del índice de exposición 
(página 100)

En el modo Custom (página 86), muestra la 
ganancia o la sensibilidad ISO.

Pantalla Significado

Modo Auto

Modo de ajuste temporal

Modo de control del bokeh 
(página 109)

27. Indicador de diafragma
Muestra el valor del diafragma (valor T-stop o 
F-stop) (si se acopla un objetivo compatible 
con la pantalla de configuración del 
diafragma).

Pantalla Significado

Modo Auto

[Nota]
El valor F-stop se muestra en lugar del valor T-stop si no 
puede obtenerse el valor T-stop.

28. Indicador del filtro ND (página 101)
Muestra la densidad del filtro ND.

Pantalla Significado

Modo Auto

Modo de control del bokeh 
(página 109)

29. Indicador de modo AE/nivel AE 
(página 53)

30. Indicador de estado del soporte

Pantalla Significado

Montura/Estado de montura 
(soporte A)

Montura/Estado de montura 
(soporte B)

Montura con la grabación de proxy 
activada/estado de montura 
(soporte proxy (tarjeta SD))

(parpa-
deando)

Grabación de proxy activada, pero 
no lista (el soporte no se ha 
insertado, etc.)

(parpa-
deando)

Grabación de proxy detenida

Si la tarjeta de memoria está protegida contra 
escritura, aparece un icono .

31. Indicador del modo de estabilización de 
imagen/distancia focal de estabilización 
de imagen (página 103)

Panta-
lla

Significado Adaptador 
de montu-
ra PL

Estabilización de imagen 
ON (High)

Acoplado

Estabilización de imagen 
ON (Low)

Estabilización de imagen 
OFF

Estabilización de imagen 
ON (Active)

No 
acoplado

Estabilización de imagen 
ON (Standard)

Estabilización de imagen 
OFF

Cuando Image Stabilization >Stabilization 
Adjustment (página 45) en el menú 
Shooting del menú completo está establecido 
en Manual, la distancia focal para la 
estabilización de la imagen se muestra debajo 
del icono de modo de la estabilización de 
imagen.

32. Indicador de posición del zoom 
(página 93)

Muestra la distancia focal del zoom (se 
visualiza solo cuando se conecta un objetivo 
que admite el indicador del ajuste de zoom).
La pantalla se puede cambiar a un indicador 
de barra o indicador numérico (página 65).
El indicador numérico 0 indica ángulo amplio 
y el indicador numérico 99 indica telefoto.
Los siguientes elementos se añaden a la 
pantalla cuando Clear Image Zoom está 
activado.

Pantalla Significado

Clear Image Zoom está activado

Valor de 
ampliación

Cuando se utiliza Clear Image 
Zoom

33. Botón de detención de seguimiento AF 
en tiempo real (página 99)
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Información mostrada en la pantalla durante la reproducción

La siguiente información se superpone sobre la imagen reproducida.

43

7

65

15

1314

9
10

21

8

11
12

004/004

1. Número del clip/Número total de clips*

2. Indicador de estado de red*

3. Indicador de carga/indicador de archivos 
restantes*

4. Indicador de estado de reproducción*

5. Visualización del nombre del aspecto

6. Indicador de capacidad de batería 
restante/tensión de DC IN*

7. Indicador del tamaño de imagen X-OCN
Muestra la resolución grabada y la relación de 
aspecto de un clip en reproducción X-OCN.

8. Indicador de la velocidad de fotogramas a 
cámara lenta y rápida

9. Formato de reproducción
Muestra la velocidad de fotogramas y el códec 
del clip en reproducción. Para XAVC, también 
se muestra el tamaño de la imagen.

10. Indicador de aspecto de grabación

11. Asistencia de visualización de gamma

12. Medidor del nivel de audio*
Muestra el nivel del audio de la reproducción.

13. Pantalla de datos de tiempo*

14. Pantalla de nombre del clip

15. Indicador de capacidad del soporte 
restante

Si la tarjeta de memoria está protegida contra 
escritura, aparece un icono .

Visualización de iconos

Visualización de iconos de conexión de red

Modo de red Estado de conexión Icono

Modo de punto de acceso Funciona como un punto de acceso

Error de funcionamiento de punto de 
acceso

Modo de estación Conexión Wi-Fi
El icono cambia según la intensidad de 
la señal (4 pasos)

   

Wi-Fi desconectado (incluso cuando se 
establece la conexión)

Error al conectarse al Wi-Fi

Anclaje USB Anclaje USB conectado

Anclaje USB desconectado

Error del anclaje USB

LAN con cable LAN con cable conectada

LAN con cable desconectada

Error de LAN con cable

Visualización de iconos de la serie UWP-D

Estado del transmisor Estado de recepción Icono

Apagado Sin recepción

Estado de transmisión normal Recibiendo
 –  (nivel de 

recepción (4 pasos))

Estado de silenciación Recibiendo (en silencio)

Estado de advertencia de capacidad 
restante de la batería

Recibiendo
 (Icono parpadeando)

Estado de advertencia de capacidad 
restante de la batería y silenciación

Recibiendo
 (Icono parpadeando)
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Pantalla Home
Pulse el botón HOME para mostrar la pantalla Home. Puede consultar el estado de la unidad y 
configurar sus ajustes básicos desde la pantalla Home.

Zona de la 
pantalla de 
función/valor de 
ajuste/nombre 
del elemento

Zona de la 
pantalla de 
estado

[Notas]
 • No es posible intercambiar entre funciones automáticas/manuales en la pantalla Home. Configure el ajuste a 

través del menú directo (página 106) o con el menú Shooting del menú completo.
 • En el modo de visualización de la información, el menú directo (página 106) no se puede usar. En primer lugar, 

cambie a la pantalla de filmación con el botón HOME y, a continuación, realice la configuración.

[Consejo]
Puede configurar elementos que se muestran en la pantalla Home utilizando solo el monitor LCD a través de la 
asignación de lo siguiente al botón asignable (página 106) en el monitor LCD.
 • MENU
 • IRIS (cuando se utiliza el objetivo con montura E)

Zona de la pantalla de función/valor de ajuste/nombre del elemento

1 2 3

4 5 6

Botón ITEM 4 Botón ITEM 5 Botón ITEM 6

Botón ITEM 3Botón ITEM 2Botón ITEM 1

[Nota]
Las áreas etiquetadas con los números del 1 al 6 
corresponden a los botones ITEM de 1 a 6. Pulse 
un botón ITEM para seleccionar el elemento 
correspondiente.

1. FPS
Muestra y configura la velocidad de 
fotogramas de la filmación.

2. Exposure Index/Base ISO
Muestra y configura el índice de exposición (EI) 
y la ISO base.

[Consejo]
En el modo Custom, muestra y configura los ajustes ISO/
Base Sensitivity o Gain/Base Sensitivity.

3. Shutter
Muestra y configura el obturador electrónico.

4. ND Filter
Muestra y configura el filtro ND.

[Nota]
En el modo VARIABLE, el filtro ND no se puede 
configurar en la pantalla Home. Realice la configuración 
utilizando los botones del filtro ND y el dial en el lado de 
interruptores del operador de la unidad.

5. Look
Muestra y configura el aspecto.

[Consejo]
En el modo Custom, muestra y configura los archivos de 
escena.

6. WB (White Balance)
Muestra y configura el equilibrio del blanco.
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Zona de la pantalla de estado

1 3 5

8 79

42

610
11

1. Pantalla de datos de tiempo
Muestra la duración, los bits de usuario o el 
código de tiempo en función del ajuste de 
TC Display del menú TC/Media del menú 
completo (página 55).
Muestra el tipo de datos que aparecen 
actualmente en la pantalla de datos de 
tiempo. Son los siguientes:

TCG: código de tiempo grabado 
EXT-LK: bloqueo de sincronización 
externa

UBG: bits de usuario grabados
TCR: código de tiempo de reproducción
UBR: bits de usuario en reproducción
Clk: reloj
Dur: duración

2. Indicador de modo de escaneado de la 
cámara

Muestra el ajuste Imager Scan en la pantalla 
de estado Project.

3. Indicador de velocidad de fotograma
Muestra el ajuste Frequency en la pantalla de 
estado Project.

4. Indicador de formato de grabación 
(códec)/resolución de imagen

Muestra el nombre del formato utilizado para 
la grabación en una tarjeta CFexpress y la 
resolución de imagen.

5. Indicador de tensión del suministro de 
alimentación/capacidad restante de la 
batería

Muestra la tensión del suministro de 
alimentación o la capacidad restante de la 
batería.

6. Medidores del nivel de audio
Indica los niveles de reproducción o de 
grabación de audio. Los números del 1 al 4 
indican los canales del 1 al 4.

7. Pantalla de nombre del clip
Muestra “Reel: Camera ID + Reel Number” y 
“Shot: Camera Position + Shot Number.”

8. Indicador de capacidad del soporte 
restante

Muestra el estado y el tiempo de grabación 
restante (cuando se graba en el formato 
de grabación actual) de cada soporte de 
grabación.

9. Indicador de diafragma
Muestra la posición del diafragma (valor 
T-stop o F-stop).

10. Icono de advertencia/error
Se muestra cuando se produce una 
advertencia o error.
Puede consultar el contenido de las 
advertencias y errores desde el menú. Si la 
visualización de la pantalla está superpuesta 
en un monitor externo, también puede 
consultarlo en el monitor externo.

11. Indicador de estado de la grabación
Muestra los siguientes estados de grabación 
de la unidad.

Pantalla Descripción

   Stby Grabación en espera

Rec Grabación

Cache Grabación en espera de caché 
de imágenes
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Operaciones de la pantalla Home

1 Pulse el botón HOME.
Aparecerá la pantalla Home.

2 Seleccione el elemento que desee 
configurar con los botones ITEM de 1 a 6.
El siguiente diagrama muestra un ejemplo 
cuando se pulsa el botón ITEM 3.

3 Mueva el cursor al elemento o valor de 
ajuste con el botón  (botón ITEM 1) o con 
el botón  (botón ITEM 4).

4 Pulse el botón Set (botón ITEM 3) para 
aplicar el ajuste.

[Consejo]
También puede usar el selector múltiple del monitor 
LCD o el dial multifunción en el lado de interruptores del 
operador de la unidad. En primer lugar, pulse para que 
se muestre un cursor y, a continuación, contrólelo.
El funcionamiento táctil también es compatible.

Elementos de la pantalla Home

A continuación, se muestran los ajustes que es posible configurar para cada elemento. Para 
obtener más detalles acerca de los elementos con los mismos ajustes en el menú completo, 
consulte la descripción del menú completo (página 33).

Elemento Descripción

FPS Establece si la velocidad de fotogramas de filmación está definida en la 
frecuencia del sistema o es distinta a la frecuencia del sistema.
 • Fixed 

Cuando se selecciona la opción “Fixed” en la pantalla, la velocidad de 
fotogramas de filmación coincide con la frecuencia del sistema y se 
muestran tanto “Fixed” como la frecuencia del sistema.

 • Variable 
Cuando se selecciona “Variable” en la pantalla, es posible establecer una 
velocidad de fotogramas de filmación distinta a la frecuencia del 
sistema.  
De 1fps a 60fps/100fps/120fps

[Nota]
Los ajustes disponibles dependen de la frecuencia del sistema, el códec y el formato 
de vídeo seleccionados.  

[Consejo]
Este ajuste corresponde a Rec Function >S&Q Motion en la pantalla de estado Project 
y S&Q Motion en el menú Shooting del menú completo.

Exposure Index/Base 
ISO
(En modo Cine EI)

Establece el índice de exposición (página 39).
Puede pulsar Base ISO para establecer la ISO base (página 39).

[Consejo]
Exposure Index corresponde a ISO/Gain/EI >Exposure Index en el menú Shooting del 
menú completo. Base ISO corresponde a ISO/Gain/EI >Base ISO en el menú Shooting 
del menú completo.

ISO/Gain / Base 
Sensitivity
(En modo Custom)

Establece la ganancia (página 39).
Puede pulsar Base Sensitivity para establecer la sensibilidad base 
(página 39).

[Consejo]
ISO/Gain corresponde a ISO/Gain/EI >ISO o Gain en el menú Shooting del menú 
completo. Base Sensitivity corresponde a ISO/Gain/EI >Base Sensitivity en el menú 
Shooting del menú completo.
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Elemento Descripción

Shutter Establece el obturador electrónico (página 40).
Pulse Angle o ECS para cambiar y ajustar el obturador por ángulo o 
frecuencia, respectivamente.

[Consejos]
 • Angle corresponde a Shutter >Shutter Angle en el menú Shooting del menú 

completo. ECS corresponde a Shutter >ECS On/Off y ECS Frequency en el menú 
Shooting del menú completo.

 • Puede establecer la velocidad del obturador en lugar del ángulo si establece 
Shutter >Mode en Speed en el menú Shooting del menú completo.

ND Filter Define la posición del filtro ND. Activado solo cuando el interruptor ND 
STEP/VARIABLE se encuentra en la posición STEP.

Look
(En modo Cine EI)

Establece el aspecto (página 53). Pulse el botón Edit Look (botón ITEM 4) 
y seleccione un aspecto. Puede establecer los sistemas de salida en los que 
desea aplicar un aspecto a través de los botones ITEM 1, 5 y 6. En función 
del estado, hay combinaciones que no se pueden establecer o ajustes que 
son dependientes entre sí.

[Consejo]
Este ajuste corresponde a un ajuste de la pantalla de estado Monitoring, Base Look 
>Select en el menú Paint/Look del menú completo, y cada elemento de LUT On/Off 
en el menú Shooting del menú completo.

Scene File
(En modo Custom)

Cambia a los ajustes de calidad de imagen preconfigurados.
Además de los ajustes de calidad de imagen preinstalados, puede guardar 
y cambiar a sus ajustes de calidad de imagen preferidos (página 53).

[Consejo]
Este ajuste corresponde a Scene File >Recall en el menú Paint/Look del menú 
completo.

WB (White Balance) Establece el balance de blancos (página 42).
Se proporcionan tres posiciones de memoria blanca (A/B/C). Puede definir 
el valor de cada posición a través de los siguientes métodos.
 • Definiendo la temperatura de color y los valores del tinte por separado
 • Definiendo que se utilice de manera automática el balance de blancos 

automático
 • Seleccionando valores preestablecidos específicos

[Consejo]
Este ajuste corresponde a los elementos que aparecen en White en el menú Shooting 
del menú completo.
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Pantalla de estado
Puede comprobar la configuración y el estado 
de la unidad en la pantalla de estado. Los 
ajustes de los elementos marcados con un 
asterisco (*) se pueden cambiar.
La pantalla de estado admite el 
funcionamiento táctil.

Para mostrar la pantalla de estado
 • Pulse el botón MENU.

[Consejo]
Puede mostrar/ocultar cada pantalla de estado con 
Menu Page On/Off (página 64) en el menú Technical.

Para cambiar la pantalla de estado
 • Gire el dial multifunción.
 • Pulse el selector múltiple hacia arriba/abajo.
 • Deslice la pantalla de estado hacia arriba/

abajo.

[Nota]
Cuando el monitor LCD se encuentra en el modo de 
visualización de información, la operación con el selector 
múltiple en el lado de interruptores del operador de la 
unidad o en el control remoto no están disponibles.

Para ocultar la pantalla de estado
 • Pulse el botón MENU.

Para cambiar un ajuste
Cuando se muestre la pantalla de estado, 
pulse el dial multifunción o el selector múltiple 
para permitir la selección de un elemento de 
configuración en una página. Seleccione un 
número de página y pulse para cambiar de 
página.
También puede seleccionar elementos 
directamente con el funcionamiento táctil.

[Nota]
Puede deshabilitar los cambios en la pantalla de 
estado ajustando Menu Settings >User Menu Only 
(página 64) en el menú Technical del menú completo 
en On.

Pantalla de estado Project

Muestra los ajustes básicos relacionados con 
el proyecto de filmación.

Elemento de la 
pantalla

Descripción

Frequency/Scan* Frecuencia del sistema y 
ajustes del método de 
escaneado

Codec* Ajustes de códec para 
grabación

Rec Function* Ajuste On/Off y ajustes 
principales de la función de 
grabación especial

Simul Rec* Estado y ajuste de 
activación/desactivación de 
la función de grabación 
simultánea en 2 ranuras

Reel Valores Camera ID y Reel 
Number definidos del 
nombre de clip

Imager Scan* Modo de escaneado del 
sensor de imagen

Video Format* Tamaño de imagen para 
grabaciones en tarjetas de 
memoria

Picture Cache 
Rec*

Activación/desactivación de 
la función de grabación en 
la memoria intermedia de 
imágenes y configuración 
del tamaño de la memoria 
intermedia

Shot Valor definido de Camera 
Position y siguiente/actual 
valor de Shot Number de 
grabación del nombre de 
clip

Shooting Mode* Ajuste del modo de disparo

Proxy Rec* Ajuste de activación/
desactivación de la función 
de grabación de proxy

Genlock Estado de Genlock

Pantalla de estado Audio

Muestra el ajuste de entrada, el medidor 
del nivel de audio y el ajuste del monitor de 
volumen para cada canal.

Elemento de la 
pantalla

Descripción

CH1 Level 
Control

Estado de activación/
desactivación del ajuste 
automático

Level Meter Medidor del nivel de audio

Source* Fuente de entrada

Reference* Nivel de referencia de 
entrada

Wind 
Filter*

Ajuste del filtro de reducción 
del ruido del viento en el 
micrófono

CH2 Level 
Control

Estado de activación/
desactivación del ajuste 
automático

Level Meter Medidor del nivel de audio

Source* Fuente de entrada

Reference* Nivel de referencia de 
entrada

Wind 
Filter*

Ajuste del filtro de reducción 
del ruido del viento en el 
micrófono

CH3 Level 
Control*

Estado de activación/
desactivación del ajuste 
automático

Level 
Meter*

Medidor del nivel de audio

Source* Fuente de entrada

Reference* Nivel de referencia de 
entrada

Wind 
Filter*

Ajuste del filtro de reducción 
del ruido del viento en el 
micrófono

Elemento de la 
pantalla

Descripción

CH4 Level 
Control*

Estado de activación/
desactivación del ajuste 
automático

Level 
Meter*

Medidor del nivel de audio

Source* Fuente de entrada

Reference* Nivel de referencia de 
entrada

Wind 
Filter*

Ajuste del filtro de reducción 
del ruido del viento en el 
micrófono

Audio Input 
Level*

Ajuste del nivel de entrada 
de audio (volumen maestro)

HDMI Output CH* Ajuste del canal de audio de 
salida HDMI

Volume* Ajuste del volumen del 
auricular/altavoz integrado

Monitor CH* Ajuste del canal del monitor

Pantalla de estado Monitoring

Muestra los ajustes de salida de SDI y HDMI.

Elemento de la 
pantalla

Descripción

SDI1 Signal* Tamaño de la imagen de 
salida

Info. 
Disp.*

Ajuste de activación/
desactivación de la 
pantalla de salida

Gamut/
Gamma*

Valor definido de la gama 
de colores/estado de 
aplicación de la LUT de 
monitor
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Elemento de la 
pantalla

Descripción

SDI2 Signal* Tamaño de la imagen de 
salida

Info. 
Disp.*

Ajuste de activación/
desactivación de la 
pantalla de salida

Gamut/
Gamma*

Valor definido de la gama 
de colores/estado de 
aplicación de la LUT de 
monitor

HDMI Signal* Tamaño de la imagen de 
salida

Info. 
Disp.*

Ajuste de activación/
desactivación de la 
pantalla de salida

Gamut/
Gamma*

Valor definido de la gama 
de colores/estado de 
aplicación de la LUT de 
monitor

LCD/
Stream

Gamut/
Gamma*

Valor definido de la gama 
de colores/estado de 
aplicación de la LUT de 
monitor

Base Look/LUT* Ajuste de Base Look/LUT

Gamma Display 
Assist*

Ajuste de activación/
desactivación de Gamma 
Display Assist

[Consejo]
En el modo Custom, se muestra Color Gamut en lugar de 
Gamut/Gamma.

Pantalla de estado Assignable Button

Muestra las funciones asignadas a cada uno 
de los botones asignables.

Elemento de la 
pantalla

Descripción

1 Función asignada al botón 
ASSIGN 1

2 Función asignada al botón 
ASSIGN 2

3 Función asignada al botón 
ASSIGN 3

4 Función asignada al botón 
ASSIGN 4

5 Función asignada al botón 
ASSIGN 5

6 Función asignada al botón 
ASSIGN 6

7 Función asignada al botón 
ASSIGN 7

8 Función asignada al botón 
ASSIGN 8

9 Función asignada al botón 
ASSIGN 9

10 Función asignada al botón 
ASSIGN 10

11 Función asignada al botón 
ASSIGN 11

Focus Hold 
Button

Función asignada al botón 
Focus Hold del objetivo

Multi Function 
Dial

Función asignada al dial 
multifunción

Grip Dial Función asignada al dial 
asignable de la empuñadura 1)

1) Control remoto de la empuñadura (opcional)

Pantalla de estado Battery

Muestra información sobre la batería y sobre la 
fuente DC IN.

Elemento de la 
pantalla

Descripción

Detected Battery Tipo de batería

Remaining Capacidad restante (%)

Charge Count Número de recargas

Capacity Capacidad restante (Ah)

Voltage Tensión de la batería (V)

Manufacture 
Date

Fecha de fabricación de la 
batería

Video Light 
Remaining

Muestra la capacidad 
restante de la batería de la 
luz de vídeo.

Power Source Fuente de alimentación

Supplied Voltage Tensión de la fuente de 
alimentación

Pantalla de estado Media

Muestra la capacidad y el tiempo de grabación 
restantes de los soportes de grabación.

Elemento de la 
pantalla

Descripción

Información del 
soporte A

Muestra el icono del soporte 
cuando el soporte de 
grabación se ha introducido 
en la ranura A.

Medidor de la 
capacidad 
restante del 
soporte A

Muestra la capacidad de 
grabación restante del 
soporte de grabación 
introducido en la ranura A, 
expresado en forma de 
porcentaje en un gráfico de 
barras.

Elemento de la 
pantalla

Descripción

Tiempo de 
grabación 
restante del 
soporte A

Muestra un cálculo del 
tiempo de grabación 
restante del soporte de 
grabación introducido en la 
ranura A, expresado en 
minutos según las 
condiciones de grabación 
actuales.

Información del 
soporte B

Muestra el icono del soporte 
cuando el soporte de 
grabación se ha introducido 
en la ranura B.

Medidor de la 
capacidad 
restante B

Muestra la capacidad de 
grabación restante del 
soporte de grabación 
introducido en la ranura B, 
expresado en forma de 
porcentaje en un gráfico de 
barras.

Tiempo de 
grabación 
restante del 
soporte B

Muestra un cálculo del 
tiempo de grabación 
restante del soporte de 
grabación introducido en la 
ranura B, expresado en 
minutos según las 
condiciones de grabación 
actuales.

Información de 
medios de la 
tarjeta Utility SD

Muestra el icono del soporte 
cuando el soporte se ha 
introducido en la ranura de 
la tarjeta Utility SD.

Protección de la 
tarjeta Utility SD

Muestra el icono de bloqueo 
cuando el soporte 
introducido en la ranura de 
la tarjeta Utility SD está 
protegido (bloqueado).

Medidor de 
capacidad 
restante de la 
tarjeta Utility SD

Muestra la capacidad 
restante del soporte 
introducido en la ranura de 
la tarjeta Utility SD, 
expresado en forma de 
porcentaje en un gráfico de 
barras.
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Elemento de la 
pantalla

Descripción

Capacidad 
restante de la 
tarjeta Utility SD

Muestra un cálculo del 
tiempo de grabación de 
proxy restante del soporte 
de grabación introducido en 
la ranura de la tarjeta Utility 
SD expresado en minutos o 
la capacidad restante en GB.

Pantalla de estado Network

Muestra el estado de conexión de red.

Elemento de la 
pantalla

Descripción

Wireless LAN Configuración de red 
inalámbrica y estado de 
conexión

Wired LAN Configuración de red LAN 
con cable y estado de 
conexión

USB Tethering Configuración de red y 
estado de conexión del 
anclaje USB

Pantalla de estado File Transfer

Muestra información sobre la transferencia de 
archivos.

Elemento de la 
pantalla

Descripción

Auto Upload Estado de activación/
desactivación de la carga 
automática del clip original

Auto Upload 
(Proxy)

Estado de activación/
desactivación de la carga 
automática del clip de proxy

Total Transfer 
Progress

Progreso de transferencia de 
todos los trabajos

Default Upload 
Server

Nombre del servidor de 
destino de carga automática 
del clip

Elemento de la 
pantalla

Descripción

Job Status 
(Remain/Total)

Número restante de trabajos 
y número total de trabajos

Current File 
Transfer Progress

Progreso de transferencia de 
la transferencia de archivos 
actual

Current 
Transferring File 
Name

Nombre del archivo que se 
está transfiriendo en estos 
momentos

Server Address Dirección del servidor de 
destino de transferencia de 
archivos

Destination 
Directory

Directorio de destino del 
servidor de transferencia de 
archivos

Uso de las pantallas de configuración táctiles

Diseño de la pantalla

Elemento

Marca indicadora del 
ajuste actual

Botón Set 
(aplicar)

Cursor de selección 
de ajuste 
(cuadro naranja)

Nombre del elemento

Opciones de selección

Funcionamiento

1 Pulse un elemento de configuración.

Pulsar

Aparecen las opciones de selección del 
valor.

2 Arrastre o desplace un ajuste para 
seleccionar el valor.

Desplazar

3 Pulse el botón SET o el cursor de selección 
de valor.
El valor se aplica y se vuelve a visualizar la 
pantalla anterior.

[Consejos]
 • Pulse el botón de BACK para volver al valor anterior.
 • También puede usar el dial multifunción o el selector 

múltiple.
 • Las operaciones táctiles también se pueden 

desactivar (página 63).
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Configuración y jerarquía del menú completo
Mantenga pulsado el botón MENU para 
mostrar el menú completo en el monitor 
LCD con el fin de especificar los distintos 
elementos para filmar y reproducir. El menú 
completo incluye los siguientes menús.

Configuración del menú

Menú User
Contiene elementos del menú 
configurados por el usuario mediante Edit 
User Menu.

Menú Edit User
Contiene elementos del menú para editar 
el menú User.

Menú Shooting
Contiene ajustes relacionados con la 
filmación.

Menú Project
Contiene ajustes básicos del proyecto.

Menú Paint/Look
Contiene ajustes relacionados con la 
calidad de la imagen.

Menú TC/Media
Contiene ajustes relacionados con 
códigos de tiempo y soportes de 
grabación.

Menú Monitoring
Contiene ajustes relacionados con la 
salida de vídeo y la pantalla del visor.

Menú Audio
Contiene ajustes relacionados con el 
audio.

Menú Clip Operations
Contiene ajustes relacionados con las 
operaciones de los clips.

Menú Technical
Contiene ajustes para elementos técnicos.

Menú Network
Contiene ajustes relacionados con las 
redes.

Menú Maintenance
Contiene ajustes de dispositivos, como el 
reloj y el idioma.

Jerarquía del menú completo

User 
(Ajustes de 
fábrica)

Focus

Auto Exposure

Noise Suppression

Image Stabilization

Rec Format

Assignable Button

Multi Function Dial

All File

User File

Base Look

Clip Name Format

Format Media

De-Squeeze

Marker

LCD Monitor Setting

Peaking

Zebra

Menu Settings

Lens

APR

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

Image Stabilization

Project Base Setting

Rec Format

Cine EI Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Paint/Look Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output Format

De-Squeeze

Output Display

Display On/Off

Marker

LCD Monitor Setting

Gamma Display Assist

Peaking

Zebra

Focus Magnifier

Audio Audio Input

Audio Output

Clip Operations Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View
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Technical Color Bars

ND Dial

Rec/Tally

LOCK Switch Setting

Touch Operation

Rec Review

Zoom

Handle Zoom

Menu Settings

Menu Page On/Off

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm

Network Network Setup

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

USB Tethering

File Transfer

Network Reset

Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Operaciones del menú completo
Mantenga pulsado el botón MENU para 
mostrar el menú completo en el monitor LCD 
con el fin de especificar los ajustes detallados 
(el menú también se puede visualizar en 
un monitor HDMI externo en el modo de 
monitorización de vídeo).

Controles del menú

Botón MENU (página 4)
Manténgalo pulsado para mostrar el 
menú completo. Púlselo de nuevo 
mientras se muestra el menú completo 
para ocultar el menú.

Selector múltiple (pad D de 8 formas y botón 
de aplicar) (página 4)

Pulse los botones del pad D de 8 
direcciones para mover el cursor hacia 
arriba, hacia abajo, hacia la izquierda o 
hacia la derecha y seleccionar elementos 
o ajustes del menú.
Pulse el botón de aplicar del selector 
múltiple para aplicar el elemento 
seleccionado.

Dial multifunción (página 4)
Gire el dial multifunción para mover el 
cursor hacia arriba y hacia abajo para 
seleccionar elementos o ajustes del menú.
Pulse el dial multifunción para aplicar el 
elemento seleccionado.

Botón BACK (página 4)
Púlselo para volver al menú anterior. Los 
cambios que no confirme se cancelarán.

[Notas]
 • El menú completo no se puede utilizar cuando el 

modo de ampliación de enfoque está activado 
(página 94).

 • Algunos elementos no pueden seleccionarse, 
dependiendo del estado, cuando se visualiza el 
menú. 

 • Cuando el monitor LCD se encuentra en el modo 
de visualización de información, la operación con 
el selector múltiple en el lado de interruptores del 
operador de la unidad o en el control remoto no están 
disponibles.

Elementos del menú de 
configuración

Presione los botones del pad D de 8 
direcciones o gire el dial multifunción para 
mover el cursor al elemento del menú que 
desea configurar y, a continuación, presione 
el botón de aplicar o el dial multifunción para 
seleccionar el elemento.
 • El área de selección de elementos del menú 

muestra hasta ocho líneas. Si las opciones 
disponibles para un elemento no se pueden 
mostrar al mismo tiempo, desplácese por 
la pantalla moviendo el cursor hacia arriba/
abajo.

 • En el caso de los subelementos con una 
amplia gama de opciones (por ejemplo, 
de –99 a +99), el área de configuración no 
se visualiza. El ajuste actual se resalta para 
indicar que el valor se puede cambiar.

 • Si selecciona Execute para una función, la 
función correspondiente se ejecutará.

 • Si selecciona un elemento que requiere 
confirmación antes de su ejecución, el menú 
se ocultará temporalmente y se mostrará 
un mensaje de confirmación. Compruebe 
el mensaje y a continuación selecciones si 
desea ejecutar o cancelar la función.

Introducción de una cadena de 
caracteres

Cuando selecciona un elemento, como por 
ejemplo un nombre de archivo, que requiere 
la introducción de caracteres, aparecerá la 
pantalla para introducir caracteres.

1

2 3

1 Presione los botones del pad D de 8 
direcciones o gire el dial multifunción para 
seleccionar un tipo de carácter y, a 
continuación, aplique la configuración.
ABC: caracteres alfabéticos en mayúsculas
abc: caracteres alfabéticos en minúsculas
123: caracteres numéricos
!#$: caracteres especiales

2 Seleccione un carácter del tipo de carácter 
seleccionado y, a continuación, aplique el 
ajuste.
El cursor pasa al campo siguiente.
Space: introduce un carácter de espacio 

en la posición del cursor.
/: mueve la posición del cursor.
BS: elimina el carácter a la izquierda del 

cursos (retroceso).

3 Cuando acabe, seleccione Done y aplique 
el ajuste.
La cadena de caracteres se confirma y la 
pantalla de introducción de caracteres 
desaparece.

Bloqueo y desbloqueo del menú

Puede bloquear el menú completo para que 
solo se muestre el menú User.
En este estado, los ajustes no se pueden 
cambiar con las pantallas Home o de estado.

Bloqueo del menú

1 Mantenga pulsado el dial multifunción y 
mantenga pulsado el botón MENU.

2 Seleccione Menu Settings >User Menu 
with Lock en el menú Technical.

 [Nota]
Si solo mantiene pulsado el botón MENU para 
mostrar el menú completo normal, User Menu 
Only se muestra en Menu Settings, en el menú 
Technical. Mantenga pulsado el dial multifunción 
y mantenga pulsado el botón MENU para mostrar 
User Menu with Lock.

3 Ajústelo en On y pulse el botón de aplicar 
o el dial multifunción.
La visualización del monitor LCD cambia a 
la pantalla de introducción del número del 
código de acceso.

4 Introduzca un número arbitrario.
Introduzca un número de 4 dígitos que se 
encuentre entre 0000 y 9999. El valor 
predeterminado es 0000.
Introduzca un número y pulse el botón de 
aplicar o el dial multifunción para mover 
el curso hasta el siguiente dígito.
Cuando haya introducido todos los 
dígitos, mueva el cursor hasta SET.

5 Pulse el botón de aplicar o el dial 
multifunción.
Se aplica el número introducido.
Aparece un mensaje de confirmación y la 
pantalla cambia a la pantalla del menú 
User.
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Desbloqueo del menú

1 Mantenga pulsado el dial multifunción y 
mantenga pulsado el botón MENU.

2 Seleccione Menu Settings >User Menu 
with Lock en el menú User.

 [Nota]
Si solo mantiene pulsado el botón MENU para 
mostrar el menú completo normal, User Menu 
Only se muestra en Menu Settings, en el menú 
Technical. Mantenga pulsado el dial multifunción 
y mantenga pulsado el botón MENU para mostrar 
User Menu with Lock.

3 Ajústelo en Off y pulse el botón de aplicar 
o el dial multifunción.
La visualización del monitor LCD cambia a 
la pantalla de introducción del número del 
código de acceso.

4 Introduzca el número del código de 
acceso que se utilizó para bloquear el 
menú.
Introduzca un número y pulse el botón de 
aplicar o el dial multifunción para mover 
el curso hasta el siguiente dígito.
Cuando haya introducido todos los 
dígitos, mueva el cursor hasta Set.

5 Pulse el botón de aplicar o el dial 
multifunción.
Se aplica el número introducido.
Si el número del código de acceso 
introducido coincide con el número del 
código de acceso que se utilizó para 
bloquear el menú, el menú se desbloquea 
y se muestra.

[Notas]
 • Si el número del código de acceso introducido no 

coincide con el número del código de acceso que 
se utilizó para bloquear el menú, el menú no se 
desbloquea.

 • Se recomienda que anote el número del código de 
acceso en un lugar cercano por si lo olvida. Si se 
olvida del número del código de acceso, póngase en 
contacto con su representante de atención al cliente 
de Sony.

 • Si el menú está bloqueado y no se han registrado 
elementos del menú completo de la siguiente tabla 
en el menú User, esas funciones no se pueden 
asignar a los botones asignables.

 • Si esas funciones ya estaban asignadas a botones 
asignables, cuando se bloquea el menú se fuerza la 
desactivación del ajuste asignable.

Elemento del menú 
completo

Selección de 
botones asignables

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI> 
Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

Shooting >Auto 
Exposure >Auto ND 
Filter

Auto ND Filter

Shooting >Auto 
Exposure >Auto Iris

Auto Iris

Shooting >Iris >Bokeh 
Control

Bokeh Control

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White >Auto 
White Balance

Auto White Balance

Shooting >White >ATW ATW

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus> 
Subject Recognition AF

Subject Recognition 
AF

Elemento del menú 
completo

Selección de 
botones asignables

Monitoring >Focus 
Magnifier >Focus Mag 
Button Target

LCD Focus Magnifier

Monitoring >Focus 
Magnifier >Focus Mag 
Button Target

Output Focus 
Magnifier

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >LUT On/Off 
>SDI/HDMI, Shooting 
>LUT On/Off >SDI

LUT On/Off

Shooting >LUT On/Off 
>LCD/Proxy/Stream, 
Shooting >LUT On/Off 
>LCD/HDMI/Px/
Stream

LUT On/Off

Monitoring >Display 
On/Off >Image 
Stabilization

Image Stabilization

Project >Rec Format 
>Imager Scan Mode

Crop Select

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Technical >Rec Review 
>Setting

Rec Review

Clip Operations >Set 
Clip Flag >Add OK

Clip Flag OK

Clip Operations >Set 
Clip Flag >Add NG

Clip Flag NG

Clip Operations >Set 
Clip Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

TC/Media >TC Display 
>Display Select

DURATION/TC/U-
BIT

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Elemento del menú 
completo

Selección de 
botones asignables

Monitoring >Marker 
>Setting

Marker

Monitoring >LCD 
Monitor Setting >Color 
Mode

LCD Monitor Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)
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Menú User
Esta sección describe la función y los ajustes de los elementos en cada menú (de manera 
predeterminada de fábrica).

User

Elemento del menú Descripción

Focus Elemento de Shooting >Focus

Auto Exposure Elemento de Shooting >Auto Exposure

Noise Suppression Elemento de Shooting >Noise Suppression

Image Stabilization Elemento de Shooting >Image Stabilization

Rec Format Elemento de Project >Rec Format

Assignable Button Elemento de Project >Assignable Button

Multi Function Dial Elemento de Project >Multi Function Dial

All File Elemento de Project >All File

User File Elemento de Project >User File

Base Look Elemento de Paint/Look >Base Look

Clip Name Format Elemento de TC/Media >Clip Name Format

Format Media Elemento de TC/Media >Format Media

De-Squeeze Elemento de Monitoring >De-Squeeze

Marker Elemento de Monitoring >Marker

LCD Monitor Setting Elemento de Monitoring >LCD Monitor Setting

Peaking Elemento de Monitoring >Peaking

Zebra Elemento de Monitoring >Zebra

Menu Settings Elemento de Technical >Menu Settings

Lens Elemento Technical >Lens

APR Elemento Technical >APR

[Nota]
Puede agregar y eliminar elementos de menú en el menú User utilizando el menú Edit User. Se pueden configurar 
hasta 20 elementos.
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Menú End User
El menú Edit User se muestra en el nivel superior cuando se selecciona Edit User Menu en el 
menú User.

Edit User

Elemento del menú Ajuste de subelementos Descripción

Add Item
Adición de un elemento 
al menú User

Agrega un elemento del menú al 
menú User.

Customize Reset
Restablecimiento de los 
elementos en el menú 
User

Restaura los elementos del menú 
registrados en el menú User de 
manera predeterminada de fábrica.

Elemento de menú 
seleccionado durante la 
edición

Delete Elimina el elemento de menú 
registrado del menú User.

Move Reordena los elementos de menú 
registrados dentro del menú User.

Edit Sub Item Edita (registra/elimina) los 
subelementos de menú registrados 
en el menú User.
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Menú Shooting
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Shooting >ISO/Gain/EI
Configura los ajustes de ganancia.

Elemento del 
menú

Ajuste de subelementos Descripción

Mode ISO / dB Selecciona el modo de ajuste de 
ganancia.

ISO/Gain Establece la ganancia.
Activado solo en el modo Custom.

Cuando Mode está ajustado en ISO

Base Look >Select S-Cinetone / Standard / 
Still / ITU709

Distinto a lo de la izquierda

Base Sensitivity Low High Low High

ISO/Gain ISO 320 ISO 1250 ISO 800 ISO 3200

ISO 400 ISO 1600 ISO 1000 ISO 4000

ISO 500 ISO 2000 ISO 1250 ISO 5000

ISO 640 ISO 2500 ISO 1600 ISO 6400

ISO 800 ISO 3200 ISO 2000 ISO 8000

ISO 1000 ISO 4000 ISO 2500 ISO 10000

ISO 1250 ISO 5000 ISO 3200 ISO 12800

ISO 1600 ISO 6400 ISO 4000 ISO 16000

ISO 2000 ISO 8000 ISO 5000 ISO 20000

ISO 2500 ISO 10000 ISO 6400 ISO 25600

Cuando Mode está ajustado en dB 
De –3dB a 0dB a 18dB (incrementos de 1dB)

Shooting >ISO/Gain/EI
Configura los ajustes de ganancia.

Elemento del 
menú

Ajuste de subelementos Descripción

Exposure 
Index

Cuando Base ISO se ajusta en ISO 800
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Cuando Base ISO se ajusta en ISO 3200
800EI / 4.0E
1000EI / 4.3E
1250EI / 4.7E
1600EI / 5.0E
2000EI / 5.3E
2500EI / 5.7E
3200EI / 6.0E
4000EI / 6.3E
5000EI / 6.7E
6400EI / 7.0E
8000EI / 7.3E
10000EI / 7.7E
12800EI / 8.0E

Establece el índice de exposición.
Disponible solo en modo Cine EI.

Shockless 
Gain

On / Off Activa y desactiva la función de ganancia 
sin vibraciones.

Base 
Sensitivity

High / Low Ajusta la sensibilidad base del modo 
Custom.

Base ISO ISO 3200 / ISO 800 Establece la sensibilidad ISO base para el 
modo Cine EI.
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Shooting >ND Filter
Establece el modo de visualización utilizado para expresar el nivel de transmitancia de luz del 
filtro ND.

Elemento del 
menú

Ajuste de subelementos Descripción

Display Mode Optical Density / Transmittance Establece el modo de visualización 
utilizado para expresar el nivel de 
transmitancia de luz del filtro ND. La 
visualización y el control se ejecutan con 
el modo de visualización seleccionado.
Optical Density: 

Muestra y controla la cantidad de luz 
transmitida a través del filtro ND en 
términos de densidad óptica 
(notación logarítmica).

Transmittance: 
Muestra y controla la cantidad de luz 
transmitida a través del filtro ND en 
términos de transmitancia 
(visualización fraccional).

Shooting >Shutter
Ajusta el funcionamiento del obturador electrónico.

Elemento del 
menú

Ajuste de subelementos Descripción

Mode Speed / Angle Selecciona el modo del obturador 
electrónico.
Selecciona el modo para ajustar la 
velocidad del obturador en segundos 
(Speed) o como el ángulo del obturador 
(Angle).

Shutter 
Speed  
On/Off

On / Off Establece si el tiempo de exposición 
cuando se selecciona el modo Speed 
sigue el valor de Shutter Speed o se 
establece para exposición completa.

Shooting >Shutter
Ajusta el funcionamiento del obturador electrónico.

Elemento del 
menú

Ajuste de subelementos Descripción

Shutter 
Speed

64F a 1/8000
Los ajustes disponibles dependen de la 
frecuencia del sistema del formato de 
grabación seleccionado.
59.94P: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Ajusta la velocidad del obturador cuando 
el modo Speed está seleccionado.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360.0° / 300.0° / 270.0° / 240.0° / 
216.0° / 210.0° / 180.0° / 172.8° / 150.0° / 
144.0° / 120.0° / 90.0° / 86.4° / 72.0° / 
45.0° / 30.0° / 22.5° / 11.25° / 5.6°

Ajusta el ángulo del obturador cuando el 
modo Angle está seleccionado.

ECS On/Off On / Off Activa y desactiva la función Extended 
Clear Scan.
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Shooting >Shutter
Ajusta el funcionamiento del obturador electrónico.

Elemento del 
menú

Ajuste de subelementos Descripción

ECS 
Frequency

De 23.99 a 8000
Los ajustes disponibles dependen de la 
frecuencia del sistema del formato de 
grabación seleccionado.
A continuación se indican los valores 
predeterminados.
59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Ajusta la frecuencia ECS cuando el modo 
ECS está seleccionado.

Shooting >Iris
Configura los ajustes de la función de control del bokeh.

Elemento del 
menú

Ajuste de subelementos Descripción

Bokeh 
Control

On / Off Permite activar/desactivar la función de 
control del bokeh.

Shooting >Auto Exposure
Configura los ajustes de la exposición automática.

Elemento del 
menú

Ajuste de subelementos Descripción

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Establece el nivel de brillo para la 
exposición detectada automáticamente.

Shooting >Auto Exposure
Configura los ajustes de la exposición automática.

Elemento del 
menú

Ajuste de subelementos Descripción

Mode Backlight / Standard / Spotlight Establece el modo de funcionamiento del 
ajuste de exposición automática.
Backlight: 

Modo de retroiluminación (modo 
para reducir el oscurecimiento de un 
sujeto cuando dicho sujeto está 
retroiluminado)

Standard: 
Modo estándar

Spotlight: 
Modo de luz direccional (modo para 
reducir la sobreexposición de blancos 
cuando el sujeto recibe una 
iluminación direccional)

Speed De –99 a +99 (±0) Establece la velocidad de ajuste del 
ajuste de exposición automática.

Auto ND Filter On / Off Activa/desactiva la función de ajuste 
automático del nivel de transmitancia del 
filtro ND.

AGC On / Off Activa y desactiva la función AGC (Control 
automático de ganancia).

AGC Limit Ajusta la ganancia máxima de la función AGC.

Cuando Mode está ajustado en ISO

Base Look >Select S-Cinetone / Standard / 
Still / ITU709

Distinto a lo de la izquierda

Base Sensitivity Low High Low High

AGC Limit ISO 400 ISO 1600 ISO 1000 ISO 4000

ISO 500 ISO 2000 ISO 1250 ISO 5000

ISO 640 ISO 2500 ISO 1600 ISO 6400

ISO 800 ISO 3200 ISO 2000 ISO 8000

ISO 1000 ISO 4000 ISO 2500 ISO 10000

ISO 1250 ISO 5000 ISO 3200 ISO 12800

ISO 1600 ISO 6400 ISO 4000 ISO 16000

ISO 2000 ISO 8000 ISO 5000 ISO 20000

ISO 2500 ISO 10000 ISO 6400 ISO 25600

Cuando Mode está establecido en dB 
3dB, 6dB, 9dB, 12dB, 15dB, 18dB
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Shooting >Auto Exposure
Configura los ajustes de la exposición automática.

Elemento del 
menú

Ajuste de subelementos Descripción

AGC Point F2.8 / F4 / F5.6 Establece el valor F-stop de los iris si la 
operación AGC empieza cuando la 
función AGC está ajustada en On.

Auto Shutter On / Off Activa y desactiva la función de control 
del obturador automático.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Ajusta la velocidad más rápida del 
obturador en la función de obturador 
automático.

A.SHT Point F5.6 / F8 / F11 / F16 Establece el valor F-stop de los iris si se 
inicia la operación de obturación 
automática.

Auto Iris On / Off Activa/desactiva el diafragma 
automático.

Clip High 
light

On / Off Activa y desactiva la función que ignora 
las zonas más iluminadas para 
proporcionar una respuesta menor a la 
luminosidad alta.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Ajusta el rango del medidor de luz para 
ajustar automáticamente la exposición 
de acuerdo con la luminosidad del sujeto. 
(No disponible cuando se ajusta la 
exposición manualmente)

Detect 
Window 
Indication

On / Off Activa/desactiva la indicación del rango 
del medidor de luz.

Custom 
Width

De 40 a 999 (500) Establece el ancho del rango del medidor 
de luz.

Custom 
Height

De 70 a 999 (500) Establece la altura del rango del medidor 
de luz.

Custom H 
Position

De –479 a +479 (±0) Ajusta la posición horizontal del rango 
del medidor de luz.

Custom V 
Position

De –464 a +464 (±0) Ajusta la posición vertical del rango del 
medidor de luz.

Shooting >White
Configura los ajustes del balance de blancos.

Elemento del 
menú

Ajuste de subelementos Descripción

White Select A / B / C Selecciona la posición de la memoria 
blanca.

Auto White 
Balance

Execute / Cancel Ejecuta el balance de blancos automático 
para la posición de memoria blanca 
seleccionada (a través de Execute).

ATW On / Off Activa y desactiva la función ATW.

[Nota]
Cuando cambie a una posición de memoria 
blanca, la función ATW se establecerá en Off.

Color Temp De 2000K a 15000K (3200K) Establece la temperatura de color del 
balance de blancos que se guardará en la 
posición de la memoria blanca 
seleccionada.

[Nota]
Dado que Color Temp se recorta a 2000K y 
15000K durante la operación R/B Gain, es 
posible que no se pueda mostrar el valor 
correcto de Color Temp correspondiente al 
valor R/B Gain.

Tint De –99 a +99 (±0) Establece el valor de tinte del balance de 
blancos que se guardará en la posición 
de la memoria blanca seleccionada.

[Nota]
Dado que Tint se recorta a ±99 durante 
la operación R/B Gain, es posible que no 
se pueda mostrar el valor correcto de Tint 
correspondiente al valor R/B Gain.

R Gain De –99.0 a +99.0 (±0.0) Establece el valor de ganancia R del 
balance de blancos que se guardará en la 
posición de la memoria blanca 
seleccionada.

B Gain De –99.0 a +99.0 (±0.0) Establece el valor de ganancia B del 
balance de blancos que se guardará en la 
posición de la memoria blanca 
seleccionada.
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Shooting >White
Configura los ajustes del balance de blancos.

Elemento del 
menú

Ajuste de subelementos Descripción

Preset White 
Select

En el modo de filmación Custom 
3200K ±00 
4300K ±00 
5600K ±00 
6300K ±00

En el modo de filmación Cine EI 
3200K ±00 
4300K ±00 
5500K ±00

Establece la temperatura de color del 
balance de blancos que se guardará en la 
posición de la memoria blanca 
seleccionada utilizando un valor 
preestablecido especificado. El valor de 
tinte está definido en ±0.

Shooting >White Setting
Ajusta los ajustes del balance de blancos.

Elemento del 
menú

Ajuste de subelementos Descripción

Shockless 
White

Off / 1 / 2 / 3 Ajusta la velocidad de respuesta del 
balance de blancos cuando se cambia el 
modo de balance de blancos.
Off: cambia instantáneamente.
De 1 a 3: cambia más lentamente cuanto 

mayor es el número.

ATW Speed 1 / 2 / 3 / 4 / 5 Ajusta la velocidad de respuesta en el 
modo ATW.
1: Velocidad de respuesta más rápida

Shooting >Focus
Configura los ajustes de enfoque.

Elemento del 
menú

Ajuste de subelementos Descripción

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Establece la velocidad del enfoque para 
cuando el sujeto cambia durante el 
enfoque automático.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Establece la sensibilidad para cambiar el 
enfoque del sujeto durante el enfoque 
automático.

Shooting >Focus
Configura los ajustes de enfoque.

Elemento del 
menú

Ajuste de subelementos Descripción

Focus Area Wide / Zone / Flexible Spot Establece el área de destino para la 
función Auto Focus y Push Auto Focus 
(AF) (página 95).
Wide: 

Busca un sujeto en un ángulo amplio 
de la imagen al enfocar.

Zone: 
Busca automáticamente un punto de 
enfoque dentro de la zona 
especificada.

Flexible Spot: 
Enfoca una posición especificada en 
la imagen.

Subject 
Recognition 
AF

Human Only AF / Human Priority AF / Off Establece la operación de la función de 
AF de reconocimiento del sujeto.
Human Only AF: 

La cámara detecta sujetos (personas) 
y enfoca a sus ojos, cara y cuerpo. 
Cuando no se detecta una persona, 
se activa el enfoque manual.

Human Priority AF: 
La cámara detecta sujetos (personas) 
y enfoca a sus ojos, cara y cuerpo. 
Cuando no se detecta una persona, 
se activa el enfoque automático.

Touch 
Function in 
MF

Tracking AF / Spot Focus Establece la acción que ocurre cuando se 
toca el panel táctil durante el enfoque 
manual.

AF Assist On / Off Cuando está ajustado en On, le permite 
anular temporalmente el enfoque 
automático para ajustar el enfoque 
manualmente.



3. Operaciones de la cámara: Menú Shooting44

Shooting >S&Q Motion
Configura los ajustes del modo de movimiento lento y rápido (página 107).

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo Slow & Quick 
Motion.
Cuando se ajusta en On, se inhabilitan las 
siguientes funciones.
 • Diafragma automático
 • Enfoque automático

Frame Rate De 1fps a 60fps/100fps/120fps Ajusta la velocidad de fotogramas para la 
filmación con el modo Slow & Quick 
Motion.

[Nota]
Los ajustes disponibles dependen de la 
frecuencia del sistema, el códec y el formato de 
vídeo seleccionados.

Shooting >LUT On/Off
Configura los ajustes de LUT.

Elemento del 
menú

Ajuste de subelementos Descripción

SDI/HDMI LUT On / LUT Off Selecciona si se va a aplicar la LUT de 
monitor al vídeo de las salidas SDI y 
HDMI.

[Nota]
Configurable cuando Rec Format >Codec 
(página 46) está ajustado en el formato 
X-OCN en el menú Project.

SDI LUT On / LUT Off Selecciona si se va a aplicar la LUT de 
monitor al vídeo de la salida SDI.

[Nota]
Configurable cuando Rec Format >Codec 
(página 46) no se establece en el formato 
X-OCN en el menú Project.

LCD/
Proxy/Stream

LUT On / LUT Off Selecciona si se va a aplicar la LUT de 
monitor al vídeo de las salidas LCD, Proxy 
y Stream.

[Nota]
Configurable cuando Rec Format >Codec 
(página 46) está ajustado en el formato 
X-OCN en el menú Project.

Shooting >LUT On/Off
Configura los ajustes de LUT.

Elemento del 
menú

Ajuste de subelementos Descripción

LCD/
HDMI/Px/
Stream

LUT On / LUT Off Selecciona si se va a aplicar la LUT de 
monitor al vídeo de las salidas LCD, HDMI, 
Proxy y Stream.

[Nota]
Configurable cuando Rec Format >Codec 
(página 46) no se establece en el formato 
X-OCN en el menú Project.

Shooting >Noise Suppression
Configura los ajustes de supresión de ruido.

[Consejo]
Los ajustes Setting(Custom) y Level(Custom) se reflejan en el ajuste Target Display (página 71).

Elemento del 
menú

Ajuste de subelementos Descripción

Setting 
(Custom)

On / Off Activa y desactiva la función de 
supresión de ruido en el modo Custom.

Level 
(Custom)

Low / Mid / High Ajusta el nivel de supresión de ruido en 
el modo Custom.

Setting 
(Cine EI)

On / Off Activa y desactiva la función de 
supresión de ruido en el modo Cine EI.

Level 
(Cine EI)

Low / Mid / High Ajusta el nivel de supresión de ruido en 
el modo Cine EI.

Shooting >Flicker Reduce
Configura los ajustes de corrección de parpadeo.

Elemento del 
menú

Ajuste de subelementos Descripción

Mode Auto / On / Off Ajusta el modo de corrección de 
parpadeo.

Frequency 50Hz / 60Hz Ajusta la frecuencia de la fuente de 
alimentación que proporciona la 
iluminación causante del parpadeo.
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Shooting >Image Stabilization
Configura los ajustes de estabilización de la imagen (página 103).

Elemento del 
menú

Ajuste de subelementos Descripción

PL 
Stabilization

High / Low / Off Configura la función de estabilización de 
la imagen.

[Nota]
Configurable solo cuando el adaptador de la 
montura PL está acoplado.

SteadyShot Active / Standard / Off Configura la función de estabilización de 
la imagen.

[Notas]
 • Configurable solo cuando un adaptador de 

montura PL no está acoplado.
 • Si hay acoplado un objetivo con un 

interruptor de estabilización de la imagen 
y el interruptor del objetivo está ajustado 
en la posición OFF, el ajuste del objetivo 
tiene prioridad y no se puede cambiar en la 
unidad.

Stabilization 
Adjustment

Auto / Manual Configura la función de estabilización de 
la imagen adecuada para el objetivo 
acoplado.
Auto: 

La estabilización de la imagen se 
efectúa de manera automática en 
base a la información obtenida del 
objetivo.

Manual: 
Estabilización de la imagen 
correspondiente a la distancia focal 
establecida en Focal Length (de 
8 mm a 1000 mm).

Shooting >Image Stabilization
Configura los ajustes de estabilización de la imagen (página 103).

Elemento del 
menú

Ajuste de subelementos Descripción

Focal Length 8mm / 9mm / 10mm / 11mm / 12mm / 
13mm / 14mm / 15mm / 16mm / 17mm / 
18mm / 19mm / 20mm / 21mm / 24mm / 
25mm / 28mm / 30mm / 32mm / 35mm / 
40mm / 45mm / 50mm / 55mm / 60mm / 
70mm / 75mm / 80mm / 85mm / 90mm / 
100mm / 105mm / 120mm / 135mm / 
150mm / 180mm / 200mm / 210mm / 
250mm / 300mm / 350mm / 400mm / 
450mm / 500mm / 600mm / 800mm / 
1000mm

Establece la información sobre la 
distancia focal para la función de 
estabilización de la imagen en la cámara 
cuando el ajuste de estabilización de la 
imagen está definido en Manual.

[Notas]
 • La estabilización de la imagen no funciona 

correctamente si no es posible obtener la 
distancia focal y otra información desde el 
objetivo. Establezca Stabilization Adjustment 
en Manual y configure la opción Focal 
Length para que coincida con el objetivo 
acoplado. El valor de la distancia focal de 
estabilización de la imagen configurado se 
muestra debajo del icono de estabilización 
de la imagen.

 • Si se acopla un objetivo conversor al objetivo 
SEL16F28 (opcional), establezca Stabilization 
Adjustment en Manual y configure la opción 
Focal Length.
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Menú Project
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Project >Base Setting
Configura los ajustes básicos.

Elemento del 
menú

Ajuste de subelementos Descripción

Shooting 
Mode

Custom / Cine EI Ajusta el modo de filmación 
(página 86).

Target 
Display

SDR(BT.709) / HDR(HLG) Ajusta la gama de colores de la 
grabación/salida en el modo Custom.

Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento del 
menú

Ajuste de subelementos Descripción

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Selecciona la frecuencia del sistema.

Imager Scan 
Mode

FF 8.6K 17:9 / FF 8.6K 16:9 / FFc 6K 17:9 / 
FFc 6K 16:9 / S35 5.8K 17:9 / S35 5.8K 16:9 /  
S35c 4K 17:9

Selecciona el tamaño de la cámara.

[Consejo]
Si desea grabar en 8K, defina la frecuencia del 
sistema en 29.97 o menos.

Codec X-OCN(LT) / XAVC H-I HQ / XAVC H-I SQ / 
XAVC H-L / XAVC-I / XAVC-L

Ajusta el códec de grabación/
reproducción del clip.

[Consejos]
 • Si desea grabar en 8K, seleccione X-OCN o 

XAVC H.
 • X-OCN solo se puede seleccionar en el 

modo Cine EI.

Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento del 
menú

Ajuste de subelementos Descripción

Video Format Los ajustes disponibles dependen de la 
configuración de Frequency y Codec.

Ajusta el tamaño de imagen y la 
velocidad de bits.

[Consejo]
El tamaño de imagen de X-OCN viene 
determinado por el modo Imager Scan. XAVC H 
solo admite 8K.

Frequency Codec Opciones de 
selección

59.94 X-OCN(LT) –

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

50 X-OCN(LT) –

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P
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Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento del 
menú

Ajuste de subelementos Descripción

Video Format 29.97 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

7680×4320P

XAVC H-I SQ 8192×4320P

7680×4320P

XAVC H-L 7680×4320P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

25 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

7680×4320P

XAVC H-I SQ 8192×4320P

7680×4320P

XAVC H-L 7680×4320P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

23.98 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

7680×4320P

XAVC H-I SQ 8192×4320P

7680×4320P

XAVC H-L 7680×4320P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento del 
menú

Ajuste de subelementos Descripción

Video Format 24 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

XAVC H-I SQ 8192×4320P

XAVC-I 4096×2160P

Project >Cine EI Setting
Configura los ajustes del modo Cine EI.

Elemento del 
menú

Ajuste de subelementos Descripción

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Ajusta la gama de colores en el modo 
Cine EI.

Embed LUT 
File

On / Off Activa y desactiva la grabación de 
metadatos del archivo 3D LUT (archivo 
CUBE).

Project >Simul Rec
Ajusta el modo de grabación simultánea (página 109).

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
grabación simultánea y ajusta el soporte 
de destino de grabación.

Project >Proxy Rec
Ajusta el modo de grabación de proxy.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo de grabación 
de proxy.

Audio 
Channel

CH1/CH2 / CH3/CH4 Selecciona el canal de audio en el que se 
grabarán los datos de proxy.
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Project >Interval Rec
Ajusta el modo de grabación de intervalos (página 107).

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo de grabación 
de intervalo. (Si se ajusta este modo en 
On, el resto de modos especiales se 
ajustará en Off).

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Ajusta el intervalo entre grabaciones en 
el modo de grabación Interval Rec 
(cuando Interval Rec está ajustado en 
On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Los ajustes disponibles dependen de la 
frecuencia de fotogramas del formato de 
vídeo seleccionado.
59.94P/50P: 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P: 

1frame / 3frames / 6frames / 9frames

Ajusta el número de fotogramas que se 
desea grabar por toma en el modo de 
grabación Interval Rec (cuando Interval 
Rec está ajustado en On).

Pre-Lighting Off / 2 s / 5 s / 10 s Ajusta el número de segundos que se 
enciende la luz de vídeo antes de que se 
inicie la grabación en el modo de 
grabación Interval Rec.

[Consejo]
Disponible únicamente cuando se utiliza el 
HVL-LBPC (opcional).

Project >Picture Cache Rec
Configura los ajustes del modo Picture Cache Rec (página 108).

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo de grabación 
de memoria intermedia.

Cache Size Short / Medium / Long / Max Ajusta la hora de acumulación de las 
imágenes en la memoria intermedia de 
imágenes (hora de grabación de 
memoria intermedia de imágenes).

Cache Rec 
Time

Muestra la hora de acumulación de las 
imágenes en la memoria intermedia de 
imágenes (hora de grabación de 
memoria intermedia de imágenes).

Project >SDI/HDMI Rec Control
Configura los ajustes de control de grabación SDI/HDMI.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Establece el control de inicio/parada de 
grabación de un dispositivo externo 
mediante la señal de salida SDI/HDMI.
Off: 

No usa el control remoto.
SDI/HDMI Remote I/F: 

Control de detención/inicio de 
grabación de un dispositivo externo 
conectado cuando no hay ningún 
soporte insertado en la unidad. No 
sincronizado con la precisión de 
fotogramas para el soporte de la 
unidad.

Parallel Rec: 
Control de detención/inicio de 
grabación de un dispositivo externo 
conectado cuando hay un soporte 
insertado en la unidad. Sincronizado 
con la precisión de fotogramas para 
el soporte de la unidad.

[Notas]
 • Para el control con la señal de salida HDMI, 

ajuste HDMI TC Out >Setting (página 55) 
en el menú TC/Media del menú completo 
en On.

 •  La opción Parallel Rec no se puede 
seleccionar cuando la grabación X-OCN está 
ajustada.
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Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento del 
menú

Ajuste de subelementos Descripción

<1> a <11>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Iris / Auto Iris / Push Auto 
Iris / Bokeh Control / Auto Shutter / Auto 
Exposure Level / Backlight / Spotlight / 
Auto White Balance / ATW / ATW Hold / 
AF Speed/Sens. / Focus Setting / Subject 
Recognition AF / Push AF/Push MF / Focus 
Hold / LCD Focus Magnifier / Output Focus 
Magnifier / S&Q Motion / LUT On/Off / 
LUT On/Off / Image Stabilization / Crop 
Select / Rec / Picture Cache Rec / Rec 
Review / Clip Flag OK / Clip Flag NG / Clip 
Flag Keep / Color Bars / DURATION/
TC/U-BIT / Display / Lens Info / Video 
Signal Monitor / Marker / LCD Monitor 
Adjust / LCD Monitor Mode / Gamma 
Display Assist / Peaking / Zebra / Volume / 
Clips / Touch Operation / Handle Zoom / 
Auto Upload (Proxy) / Direct Menu / User 
Menu / Menu

Asigna funciones a los botones 
asignables.
Base ISO/Sensitivity: 

Cambia la sensibilidad base del 
sensor de imagen.

AGC: 
Activa y desactiva la función AGC.

Push AGC: 
Habilita la función AGC mientras se 
mantiene pulsado el botón.

ND Filter Position: 
Cambia los filtros ND.

Auto ND Filter: 
Activa y desactiva la función de filtro 
ND.

Push Auto ND: 
Habilita la función Auto ND Filter 
mientras se mantiene pulsado el 
botón.

Iris: 
Selecciona el ajuste de posición del 
diafragma. 
En el modo de monitorización de 
vídeo, manténgalo pulsado para 
seleccionar los ajustes automáticos/
manuales.

Auto Iris: 
Activa y desactiva la función del 
diafragma automático.

Push Auto Iris: 
Habilita la función de diafragma 
automático mientras se mantenga 
pulsado el botón.

Control del bokeh: 
permite activar/desactivar la función 
de control del bokeh.

Auto Shutter: 
Activa y desactiva la función del 
obturador automático.

Auto Exposure Level: 
Muestra/sale del menú directo de 
Auto Exposure Level.

Backlight: 
Cambia entre retroiluminación y 
estándar.

Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento del 
menú

Ajuste de subelementos Descripción

<1> a <11>, 
Focus Hold 
Button

Spotlight: 
Cambia entre luz direccional y 
estándar.

Auto White Balance: 
Ejecuta el balance de blancos 
automático.

ATW: 
Activa y desactiva la función ATW.

ATW Hold: 
Pausa la operación de la función 
ATW.

AF Speed/Sens.: 
Cambia el ajuste de la velocidad de 
transición AF y el ajuste de la 
sensibilidad de desplazamiento del 
sujeto AF.

Focus Setting: 
Establece el área de enfoque.

Subject Recognition AF: 
Cambia el ajuste Subject Recognition 
AF.

Push AF/Push MF: 
En el modo de enfoque MF, activa AF 
mientras se presiona el botón. 
En el modo de enfoque AF, activa MF 
mientras se presiona el botón.

Focus Hold: 
En el modo de enfoque AF, el 
enfoque se fija mientras se presiona 
el botón.

LCD Focus Magnifier:
Output Focus Magnifier: 

Cambia la relación del amplificador 
de enfoque del monitor LCD o la 
salida externa.

[Consejo]
Puede seleccionar LCD Focus Magnifier 
cuando la opción Focus Magnifier >Focus 
Mag Button Target (página 59) en el 
menú Monitoring del menú completo 
está establecida en LCD Monitor. Puede 
seleccionar Output Focus Magnifier 
cuando está definida en Output.
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Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento del 
menú

Ajuste de subelementos Descripción

<1> a <11>, 
Focus Hold 
Button

S&Q Motion: 
Activa y desactiva el movimiento 
lento y rápido. 
Establece la velocidad de fotogramas 
de filmación si se mantiene pulsado.

LUT On/Off: 
Cambia el ajuste LUT On/Off >SDI 
o SDI/HDMI en el menú Shooting.

LUT On/Off: 
Cambia el ajuste LUT On/Off >LCD/
HDMI/Px/Stream o LCD/Proxy/
Stream en el menú Shooting.

Image Stabilization: 
Cambia la operación de la función de 
estabilización de la imagen.

Crop Select: 
Establece el modo de escaneado de 
la cámara.

Rec: 
Inicia/detiene la grabación.

Picture Cache Rec: 
Activa y desactiva el modo de 
grabación de memoria intermedia.

Rec Review: 
Activa y desactiva la función Rec 
Review.

Clip Flag OK: 
Ejecuta la función Add OK. 
Pulse dos veces para ejecutar Delete 
Clip Flag.

Clip Flag NG: 
Ejecuta la función Add NG. 
Pulse dos veces para ejecutar Delete 
Clip Flag.

Clip Flag Keep: 
Ejecuta la función Add Keep. 
Pulse dos veces para ejecutar Delete 
Clip Flag.

Color Bars: 
Activa y desactiva las barras de 
colores.

DURATION/TC/U-BIT: 
Alterna entre Time Code, Users Bit y 
Duration.

Display: 
Activa y desactiva los indicadores de 
la pantalla..

Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento del 
menú

Ajuste de subelementos Descripción

<1> a <11>, 
Focus Hold 
Button

Lens Info: 
Cambia el indicador de profundidad 
de campo.

Video Signal Monitor: 
Cambia el monitor de señal de vídeo 
(como un monitor de forma de onda)

Marker: 
Activa y desactiva la función de 
marcador.

LCD Monitor Adjust: 
Muestra las barras de nivel para el 
ajuste del brillo del monitor LCD.

LCD Monitor Mode: 
Cambia el monitor LCD entre color y 
blanco y negro.

Gamma Display Assist: 
Cambia la función de asistencia de 
visualización de gamma.

Peaking: 
Activa y desactiva la función de 
nitidez.

Zebra: 
Activa y desactiva la función cebra.

Volume: 
Ajusta la salida del nivel de audio del 
monitor en la toma de auriculares y 
en el altavoz incorporado.

Clips: 
Muestra/cierra la pantalla de clips.

Touch Operation: 
Activa y desactiva el funcionamiento 
táctil.

Handle Zoom: 
Cambia el funcionamiento del zoom 
del asa.

Auto Upload (Proxy): 
Activa/desactiva la carga automática 
del clip de proxy.

Direct Menu: 
Muestra/sale del menú directo.

User Menu: 
Muestra/sale del menú directo.

Menu: 
Muestra/sale del menú completo.
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Project >Assignable Dial
Establece las asignaciones de funciones para el dial asignable y ajusta el sentido de rotación.

Elemento del 
menú

Ajuste de subelementos Descripción

Grip/Remote 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS /  
Auto Exposure Level / Audio Input Level / 
Multi Function Dial

Asigna funciones al dial asignable del 
control remoto de la empuñadura 
(opcional) o RM-30BP.
ISO/Gain/EI: 

Ajusta la ganancia o EI.
ND Filter: 

Ajusta el filtro ND.
IRIS: 

Ajusta el diafragma.
Auto Exposure Level: 

Ajusta el nivel de exposición 
automática.

Audio Input Level: 
Ajusta el nivel de grabación de audio.

Multi Function Dial: 
Funciona como un dial multifunción.

Grip Dial 
Direction

Normal / Opposite Establece la dirección de rotación del dial 
asignable del control remoto de la 
empuñadura (opcional) o RM-30BP.
Normal: girar en sentido normal.
Opposite: Girar en sentido contrario.

Project >Multi Function Dial
Asigna funciones al dial multifunción.

Elemento del 
menú

Ajuste de subelementos Descripción

Default 
Function

Off / ISO/Gain/EI / IRIS / Auto Exposure 
Level / Audio Input Level 

Asigna la función predeterminada al dial 
multifunción.
IRIS: 

Ajusta el diafragma.
ISO/Gain/EI: 

Ajusta la ganancia o EI.
Auto Exposure Level: 

Ajusta el nivel de exposición 
automática.

Audio Input Level: 
Ajusta el nivel de grabación de audio.

Project >User File
Establece configuraciones relacionadas con las operaciones de archivos de usuario.

Elemento del 
menú

Ajuste de subelementos Descripción

Load from 
UTILITY SD

Execute / Cancel Carga los ajustes del archivo de usuario 
desde una tarjeta SD.
Execute: ejecuta la función.

Save to 
UTILITY SD

Execute / Cancel Guarda los ajustes del archivo de usuario 
en una tarjeta SD.
Execute: ejecuta la función.

File ID Muestra una pantalla para mostrar/editar 
el identificador de archivo de los archivos 
de usuario.

Load 
Customize 
Data

On / Off Establece si desea cargar la información 
personalizada del menú User al ejecutar 
Load from UTILITY SD.

Load White 
Data

On / Off Establece si desea cargar la información 
del balance de blancos al ejecutar Load 
from UTILITY SD.

Project >All File
Configura los ajustes relacionados con los archivos ALL (todos los ajustes).

Elemento del 
menú

Ajuste de subelementos Descripción

Load from 
UTILITY SD

Execute / Cancel Carga un archivo ALL desde una tarjeta 
SD.
Execute: ejecuta la función.

Load from 
Cloud(Private)

Execute / Cancel Carga un archivo ALL cargado desde el 
servicio en la nube de C3 Portal (privado).
Execute: ejecuta la función.

Load from 
Cloud(Share)

Execute / Cancel Carga un archivo ALL cargado desde el 
servicio en la nube de C3 Portal 
(compartido).
Execute: ejecuta la función.

Save to 
UTILITY SD

Execute / Cancel Guarda los ajustes de un archivo ALL en 
una tarjeta SD.
Execute: ejecuta la función.

Save to 
Cloud(Private)

Execute / Cancel Guarda los ajustes de un archivo ALL en 
el servicio en la nube de C3 Portal 
(privado).
Execute: ejecuta la función.
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Project >All File
Configura los ajustes relacionados con los archivos ALL (todos los ajustes).

Elemento del 
menú

Ajuste de subelementos Descripción

Save to 
Cloud(Share)

Execute / Cancel Guarda los ajustes de un archivo ALL en 
el servicio en la nube de C3 Portal 
(compartido).
Execute: ejecuta la función.

File ID Asigna un nombre al archivo.

Load Network 
Data

On / Off Define si se carga la información de los 
ajustes del menú Network cuando se 
ejecuta Load from UTILITY SD, Load from 
Cloud(Private) o Load from Cloud(Share).
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Menú Paint/Look
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Paint/Look >Scene File
Configura los ajustes relacionados con los archivos de escena.

Elemento del 
menú

Ajuste de subelementos Descripción

Recall Carga un archivo de escena restaurado 
en la memoria interna y aplica los ajustes 
a la configuración actual de la calidad de 
imagen.

Store Guarda el estado actual de la calidad de 
imagen como archivo de escena en la 
memoria interna.

Delete Elimina un archivo de escena 
almacenado en la memoria interna.

Preset Recall Cuando Shooting Mode está ajustado en 
Custom y Target Display está ajustado en 
SDR(BT.709)

S-Cinetone / Standard / Still / ITU709
Cuando Shooting Mode está ajustado en 
Custom y Target Display está ajustado en 
HDR(HLG)

HLG Live / HLG Natural

Aplica los ajustes predeterminados de la 
calidad de imagen (no regrabables) a la 
configuración actual de la calidad de 
imagen.

Paint/Look >Base Look
Configura los ajustes relacionados con el aspecto básico.

Elemento del 
menú

Ajuste de subelementos Descripción

Select Cuando Shooting Mode está ajustado en 
Custom y Target Display está ajustado en 
SDR(BT.709)

S-Cinetone / Standard / Still / ITU709 / 
De User1 a User16

Cuando Shooting Mode está ajustado en 
Custom y Target Display está ajustado en 
HDR(HLG):

HLG Live / HLG Natural / De User1 a 
User16

Cuando Shooting Mode está ajustado en 
Cine EI

709(800%) / S-Log3 / s709 / Warm / 
Cool / Vintage / Teal and Orange / 
ACESproxy / ACEScct / ACES 1.0 
Output-Rec.709 / De User1 a User16

Selecciona un aspecto básico.

[Nota]
Puede seleccionar los siguientes aspectos 
básicos cuando Cine EI Setting >Color Gamut 
(página 47) en el menú Project del menú 
completo está ajustado en S-Gamut3/SLog3.
 • ACESproxy
 • ACEScct
 • ACES 1.0 Output-Rec.709

Delete Elimina el aspecto básico seleccionado.

Paint/Look >Base Look
Configura los ajustes relacionados con el aspecto básico.

Elemento del 
menú

Ajuste de subelementos Descripción

Delete All Elimina todos los aspectos básicos.

Import from 
Utility SD

Execute / Cancel Carga un archivo de aspecto básico 
desde una tarjeta SD.
Execute: ejecuta la función.

Import from 
Cloud(Private)

Execute / Cancel Importa un archivo de aspecto base 
cargado desde el servicio en la nube de 
C3 Portal (privado).
Execute: ejecuta la función.

Import from 
Cloud(Share)

Execute / Cancel Importa un archivo de aspecto base 
cargado desde el servicio en la nube de 
C3 Portal (compartido).
Execute: ejecuta la función.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Establece la gama de entrada para el 
aspecto básico seleccionado.

Output BT.709 / HLG Establece la gama de salida para el 
aspecto básico seleccionado.

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 
5/3EV / 2EV

Establece el valor de referencia de la 
exposición para el aspecto básico 
seleccionado.

Paint/Look >Reset Paint Settings
Restablece los ajustes del menú Paint/Look, excepto el aspecto básico.

Elemento del 
menú

Ajuste de subelementos Descripción

Reset without 
Base Look

Execute / Cancel Restablece los ajustes del menú Paint/
Look, excepto el aspecto básico.
Execute: ejecuta la función.

Paint/Look >Black
Configura los ajustes de negro.

Elemento del 
menú

Ajuste de subelementos Descripción

Master Black De –99.0 a +99.0 (±0.0) Ajusta el nivel de negro maestro.

R Black De –99.0 a +99.0 (±0.0) Ajusta el nivel de negro R.

B Black De –99.0 a +99.0 (±0.0) Ajusta el nivel de negro B.
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Paint/Look >Knee
Configura los ajustes de corrección de inflexión.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting Cuando Target Display está ajustado en 
SDR(BT.709)

On / Off
Cuando Target Display está ajustado en 
HDR(HLG)

On / Off

Activa/desactiva la función de corrección 
de inflexión.

[Consejo]
Activado solo cuando Base Look >Select está 
ajustado en Standard, ITU709, HLG Live o HLG 
Natural.

Auto Knee Cuando Target Display está ajustado en 
SDR(BT.709):

On / Off
Cuando Target Display está ajustado en 
HDR(HLG)

On / Off

Activa y desactiva la función de inflexión 
automática.

[Consejo]
Activado solo cuando el ajuste de corrección 
de inflexión está ajustado en On y Base Look > 
Select está ajustado en Standard o ITU709. 

Point De 75% a 109% (90%) Ajusta el punto de inflexión.

Slope De –99 a +99 (±0) ajusta la pendiente de inflexión.

Paint/Look >Detail
Configura las opciones de ajuste de detalles.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de detalles.

Level De –7 a +7 (±0) Ajusta el nivel de detalle.

H/V Ratio De –2 a +2 (±0) Ajusta el balance entre el detalle vertical 
(V) y el horizontal (H).

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Ajusta el balance entre el detalle de 
negros (B) para las áreas de baja 
luminosidad y el detalle de blancos (W) 
para las áreas de alta luminosidad.

Limit De 0 a 7 Ajusta el nivel de límite de detalle.

Crispening De 0 a 7 Ajusta el nivel de nitidez.

High Light 
Detail

De 0 a 4 Establece el nivel de detalle de las áreas 
de alta luminosidad.

Paint/Look >Matrix
Configura los ajustes de corrección de matrices.

Elemento del 
menú

Ajuste de subelementos Descripción

User Matrix On / Off Activa y desactiva la función de 
corrección matricial del usuario.

Paint/Look >Matrix
Configura los ajustes de corrección de matrices.

Elemento del 
menú

Ajuste de subelementos Descripción

User Matrix 
Level

De –99 a +99 (±0) Ajusta la saturación de color de toda la 
imagen.

User Matrix 
Phase

De –99 a +99 (±0) Ajusta el tono de color (fase) de toda la 
imagen.

User Matrix 
R-G

De –99 a +99 (±0) Ajusta una matriz del usuario R-G 
definida por el usuario.

User Matrix 
R-B

De –99 a +99 (±0) Ajusta una matriz del usuario R-B 
definida por el usuario.

User Matrix 
G-R

De –99 a +99 (±0) Ajusta una matriz del usuario G-R 
definida por el usuario.

User Matrix 
G-B

De –99 a +99 (±0) Ajusta una matriz del usuario G-B 
definida por el usuario.

User Matrix 
B-R

De –99 a +99 (±0) Ajusta una matriz del usuario B-R 
definida por el usuario.

User Matrix 
B-G

De –99 a +99 (±0) Ajusta una matriz del usuario B-G 
definida por el usuario.

Paint/Look >Multi Matrix
Configura los ajustes de corrección de matrices múltiples.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
corrección de matrices múltiples.

Reset Execute / Cancel Restablece el tono y la saturación de 
cada color de eje a los valores 
predeterminados.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Selecciona el eje.

Hue De –99 a +99 (±0) Ajusta el matiz del color utilizado para la 
corrección de matrices múltiples.

Saturation De –99 a +99 (±0) Ajusta la saturación del color utilizado 
para la corrección de matrices múltiples.
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Menú TC/Media
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

TC/Media >Timecode
Configura los ajustes de código de tiempo.

Elemento del 
menú

Ajuste de subelementos Descripción

Mode Preset / Regen / Clock Ajusta el modo de ejecución del código 
de tiempo.
Preset: 

Empieza a funcionar a partir de un 
valor preestablecido.

Regen: 
Empieza a funcionar a partir del 
código de tiempo del final del clip 
anterior.

Clock: 
Utiliza el reloj interno como código 
de tiempo.

Run Rec Run / Free Run Rec Run: Funciona solo durante la 
grabación.

Free Run: Funciona siempre, 
independientemente de si la unidad 
está grabando.

Setting Ajusta el código de tiempo en un valor 
arbitrario.
SET: Ajustar el valor.

Reset Execute / Cancel Restablece el valor del código de tiempo 
a 00:00:00:00.
Execute: ejecuta la función.

TC Format DF / NDF Ajusta el formato del código de tiempo.
DF: omisión de fotograma
NDF: sin omisión de fotograma

TC/Media >TC Display
Configura los ajustes de visualización de datos de tiempo.

Elemento del 
menú

Ajuste de subelementos Descripción

Display Select Timecode / Users Bit / Duration Cambia la visualización de datos de 
tiempo.

TC/Media >Users Bit
Configura los ajustes relacionados con los bits de usuario.

Elemento del 
menú

Ajuste de subelementos Descripción

Mode Fix / Time Ajusta el modo de bit de usuario.
Fix: utiliza un valor fijo arbitrario en bits 

de usuario.
Time: utiliza la hora actual en hora, 

minuto y segundo en bits de usuario.

Setting Ajusta los bits de usuario en un valor 
arbitrario.

TC/Media >HDMI TC Out
Configura los ajustes relacionados con la salida de código de tiempo cuando se utiliza HDMI.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Ajusta si enviar la salida del código de 
tiempo a dispositivos con otros objetivos, 
mediante HDMI.

TC/Media >Clip Name Format
Configura los ajustes relacionados con el nombre y las carpetas de los clips.

Elemento del 
menú

Ajuste de subelementos Descripción

Camera ID De la A a la Z Ajusta el ID de la cámara usado cuando 
se generan los nombres de clips.

Reel Number 001 a 999 Define la parte numérica de Reel Number 
que se utilizará al generar los nombres 
de los clips.

Camera 
Position

C / L / R Ajusta la parte de primer carácter del 
Shot Number usado cuando se generan 
los nombres de clips.

XAVC Root 
Folder Name

XDROOT / Cam ID + Reel# Establece el nombre de la etiqueta de 
volumen y el nombre de la carpeta raíz 
del soporte de grabación.
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TC/Media >Update Media
Actualiza el archivo de gestión en las tarjetas de memoria.

Elemento del 
menú

Ajuste de subelementos Descripción

Media(A) Execute / Cancel Actualiza el archivo de gestión en la 
tarjeta de memoria en la ranura A.
Execute: ejecuta la función.

Media(B) Execute / Cancel Actualiza el archivo de gestión en la 
tarjeta de memoria en la ranura B.
Execute: ejecuta la función.

TC/Media >Format Media
Inicializa las tarjetas de memoria.

Elemento del 
menú

Ajuste de subelementos Descripción

Media(A) Full Format / Cancel Formatea la tarjeta de memoria de la 
ranura A.

Media(B) Full Format / Cancel Formatea la tarjeta de memoria de la 
ranura B.

Utility SD Full Format / Quick Format / Cancel Formatea la tarjeta SD.
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Menú Monitoring
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Monitoring >Output Format
Configura los ajustes del formato de salida.

Elemento del 
menú

Ajuste de subelementos Descripción

SDI1 Para obtener más información acerca de 
los ajustes, consulte “Limitaciones y 
formatos de salida” (página 118).

Ajusta la resolución de salida de SDI y 
HDMI.SDI2

HDMI

REF HD Sync Muestra el formato de salida de la señal 
de sincronización. (Solo HD Sync).

Monitoring >De-Squeeze
Ajusta la configuración de eliminación de la compresión.

Elemento del 
menú

Ajuste de subelementos Descripción

Ratio Off(1.0×) / 1.3× / 2.0× Selecciona la relación de eliminación de 
la compresión para la imagen mostrada 
para el sistema de salida especificado 
cuando se filma con un objetivo 
anamórfico.

SDI (X-OCN) On / Off Establece si se eliminará la compresión 
en la visualización de la imagen de salida 
SDI cuando se graba en formato X-OCN.

HDMI (FHD 
Output)

On / Off Establece si se eliminará la compresión 
en la visualización de la imagen de salida 
HDMI para el tamaño de la imagen de 
salida FHD.

LCD Monitor On / Off Establece si se eliminará la compresión 
en la visualización de la imagen de salida 
del monitor LCD.

Monitoring >Output Display
Ajusta la salida de la visualización de pantalla.

Elemento del 
menú

Ajuste de subelementos Descripción

SDI On / Off Establece si el menú, el estado y la 
pantalla están integrados en la señal de 
salida SDI.

HDMI On / Off Establece si el menú, el estado y la 
pantalla están integrados en la señal de 
salida HDMI.

Monitoring >Display On/Off
Configura los ajustes de los elementos de la pantalla.

Elemento del 
menú

Ajuste de subelementos Descripción

Focus Mode On / Off Selecciona los elementos que se 
visualizan en el monitor LCD.Focus 

Position
On / Off

Network 
Status

On / Off

File Transfer 
Status

On / Off

Rec/Play 
Status

Always On / On / Off

SDI/HDMI 
Rec Control

On / Off

Tally On / Off

Battery 
Remain

On / Off

Zoom 
Position

On / Off

Image 
Stabilization

On / Off

Media Status On / Off

Lens Info On / Off

Look Name On / Off

UWP RF Level On / Off

Focus Area 
Indicator

On / Off

Subject 
Recognition 
Frame

On / Off

Clip Name On / Off

Video Level 
Warning

On / Off

Timecode On / Off

Gamma 
Display Assist

On / Off
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Monitoring >Display On/Off
Configura los ajustes de los elementos de la pantalla.

Elemento del 
menú

Ajuste de subelementos Descripción

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Imager Scan 
Mode

On / Off

Frame Rate On / Off

Rec Format On / Off

Rec Look On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Base ISO/
Sensitivity

On / Off

Shutter On / Off

White 
Balance

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Configura los ajustes de visualización de marcadores.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la visualización de 
todos los marcadores.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Selecciona el color de la señal de los 
marcadores.

Monitoring >Marker
Configura los ajustes de visualización de marcadores.

Elemento del 
menú

Ajuste de subelementos Descripción

Center 
Marker

1 / 2 / 3 / 4 / Off Selecciona el marcador central.

Safety Zone On / Off Activa y desactiva el marcador de la zona 
de seguridad.

Safety Area 80% / 90% / 92.5% / 95% Selecciona el tamaño del marcador de la 
zona de seguridad (como un porcentaje 
del tamaño total de la pantalla).

Aspect 
Marker

Line / Mask / Off Selecciona el tipo de marcador de 
aspecto.

Aspect Mask De 0 a 15 (12) Ajusta el nivel de la señal de vídeo fuera 
del marcador.

Aspect Safety 
Zone

On / Off Activa y desactiva el marcador de la zona 
de seguridad de aspecto.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Selecciona el tamaño del marcador de la 
zona de seguridad de aspecto (como un 
porcentaje del tamaño total de la 
pantalla).

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Ajusta el modo cuando se muestra el 
marcador de aspecto.

Custom 
Aspect Ratio

Introduzca un valor arbitrario (01.00:01.00) Configura la relación de aspecto en un 
valor arbitrario.

[Nota]
Esta opción se activa cuando Aspect Select 
está ajustado en Custom.

Guide Frame On / Off Activa y desactiva la visualización del 
fotograma de la imagen.

100% Marker On / Off Activa y desactiva el marcador de 100%.

User Box On / Off Activa y desactiva la visualización del 
marcador de casilla del usuario.

User Box 
Width

De 3 a 479 (240) Ajusta la amplitud del marcador de 
casilla de usuario (distancia del centro a 
los bordes derecho e izquierdo).

User Box 
Height

De 3 a 269 (135) Ajusta la altura del marcador de casilla 
de usuario (distancia del centro a los 
bordes superior e inferior).

User Box H 
Position

De –476 a +476 (0) Establece la posición horizontal del 
centro del marcador de la casilla de 
usuario.
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Monitoring >Marker
Configura los ajustes de visualización de marcadores.

Elemento del 
menú

Ajuste de subelementos Descripción

User Box V 
Position

De –266 a +266 (0) Establece la posición vertical del centro 
del marcador de la casilla de usuario.

Monitoring >LCD Monitor Setting
Configura los ajustes del visor.

Elemento del 
menú

Ajuste de subelementos Descripción

Brightness De 1 a 15 (8) Ajusta el brillo de la imagen del visor.

Color Mode Color / B&W Selecciona el modo de visualización del 
visor en modo E-E/grabación.

Monitoring >Gamma Display Assist
Ajusta la asistencia de la visualización de gamma.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de pantalla 
asistida de gamma en el modo Custom 
cuando Target Display está ajustado en 
HDR(HLG).

Monitoring >Peaking
Configura los ajustes de nitidez.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de nitidez.

Peaking Level High / Mid / Low Ajusta el nivel de la señal de nitidez de 
color.

Color B&W / Red / Yellow / Blue Selecciona el color de la señal de nitidez 
de color.

Monitoring >Zebra
Configura los ajustes de los patrones de cebra.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting Off / Zebra1 / Zebra2 Selecciona el tipo de patrón de cebra 
(Off, Zebra 1, Zebra 2).

Zebra1 Level De 0% a 109% (70%) Ajusta el nivel de visualización de Zebra 1.

Zebra1 
Aperture 
Level

De 2% a 20% (10%) Ajusta el nivel de apertura de Zebra 1.

Monitoring >Zebra
Configura los ajustes de los patrones de cebra.

Elemento del 
menú

Ajuste de subelementos Descripción

Zebra2 Level De 0% a 109% (100%) Ajusta el nivel de visualización de Zebra 2.

Monitoring >Focus Magnifier
Configura los ajustes del amplificador del enfoque.

Elemento del 
menú

Ajuste de subelementos Descripción

Focus Mag 
Button Target

LCD Monitor / Output Establece el objetivo del amplificador del 
enfoque para el control a través de un 
botón asignable.
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Menú Audio
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).
Consulte “Diagramas de bloques” (página 137).

Audio >Audio Input
Configura los ajustes de entrada de audio.

Elemento del 
menú

Ajuste de subelementos Descripción

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Cambia la fuente de entrada para la 
grabación en el canal 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Cambia la fuente de entrada para la 
grabación en el canal 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Cambia la fuente de entrada para la 
grabación en el canal 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Cambia la fuente de entrada para la 
grabación en el canal 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Ajusta el nivel de la grabación de 
referencia para la entrada del micrófono 
XLR desde INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Ajusta el nivel de la grabación de 
referencia para la entrada del micrófono 
XLR desde INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Selecciona el nivel de entrada de 
referencia cuando los interruptores 
INPUT1/INPUT2 están ajustados en LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Selecciona el nivel de grabación de la 
señal del tono de referencia de 1 kHz.

CH1 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 1.

CH2 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 2.

CH3 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 3.

CH4 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 4.

Audio >Audio Input
Configura los ajustes de entrada de audio.

Elemento del 
menú

Ajuste de subelementos Descripción

CH3 Level 
Control

Auto / Manual Selecciona el ajuste de nivel de entrada 
de audio automático o el ajuste manual 
para el canal de grabación 3.

[Nota]
Si CH3 Input Select y CH4 Input Select están 
ajustados en Internal MIC, CH4 cambia a 
automático/manual junto con este ajuste.

CH4 Level 
Control

Auto / Manual Selecciona el ajuste de nivel de entrada 
de audio automático o el ajuste manual 
para el canal de grabación 4.

[Nota]
Si CH3 Input Select y CH4 Input Select están 
ajustados en Internal MIC, CH4 cambia a 
automático/manual junto con el ajuste CH3 
Level Control.

CH3 Input 
Level

De 0 a 99 (49) Ajusta el nivel de entrada para el canal 
de grabación 3.

CH4 Input 
Level

De 0 a 99 (49) Ajusta el nivel de entrada para el canal 
de grabación 4.

Audio Input 
Level

De 0 a 99 Ajusta el nivel de entrada de audio.
Se puede utilizar como volumen maestro 
en función de los ajustes de CH1 Level a 
CH4 Level.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Selecciona la característica del limitador 
para señales de entrada grandes cuando 
está ajustado el nivel de entrada de 
audio manualmente.

CH1&2 AGC 
Mode

Mono / Stereo Establece el modo de ajuste de nivel 
automático para la grabación en el canal 
1 y en el canal 2. Cuando se selecciona 
Stereo, AGC se vincula entre los canales.

CH3&4 AGC 
Mode

Mono / Stereo Establece el modo de ajuste de nivel 
automático para la grabación en el canal 
3 y en el canal 4. Cuando se selecciona 
Stereo, AGC se vincula entre los canales.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Selecciona la característica AGC.
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Audio >Audio Input
Configura los ajustes de entrada de audio.

Elemento del 
menú

Ajuste de subelementos Descripción

1kHz Tone on 
Color Bars

On / Off Activa y desactiva la señal de tono de 
referencia de 1 kHz cuando se muestran 
las barras de colores.

[Nota]
Cuando se ajusta en On, la señal de tono de 
referencia de 1 kHz se establece para grabar 
en el canal 3 y en el canal 4, aunque CH3 Input 
Select y CH4 Input Select estén ajustados en 
Off.

CH1 Level Entrada sin el adaptador de XLR
Audio Input Level / Side / Level+Side

Entrada con el adaptador de XLR 
(página 105)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 1.

[Nota]
“Side” hace referencia al dial AUDIO LEVEL 
(CH1) situado en el lateral de la unidad. Cuando 
se selecciona Level+Side, el nivel de grabación 
de audio está determinado por la combinación 
de Audio Input Level y los ajustes del dial 
(página 137).

CH2 Level Entrada sin el adaptador de XLR
Audio Input Level / Side / Level+Side

Entrada con el adaptador de XLR 
(página 105)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 2.

[Nota]
“Side” hace referencia al dial AUDIO LEVEL 
(CH2) situado en el lateral de la unidad. Cuando 
se selecciona Level+Side, el nivel de grabación 
de audio está determinado por la combinación 
de Audio Input Level y los ajustes del dial 
(página 137).

CH3 Level Entrada sin el adaptador de XLR
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Entrada con el adaptador de XLR 
(página 105)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 3.

CH4 Level Entrada sin el adaptador de XLR
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Entrada con el adaptador de XLR 
(página 105)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 4.

Audio >Audio Output
Configura los ajustes de salida de audio.

Elemento del 
menú

Ajuste de subelementos Descripción

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Selecciona la salida del canal de audio en 
la toma de auriculares y en el altavoz 
incorporado.

[Nota]
Si el audio de varios canales se establece para 
la salida simultánea, el nivel de salida de cada 
canal se reduce para la emisión con el fin de 
evitar la sobreexposición.

Volume De 0 a 50 Ajusta la salida del nivel de audio del 
monitor en la toma de auriculares y en el 
altavoz incorporado.

Headphone 
Out

Mono / Stereo Selecciona si la salida de la toma de 
auriculares es monoaural (Mono) o 
estéreo (Stereo).

Alarm Level De 0 a 7 (4) Ajusta el volumen de la alarma.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Ajusta la combinación de canales de 
audio en la salida HDMI.

SDI Output 
CH (X-OCN)

CH1/CH2 / CH3/CH4 Ajusta la combinación de canales de 
audio en la salida SDI cuando el formato 
de grabación está ajustado en X-OCN.
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Menú Clip Operations
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Operaciones con clips

Elemento del 
menú

Ajuste de subelementos Descripción

Display Clip 
Properties

Muestra la pantalla de propiedades de 
visualización de clips.

Clip Operations >Set Clip Flag
Configura los ajustes de marca de clip.

Elemento del 
menú

Ajuste de subelementos Descripción

Add OK Agrega una marca OK.

Add NG Agrega una marca NG.

Add KEEP Agrega una marca Keep.

Delete Clip 
Flag

Elimina todas las marcas.

Clip Operations >Lock/Unlock Clip
Configura los ajustes de protección de clips.

Elemento del 
menú

Ajuste de subelementos Descripción

Select Clip Selecciona y bloque/desbloquea un clip.

Lock All Clips Bloquea todos los clips.

Unlock All 
Clips

Desbloquea todos los clips.

Clip Operations >Transfer Clip
Transfiere los clips.

[Nota]
Transfer Clip no se puede configurar si no se ha configurado una contraseña mediante Network Setup en el 
menú Network.

Elemento del 
menú

Ajuste de subelementos Descripción

Select Clip Transfiere los clips seleccionados.

All Clips Transfiere todos los clips.

[Nota]
Se pueden transferir hasta 200 clips.

Clip Operations >Transfer Clip (Proxy)
Transfiere los clips de proxy.

[Nota]
Transfer Clip (Proxy) no se puede configurar si no se ha configurado una contraseña mediante Network Setup 
en el menú Network.

Elemento del 
menú

Ajuste de subelementos Descripción

Select Clip Transfiere los clips de proxy 
correspondientes a los clips 
seleccionados.

All Clips Transfiere los clips de proxy 
correspondientes a todos los clips.

[Nota]
Se pueden transferir hasta 200 clips.

Clip Operations >Filter Clips
Configura los ajustes de los clips que se van a visualizar.

Elemento del 
menú

Ajuste de subelementos Descripción

OK Muestra todos los clips con la marca OK.

NG Muestra todos los clips con la marca NG.

KEEP Muestra todos los clips con la marca 
Keep.

None Muestra solo los clips que no tienen 
marca.

All Muestra todos los clips, 
independientemente de si hay marcas.

Clip Operations >Customize View
Cambia la vista de la pantalla de clips.

Elemento del 
menú

Ajuste de subelementos Descripción

Clips Caption Clip Name / Date Time / Time Code / 
Duration / Sequential Number

Cambia la información mostrada debajo 
de la imagen del clip.
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Menú Technical
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Technical >Color Bars
Configura los ajustes de las barras de colores.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva las barras de colores.

Type ARIB / 100% / 75% / SMPTE Selecciona el tipo de barra de color.

Technical >ND Dial
Configura los ajustes relacionados con las operaciones del dial ND VARIABLE.

Elemento del 
menú

Ajuste de subelementos Descripción

CLEAR with 
Dial

On / Off Establece si se activa el cambio de 
estado ND (CLEAR  On) mediante la 
operación del dial ND VARIABLE.

Technical >Rec/Tally
Ajusta la lámpara indicadora/indicador de grabación.

Elemento del 
menú

Ajuste de subelementos Descripción

Rec/Tally 
Lamp

On / Off Activa/desactiva la lámpara indicadora/
indicador de grabación.

Rec Start/
Stop Beep

De 0 a 50 Ajusta el volumen del aviso acústico que 
se emite cuando la grabación comienza y 
termina.

Technical >LOCK Switch Settings
Configura los ajustes del interruptor de bloqueo.

Elemento del 
menú

Ajuste de subelementos Descripción

with Rec 
Button

On / Off Establece si se bloquea también el 
funcionamiento del botón REC (inicio/
parada de grabación).

with Hand 
Grip Remote

On / Off Ajusta si se bloquea el funcionamiento 
del control remoto de la empuñadura.

with LCD 
Monitor

On / Off Ajusta si se bloquea el funcionamiento 
de los botones del monitor LCD.

Technical >Touch Operation
Configura los ajustes relacionados con las operaciones táctiles.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el funcionamiento 
táctil.

Technical >Rec Review
Configura los ajustes de revisión de grabación.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting 3 s / 10 s / Clip Selecciona la hora de reproducción de los 
clips recién grabados para revisar la 
grabación.

Technical >Zoom
Configura los ajustes del zoom.

Elemento del 
menú

Ajuste de subelementos Descripción

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Establece el tipo de zoom.
Optical Zoom Only: 

El zoom óptico se ajusta mediante el 
objetivo.

On(Clear Image Zoom): 
Zoom electrónico con poco o nada 
de deterioro de la calidad de imagen.

Technical >Handle Zoom
Establece los ajustes de zoom del asa para un asa (opcional) equipada con una zapata MI.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting Off / Low / High / Variable Ajusta la velocidad del zoom del asa.

High De 1 a 8 (8) Establece la velocidad del zoom de la 
palanca de zoom del asa cuando se 
selecciona la velocidad High del zoom 
del asa.

Low De 1 a 8 (3) Establece la velocidad del zoom de la 
palanca de zoom del asa cuando se 
selecciona la velocidad Low del zoom del 
asa.

[Nota]
Puede producirse un zoom desequilibrado 
cuando la velocidad de zoom se ajusta a un 
valor bajo.
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Technical >Menu Settings
Configura los ajustes relacionados con el menú.

Elemento del 
menú

Ajuste de subelementos Descripción

User Menu 
Only

On / Off Ajusta si solo se muestra el menú User 
(On) o si se muestra la lista del menú 
(Off) cuando se muestre el menú.

User Menu 
with Lock

On / Off Ajusta si se bloquea la pantalla del menú 
y se muestra solo el menú User.

[Nota]
Este elemento no se muestra durante el 
funcionamiento normal de la pantalla del 
menú. Para obtener más información acerca 
del funcionamiento de la pantalla del menú, 
consulte la página 35.

Technical >Menu Page On/Off
Establece la configuración relacionada con la visualización de la pantalla de estado.

Elemento del 
menú

Ajuste de subelementos Descripción

Project On / Off Activa y desactiva la visualización de la 
pantalla de estado Project.

Audio On / Off Activa y desactiva la visualización de la 
pantalla de estado Audio.

Monitoring On / Off Activa y desactiva la visualización de la 
pantalla de estado Monitoring.

Assignable 
Button

On / Off Activa y desactiva la visualización de la 
pantalla de estado Assignable Button.

Battery On / Off Activa y desactiva la visualización de la 
pantalla de estado Battery.

Media On / Off Activa y desactiva la visualización de la 
pantalla de estado Media.

Network On / Off Activa y desactiva la visualización de la 
pantalla de estado Network.

File Transfer On / Off Activa y desactiva la visualización de la 
pantalla de estado File Transfer.

Technical >Fan Control
Configura los ajustes del modo de control del ventilador.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting Auto / Minimum / Off in Rec Ajusta el modo de control del ventilador 
de la unidad.

[Nota]
Si la temperatura interna de la unidad asciende 
por encima de un valor determinado, el 
ventilador comenzará a funcionar, aunque esté 
seleccionada la opción Off in Rec.

Technical >Lens
Configura los ajustes relacionados con los objetivos.

Elemento del 
menú

Ajuste de subelementos Descripción

PL-Mt 
Interface 
Position

Top / Side / Off Establece la posición de la interfaz en el 
objetivo con montura PL.

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Ajusta el sentido de funcionamiento del 
anillo del zoom.

[Nota]
Solo está habilitado cuando se utiliza un 
objetivo de montura E compatible con el 
cambio de dirección del anillo de zoom.

Shading 
Compensation

Auto / Auto(Low) / Off Define la compensación automática para 
la iluminación periférica cuando se 
acopla un objetivo compatible.

[Notas]
 • En función del objetivo, es posible que la 

iluminación periférica no se compense 
incluso si la opción Shading Compensation 
está activada.

 • En función del objetivo, puede que no haya 
diferencia en la compensación obtenida 
entre Auto y Auto(Low).

Chroma 
Aberration 
Comp.

Auto / Off Define la compensación automática para 
la aberración cromática cuando se 
conecta un objetivo compatible.

Distortion 
Comp.

Auto / Off Ajusta la compensación de distorsión 
automática.

[Nota]
Cuando Image Stabilization >SteadyShot 
(página 45) está ajustado en Active en el 
menú Shooting, Distortion Comp. se establece 
en Auto.
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Technical >Lens
Configura los ajustes relacionados con los objetivos.

Elemento del 
menú

Ajuste de subelementos Descripción

Breathing 
Compensation

Auto / Off Ajusta la Breathing Compensation del 
objetivo.

Distance 
Display

Meter / Feet Establece las unidades de visualización 
para la información del objetivo y la 
posición de enfoque.

Zoom 
Position 
Display

Focal Length / Number / Bar Establece el formato de visualización 
para la posición del zoom.

Technical >Video Light Set
Ajusta el método de iluminación de la luz de vídeo. Disponible únicamente cuando se utiliza el 
HVL-LBPC (opcional).

Elemento del 
menú

Ajuste de subelementos Descripción

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Ajusta el método de control de 
iluminación para la luz de vídeo acoplada 
a la zapata de interfaces múltiples.
Power Link: 

Activa y desactiva la luz de vídeo 
cuando la unidad se enciende/
apaga.

Rec Link: 
Activa y desactiva la luz de vídeo 
cuando la unidad inicia/detiene la 
grabación.

Rec Link + Stby: 
Activa y habilita el modo de espera 
en la luz de vídeo cuando la unidad 
inicia/detiene la grabación.

Technical >APR
Ejecuta APR.

Elemento del 
menú

Ajuste de subelementos Descripción

APR Execute / Cancel Ejecuta APR (restauración automática de 
píxeles) para ajustar automáticamente el 
sensor de imagen.
Execute: ejecuta la función.

[Nota]
Coloque siempre la tapa del objetivo antes de 
ejecutar APR.

Technical >Camera Battery Alarm
Configura los ajustes de la alarma de tensión baja en la batería.

Elemento del 
menú

Ajuste de subelementos Descripción

Near End:Info 
Battery

De 5% a 100% (incrementos de 5%) Establece el valor límite al cual el 
indicador de capacidad restante de la 
batería empieza a parpadear cuando se 
utiliza una batería Sony Info.

End:Info 
Battery

De 0% a 5% Establece el valor límite para que se 
muestre la advertencia “Battery End” 
cuando se utiliza una batería Sony Info.

Near 
End:Sony 
Battery

De 11.5V a 17.0V (incrementos de 0.1V) Establece el valor límite al cual el 
indicador de capacidad restante de la 
batería empieza a parpadear cuando se 
utiliza una batería Sony que no es Info.

End:Sony 
Battery

De 11.0V a 12.5V (incrementos de 0.1V) Establece el valor límite para que se 
muestre la advertencia “Battery End” 
cuando se utiliza una batería Sony que 
no es Info.

Near 
End:Other 
Battery

De 11.5V a 17.0V (11.8V) (incrementos de 
0.1V)

Establece el valor límite en el cual el 
indicador de capacidad restante de la 
batería empieza a parpadear cuando se 
utiliza una batería que no es Sony.

End:Other 
Battery

De 11.0V a 14.0V (incrementos de 0.1V) Establece el valor límite para que se 
muestre la advertencia “Battery End” 
cuando se utiliza una batería que no es 
Sony.

Detected 
Battery

Sony Info Battery / Sony Battery / Other 
Battery / DC IN

Muestra el resultado de la detección 
automática de tipo de batería.

Technical >Camera DC IN Alarm
Configura los ajustes de la alarma de tensión de entrada.

Elemento del 
menú

Ajuste de subelementos Descripción

DC Low 
Voltage1

De 11.5V a 17.0V (incrementos de 0.1V) Ajusta la tensión a partir de la cual se 
mostrará una alarma de tensión de 
entrada DC IN baja.

DC Low 
Voltage2

De 11.0V a 14.0V (incrementos de 0.1V) Ajusta la tensión a partir de la cual se 
mostrará una alarma de tensión de 
entrada DC IN insuficiente.
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Menú Network
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Network >Network Setup
Realiza ajustes relacionados con la red.

Elemento del 
menú

Ajuste de subelementos Descripción

Setup for 
Mobile App

Inicia la herramienta de ayuda de 
configuración de red.

User Name Establece el nombre del usuario para la 
autenticación de acceso.

Input 
Password

Establece la contraseña para la 
autenticación de acceso.

[Nota]
Desde el punto de vista de la seguridad, se 
recomienda que establezca una contraseña 
con una cadena de caracteres suficientemente 
larga que sea difícil de adivinar por otros, y que 
la guarde de forma segura.

Generate 
Password

Execute / Cancel Genera automáticamente una contraseña 
para la autenticación de acceso.
Execute: ejecuta la función.

Show 
Authentication

Muestra el nombre de usuario y la 
contraseña para la autenticación de 
acceso como texto y código QR.

LAN Type 
Select

WLAN (AP Mode) / WLAN (ST Mode) / 
Wired LAN / Off

Define el método de conexión LAN.

Network >Wireless LAN
Establece la configuración relacionada con las conexiones LAN inalámbricas.

Elemento del 
menú

Ajuste de subelementos Descripción

WPS Execute / Cancel Establece una conexión mediante WPS 
(configuración Wi-Fi segura).
Execute: ejecuta la función.

MAC Address Muestra la dirección MAC de la interfaz 
LAN inalámbrica de la unidad.

Network >AP Mode Settings
Establece la configuración relacionada con las conexiones de modo de punto de acceso.

Elemento del 
menú

Ajuste de subelementos Descripción

Channel Auto(5GHz) / Auto / CH1 / CH2 / CH3 / 
CH4 / CH5 / CH6 / CH7 / CH8 / CH9 /  
CH10 / CH11

Establece el canal de LAN inalámbrica. 
Auto(5GHz) solo está disponible en el 
modelo WW279317.

Camera SSID & 
Password

Muestra el SSID y la contraseña de la 
unidad.

Regenerate 
Password

Execute / Cancel Crea una nueva contraseña.
Execute: ejecuta la función.

IP Address Muestra la dirección IP de la unidad en el 
modo de punto de acceso.

Subnet Mask Muestra la máscara de subred de la 
unidad en el modo de punto de acceso.

Network >ST Mode Settings
Establece la configuración relacionada con las conexiones de modo de estación.

Elemento del 
menú

Ajuste de subelementos Descripción

Camera 
Remote 
Control

Enable / Disable Establece si se activa el control remoto 
desde un dispositivo de control 
conectado a la unidad mediante LAN 
inalámbrica en el modo de estación.

Connected 
Network

Muestra la red LAN inalámbrica 
conectada (punto de acceso).

SSID Muestra el SSID del punto de acceso que 
se va a conectar.

Security Muestra el tipo de seguridad del punto 
de acceso que se va a conectar.

Password Muestra la contraseña del punto de 
acceso que se va a conectar.
Cuando Security está ajustada en WEP o 

WPA: *******
Cuando Security está ajustada en None: 

(en blanco)

DHCP Muestra si DHCP está activado/
desactivado.

IP Address Muestra la dirección IP de la unidad 
cuando DHCP está ajustado en Off.

Subnet Mask Muestra la máscara de subred de la 
unidad cuando DHCP está ajustado en 
Off.
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Network >ST Mode Settings
Establece la configuración relacionada con las conexiones de modo de estación.

Elemento del 
menú

Ajuste de subelementos Descripción

Connected 
Network

Gateway Muestra la puerta de enlace 
predeterminada de la unidad cuando 
DHCP está ajustado en Off.

DNS Auto Muestra si la adquisición de DNS está 
activada/desactivada.

Primary DNS Server Muestra el servidor principal de DNS de 
la unidad cuando DNS Auto está ajustado 
en Off.

Secondary DNS Server Muestra el servidor secundario de DNS 
de la unidad cuando DNS Auto está 
ajustado en Off.

Scan 
Networks

Detecta las redes LAN inalámbricas 
(puntos de acceso) y muestra una lista.
Seleccione un destino de entre las 
opciones de la lista para la realizar la 
conexión.

SSID Muestra el SSID del punto de acceso que 
se va a conectar.

Security Muestra el tipo de seguridad del punto 
de acceso que se va a conectar.

Password Introduzca la contraseña del punto de 
acceso que se va a conectar.

DHCP 
On / Off

Activa y desactiva DHCP.

IP Address Introduzca la dirección IP de la unidad 
cuando DHCP está ajustado en Off.

Subnet Mask Introduzca la máscara de subred de la 
unidad cuando DHCP está ajustado en 
Off.

Gateway Introduzca la puerta de enlace 
predeterminada de la unidad cuando 
DHCP está ajustado en Off.

DNS Auto 
On / Off

Activa y desactiva la adquisición 
automática de DNS.

Primary DNS Server Introduzca el servidor principal de DNS 
de la unidad cuando DNS Auto está 
ajustado en Off.

Secondary DNS Server Introduzca el servidor secundario de DNS 
de la unidad cuando DNS Auto está 
ajustado en Off.

Network >ST Mode Settings
Establece la configuración relacionada con las conexiones de modo de estación.

Elemento del 
menú

Ajuste de subelementos Descripción

Manual 
Register

Registra los ajustes para la conexión 
manual a un punto de acceso.

SSID Introduzca el SSID del punto de acceso 
que se va a conectar.

Security 
None / WEP / WPA

Ajusta el tipo de seguridad del punto de 
acceso que se va a conectar. Seleccione 
WPA si el tipo de seguridad del punto de 
acceso de destino es WPA o WPA2.

Password Introduzca la contraseña del punto de 
acceso que se va a conectar.

DHCP 
On / Off

Activa y desactiva DHCP.

IP Address Introduzca la dirección IP de la unidad 
cuando DHCP está ajustado en Off.

Subnet Mask Introduzca la máscara de subred de la 
unidad cuando DHCP está ajustado en 
Off.

Gateway Introduzca la puerta de enlace 
predeterminada de la unidad cuando 
DHCP está ajustado en Off.

DNS Auto 
On / Off

Activa y desactiva la adquisición 
automática de DNS.

Primary DNS Server Introduce el servidor principal de DNS 
cuando DNS Auto está ajustado en Off.

Secondary DNS Server Introduce el servidor secundario de DNS 
cuando DNS Auto está ajustado en Off.
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Network >Wired LAN
Establece la configuración relacionada con las conexiones LAN con cable.

Elemento del 
menú

Ajuste de subelementos Descripción

Camera 
Remote 
Control

Enable / Disable Establece si se activa el control remoto 
desde un dispositivo de control 
conectado a la unidad mediante LAN con 
cable.

Detail 
Settings

Configura las propiedades de la conexión 
LAN con cable.

DHCP 
On / Off

Activa y desactiva DHCP.

IP Address Introduzca la dirección IP de la unidad 
cuando DHCP está ajustado en Off.

Subnet Mask Introduzca la máscara de subred de la 
unidad cuando DHCP está ajustado en 
Off.

Gateway Introduzca la puerta de enlace 
predeterminada de la unidad cuando 
DHCP está ajustado en Off.

DNS Auto 
On / Off

Activa y desactiva la adquisición 
automática de DNS.

Primary DNS Server Introduce el servidor principal de DNS 
cuando DNS Auto está ajustado en Off.

Secondary DNS Server Introduce el servidor secundario de DNS 
cuando DNS Auto está ajustado en Off.

MAC Address Muestra la dirección MAC de la interfaz 
LAN con cable de la unidad.

Network >USB Tethering
Configura los ajustes relacionados con el anclaje USB.

Elemento del 
menú

Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la conexión del 
smartphone.

Camera 
Remote 
Control

Enable / Disable Establece el permiso para el control 
remoto a través de anclaje USB mediante 
una aplicación para smartphone, como 
Monitor & Control o Creators' App for 
enterprise.

Device Name Muestra el nombre de dispositivo del 
smartphone.

IP Address Muestra la dirección IP del smartphone.

Network >USB Tethering
Configura los ajustes relacionados con el anclaje USB.

Elemento del 
menú

Ajuste de subelementos Descripción

Subnet Mask Muestra la máscara de subred del 
smartphone.

Network >File Transfer
Configura los ajustes relacionados con la transferencia de archivos.

Elemento del 
menú

Ajuste de subelementos Descripción

Auto Upload On / Off Activa/desactiva la carga automática del 
clip original.

[Nota]
Cuando Simul Rec >Setting (página 47) en 
el menú Project está ajustado en On, los clips 
grabados en el soporte de la ranura B no se 
cargan automáticamente.

Auto Upload 
(Proxy)

On / Off On:
Activa la carga automática del clip de 
proxy.

Off:
Desactiva la carga automática del clip 
de proxy.

Default 
Upload 
Server

Selecciona el servidor de carga para los 
archivos. El servidor seleccionado aquí se 
convierte en el destino de carga 
automática para los clips originales y de 
proxy y el destino de carga para los 
archivos desde la pantalla de clips.
Muestra el nombre para mostrar 
configurado en Server Settings del 1 al 3.

Clear 
Completed 
Jobs

Execute / Cancel Borra de la lista los trabajos de 
transferencia finalizados.
Execute: ejecuta la función.

Clear All Jobs Execute / Cancel Borra de la lista todos los trabajos de 
transferencia.
Execute: ejecuta la función.

View Job List Muestra la lista de trabajos de 
transferencia.



3. Operaciones de la cámara: Menú Network69

Network >File Transfer
Configura los ajustes relacionados con la transferencia de archivos.

Elemento del 
menú

Ajuste de subelementos Descripción

Server 
Settings1

Display Name Establece el nombre para mostrar que 
aparece en el menú de configuración del 
destino de la transferencia.

Service 
FTP

Muestra el tipo de servidor.

Host Name Establece el nombre de host del servidor 
de destino de la transferencia.

Port (1 a 65535 (21)) Establece el número de puerto del 
servidor de destino de la transferencia.

User Name Establece el nombre del usuario para la 
autenticación de la conexión del servidor 
de destino de la transferencia.

Password Establece la contraseña de autenticación 
de la conexión del servidor de destino de 
la transferencia.

Passive Mode 
On / Off (Active Mode)

Activa y desactiva el modo PASV.

Destination Directory Introduzca el nombre del directorio de 
destino de la transferencia.

Using Secure Protocol 
On / Off

Establece si se utiliza (On) o no (Off) la 
transferencia FTP segura (modo FTPS 
explícito: FTPES).

Root Certificate 
Load / Clear / None

Carga un certificado raíz para la 
transferencia FTP segura y borra los 
ajustes.

Root Certificate Status 
Loaded / No Certificate

Muestra el estado de carga del 
certificado raíz para la transferencia FTP 
segura.

Reset 
Execute / Cancel

Restablece los ajustes predeterminados 
de Server Settings.
Execute: ejecuta la función.

Server 
Settings2

Igual que Server Settings1.

Server 
Settings3

Igual que Server Settings1.

Network >Network Reset
Restablece los ajustes de red.

Elemento del 
menú

Ajuste de subelementos Descripción

Reset Execute / Cancel Restablece los ajustes de red.
Execute: ejecuta la función.
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Menú Maintenance
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Maintenance >Language
Ajusta el idioma de visualización.

Elemento del 
menú

Ajuste de subelementos Descripción

Select Ajusta el idioma de visualización.
SET: Ajustar el lenguaje.

Maintenance >Clock Set
Configura los ajustes del reloj interno.

Elemento del 
menú

Ajuste de subelementos Descripción

Time Zone De UTC – 12:00 a UTC + 14:00 Ajusta la diferencia horaria desde UTC en 
intervalos de 30 minutos.

Date Mode YYMMDD / MMDDYY / DDMMYY Selecciona el formato de visualización de 
la fecha.
YYMMDD: año, mes, día
MMDDYY: mes, día, año
DDMMYY: día, mes, año

12h/24h 12h / 24h Ajusta el formato de visualización del 
reloj.
12h: modo de 12 horas
24h: modo de 24 horas

Date Ajusta la fecha actual.
SET: Ajustar el valor.

Time Ajusta la hora actual.
SET: Ajustar el valor.

Maintenance >All Reset
Restablece los valores predeterminados de fábrica.

Elemento del 
menú

Ajuste de subelementos Descripción

Reset Execute / Cancel Restablece todos los ajustes a los valores 
predeterminados de fábrica.
Execute: ejecuta la función.

[Nota]
Los archivos 3D LUT importados con Base 
Look >Import from Utility SD, Import from 
Cloud(Private) o Import from Cloud(Share) 
(página 53) en el menú Paint/Look no 
se pueden eliminar. Para eliminar todos los 
archivos 3D LUT importados, seleccione Base 
Look >Delete All (página 53) en el menú 
Paint/Look.

Maintenance >All Reset
Restablece los valores predeterminados de fábrica.

Elemento del 
menú

Ajuste de subelementos Descripción

Reset without 
Network

Execute / Cancel Restablece los ajustes predeterminados 
del menú, con excepción de los ajustes 
del menú Network.

Maintenance >Hours Meter
Muestra el tiempo de ejecución acumulado.

Elemento del 
menú

Ajuste de subelementos Descripción

Hours(System) Muestra el número de horas acumuladas 
de uso (no se puede restablecer).

Hours(Reset) Muestra el número de horas acumuladas 
de uso (se puede restablecer).

Reset Execute / Cancel Restablece la visualización de Hours 
(Reset) a 0.
Execute: ejecuta la función.

Maintenance >Version
Muestra la información de versión.

Elemento del 
menú

Ajuste de subelementos Descripción

Version 
Number

Vx.xx Muestra la versión del software de la 
unidad.

Version Up Execute / Cancel Actualiza la unidad.*

Execute: ejecuta la función.
* Esta función actualiza el software de la 

unidad.

Lens Version 
Number

Vxx Muestra el número de la versión del 
software de un objetivo de montura E.
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Ajustes de calidad de imagen guardados para cada modo de filmación
El estado actual de algunos elementos de configuración relacionados con la calidad de la imagen se guarda en los siguientes modos de filmación. Los elementos comunes se guardan en todos los 
modos de filmación. En el caso de los elementos que se guardan por separado, cuando se cambia el modo de filmación, los ajustes correspondientes que se guardan se aplican al modo de filmación 
de objetivo.
 • Modo Cine EI
 • Modo Custom SDR(BT.709)
 • Modo Custom HDR(HLG)

A continuación se muestran los elementos de configuración relacionados con la calidad de la imagen que se guardan para cada modo de filmación.
: Guardado (ajustes comunes al cambiar entre los modos de filmación)
–: Desactivado en el modo de filmación correspondiente

Elemento de configuración Modo de filmación

Modo Cine EI Modo Custom

SDR(BT.709) HDR(HLG)

Menú Shooting ISO/Gain/EI ISO/Gain – 1)

Exposure Index  –

Base Sensitivity – 
Base ISO  –

White 
White Setting 
LUT On/Off  –

Noise Suppression Setting(Custom) –  

Level(Custom) –  
Setting(Cine EI)  –

Level(Cine EI)  –

Menú Paint/Look Base Look Select   
Input2) 
Output2) 
AE Level Offset2) 

Black –  
Knee Auto Knee –  

Distinto de lo anterior –  
Detail –  
Matrix –  
Multi Matrix –  

1) Se guardan ajustes de sensibilidad ISO separados para los modos Custom SDR(BT.709) y HDR(HLG).
2) Los ajustes se guardan para cada Base Look y no dependen del modo de filmación.
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Guardar y cargar datos de configuración

Datos de configuración

Puede guardar los ajustes del menú completo 
en una tarjeta SD. También puede guardar 
un archivo ALL en un servicio en la nube. Le 
permitirá cargar rápidamente el conjunto de 
ajustes de menú apropiado para la situación 
actual.
Los datos de configuración se guardan en las 
categorías siguientes.

Archivos de usuario
Los archivos de usuario guardan los 
elementos de configuración del menú User 
personalizable.
Puede guardar hasta 64 archivos en una 
tarjeta SD.
Si carga este archivo en la memoria de la 
unidad, puede personalizar la configuración 
del menú User.

Todos los archivos (archivo ALL)
Los archivos ALL guardan los datos de 
configuración de todos los menús. Puede 
guardar hasta 64 archivos en una tarjeta SD. 
Se pueden guardar hasta 120 archivos en 
C3 Portal (servicio en la nube), incluyendo 
hasta 60 archivos privados y 60 archivos 
compartidos.

[Nota]
Para obtener más información sobre el contenido 
guardado en un archivo ALL, consulte “Elementos 
guardados en Files” (página 129).

Guardar un archivo de usuario/un 
archivo ALL

Almacenamiento en una tarjeta SD

1 Coloque una tarjeta SD en la ranura para 
tarjetas Utility SD (página 4).

2 Para un archivo de usuario, seleccione 
User File >Save to UTILITY SD 
(página 51) >Execute en el menú 
Project del menú completo.
Para un archivo ALL, seleccione All File 
>Save to UTILITY SD (página 51) 
>Execute en el menú Project del menú 
completo.
Aparecerá una pantalla de destino de 
almacenamiento del archivo.

3 Seleccione una fila “No File” en la pantalla 
de destino de almacenamiento.
Si selecciona una fila con una entrada de 
File ID, se sobrescribirá el archivo 
seleccionado.
El File ID asignado al guardar se puede 
cambiar a través del menú. Para obtener 
más detalles acerca de la configuración, 
consulte “Cambio del File ID” 
(página 73).

4 Seleccione Execute en la pantalla de 
confirmación.

Guardado de un archivo ALL en un 
servicio en la nube

1 Conecte la unidad desde la aplicación 
para smartphone “Creators' App for 
enterprise” (página 85).

2 Seleccione All File >Save to Cloud(Private) 
o Save to Cloud(Share) (página 51) 
>Execute en el menú Project del menú 
completo.
Aparecerá una pantalla de destino de 
almacenamiento del archivo.

3 Seleccione una fila “No File” en la pantalla 
de destino de almacenamiento.
Si selecciona una fila con una entrada de 
File ID, se sobrescribirá el archivo 
seleccionado.
El File ID asignado al guardar se puede 
cambiar a través del menú. Para obtener 
más detalles acerca de la configuración, 
consulte “Cambio del File ID” 
(página 73).

4 Seleccione Execute en la pantalla de 
confirmación.

Cargar un archivo de usuario/un 
archivo ALL

Carga desde una tarjeta SD

1 Introduzca la tarjeta SD que contiene un 
archivo guardado en la ranura para 
tarjetas Utility SD (página 4).

2 Para un archivo de usuario, seleccione 
User File >Load from UTILITY SD 
(página 51) >Execute en el menú 
Project del menú completo.
Para un archivo ALL, seleccione All File 
>Load from UTILITY SD (página 51) 
>Execute en el menú Project del menú 
completo.
Aparecerá una pantalla con la lista de 
archivos.

3 Seleccione un archivo para cargar.
Aparece una pantalla de confirmación.

4 Seleccione Execute.

[Notas]
 • La unidad se reiniciará automáticamente después de 

cargar los datos de configuración.
 • Cuando All File >Load Network Data, en el menú 

Project del menú completo, está ajustado en Off, se 
cargan todos los ajustes del archivo ALL, salvo los 
ajustes del menú Network.
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Carga de un archivo ALL desde un 
servicio en la nube

1 Conecte la unidad desde la aplicación 
para smartphone “Creators' App for 
enterprise” (página 85).

2 Seleccione All File >Load from 
Cloud(Private) o Load from Cloud(Share) 
(página 51) >Execute en el menú 
Project del menú completo.
Aparecerá una pantalla con la lista de 
archivos.

3 Seleccione un archivo para cargar.
Aparece una pantalla de confirmación.

4 Seleccione Execute.

[Notas]
 • La unidad se reiniciará automáticamente después de 

cargar los datos de configuración.
 • Cuando All File >Load Network Data, en el menú 

Project del menú completo, está ajustado en Off, se 
cargan todos los ajustes del archivo ALL, salvo los 
ajustes del menú Network.

Cambio del File ID

1 Para un archivo de usuario, seleccione 
User File >File ID (página 51) en el 
menú Project del menú completo.
Para un archivo ALL, seleccione All File 
>File ID (página 52) en el menú Project 
del menú completo.
Aparecerá una pantalla para editar File ID.

2 Seleccione un carácter con el selector 
múltiple (página 9) o el dial 
multifunción (página 4) y, a 
continuación, presione el botón de aplicar 
del selector múltiple o el dial 
multifunción.

3 Repita el paso 2 según sea necesario.

4 Al terminar de introducir los caracteres, 
seleccione Done.
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Operaciones con clips
Cuando pulsa el botón CLIPS (página 4), los clips grabados en la tarjeta de memoria se muestran en la pantalla de clips.
Puede seleccionar un clip en la pantalla de clips y reproducir dicho clip. En la pantalla de clips, puede utilizar los clips o comprobar sus propiedades a través del menú Clip Operations del menú 
completo. En el modo de visualización de la información, puede controlar la reproducción en el monitor LCD (pantalla de control de reproducción).
Si pulsa el botón CLIPS de nuevo, se cierra la pantalla de clips y vuelve a la imagen de la cámara.

[Notas]
 • Solo los clips grabados con el formato de grabación seleccionado actualmente se mostrarán en la pantalla de clips. Si un clip grabado esperado no se muestra, compruebe el formato de grabación. Tenga en cuenta esto antes de formatear 

(inicializar) soportes.
 • Tenga en cuenta que la página del menú se mostrará en un monitor externo si abre un ajuste relacionado con la contraseña en el menú completo mientras la pantalla de clips está abierta.

Pantalla de clips

La información para el clip sobre el que se encuentra el cursor se muestra en la parte inferior de la pantalla.

4 6

7

53

1

2

Indicador de la tarjeta de memoria 
seleccionada actualmente
(se muestra un icono de bloqueo si 
la tarjeta está protegida).

Cursor 
(amarillo)

Número del clip/Número 
total de clips

1. Miniaturas (imágenes índice)
Muestra la imagen índice de un clip. Cuando 
se graba un clip, su primer fotograma se ajusta 
automáticamente como imagen índice.
La información del clip/fotograma se 
muestra debajo de la imagen en miniatura. 
Puede cambiar la información mostrada 
en Customize View (página 62) >Clips 
Caption en el menú Clip Operations del menú 
completo. También muestra el estado de los 
clips mediante iconos.

Icono Significado

(No 
reproducible)

No se puede reproducir el 
clip

[Nota]
En el formato X-OCN(LT), la cadena de caracteres 
“X-OCN” se muestra en lugar de la imagen del índice de 
miniaturas.

2. Nombre del clip
Muestra el nombre del clip seleccionado.

3. Formato de grabación del vídeo
Muestra el formato de archivo del clip 
seleccionado.

4. Información del modo de grabación 
especial

Muestra el modo de grabación solo si el clip se 
grabó con un modo especial de grabación.
En clips con Slow & Quick Motion, la velocidad 
de fotogramas se muestra a la derecha.

5. Fecha de creación

6. Duración del clip

7. Marca de tiempo
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Pantalla de control de reproducción

Cuando el monitor LCD se encuentra en modo de visualización de la información, puede 
seleccionar un clip en la pantalla de clips para mostrar la pantalla de control de reproducción. El 
área de visualización de funciones admite el funcionamiento táctil.

Zona de la pantalla de función

1 2 3

4 5 6

Botón ITEM 4 Botón ITEM 5 Botón ITEM 6

Botón ITEM 3Botón ITEM 2Botón ITEM 1

[Nota]
Las áreas etiquetadas con los números del 1 al 6 
corresponden a los botones ITEM de 1 a 6. Pulse 
un botón ITEM para seleccionar el elemento 
correspondiente.

1. Botón F Rev
Reproduce hacia atrás a gran velocidad.
Pulse el botón varias veces para cambiar entre 
estas tres velocidades.

2. Botón Play/Pause
Reproduce un clip o detiene la reproducción.

3. Botón F Fwd
Reproduce hacia delante a gran velocidad.
Pulse el botón varias veces para cambiar entre 
estas tres velocidades.

4. Botón Prev
Salta al principio del clip anterior.

5. Botón Stop/Clips
Detiene la reproducción y vuelve a la pantalla 
de clips.

6. Botón Next
Salta al principio del clip siguiente.

Zona de la pantalla de estado

1 2 3

7 6 58910

412
11

13

1. Pantalla de datos de tiempo
Muestra el código de tiempo de la posición de 
la reproducción.

2. Indicador de velocidad de fotograma
Muestra la velocidad de fotogramas del clip en 
reproducción.

3. Indicador de tensión del suministro de 
alimentación/capacidad restante de la 
batería

Muestra la tensión del suministro de 
alimentación o la capacidad restante de la 
batería.

4.  Medidores del nivel de audio
Muestra el nivel del audio de la reproducción.

5. Indicador del modo de grabación especial
Muestra el información sobre el modo de 
grabación especial del clip en reproducción. 

6. Indicador de resolución de imagen
Muestra la resolución de la imagen.

7. Visualización del nombre del códec
Muestra el nombre del códec.

8. Indicador del tamaño de imagen
Muestra el tamaño de la imagen.

9. Indicador del número del clip/número 
total de clips

Muestra el número de clip en reproducción 
actual/número total de clips reproducibles.

10. Pantalla de nombre del clip
Muestra el nombre del clip.

11. Indicador del soporte
Muestra el soporte que se está reproduciendo.
Si la tarjeta de memoria está protegida contra 
escritura aparece un icono  (proteger) a la 
derecha.

12. Icono de advertencia/error
Se muestra cuando se produce una 
advertencia o error.
Puede consultar el contenido de las 
advertencias y errores desde el menú. Si la 
visualización de la pantalla está superpuesta 
en un monitor externo, también puede 
consultarlo en el monitor externo.

13. Indicador de estado de reproducción
Muestra el estado de funcionamiento de la 
reproducción.
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Funcionamiento del menú Clip 
Operations

El menú Clip Operations (página 62) 
aparece cuando mantiene pulsado el botón 
MENU y selecciona Clip Operations.
Use el selector múltiple (página 4) o el dial 
multifunción (página 4) para seleccionar 
una función y, a continuación, presione el 
botón de aplicar del selector múltiple o el dial 
multifunción.
Pulse el botón de BACK (página 4) para 
volver a la pantalla anterior.

[Nota]
Algunos elementos no pueden seleccionarse, 
dependiendo del estado, cuando se visualiza el menú.

Visualización de propiedades de clips

Seleccione Display Clip Properties 
(página 62) en el menú Clip Operations 
para mostrar la pantalla de propiedades de los 
clips.
Pulse el botón izquierdo/derecho del selector 
múltiple para saltar al clip anterior/siguiente.

Añadir marcas de clip

Puede añadir marcas de clip (marcas OK, NG o 
KP) en los clips para filtrar la visualización de 
estos según las marcas de clip.
Seleccione el clip al que desea añadir una 
marca de clip y, a continuación, seleccione 
la marca de clip mediante Set Clip Flag 
(página 62) en el menú Clip Operations del 
menú completo.

Ajuste Marca de clip añadida

Add OK OK

Add NG NG

Add KEEP KP

Visualización de la pantalla de clips 
filtrados

Seleccione Filter Clips (página 62) en el 
menú Clip Operations del menú completo 
y seleccione un tipo de marca de clip para 
mostrar solo aquellos clips que tengan la 
marca especificada.
Para mostrar todos los clips, seleccione All.

[Consejo]
También puede cambiar los filtros en secuencia usando 
el botón DISPLAY.

Cambio de información en la pantalla de 
clips

Puede cambiar la información de fotogramas/
clips que se muestra debajo de la imagen en 
miniatura.
Seleccione Customize View >Clips Caption en 
el menú Clip Operations del menú completo y 
seleccione la información que desea mostrar.
Clip Name: 

Muestra el nombre del clip.
Date Time: 

Muestra la fecha y la hora de creación del 
clip y de su última modificación.

Time Code: 
Muestra el código de tiempo.

Duration: 
Muestra la duración del clip.

Sequential Number: 
Muestra el número secuencial de cada 
imagen en miniatura.
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Reproducción
Puede reproducir clips grabados cuando la 
unidad está en modo de espera (Stby).

1 Inserte la tarjeta de memoria que desea 
reproducir.

2 Pulse el botón CLIPS (página 4).
La pantalla de clips para el soporte de 
reproducción activo se muestra en el 
monitor LCD.

3 Use el selector múltiple (página 4) o el 
dial multifunción (página 4) para 
mover el cursor al clip que desea 
reproducir.

4 Pulse el botón de aplicar del selector 
múltiple o el dial multifunción.
La reproducción comienza desde el 
principio del clip seleccionado.

[Nota]
La unidad no efectúa una reproducción continua.

Operaciones de reproducción

Puede controlar la reproducción con los 
siguientes botones.
Pulse el botón de aplicar del selector 

múltiple o el dial multifunción: detiene la 
reproducción. Pulse de nuevo para volver a 
la reproducción normal.

Pulse los botones izquierda/derecha del 
selector múltiple: salta al inicio del clip o al 
clip anterior/siguiente.

Mantenga pulsados los botones izquierda/
derecha del selector múltiple: rebobinado/
avance rápido. Vuelve a la reproducción 
normal cuando suelta el botón.

Botón BACK: detiene la reproducción y 
vuelve al modo de espera de grabación. 
Aparecerá la pantalla de filmación o la 
pantalla Home.

Control mediante los botones de la pantalla 
de control de reproducción
Cuando el monitor LCD se encuentra en modo 
de visualización de la información, puede 
controlar la reproducción con los botones de 
la pantalla de control de reproducción.
Botón Play/Pause: sitúa la reproducción en 
pausa. Para reanudar la reproducción, vuelva a 
pulsar el botón.
Botón Prev/Next: salta al inicio del clip o al clip 
anterior/siguiente.
Botón F Fwd/F Rev: avanza la reproducción 

hacia adelante/atrás. Para volver a la 
reproducción normal, pulse el botón Play/
Pause.

Botón Stop/Clips: detiene la reproducción y 
vuelve a la pantalla de clips.

[Consejo]
También puede controlar elementos directamente con el 
funcionamiento táctil.

Monitorización de audio

Durante el modo de reproducción normal, 
puede monitorizar el audio grabado con 
el altavoz integrado (página 4) o unos 
auriculares conectados.
Al conectar unos auriculares al conector de 
auriculares (página 4), el altavoz integrado 
se desactiva.
Puede seleccionar el canal que desea 
supervisar y ajustar el volumen con Audio 
Output >Monitor CH y Volume (página 61) 
en el menú Audio del menú completo.

Localización

Para reproducir un clip desde el principio, 
pulse el botón Prev en la pantalla de 
reproducción.
Puede omitir clips y pasar a otro clip de la cola 
pulsando los botones Prev o Next varias veces.

Intercambio de tarjetas de memoria

Si introduce dos tarjetas de memoria, pulse 
el botón SLOT SELECT (página 4) para 
intercambiar las tarjetas en la pantalla de clips.

[Nota]
No se puede cambiar de tarjeta de memoria durante la 
reproducción. No es posible la reproducción continua de 
las tarjetas de las ranuras A y B.
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Conexión a otros dispositivos a través de una LAN
La unidad se puede conectar a smartphones, 
tablets y otros dispositivos de control a través 
de una conexión LAN mediante la función LAN 
de la unidad.
El establecimiento de una conexión LAN entre 
un dispositivo y la unidad le permite llevar 
a cabo lo siguiente mediante la aplicación 
“Monitor & Control”.
 • Control remoto 

Puede controlar la unidad desde un 
smartphone o una tableta conectados a 
esta a través de una LAN.

 • Transferencia de archivos 
Puede transferir un clip de proxy (baja 
resolución) o un clip original (alta 
resolución) que se haya grabado en una 
tarjeta de memoria en la unidad a un 
servidor a través de una LAN.

 • Monitorización de vídeo 
Puede monitorizar la imagen de la cámara 
o reproducir vídeo de la unidad mediante 
la aplicación “Monitor & Control” en un 
dispositivo.

 [Notas]
 •  La supervisión del vídeo no es compatible con los 

siguientes ajustes.
 – Modo de movimiento lento y rápido
 – Frecuencia del sistema de 24
 – Modo Interval Rec
 – Cuando Codec se establece en XAVC H-I o XAVC 

H-L
 • No se pueden usar al mismo tiempo la LAN 

inalámbrica y la LAN con cable.

Aplicación “Monitor & Control”

Puede usar esta aplicación para controlar la 
unidad de manera remota y configurar los 
ajustes de la unidad mientras monitoriza 
el vídeo desde la unidad en la pantalla del 
dispositivo.

Para obtener más información acerca de la aplicación 
“Monitor & Control”, póngase en contacto con el servicio 
de asistencia técnica o de ventas de Sony.

Establecimiento del nombre de 
usuario y la contraseña

Establezca el nombre de usuario y la 
contraseña de la unidad para usar la función 
de red.

1 Configure Network Setup >User Name 
(página 66) en el menú Network del 
menú completo.

2 Configure Network Setup >Input Password 
(página 66) en el menú Network del 
menú completo.

 [Consejos]
 • También puede generar una contraseña 

automáticamente. Ejecute Generate Password 
en lugar de Input Password.

 • El nombre de usuario y la contraseña se pueden 
visualizar como texto y código QR mediante 
Show Authentication.

 [Nota]
Tenga cuidado de que otras personas no puedan 
ver el código QR y la contraseña. En concreto, 
durante la grabación X-OCN, tenga en cuenta que 
la página del menú se mostrará en un monitor SDI 
y en un monitor HDMI si muestra la contraseña 
o el código QR en el menú completo mientras la 
pantalla de clips está abierta.

Conexión con Wireless LAN Access 
Point Mode

La unidad funciona como un punto de acceso 
y se conecta a un dispositivo de control a 
través de una red LAN inalámbrica.

Smartphone/Tableta

Conexión con un dispositivo compatible 
con WPS

Los dispositivos compatibles con WPS pueden 
conectarse mediante WPS.

1 Seleccione Network Setup >LAN Type 
Select >WLAN (AP Mode) en el menú 
Network del menú completo.

2 Seleccione Wireless LAN >WPS >Execute 
en el menú Network del menú completo.

3 Abra ajustes de red o ajustes de Wi-Fi del 
dispositivo y active Wi-Fi.

4 Seleccione el SSID de la unidad en la lista 
de SSID de Wi-Fi Network en el dispositivo 
y, a continuación, seleccione el pulsador 
WPS en Option, en el dispositivo, para 
conectarlo.

 [Notas]
 • El método de funcionamiento varía en función 

del dispositivo.
 • Para obtener información acerca del SSID 

y la contraseña de la unidad, consulte AP 
Mode Settings >Camera SSID & Password 
(página 66) en el menú Network del menú 
completo.

5 Establezca la conexión con la aplicación 
“Monitor & Control”.

 [Consejo]
Puede consultar la información necesaria para 
conectarse a la unidad mediante Network Setup 
>Show Authentication (página 66) en el menú 
Network del menú completo.
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Conexión mediante la introducción de 
un SSID y una contraseña en un 
dispositivo

Puede conectar la unidad a un dispositivo 
mediante la introducción de un SSID y una 
contraseña de la unidad en un dispositivo.

1 Seleccione Network Setup >LAN Type 
Select >WLAN (AP Mode) en el menú 
Network del menú completo.

2 Abra ajustes de red o ajustes de Wi-Fi del 
dispositivo y active Wi-Fi.

3 Conecte el dispositivo a la unidad 
seleccionando el SSID de la unidad en la 
lista de SSID de Wi-Fi Network e 
introduciendo la contraseña.
Para obtener información acerca del SSID 
y la contraseña de la unidad, consulte AP 
Mode Settings >Camera SSID & Password 
(página 66) en el menú Network.

 [Nota]
El método de funcionamiento varía en función del 
dispositivo.

4 Establezca la conexión con la aplicación 
“Monitor & Control”.

 [Consejo]
Puede consultar la información necesaria para 
conectarse a la unidad mediante Network Setup 
>Show Authentication (página 66) en el menú 
Network del menú completo.

Conexión del modo de estación de 
LAN inalámbrica

La unidad se conecta a un punto de acceso 
existente de la red LAN inalámbrica como 
cliente. El dispositivo de control se conecta a 
través del punto de acceso.
Los 10 puntos de acceso conectados más 
recientemente se mostrarán en el historial.
El historial de conexión se guarda en un 
archivo ALL, pero no se guardarán las 
contraseñas de acceso. Es obligatorio 
introducir la contraseña la próxima vez que se 
conecte después de cargar el archivo ALL.

Smartphone/
Tableta

Punto de acceso

Ordenador

Conexión a un punto de acceso a través 
de WPS

Si el punto de acceso es compatible con la 
función WPS, puede conectarse al punto de 
acceso mediante ajustes sencillos.

1 Active el punto de acceso.

2 Encienda la unidad.

3 Seleccione Network Setup >LAN Type 
Select >WLAN (ST Mode) en el menú 
Network del menú completo.

4 Seleccione ST Mode Settings >Camera 
Remote Control (página 66) >Enable en 
el menú Network del menú completo.

5 Seleccione Wireless LAN >WPS >Execute 
en el menú Network del menú completo.

6 Pulse el botón WPS del punto de acceso.
Para obtener más información acerca de 
cómo utilizar el botón WPS, consulte el 
manual de instrucciones del punto de 
acceso.
Cuando la conexión se realiza 
correctamente, el icono indicador del 
estado de red mostrará una fuerza de 1 o 
superior en el monitor LCD.

 [Nota]
En caso de que falle la conexión, vuelva a llevar a 
cabo los pasos a partir del 1.

7 Conecte el dispositivo al punto de acceso.
Para obtener más información acerca de 
la conexión, consulte el manual de 
instrucciones del dispositivo.

8 Inicie la aplicación Monitor & Control en 
un dispositivo y seleccione la unidad.

 [Consejo]
Puede consultar la información necesaria para 
conectarse a la unidad mediante Network Setup 
>Show Authentication (página 66) en el menú 
Network del menú completo.

Conexión mediante la función de 
detección automática de punto de 
acceso

1 Siga los pasos de 1 a 3 en “Conexión a un 
punto de acceso a través de WPS” 
(página 79).

2 Seleccione ST Mode Settings >Scan 
Networks (página 67) >Execute en el 
menú Network del menú completo.
La unidad comienza a detectar los 
destinos de conexión.
Los posibles destinos encontrados se 
muestran en una lista.

3 Seleccione un destino de entre las 
opciones de la lista.
Aparecerá la pantalla de detalles de la red 
(punto de acceso). La conexión 
seleccionada se muestra en SSID.

4 Seleccione Password e introduzca la 
contraseña del punto de acceso para 
conectarse en la pantalla de entrada de 
contraseña.
La selección de un SSID en el historial de 
conexiones configura automáticamente 
los ajustes, incluida la contraseña.
Establezca la contraseña para volver a la 
pantalla de detalles de red (punto de 
acceso).
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5 Configure los siguientes ajustes de 
conexión.
 • DHCP 

Establezca el ajuste DHCP.  
Cuando establezca el ajuste en On, la 
dirección IP se asignará a la unidad 
automáticamente.  
Para asignar la dirección IP a la unidad 
manualmente, establezca el ajuste Off.

 • IP Address 
Introduzca la dirección IP de la unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.

 • Subnet Mask 
Introduzca la máscara de subred de la 
unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.

 • Gateway 
Introduzca la puerta de enlace del 
punto de acceso.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.

 • DNS Auto 
Establece si adquirir DNS 
automáticamente.  
Cuando se establece en On, se 
adquiere automáticamente la dirección 
del servidor DNS. Este ajuste está 
disponible únicamente si DHCP está 
ajustado en On.

 • Primary DNS Server 
Introduzca el servidor DNS principal del 
punto de acceso.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

 • Secondary DNS Server 
Introduzca el servidor DNS secundario 
del punto de acceso.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

6 Cuando haya terminado, seleccione 
Connect para conectarse al punto de 
acceso.

7 Conecte el dispositivo al punto de acceso.
Para obtener más información acerca de 
la conexión, consulte el manual de 
instrucciones del dispositivo.

8 Inicie la aplicación Monitor & Control en 
un dispositivo y seleccione la unidad.

 [Consejo]
Puede consultar la información necesaria para 
conectarse a la unidad mediante Network Setup 
>Show Authentication (página 66) en el menú 
Network del menú completo.

Conexión manual introduciendo 
información del punto de acceso

1 Siga los pasos de 1 a 3 en “Conexión a un 
punto de acceso a través de WPS” 
(página 79).

2 Seleccione ST Mode Settings >Manual 
Register (página 67) >Execute en el 
menú Network del menú completo.
Aparecerá la pantalla de detalles de la red 
(punto de acceso) de forma momentánea.

3 Configure los siguientes ajustes de 
conexión.
 • SSID 

Introduzca el SSID del punto de acceso.
 • Security 

Seleccione el método de cifrado.
 • Password 

Introduzca la contraseña del punto de 
acceso.

 • DHCP 
Establezca el ajuste DHCP.  
Cuando establezca el ajuste en On, la 
dirección IP se asignará a la unidad 
automáticamente.  
Para asignar la dirección IP a la unidad 
manualmente, establezca el ajuste Off.

 • IP Address 
Introduzca la dirección IP de la unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.

 • Subnet Mask 
Introduzca la máscara de subred de la 
unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.

 • Gateway 
Introduzca la dirección de la puerta de 
enlace.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.

 • DNS Auto 
Establece si adquirir DNS 
automáticamente.  
Cuando se establece en On, se 
adquiere automáticamente la dirección 
del servidor DNS. Este ajuste está 
disponible únicamente si DHCP está 
ajustado en On.

 • Primary DNS Server 
Indique la dirección del servidor DNS 
principal.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

 • Secondary DNS Server 
Indique la dirección del servidor DNS 
secundario.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

4 Cuando haya terminado, seleccione 
Connect para conectarse al punto de 
acceso.

5 Conecte el dispositivo al punto de acceso.
Para obtener más información acerca de 
la conexión, consulte el manual de 
instrucciones del dispositivo.

6 Inicie la aplicación Monitor & Control en 
un dispositivo y seleccione la unidad.

 [Consejo]
Puede consultar la información necesaria para 
conectarse a la unidad mediante Network Setup 
>Show Authentication (página 66) en el menú 
Network del menú completo.
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Conexión a Internet
Puede conectar la unidad a Internet mediante 
un anclaje USB, LAN con cable o LAN 
inalámbrica.
Establezca primero el nombre de usuario y la 
contraseña de la unidad (página 78).

Conexión mediante anclaje USB

Puede conectar la unidad a un smartphone 
mediante un cable USB y, a continuación, 
conectarse a Internet a través del smartphone.

Configuración de la comunicación con el 
smartphone

Habilite la comunicación Tethering en el 
smartphone.
Para obtener más información, consulte el 
manual de funcionamiento del smartphone.

Acople de un smartphone a la unidad

Conecte un cable USB al conector USB-C 
(página 5) de la unidad y, a continuación, 
conecte el smartphone.

[Notas]
 • Fije/retire el smartphone mientras la unidad está 

apagada.
 • El anclaje USB no se puede utilizar si el smartphone 

se conecta mediante un concentrador USB.

Conexión a una red

1 Encienda la unidad.

2 Ajuste USB Tethering >Setting 
(página 68) en el menú Network del 
menú completo en On.

Habilitar el control desde un 
smartphone

Puede controlar la unidad de forma remota 
mediante la aplicación Monitor & Control en 
un smartphone conectado mediante un cable 
USB.

1 Ajuste USB Tethering >Camera Remote 
Control (página 68) en el menú 
Network del menú completo en Enable.

2 Inicie la aplicación Monitor & Control en 
un smartphone y seleccione la unidad.

 [Consejo]
Puede consultar la información necesaria para 
conectarse a la unidad desde la aplicación 
Monitor & Control mediante Network Setup >Show 
Authentication (página 66) en el menú Network 
del menú completo.

Conexión mediante el Wireless 
LAN Station Mode (Wi-Fi Station 
Mode)

Puede conectar la unidad a Internet en modo 
de estación Wi-Fi utilizando un router Wi-
Fi opcional o mediante anclaje Wi-Fi en un 
smartphone.
Conéctese al router o dispositivo Wi-Fi, tal 
como se describe en “Conexión del modo de 
estación de LAN inalámbrica” (página 79).

Smartphone/
Tableta

Router Wi-Fi

Ordenador

Internet

Smartphone/
Tableta

Internet

Conexión con un cable LAN

Puede conectarse a Internet si conecta el 
conector de red de la unidad a un router Wi-Fi 
(opcional) con un cable LAN.

Smartphone/
Tableta

Ordenador

Router Wi-Fi

Internet
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Conexiones de cable LAN y ajustes del 
LAN con cable

1 Conecte el conector de red de la unidad al 
router Wi-Fi a través de un cable de LAN.

2 Encienda la unidad.

3 Configure Network Setup >LAN Type 
Select en Wired LAN en el menú Network 
del menú completo.

4 Configure los ajustes de conexión usando 
Wired LAN >Detail Settings (página 68) 
en el menú Network.
 • DHCP 

Establezca el ajuste DHCP.  
Cuando establezca el ajuste en On, la 
dirección IP se asignará a la unidad 
automáticamente.  
Para asignar la dirección IP a la unidad 
manualmente, establezca el ajuste Off.

 • IP Address 
Introduzca la dirección IP de la unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.

 • Subnet Mask 
Introduzca la máscara de subred de la 
unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.

 • Gateway 
Introduzca la dirección de la puerta de 
enlace.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.

 • DNS Auto 
Establece si adquirir DNS 
automáticamente.  
Cuando se establece en On, se 
adquiere automáticamente la dirección 
del servidor DNS. Este ajuste está 
disponible únicamente si DHCP está 
ajustado en On.

 • Primary DNS Server 
Indique la dirección del servidor DNS 
principal.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

 • Secondary DNS Server 
Indique la dirección del servidor DNS 
secundario.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

5 Cuando haya terminado, seleccione Set 
para aplicar los ajustes.

[Nota]
Seleccione siempre Set tras cambiar los ajustes de 
conexión. No se aplicarán los ajustes si no se selecciona 
Set.

Habilitar el funcionamiento desde un 
smartphone a través de una LAN con 
cable

Para controlar la unidad de forma remota 
mediante la aplicación Monitor & Control 
en un smartphone a través de Wi-Fi con un 
router Wi-Fi conectado por LAN con cable, 
ajuste Wired LAN >Camera Remote Control 
(página 68) en el menú Network del menú 
completo en Enable.
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Carga de archivos
Puede cargar un clip de proxy o un clip 
original que se haya grabado en la unidad en 
un servidor de Internet o en un servidor de 
una red local a través un smartphone o un 
punto de acceso.

Preparación

Conexión a una red

Conecte la unidad a Internet o a la red local 
siguiendo el procedimiento que se detalla 
en “Conexión a Internet” (página 81) o 
“Conexión a otros dispositivos a través de una 
LAN” (página 78).

Registro de un destino de transferencia 
de archivo

Registre el servidor para la carga de 
antemano.

1 Seleccione File Transfer >Server Settings1 
(o Server Settings2, Server Settings3) en el 
menú Network del menú completo.
Aparecerá la pantalla de configuración de 
destino de la transferencia.

2 Configure cada elemento de la pantalla 
de configuración de destino de la 
transferencia.
Display Name
Introduzca el nombre del servidor que 
desea visualizar en la lista de destino de 
la transferencia.
Service
Muestra el tipo de servidor.
“FTP”: servidor FTP
Host Name
Introduzca la dirección del servidor.

Port
Introduzca el nombre del servidor para 
conectarse.
User Name
Introduzca el nombre del usuario.
Password
Introduzca la contraseña.
Passive Mode
Active y desactive el modo pasivo.
Destination Directory
Introduzca el nombre del directorio en el 
servidor de destino.

 [Notas]
 • Los clips originales se cargan en la carpeta 

“Main” del directorio especificado como destino 
de la transferencia.

 • Al editar, “” indica los caracteres que no 
podrán cambiarse. No se garantiza el correcto 
funcionamiento al editar un nombre de 
directorio que contenga estos caracteres.  
Si necesita realizar la edición, elimine todos los 
caracteres y vuelva a introducir un valor.

 • Si se introducen caracteres en el directorio de 
destino no válidos en el servidor de destino, los 
archivos se transferirán al directorio de inicio 
del usuario. Los caracteres no válidos variarán 
dependiendo del servidor.

Using Secure Protocol
Ajuste si desea llevar a cabo la carga a 
través de FTP segura.
Root Certificate
Cargue/borre un certificado.
 • Load 

Seleccione Set en el paso 3 para 
importar un certificado de CA.
* El certificado que se cargue debe estar en 

formato PEM y debe grabarse en el directorio 
raíz de la tarjeta SD insertada en la ranura para 
tarjetas Utility SD con el nombre de archivo 
“certification.pem”.

[Consejo]
El método de verificación de validación del 
certificado es OCSP. A continuación se muestra 
la estructura del certificado.  
-----BEGIN CERTIFICATE----- 
(su certificado raíz) 
-----END CERTIFICATE-----

 • Clear 
Seleccione Set en el paso 3 para borrar 
un certificado de CA.

 • None 
No cargue ni borre ningún certificado.

 [Notas]
 • Ajuste el reloj de la unidad a la hora correcta 

antes de importar un certificado CA.
 • Al grabar en XAVC-I 4096×2160P/3840×2160P, 

XAVC H-I HQ/SQ o X-OCN, no se puede 
seleccionar Load.

 • En el estado de baja tensión, Load/Clear no 
podrán seleccionarse para un certificado de CA.

Root Certificate Status
Muestra el estado de carga del certificado.
Reset
Restablezca los ajustes predeterminados 
de Server Settings.

3 Cuando haya terminado, seleccione Set 
para aplicar los ajustes.
Seleccione siempre Set tras cambiar los 
ajustes. No se aplicarán los ajustes si no 
se selecciona Set.

Selección y carga de clips

Puede cargar clips proxy y clips originales en 
tarjetas de memoria en un servidor.

Carga de un clip de proxy en una tarjeta 
de memoria desde la pantalla de clips

1 Conecte la unidad y el dispositivo 
mediante una conexión de LAN 
(página 78).

2 Seleccione Transfer Clip (Proxy) >Select 
Clip en el menú Clip Operations del menú 
completo.
La pantalla cambia del menú completo a 
la pantalla de clips.
Los clips se pueden transferir desde la 
pantalla de clips o la pantalla de clips 
filtrados.

3 Seleccione el clip que desea transferir y, a 
continuación, pulse el botón MENU.
Aparece una pantalla de confirmación de 
transferencia.

4 Seleccione Execute.
El grupo de archivos correspondiente a 
los clips de proxy seleccionados se 
registra como trabajo de transferencia y 
comienza la carga.
Cuando el trabajo de transferencia se 
registra correctamente, aparece la 
pantalla de resultados de la transferencia.

5 Seleccione OK.
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Transferencia de todos los clips
Seleccione All Clips en lugar de Select Clip en 
el paso 2 para transferir el grupo de archivos 
correspondientes a todos los clips de proxy.

[Nota]
Se pueden registrar hasta 200 trabajos de transferencia.

Carga de un clip original en una tarjeta 
de memoria desde la pantalla de clips

[Nota]
Los clips originales se cargan en la carpeta “Main” del 
directorio especificado como destino de la transferencia.

1 Conecte la unidad y el dispositivo 
mediante una conexión de LAN 
(página 78).

2 Seleccione Transfer Clip >Select Clip en el 
menú Clip Operations del menú completo.
La pantalla cambia del menú completo a 
la pantalla de clips.
Los clips se pueden transferir desde la 
pantalla de clips o la pantalla de clips 
filtrados.

3 Seleccione el clip que desea transferir y, a 
continuación, pulse el botón MENU.
Aparece una pantalla de confirmación de 
transferencia.

4 Seleccione Execute.
El grupo de archivos correspondiente a 
los clips seleccionados se registra como 
trabajo de transferencia y comienza la 
carga.
Cuando el trabajo de transferencia se 
registra correctamente, aparece la 
pantalla de resultados de la transferencia.

5 Seleccione OK.

Transferencia de todos los clips
Seleccione All Clips en lugar de Select Clip en 
el paso 2 para transferir todos los archivos.

[Nota]
Se pueden registrar hasta 200 trabajos de transferencia.

Comprobación de la transferencia de 
archivos

Puede verificar el estado de la transferencia 
de archivos seleccionando File Transfer >View 
Job List (página 68) en el menú Network del 
menú completo.
También puede verificar el estado de la 
transferencia de archivos desde la pantalla de 
la aplicación Monitor & Control.

[Consejo]
Si se ajusta File Transfer >Auto Upload (página 68) o 
Auto Upload (Proxy) (página 68) en el menú Network 
del menú completo en On, y existe una conexión 
de red, los clips originales y de proxy se cargarán 
automáticamente en el servidor especificado mediante 
Default Upload Server (página 68) cuando acabe 
la grabación. Si los clips originales y los clips de proxy 
están configurados para la carga automática, ese tipo de 
carga de los clips de proxy tendrá prioridad.

[Notas]
 • Se pueden registrar hasta 200 trabajos de 

transferencia.
 • La lista de trabajos se conserva cuando la unidad 

se apaga, pero es posible que se pierdan hasta 
10 minutos de la información de progreso reciente si 
se extrae la batería o se apaga la unidad sin ajustar 
primero el interruptor de alimentación en STANDBY.

 • Los trabajos añadidos después del estado de baja 
tensión de la batería no se guardan en la lista de 
trabajos.

 • Si se produce un error durante la transferencia de 
archivos, no se reanudará la transferencia de un 
clip con el mismo nombre que un clip transferido 
dependiendo de la configuración y el estado del 
servidor de destino de la transferencia. En este caso, 
compruebe la configuración y el estado del servidor 
de destino de la transferencia.

Carga automática de clips

Carga automática de clips originales

Los clips originales se pueden cargar en 
el servidor especificado cuando finalice la 
grabación. Para activar esta función, defina 
File Transfer >Auto Upload (página 68) en 
On en el menú Network del menú completo.

Carga automática de clips de proxy

Los clips de proxy se pueden cargar en 
el servidor especificado cuando finalice 
la grabación. Para activar esta función, 
defina File Transfer >Auto Upload (Proxy) 
(página 68) en On en el menú Network del 
menú completo.

Carga a través de FTP segura

Puede cargar archivos cifrados mediante FTPS 
en el modo Explicit (FTPES) para conectarse 
con el servidor de archivos de destino.

Configuración de la transferencia de FTP 
segura

Para una transferencia de FTP segura, ajuste 
Using Secure Protocol, en los ajustes del 
servidor de archivos de destino, en ON e 
importe un certificado.
Para obtener más detalles acerca de 
la configuración, consulte “Registro de 
un destino de transferencia de archivo” 
(página 83).
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Uso de Creators' App for enterprise
Puede transferir fácilmente archivos al servicio 
en la nube de C3 Portal vinculando la unidad 
con la aplicación para smartphone “Creators' 
App for enterprise”.
Primero, consiga una cuenta de C3 Portal e 
instale Creators' App for enterprise en un 
smartphone.
Para obtener más información sobre cómo 
obtener una cuenta del servicio en la nube 
de C3 Portal, póngase en contacto con el 
administrador de su organización.

[Notas]
 • Puede que el servicio no esté disponible, según la 

región en que se encuentre.
 • Para obtener información detallada sobre cómo 

utilizar Creators' App for enterprise, consulte la Guía 
de Ayuda de Creators' App for enterprise.

Carga de archivos a C3 Portal

1 Seleccione Network Setup >Setup for 
Mobile App (página 66) en el menú 
Network del menú completo.
Se muestra una pantalla de confirmación 
para los elementos que se actualizarán 
automáticamente.
Los siguientes ajustes del menú Network 
se seleccionan automáticamente.
 • USB Tethering >Setting: On
 • USB Tethering >Camera Remote Control: 

Enable
 • Network Setup >Input Password: (se 

genera automáticamente si no se 
especifica)

2 Compruebe los ajustes y seleccione OK.
Comienza la configuración. Aparece un 
mensaje “Now changing” mientras la 
configuración está en proceso.
Cuando se completa la configuración, 
aparece la siguiente pantalla en el visor.

Se muestra la siguiente información para 
la autenticación del acceso.
Nombre de usuario, contraseña, huella 
digital, nombre de modelo de cámara y 
número de serie

 [Consejo]
Esta pantalla no se emite en la salida de vídeo.

 [Nota]
Tenga cuidado de que otras personas no puedan 
ver la contraseña ni copiar la imagen del código 
QR. En concreto, durante la grabación X-OCN, tenga 
en cuenta que la página del menú se mostrará en 
un monitor SDI y en un monitor HDMI si muestra 
la contraseña o el código QR en el menú completo 
mientras la pantalla de clips está abierta.

3 Inicie Creators' App for enterprise en un 
smartphone e inicie sesión en el servicio 
en la nube.

4 Conecte el smartphone con el cable USB 
al conector USB-C de la unidad.

5 Active el anclaje USB en la pantalla del 
smartphone.
Para obtener más detalles acerca de la 
configuración, consulte “Conexión 
mediante anclaje USB” (página 81).
El funcionamiento variará según el 
smartphone. Consulte el manual de 
instrucciones del smartphone.

6 Escanee el código QR mostrado en el 
visor según las instrucciones en la 
pantalla de Creators' App for enterprise.

La información de configuración de 
transferencia del archivo se envía desde el 
smartphone a la unidad y aparece el 
siguiente mensaje.

7 Seleccione OK.
La información de configuración empieza 
a cargar.
Cuando se carga la configuración con 
éxito, aparece un mensaje “Network File 
loaded.”.

[Notas]
 • Creators' App for enterprise sobrescribe el ajuste File 

Transfer (página 68) en el menú Network de la 
unidad.

 • Root Certificate no puede ajustarse automáticamente. 
Configúrelo manualmente.

Carga de clips originales

Establezca File Transfer >Auto Upload 
(página 68) en el menú Network a On para 
activar la carga de clips originales al C3 Portal.
Cada vez que finaliza una grabación, el archivo 
se carga a la ubicación asociada con su cuenta 
de C3 Portal.

Carga de clips de proxy

Establezca File Transfer >Auto Upload (Proxy) 
(página 68) en el menú Network a On para 
activar la carga de clips de proxy al C3 Portal.
Cada vez que finaliza una grabación, el archivo 
se carga a la ubicación asociada con su cuenta 
de C3 Portal.

Carga de clips seleccionados

Consulte la “Selección y carga de clips” 
(página 83).

[Consejos]
 • Los archivos enviados por la unidad se almacenan 

en la memoria media de Creators' App for enterprise 
y se transfieren a C3 Portal. La pantalla de estado de 
transferencia del archivo de la unidad indica el estado 
de transferencia a Creators' App for enterprise.

 • Cuando la transferencia de archivos desde la unidad 
a Creators' App for enterprise en el smartphone se 
completa, puede apagar la unidad, pero tenga en 
cuenta que puede que continúe la transferencia de 
archivos desde el smartphone. Compruebe la carga 
de batería restante del smartphone.

Otras funciones que utilizan C3 
Portal

Gestión de archivos 3D LUT

Puede importar archivos 3D LUT almacenados 
en C3 Portal a la unidad. Consulte la 
“Importación desde un servicio en la nube” 
(página 90).

Gestión de archivos ALL

Puede guardar un archivo ALL creado por 
la unidad en C3 Portal y cargar un archivo 
ALL desde C3 Portal. Consulte “Guardado de 
un archivo ALL en un servicio en la nube” 
(página 72) y “Carga de un archivo ALL 
desde un servicio en la nube” (página 73).
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Configuración del funcionamiento básico
Antes de filmar, configure el funcionamiento 
básico de la unidad en la pantalla de estado 
Project que mejor se adapte a su uso.

Modo de grabación

Puede cambiar el modo de filmación entre 
“Cine EI”, en el que la unidad funciona de 
manera similar a una cámara de cine con 
metraje que se revela en postproducción, y 
“Custom”, para crear imágenes de manera 
flexible in situ.
Configure el modo de filmación en Shooting 
Mode (página 30) en la pantalla de estado 
Project.

[Consejo]
También puede configurar el modo de filmación en 
Base Setting >Shooting Mode (página 46) en el menú 
Project del menú completo.

Cine EI

Si el modo de filmación está ajustado en Cine 
EI, seleccione la gama de colores básicos para 
la señal de grabación y la señal de salida. La 
gama de colores seleccionada aquí es la gama 
de colores del vídeo grabado y la salida de 
vídeo cuando la LUT del monitor se ajusta en 
Off.
Puede establecer la gama de colores en Cine 
EI Setting >Color Gamut (página 47) en el 
menú Project del menú completo.
 • S-Gamut3.Cine/SLog3: gama de colores fácil 

de ajustar para el cine digital (DCI-P3).
 • S-Gamut3/SLog3: amplia gama de colores 

de Sony que cubre la gama de colores ITU-R 
BT.2020.

Para obtener más detalles, consulte la 
página 90.

[Notas]
 • El modo de filmación Cine EI tiene las siguientes 

limitaciones.
 • Funciones que no se pueden ajustar de forma 

automática (corrección)
 – Balance de blancos
 – Ganancia
 – Obturador

 • Funciones que no se pueden configurar
 – Ganancia/sensibilidad ISO (establecida en la 

sensibilidad ISO base (fija))
 – Configuración del menú Paint/Look (excepto 

Base Look)
 – Scene File (deshabilitado)

 • Las siguientes funciones solo están disponibles en el 
modo de filmación Cine EI (página 90):

 • Exposure Index
 • Monitor LUT

 • Cuando grabe en Cine EI, es recomendable que 
mantenga el ajuste Exposure Index constante. Si 
modifica el ajuste Exposure Index, es posible que 
sea muy difícil conseguir la corrección de brillo en la 
postproducción, por lo que puede resultar imposible 
reproducir el estado en el que la imagen se filmó 
originalmente.

Custom

Si el modo de filmación está ajustado en 
Custom, puede seleccionar el estándar de 
vídeo.
Puede configurar el estándar de vídeo en Base 
Setting >Target Display (página 46) en el 
menú Project del menú completo.
 • SDR(BT.709): filmación según el estándar de 

emisión HD
 • HDR(HLG): filmación según el estándar de 

emisión 4K de última generación
Para obtener más detalles, consulte la 
página 92.

Frecuencia del sistema

Configure la frecuencia del sistema en 
Frequency/Scan (página 30) en la pantalla 
de estado Project. La unidad puede reiniciarse 
automáticamente después de hacer el cambio, 
dependiendo del valor seleccionado.

[Consejo]
También puede configurar la frecuencia del sistema 
en Rec Format >Frequency (página 46) en el menú 
Project del menú completo.

[Nota]
No puede cambiar la frecuencia del sistema durante una 
grabación o una reproducción.

Modo de escaneado de la cámara

Puede establecer el tamaño efectivo de la 
imagen y la resolución del sensor de imagen.
Configure el modo de escaneado en Imager 
Scan (página 30) en la pantalla de estado 
Project.
 • FF 8.6K 16:9, FF 8.6K 17:9, FFc 6K 16:9, FFc 6K 

17:9: uso para tamaño completo.
 • S35 5.8K 16:9, S35 5.8K 17:9, S35c 4K 17:9: 

uso para tamaño Super 35mm.

[Consejo]
También puede seleccionar el modo de escaneado en 
Rec Format >Imager Scan Mode (página 46) en el 
menú Project del menú completo.

[Nota]
No puede cambiar el modo de escaneado de la cámara 
durante una grabación o una reproducción.
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Tamaño de imagen efectivo

La unidad admite la filmación en los siguientes tamaños de imagen efectivos. (Unidad: mm)

FF 8.6K 16:9
(35.9x20.2)

FF 8.6K 17:9
(35.9x18.9)

FFc 6K 16:9
(33.6x18.9) 

FFc 6K 17:9
(33.6x17.7) 

S35 5.8K 16:9
(24.0x13.5)

S35 5.8K 17:9
(24.0x12.6)

S35c 4K 17:9
(17.0x9.0)

Códec

Ajuste el códec en Codec (página 30) 
en la pantalla de estado Project. La unidad 
puede reiniciarse automáticamente después 
de hacer el cambio, dependiendo del valor 
seleccionado.

[Consejo]
También puede ajustar el códec en Rec Format >Codec 
(página 46) en el menú Project del menú completo.

[Notas]
 • No puede cambiar el códec durante una grabación o 

una reproducción.
 •  La unidad se reiniciará cuando cambie de o a X-OCN o 

XAVC.
 •  En el formato X-OCN, hay limitaciones en la señal de 

salida de vídeo. Para obtener más detalles, consulte la 
página 118.

 • Para cambiar a X-OCN, primero debe establecer el 
modo de filmación en Cine EI.

Formato de vídeo

Puede configurar el formato de vídeo para la 
grabación. Configure el formato de vídeo en 
Video Format (página 30) en la pantalla de 
estado Project.

[Consejo]
También puede configurar el formato de vídeo en Rec 
Format >Video Format (página 46) en el menú Project 
del menú completo.

[Notas]
 •  No se puede configurar en formato X-OCN.
 • No puede cambiar el formato de vídeo durante una 

grabación o una reproducción.
 • Se pueden aplicar restricciones a la señal de 

los conectores SDI OUT y HDMI OUT, según la 
configuración del formato de vídeo.
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Procedimiento básico de funcionamiento
La filmación básica se realiza mediante el 
siguiente procedimiento.

1 Acople los dispositivos necesarios y 
compruebe que se suministra la 
alimentación necesaria.

2 Introduzca las tarjetas de memoria.

 [Nota]
Antes de filmar, realice una copia de seguridad 
de los clips y, a continuación, efectúe el formateo 
completo del soporte de grabación desde Format 
Media (página 56) en el menú TC/Media del 
menú completo.

3 Encienda la unidad.
Se encenderá el testigo de alimentación y 
aparecerá la imagen de la cámara en el 
monitor LCD.

4 Pulse el botón REC (inicio/parada de 
grabación) (página 4).
El testigo REC se enciende y se inicia la 
grabación.

5 Para detener la grabación, pulse el botón 
REC (inicio/parada de grabación) de 
nuevo.
Se detiene la grabación y la unidad pasa 
al modo STBY (grabación en espera).

[Nota]
Si se pulsa el botón REC (inicio/parada de grabación) 
pocos segundos después de encender la unidad, el 
testigo REC se iluminará para indicar que la unidad se 
encuentra en estado de grabación; pero es posible que 
la grabación en los soportes no se produzca durante 
los primeros segundos, según el formato de grabación 
seleccionado.

Intercambio de tarjetas de 
memoria

Si introduce dos tarjetas de memoria, pulse 
el botón SLOT SELECT (página 4) para 
intercambiar las tarjetas.
La grabación cambia automáticamente a 
la segunda tarjeta de memoria justo antes 
de que la capacidad restante en la primera 
tarjeta se reduzca a cero (grabación de 
retransmisión). Puede continuar grabando 
de forma continua al cambiar de tarjeta de 
memoria si sustituye la tarjeta de memoria 
llena por una nueva.

[Nota]
No se pueden intercambiar las tarjetas de memoria 
durante el modo de reproducción. Además, la 
reproducción continua de un soporte de duración de un 
clip en la ranura A y B no es compatible.

Clips (datos grabados)
Al dejar de grabar, el vídeo, el audio, y los 
datos que los acompañan desde el principio 
hasta el final de la grabación se guardan como 
un solo “clip” en una tarjeta de memoria.

Nombres de clips
A todos los clips grabados con esta unidad 
se les asignará un nombre automáticamente 
usando el formato establecido en la opción 
Clip Name Format (página 55) del menú TC/
Media del menú completo.

Duración máxima de clip
Hasta 6 horas por clip.
La duración máxima de una grabación 
continua es la misma que la duración máxima 
de un clip. Si el tiempo de grabación supera 
la duración máxima de un clip, se crea un 
clip nuevo automáticamente y continúa la 
grabación. El nuevo clip aparece como un clip 
separado en la pantalla de clips.

Se graban varios clips sucesivamente durante 
la grabación continua, pero la grabación se 
detendrá de manera automática transcurridas 
unas 24 horas.

[Notas]
 • No extraiga una tarjeta de memoria mientras se 

esté grabando en ella. Cambie solo las tarjetas de 
memoria en las ranuras cuyo indicador de acceso esté 
apagado.

 • Cuando la capacidad restante de la tarjeta de 
memoria en la que se está grabando es inferior a un 
minuto y en la otra ranura se ha insertado otra tarjeta 
de memoria en la que se puede grabar, aparecerá 
el mensaje “Will Switch Slots Soon”. El mensaje 
desaparecerá después de cambiar las ranuras de 
tarjeta de memoria.

 • Es posible que la grabación continua no funcione si 
la grabación comienza cuando la capacidad restante 
de la tarjeta de memoria es inferior a un minuto. Para 
una grabación continua correcta, compruebe que 
la capacidad restante de la tarjeta de memoria es 
superior a un minuto antes de comenzar a grabar.

 • Los vídeos creados con la función de grabación 
continua de la unidad no se pueden reproducir sin 
interrupciones en la unidad.

 • Para combinar los vídeos creados con la función de 
grabación continua de la unidad, utilice el software 
“Catalyst Browse”.

Control del audio

Puede controlar el audio que se está grabando 
con los auriculares.
Al conectar unos auriculares a la toma de 
auriculares (página 4) podrá controlar 
el audio que se está grabando. También 
puede controlar el audio de reproducción 
(página 77) con el altavoz integrado 
(página 4) o con los auriculares.
Puede ajustar el volumen del audio que desea 
controlar con Volume (página 30) en la 
pantalla de estado Audio o con Audio Output 
>Volume (página 61) en el menú Audio del 
menú completo.
Puede seleccionar el canal de que desea 
supervisar con Monitor CH (página 30) en la 
pantalla de estado Audio o con Audio Output 
>Monitor CH (página 61) en el menú Audio 
del menú completo.

Especificación de los datos de 
tiempo

Ajuste del código de tiempo

Ajuste el código de tiempo para grabar 
mediante Timecode (página 55) en el menú 
TC/Media del menú completo.

Ajuste de los bits del usuario

Puede añadir un número hexadecimal de 8 
dígitos a la imagen grabada como bits de 
usuario. También puede establecer los bits del 
usuario a la hora actual. Establezca el uso de 
Users Bit (página 55) en el menú TC/Media.
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Visualización de los datos de tiempo

Ajuste el código de tiempo que se va a 
mostrar mediante TC Display (página 55) 
>Display Select en el menú TC/Media.
Si pulsa un botón asignable (página 106) 
al que se le haya asignado DURATION/TC/U-
BIT, cambiará la visualización entre código de 
tiempo, bits de usuario y duración de forma 
consecutiva.

Cambio de la entrada/salida de código 
de tiempo

Puede cambiar la entrada/salida de código de 
tiempo con el interruptor de selección TC/REF 
IN/OUT (página 6).
Para obtener más detalles, consulte la 
página 113.

Revisión de la grabación  
(Rec Review)

Puede revisar el último clip grabado en la 
pantalla (revisión de grabación).

[Nota]
Rec Review no es compatible si el formato de vídeo se 
cambia después de grabar un clip.

Método de revisión de la grabación

Asigne Rec Review a uno de los botones 
asignables primero.
Cuando detenga la grabación, pulse el botón 
asignable (página 106) al que se ha asignado 
la función Rec Review. La reproducción del 
último clip grabado se inicia.
El clip se reproduce hasta el final, Rec Review 
finaliza y la unidad vuelve al modo STBY  
(en espera).

Para detener Rec Review

Presione el botón asignable asignado a Rec 
Review o presione el botón BACK.

Ajustes de revisión de grabación

Puede establecer el punto de inicio de 
la reproducción en uno de los siguientes 
mediante el ajuste Rec Review (página 63) 
en el menú Technical.
 • Últimos 3 segundos del clip
 • Últimos 10 segundos del clip
 • Inicio del clip

[Consejo]
Si desea revisar un clip específico después de grabar 
varios clips, presione el botón CLIPS para mostrar la 
pantalla de clips y seleccione el clip para comenzar la 
reproducción.
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Filmación con ajuste del aspecto en posproducción
Si utiliza la unidad en el modo Cine EI y graba 
gradaciones uniformes de las áreas oscuras 
a las luminosas, puede realizar ajustes finos, 
como restaurar localmente las gradaciones 
de las áreas oscuras y las luminosas, en la 
posproducción.
Sin embargo, cuando vea las imágenes 
grabadas en un monitor convencional, el 
contraste total será bajo y resultará difícil 
ajustar el enfoque y la exposición.
Puede aplicar una LUT al destino del monitor 
en la unidad para facilitar diversos ajustes 
durante la filmación. También puede aplicar 
una LUT al vídeo de reproducción para 
verificar el resultado final.
Las LUT se aplican en los siguientes sistemas. 
Sin embargo, solo se puede aplicar una LUT.
 • Durante la grabación X-OCN:

 – Salida SDI o salida HDMI (solo una salida)
 – Monitor LCD, proxy, transmisión

 • Distinto a la grabación X-OCN:
 – Salida SDI
 – Salida HDMI, monitor LCD, proxy y 
transmisión

Aplicación de una LUT a la imagen 
del monitor LCD

1 Pulse el botón MENU para mostrar la 
pantalla de estado Monitoring.

2 Seleccione la columna Gamut/Gamma en 
la fila LCD/Stream.

3 Seleccione On u Off.

[Notas]
 • El ajuste LUT On/Off del monitor LCD también se 

aplica los archivos de proxy y al vídeo de transmisión 
durante la grabación X-OCN. Para los formatos 
distintos a la grabación X-OCN, también se aplica a 
la salida HDMI, a los archivos de proxy y al vídeo de 
transmisión.

 • La pantalla asistida de gamma está disponible 
cuando se utiliza la ampliación de enfoque.

[Consejos]
 • También puede realizar el ajuste de LUT con LUT On/

Off (página 44) en el menú Shooting del menú 
completo.

 • SDI/HDMI se puede ajustar de manera similar al 
monitor LCD.

Cambio de una LUT

1 Pulse el botón MENU para mostrar la 
pantalla de estado Monitoring.

2 Seleccione el campo Base Look/LUT.

3 Seleccione la LUT que desea aplicar en la 
lista de aspectos básicos.

[Consejos]
 • La unidad ofrece s709, 709(800%), S-Log3, Warm, 

Cool, Vintage, Teal and Orange, ACESproxy, ACEScct y 
ACES 1.0 Output-Rec.709 como LUT predeterminados.

 • También puede importar y aplicar un archivo 3D LUT. 
Para obtener más información, consulte “Importación 
del aspecto básico deseado” (página 90) y 
“Eliminación de un aspecto básico” (página 91).

 • El aspecto básico también se puede ajustar con Base 
Look >Select (página 53) en el menú Paint/Look 
del menú completo.

Importación del aspecto básico 
deseado

Puede importar un archivo 3D LUT, creado 
en un ordenador o en otro dispositivo, como 
aspecto básico desde una tarjeta de memoria 
o un servicio en la nube. Se pueden importar 
hasta 16 archivos.
 • Formato de archivo: archivo CUBE (*.cube) 

para una 3D LUT de 17 o 33 cuadrículas 
creada con Catalyst Browse o RAW Viewer

 • Gamma/gama de colores de entrada: 
S-Gamut3.Cine/S-Log3 o S-Gamut3/S-Log3

Importación desde una tarjeta de 
memoria

Puede importar un archivo 3D LUT desde una 
tarjeta de memoria.

1 En el ordenador u otro dispositivo, guarde 
el archivo 3D LUT en la carpeta o el 
soporte de grabación especificado.

Soporte de 
grabación

Ruta de acceso a la carpeta

Tarjeta SD /PRIVATE/SONY/PRO/LUT/

2 Introduzca el soporte de grabación en el 
que están grabados los archivos 3D LUT 
en la ranura para tarjetas Utility SD.

3 Seleccione Base Look >Import from Utility 
SD (página 53) en el menú Paint/Look 
del menú completo.

4 Seleccione el destino de la importación.

5 Seleccione un archivo 3D LUT para 
importar.
Siga las instrucciones que aparecen en 
pantalla. La unidad procesa un archivo 3D 
LUT como un aspecto básico.

6 Seleccione el archivo 3D LUT importado 
con Base Look >Select (página 53) en el 
menú Paint/Look del menú completo.

7 Configure Base Look >Input y Output 
(página 53) en el menú Paint/Look del 
menú completo para que coincida con los 
atributos del archivo 3D LUT importado.

Importación desde un servicio en la 
nube

Puede importar un archivo 3D LUT desde un 
servicio en la nube.

1 Conecte la unidad desde la aplicación 
para smartphone “Creators' App for 
enterprise” (página 85).

2 Seleccione Base Look >Import from 
Cloud(Private) o Import from Cloud(Share) 
(página 53) en el menú Paint/Look del 
menú completo.

3 Seleccione el destino de la importación.
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4 Seleccione un archivo 3D LUT para 
importar.
Siga las instrucciones que aparecen en 
pantalla. La unidad procesa un archivo 3D 
LUT como un aspecto básico.

5 Seleccione el archivo 3D LUT importado 
con Base Look >Select (página 53) en el 
menú Paint/Look del menú completo.

6 Configure Base Look >Input y Output 
(página 53) en el menú Paint/Look del 
menú completo para que coincida con los 
atributos del archivo 3D LUT importado.

Ajuste de subexposición

Si existe tendencia a la subexposición 
cuando se selecciona la exposición 
automática durante el uso del aspecto básico 
importado, ajuste Base Look >AE Level Offset 
(página 53) en el menú Paint/Look.

[Notas]
 • La imagen no se ve afectada simplemente por 

importar un archivo 3D LUT. Cargue el archivo 3D LUT 
importado con Base Look >Select (página 53) en el 
menú Paint/Look del menú completo.

 • Si la opción Input no se configura correctamente, no 
se obtendrá el aspecto adecuado.

 • Los ajustes de los elementos de menú Input, Output 
y AE Level Offset se aplican al aspecto básico 
seleccionado mediante Select. Si se importan varios 
archivos 3D LUT, seleccione Select para cada archivo 
3D LUT y configure Input, Output y AE Level Offset de 
forma individual para cada archivo.

 • La configuración de Input, Output y AE Level Offset se 
guarda para cada archivo 3D LUT.

 • Las opciones de selección de aspecto básico/LUT 
para los archivos 3D LUT importados son las mismas 
en los modos Custom/Cine EI, pero la gama de 
colores y la conversión gamma no se realizan de 
acuerdo con estos modos.

 • Los archivos 3D LUT no se eliminan cuando se ejecuta 
All Reset >Reset en el menú Maintenance del menú 
completo.

Eliminación de un aspecto básico

Puede eliminar un archivo 3D LUT importado 
con Base Look >Delete (página 53) en el 
menú Paint/Look del menú completo.
Puede eliminar todos los archivos 3D LUT 
importados con Base Look >Delete All 
(página 53) en el menú Paint/Look del 
menú completo.

[Notas]
 • Antes de eliminarlo, compruebe que el aspecto 

básico no esté siendo utilizado en ningún archivo 
de escena. Si elimina un aspecto básico que está 
siendo utilizado, el aspecto de los archivos de escena 
correspondientes será incorrecto.

 • Los aspectos básicos eliminados ya no podrán 
utilizarse en el modo Custom (página 90).

 • Los archivos 3D LUT importados no se eliminan 
cuando se selecciona All Reset >Reset (página 70) 
en el menú Maintenance del menú completo.

Grabación de un archivo 3D LUT 
como metadatos

Puede grabar un archivo 3D LUT (archivo 
CUBE) aplicado a la imagen del monitor 
cuando filme como metadatos para el clip.
Para activar esta función, defina Cine EI Setting 
>Embed LUT File (página 47) en On en el 
menú Project del menú completo.
El archivo 3D LUT (archivo CUBE) seleccionado 
cuando comienza la grabación se graba como 
metadatos.
No obstante, no es posible grabar como 
metadatos en las siguientes situaciones.
 • Cuando no es posible guardar un archivo 

3D LUT (archivo CUBE) en la cámara, por 
ejemplo, porque el tamaño del archivo 3D 
LUT importado supera los 1,25 MB (“!” se 
muestra delante del nombre del archivo 
cuando se selecciona Base Look)

 • Cuando se selecciona un archivo 3D LUT que 
se puede guardar, pero luego los datos de 
la LUT a usar se modifican y la grabación 
comienza de inmediato

[Notas]
 • Solo es posible grabar un elemento de metadatos 

por clip.
 • Durante la grabación X-OCN, no es posible grabar un 

archivo 3D LUT como metadatos.
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Filmación con el aspecto deseado
Cuando la unidad está en el modo Custom, 
puede añadir ajustes al negro, la matriz y otros 
parámetros para crear un “aspecto” basado en 
el aspecto básico.

Aspecto 
básico

Aspecto Negro

:

Matriz

También puede seleccionar rápidamente otro 
aspecto guardando combinaciones diferentes 
de ajustes en archivos de escena.
La unidad viene con un total de seis aspectos 
predeterminados.

Selección del aspecto

1 Mientras se muestra la pantalla de 
filmación, pulse el dial multifunción.

2 Seleccione el icono  (archivo de 
escena).
El número del icono es el número de 
archivo.

3 Pulse el dial multifunción.

4 Seleccione el aspecto deseado en el 
menú y pulse el dial multifunción.

[Consejos]
 • Los siguientes preajustes vienen configurados de 

fábrica:

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Archivo de escena 1 S-Cinetone HLG Live

Archivo de escena 2 Standard HLG Natural

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Archivo de escena 3 Still (Sin registrar)

Archivo de escena 4 ITU709 (Sin registrar)

Archivos de escena 5 

a 16

(Sin registrar) (Sin registrar)

 • También puede seleccionar un aspecto con Scene 
File >Recall (página 53) en el menú Paint/Look del 
menú completo. También puede cargar un preajuste 
con Scene File >Preset Recall.

Personalización del aspecto

Si desea filmar con un aspecto diferente 
a los aspectos predeterminados, puede 
personalizar un aspecto basándose en 
cualquier aspecto básico mediante los 
elementos Black, Knee, Detail, Matrix y 
Multi Matrix del menú Paint/Look del menú 
completo. Para obtener más información sobre 
cada elemento de configuración, consulte la 
página 53.
Conecte la unidad a una televisión o a un 
monitor y ajuste la calidad de la imagen 
mientras observa la pantalla de la televisión o 
del monitor.

[Nota]
Al importar un archivo 3D LUT y aplicarlo a la imagen, 
no se obtendrá el aspecto deseado definido en el 
archivo 3D LUT si se cambia la opción Matrix y otros 
ajustes que no sean los ajustes de aspecto básico del 
menú Paint/Look. Puede restablecer todos los ajustes 
personalizados con Reset Paint Settings >Reset without 
Base Look (página 53) en el menú Paint/Look del 
menú completo.

Guardar un aspecto

Puede guardar el aspecto actual como archivo 
de escena en la memoria interna con Scene 
File >Store (página 53) en el menú Paint/
Look del menú completo.
Para guardarlo rápidamente, utilice las 
operaciones del menú directo en la pantalla 
de filmación.

[Notas]
 • Si selecciona otro aspecto sin guardar el aspecto 

actual, se descartará el aspecto actual.
 • Los archivos Scene no se eliminan cuando se 

ejecuta All Reset >Reset (página 70) en el menú 
Maintenance del menú completo.

[Consejo]
Puede sobrescribir los archivos de escena 
predeterminados.
Para restaurar un archivo de escena predeterminado, 
cargue el aspecto que desee restaurar mediante Scene 
File >Preset Recall (página 53) en el menú Paint/Look 
del menú completo y, a continuación, guarde el archivo 
de escena mediante Scene File >Store.

Eliminación de un aspecto guardado

Puede eliminar un archivo de escena 
guardado en la memoria interna con Scene 
File >Delete (página 53) en el menú Paint/
Look del menú completo.

[Consejo]
Una vez eliminado, dejará de mostrarse en el menú 
directo.
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Ajuste del zoom
Puede ajustar el zoom según las condiciones 
de filmación.

Si acopla un objetivo con zoom motorizado 
con montura E, puede ajustar el zoom con 
la palanca de zoom del control remoto de la 
empuñadura o del asa (opcional) equipada 
con una zapata MI. La velocidad del zoom 
varía según la presión aplicada a la palanca.
La videocámara cuenta con una función de 
zoom que utiliza un procesamiento de la señal 
de la imagen llamado Clear Image Zoom. 
Cuando Clear Image Zoom está activado, se 
admite el zoom incluso para los objetivos 
de distancia focal fija. Se puede utilizar para 
ampliar el rango más allá del rango óptico de 
un objetivo con zoom motorizado.
La relación de zoom máxima con Clear Image 
Zoom varía en función de la resolución de 
grabación.
 • Para la resolución de grabación QFHD/4K: 

1,5×
 • Para la resolución de grabación HD: 2×

[Notas]
 • Clear Image Zoom solo se puede usar cuando el 

modo de escaneado de la cámara (página 86) está 
definido en S35.

 • Si se acopla un objetivo con montura PL, no se admite 
el funcionamiento del zoom óptico con la palanca de 
zoom. Se admite Clear Image Zoom.

Selección del tipo de zoom

Configure el tipo de zoom con Zoom >Zoom 
Type (página 63) en el menú Technical del 
menú completo.
El tipo de zoom variará en función del tipo de 
objetivo acoplado.

Objetivo 
acoplado

Ajuste de Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Objetivo 
de 
distancia 
focal fija/
objetivo 
con zoom 
manual

No se admite el 
funcionamiento 
del zoom con la 
palanca.

Se admite Clear 
Image Zoom.

Objetivo 
con zoom 
motoriza-
do

Solo el zoom 
óptico

Se admiten el 
zoom óptico y 
Clear Image 
Zoom.

[Notas]
 • Clear Image Zoom no está disponible cuando S&Q 

Motion >Frame Rate (página 44) es superior a 
60fps en el menú Shooting del menú completo.

 • Cuando se utiliza el interruptor de selección SERVO/
MANUAL de un objetivo, la ampliación de Clear Image 
Zoom se restablece en 1×.

Ajuste del zoom del asa

Ajuste la palanca de zoom de un asa 
(opcional) equipada con una zapata MI a 
través de Handle Zoom (página 63) en el 
menú Technical del menú completo.

Ajuste del sentido del anillo del 
zoom

En algunos objetivos de montura E, el sentido 
de rotación del anillo del zoom se puede 
invertir.
Establezca el sentido de rotación con Lens 
>Zoom Ring Direction (página 64) en el 
menú Technical del menú completo.
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Ajuste del enfoque
Puede ajustar el enfoque de forma automática 
o manual según las condiciones de disparo.

[Notas]
 • Si se acopla un objetivo con montura PL, no se admite 

el funcionamiento del enfoque desde la unidad ni el 
control remoto de la empuñadura.

 • Cuando el monitor LCD se encuentra en el modo 
de visualización de información, no puede utilizar 
la pantalla que se muestra en un monitor externo 
mediante el selector múltiple del monitor LCD.

Ajuste manual del enfoque 
(Manual Focus)

Para ajustar el enfoque manualmente, ajuste 
el interruptor FOCUS (página 4) en la 
posición “MF”.
Esto le permitirá ajustar el enfoque 
manualmente según las condiciones de 
filmación.
El enfoque manual resulta útil para los 
siguientes tipos de sujetos.
 • Sujetos en la parte más alejada de una 

ventana cubierta por gotas de agua
 • Sujetos con poco contraste con el fondo
 • Sujetos más alejados que otros más 

cercanos

[Consejos]
 • Es posible mantener un enfoque estable esperando al 

menos 10 minutos tras encender la unidad antes de 
ajustar el enfoque.  
Además, si la temperatura medioambiental cambia 
significativamente, puede mantener unas condiciones 
de filmación óptimas volviendo a enfocar.

 • También puede utilizar en enfoque automático en 
los siguientes casos cuando el ajuste manual es el 
principal método de funcionamiento.
 – Cuando la sensibilidad de desplazamiento del 

sujeto AF está ajustada en 1(Locked)
 – Cuando el interruptor FOCUS está ajustado en la 

posición “AF”
 – Cuando se utiliza el anillo de enfoque (AF Assist, 

página 97)

Enfoque mediante un toque (Spot 
Focus)

En el modo de enfoque manual, puede 
especificar la posición en la que quiere ajustar 
el enfoque mediante un toque.
Para usar Spot Focus, establezca Focus >Touch 
Function in MF (página 43) como Spot 
Focus en el menú Shooting.
Se muestra una marca de Spot Focus cuando 
toca la posición en la que quiere ajustar el 
enfoque.

[Consejos]
 • En modo Spot Focus, puede pulsar un botón 

asignable (página 106) con Push AF/Push MF 
asignado para detener temporalmente Spot Focus y 
poder enfocar automáticamente mientras el botón 
está pulsado. El enfoque volverá al enfoque manual 
cuando suelte el botón.

 • La función Spot Focus no se puede utilizar si el 
objetivo está ajustado en enfoque manual.

 • La posición función de enfoque a un punto no puede 
especificarse mientras se utiliza el amplificador de 
enfoque o cuando Touch Operation (página 63) en 
el menú Technical está ajustado en Off.

Uso del enfoque automático de forma 
temporal (Push Auto Focus (AF))

En modo de enfoque manual, puede pulsar 
un botón asignable (página 106) con la 
función Push AF/Push MF asignada para 
activar temporalmente el enfoque automático 
mientras el botón está pulsado.
El enfoque ocurre dentro del área de enfoque 
establecida usando Focus >Focus Area 

(página 43) en el menú Shooting del menú 
completo.
El enfoque volverá al enfoque manual cuando 
suelte el botón.
Esto es útil cuando desea mover el enfoque 
lentamente de un sujeto a otro durante el 
enfoque manual.

[Nota]
La función Push Auto Focus no se puede utilizar si el 
objetivo está ajustado en enfoque manual.

Enfocar con una visualización 
aumentada (Focus Magnifier)

Puede seleccionar la salida objetivo para la 
ampliación de enfoque desde Focus Magnifier 
(página 59) en el menú Monitoring del 
menú completo. El nombre de la función 
asignada a un botón asignable utilizado 
para la ampliación de enfoque cambiará de 
acuerdo con este ajuste.
Puede cambiar la ampliación del amplificador 
de enfoque del monitor LCD si pulsa un botón 
asignable (página 106) con la función LCD 
Focus Magnifier asignada. La ampliación en el 
centro de la pantalla cambia como se indica a 
continuación cada vez que pulsa el botón.

Configuración 
del códec

Tamaño de la 
imagen 
grabada

Ampliación

X-OCN 8K 3×, 6×

Distinto de 8K

Distinto de 
X-OCN

8K 4×

Distinto de 8K 3×, 6×

Esta función resulta útil para comprobar el 
enfoque.
Tras alcanzar la ampliación máxima, si pulsa el 
botón de nuevo, volverá a la vista original.
Puede mover la posición para que se amplíe 
durante la ampliación del enfoque mediante 
el selector múltiple (página 4). Si presiona 
el selector múltiple, se vuelve al centro de la 
imagen.

Puede cambiar la ampliación del amplificador 
de enfoque de la salida SDI y de la salida HDMI 
tal y como se muestra más abajo si pulsa un 
botón asignable (página 106) con la función 
Output Focus Magnifier asignada.

Configura-
ción del 
códec

Tamaño 
de la 
imagen 
grabada

Ampliación

SDI (FHD) HDMI 
(FHD)

X-OCN – 2×, 4× 2×, 4×

Distinto de 
X-OCN

8K – 4×

Distinto de 
8K

– 2×, 4×

[Notas]
 • La imagen no se amplía en las salidas SDI, excepto 

durante la grabación X-OCN, ni en salidas SDI/HDMI 
distintas a FHD.

 • No es posible aplicar una LUT a la imagen de salida si 
la ampliación de enfoque se utiliza en la imagen de 
salida HDMI, excepto durante la grabación X-OCN.

 • La posición de ampliación regresa al centro de la 
pantalla cuando se apaga la unidad.

 •  Es posible aplicar una LUT a la imagen del monitor 
LCD si la ampliación de enfoque se utiliza en la 
imagen cuando se selecciona LUT Off durante la 
grabación X-OCN.

 • El vídeo con formato Log se emitirá si la ampliación 
de enfoque se utiliza en la imagen de salida HDMI 
durante la grabación X-OCN.
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Ajuste automático del enfoque 
(Auto Focus)

La unidad utiliza AF de detección de fase para 
enfoque de alta velocidad y AF de contraste 
para enfoque de alta precisión.
La combinación de estos dos métodos AF 
proporciona un enfoque automático con alta 
velocidad y alta precisión.
Para ajustar el enfoque automáticamente, 
sitúe el interruptor FOCUS (página 4) de 
la unidad en la posición “AF”. Si el objetivo 
dispone de interruptor de selección de 
enfoque, sitúe el interruptor en la posición 
“AF/MF” o “AF”. Si se ajusta el interruptor en 
la posición “Full MF” o “MF”, el enfoque del 
objetivo no se puede realizar con la unidad.

[Consejo]
Cuando Focus >AF Assist (página 43) en el menú 
Shooting del menú completo está ajustado en On, aún 
puede usar el anillo de enfoque en el objetivo durante el 
enfoque automático para ajustar el enfoque.

[Notas]
 • Se necesita un objetivo compatible con enfoque 

automático.
 • Es posible que no se obtenga precisión según las 

condiciones de disparo.
 • El enfoque no se puede ajustar de manera automática 

en un objetivo de montura PL.
 • El enfoque automático no se puede usar cuando 

De-Squeeze >Ratio (página 57) está ajustado en un 
valor distinto de Off(1.0×) en el menú Monitoring del 
menú completo.

Especificación de la posición/área de 
enfoque automático (Focus Area)

Puede establecer el área de destino para el 
enfoque automático con Focus >Focus Area 
(página 43) en el menú Shooting del menú 
completo.

Flexible Spot:
Enfoca una posición especificada en la 
imagen.
Cuando se selecciona, especifique la posición 
con el selector múltiple (página 4).
Puede volver a la posición central 
manteniendo presionado el selector múltiple.

Zone:
Busca automáticamente una posición de 
enfoque dentro de la zona especificada.
Cuando se selecciona, especifique la posición 
con el selector múltiple (página 4).
Puede volver a la posición central 
manteniendo presionado el selector múltiple.

Wide:
Busca un sujeto en un ángulo amplio de la 
imagen al enfocar. No se muestra un marco.

[Consejo]
Puede mostrar/ocultar el marco del área de enfoque 
usando Display On/Off >Focus Area Indicator 
(página 57) en el menú Monitoring del menú 
completo.

[Nota]
El marco del área de enfoque no está oculto cuando se 
usa el botón DISPLAY.

Cambio del área de enfoque 
rápidamente (Focus Setting)

También puede cambiar la posición y el 
tamaño del área de enfoque automático 
rápidamente durante la grabación asignando 
Focus Setting a un botón asignable 
(página 106).
La operación varía según el ajuste del área del 
enfoque.

Cuando Focus >Focus Area (página 43) en 
el menú Shooting del menú completo está 
ajustado en Flexible Spot o Zone
Puede cambiar la posición del área de 
enfoque pulsando un botón asignable 
asignado con Focus Setting y realizando el 
ajuste con el selector múltiple (página 4).
Puede volver a la posición central del área 
del enfoque a la vez que ajusta la posición 
presionando el selector múltiple.
Puede cambiar el tamaño del área de enfoque 
manteniendo pulsado un botón asignable 
asignado con Focus Setting.
Después de cambiar el tamaño, ajuste la 
posición del área del enfoque pulsando el 
selector múltiple.
Al finalizar, pulse el botón asignable asignado 
con Focus Setting para volver a la pantalla 
original.

Cuando Focus >Focus Area (página 43) en 
el menú Shooting del menú completo está 
ajustado en Wide
Solo puede cambiar el tamaño del área de 
enfoque manteniendo pulsado un botón 
asignable asignado con Focus Setting. 
La posición también puede cambiarse 
modificando primero el tipo a Flexible Spot o 
Zone.

[Consejo]
El marco del área de enfoque se muestra de color 
naranja cuando la modificación de la posición del área 
de enfoque es posible.

Mover el marco del área de enfoque 
mediante el funcionamiento táctil (área 
de enfoque táctil)

Puede cambiar la posición del área de 
enfoque pulsando un botón asignable 
(página 106) asignado con Focus Setting 
para cambiar la visualización del área de 
enfoque a naranja y, a continuación, moverla 
con el funcionamiento táctil.
Pulse la pantalla para mover el área de 
enfoque, con el área de enfoque centrada 
en la posición pulsada. Arrastre la pantalla 
para mover el área de enfoque a la posición 
indicada con el dedo (página 10).

[Consejo]
Puede activar/desactivar el funcionamiento táctil del 
enfoque en la pantalla de filmación mediante un botón 
asignable asignado con Focus Setting.
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Pulse cualquier posición

El área de enfoque se mueve y se centra en 
la posición pulsada.

Arrastre para mover el área de enfoque, 
indicando la posición con el dedo

[Notas]
 •  Si pulsa una posición o arrastra el área de enfoque 

hasta una posición que supere el rango de ajuste, 
el área de enfoque se ajustará al límite superior/
inferior/izquierdo/derecho del rango de ajuste.

 •  Esta función no está disponible en las siguientes 
circunstancias.
 – Cuando Touch Operation (página 63) en el menú 

Technical del menú completo está ajustado en Off
 – Cuando el área de enfoque aparece de color gris o 

no aparece

Ajuste del funcionamiento del enfoque 
automático (velocidad de transición AF, 
sensibilidad de desplazamiento del 
sujeto AF)

Velocidad de transición AF
Puede establecer la velocidad de la unidad de 
enfoque para cuando el sujeto cambia usando 
Focus >AF Transition Speed (página 43) en 
el menú Shooting del menú completo.
Cuando se configura a baja velocidad, el 
enfoque se mueve lentamente cuando el 
sujeto que se enfoca se mueve, lo que permite 
tomar imágenes impresionantes.
Cuando se configura a alta velocidad, el 
enfoque alterna entre sujetos rápidamente. El 
sujeto que entra en el encuadre se enfoca al 
instante, lo que convierte este ajuste en ideal 
para la grabación documental que requiere un 
enfoque rápido.

Durante el cambio:
1(Slow): el enfoque funciona 
lentamente.
.
.
.
7(Fast): el enfoque funciona 
rápidamente.

Centrado en un sujeto lejano

Centrado en un sujeto cercano

Sensibilidad de desplazamiento del sujeto AF
Puede establecer la sensibilidad para cambiar 
entre sujetos usando Focus >AF Subj. Shift 
Sens. (página 43) en el menú Shooting del 
menú completo.
Cuando se establece en una sensibilidad 
baja, el enfoque no cambia fácilmente incluso 
cuando otro sujeto se mueve delante del 
sujeto enfocado. Cuando se establece en una 
sensibilidad alta, el enfoque cambia para dar 
prioridad al sujeto que se mueve al frente.

[Consejo]
Si asigna AF Speed/Sens. a un botón asignable, las 
barras de nivel para el ajuste de los valores se muestran 
en el siguiente orden cada vez que se presiona el botón, 
lo que le permite cambiar los ajustes de velocidad de 
transición AF y de sensibilidad de desplazamiento del 
sujeto AF.
Velocidad de transición AF  Sensibilidad de 
desplazamiento del sujeto AF  Sin visualización…
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AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

Cambio del enfoque a otro sujeto 
lentamente

Cambio del enfoque a otro sujeto 
rápidamente

Cambio del objetivo de enfoque 
manualmente (AF Assist)

Cuando Focus >AF Assist (página 43) en 
el menú Shooting del menú completo está 
ajustado en On, aún puede usar el anillo de 
enfoque en el objetivo durante el enfoque 
automático para ajustar el enfoque en un 
sujeto.
Cuando deje de utilizar la operación de anillo 
de enfoque, el enfoque automático seguirá 
enfocando al sujeto mediante el anillo de 
enfoque (estado AF Assist).
Después de operar el anillo de enfoque, mover 
el enfoque a otro sujeto es ligeramente más 
difícil, independientemente del ajuste Focus 
>AF Subj. Shift Sens. (página 43) en el menú 
Shooting del menú completo.
El estado AF Assist se cancela en los 
siguientes casos:
 • Cuando el sujeto enfocado mediante el 

anillo de enfoque ya no es visible
 • Al cambiar al enfoque manual
 • Al iniciar el AF de seguimiento en tiempo 

real

[Consejos]
 • El estado AF Assist se puede cancelar rápidamente 

con un botón asignable (página 106) asignado con 
Push AF/Push MF.

 • El AF de seguimiento en tiempo real se detiene 
cuando se acciona el anillo de enfoque.

 • En el modo Human Only AF, el enfoque automático 
enfoca la cara más cercana a la posición de enfoque 
del anillo de enfoque.

Uso del enfoque manual de forma 
temporal (Push Manual Focus)

En modo de enfoque automático, puede 
pulsar un botón asignable (página 106) con 
la función Push AF/Push MF asignada para 
activar temporalmente el enfoque manual 
mientras el botón está pulsado.
El enfoque volverá al enfoque automático 
cuando suelte el botón.
Esto le permite detener temporalmente el 
enfoque automático y enfocar manualmente 
cuando algo que no es el sujeto de la 
filmación se cruza delante de este.
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Seguimiento utilizando la 
detección humana (Subject 
Recognition AF)

La unidad puede detectar personas como 
objetivo para seguir y ajustar el enfoque en 
los ojos, cara y cuerpo dentro del área de 
enfoque.
Esta función solo está disponible cuando 
el modo del enfoque está el modo AF o 
durante el enfoque automático mediante una 
pulsación.
Cuando se detecta una persona, se muestra 
un marco de reconocimiento del sujeto gris. 
Cuando se identifica el objetivo de enfoque 
automático, el marco se vuelve de color 
blanco y el seguimiento se inicia.
Si se reconoce un rasgo de identificación más 
preciso (como los ojos), esa parte se prioriza 
automáticamente y aparece un marco de 
reconocimiento.
Cuando se detectan varios individuos, 
se determina el individuo principal 
automáticamente.

[Consejo]
Cuando el área de enfoque está definida en Zone o 
en Flexible Spot, aparecen marcos de reconocimiento 
alrededor de partes del sujeto (cara/ojos/cabeza/
cuerpo) cuando una persona entra en el rango del área 
de enfoque configurada.

Configure el funcionamiento del AF de 
reconocimiento del sujeto mediante Focus 
>Subject Recognition AF (página 43) en el 
menú Shooting.

Human Only AF:
La cámara detecta sujetos (personas) y 
enfoca y hace un seguimiento de su cara/
ojos, cabeza y cuerpo. Si no se detecta 
ninguna cara/ojo, cabeza o cuerpo, el AF se 
detiene temporalmente y se muestra el icono 

 (AF pausado) (página 23). Este modo 
resulta eficaz cuando desea enfocar y seguir 
automáticamente únicamente las caras/ojos, 
cabezas y cuerpos.

Human Priority AF:
La cámara detecta las caras/ojos, cabezas y 
cuerpos de los sujetos (personas) y prioriza 
el enfoque/seguimiento en las caras/ojos, 
cabezas y cuerpos. Cuando no se detecta 
ninguna cara/ojo, cabeza o cuerpo, el enfoque 
está en modo AF (ajuste predeterminado).

Off:
La función de AF de reconocimiento del sujeto 
está desactivada.

[Notas]
 • Durante el funcionamiento del enfoque automático 

mediante una pulsación, se activa Human Priority AF, 
aunque se haya seleccionado Human Only AF.

 • Cuando el interruptor FOCUS se ha establecido en MF, 
se desactiva el AF de reconocimiento del sujeto (salvo 
durante el funcionamiento del enfoque automático 
mediante una pulsación).

 • Si apaga la unidad mientras Human Only AF está 
seleccionado, el modo cambiará automáticamente 
a Human Priority AF cuando vuelva a encender la 
unidad.

Ocultación de marcos de reconocimiento 
del sujeto

Puede mostrar/ocultar los marcos de 
reconocimiento del sujeto mediante 
Display On/Off >Subject Recognition Frame 
(página 57) en el menú Monitoring del 
menú completo.

Cambio del funcionamiento del AF de 
reconocimiento del sujeto con un botón 
asignable

Asigne Subject Recognition AF a un botón 
asignable (página 106). Puede cambiar el 
funcionamiento del AF de reconocimiento 
del sujeto cada vez que pulse el botón, en el 
siguiente orden: Human Priority AF, Human 
Only AF y Off.

Ajuste mediante el menú directo

También se puede ajustar el funcionamiento 
del AF de reconocimiento del sujeto mediante 
el menú directo (página 106).

Seguimiento de un sujeto 
especificado (Realtime Tracking 
AF)

Puede mantener el enfoque en un sujeto 
especificando el sujeto mediante un toque o 
seleccionado un marco de reconocimiento del 
sujeto.
Cuando se selecciona un sujeto, se muestra un 
marco de seguimiento blanco y comienza el 
seguimiento.

[Consejos]
 • El seguimiento tiene lugar en toda el área de la 

imagen, sin importar el ajuste de área de enfoque.
 • Cuando Focus >Touch Function in MF (página 43) 

en el menú Shooting se establece como Tracking 
AF, se admite el AF de seguimiento en tiempo real 
aunque el modo de enfoque sea modo MF.

Ocurren las siguientes acciones para el 
objetivo de seguimiento, dependiendo 
del modo de funcionamiento de AF de 
reconocimiento del sujeto.

Human Only AF / Human Priority AF:
Enfoca y hace un seguimiento de un sujeto 
especificado.
Si el objetivo del seguimiento es una persona 
y se detecta una cara/ojo/cabeza/cuerpo, la 
cámara enfoca esa cara/ojo/cabeza/cuerpo.

Off:
Enfoca y hace un seguimiento de un sujeto 
especificado.
No se realiza la detección de cara/ojo/cabeza/
cuerpo, aunque el objetivo de seguimiento 
sea una persona.

[Nota]
La función Realtime Tracking AF no se puede utilizar si el 
objetivo está ajustado en enfoque manual.

Inicio de AF de seguimiento en tiempo 
real

Cuando se especifica un sujeto específico 
como objetivo de seguimiento, se inicia el 
seguimiento de ese objetivo.

Especificación mediante un toque
Toque el sujeto objetivo que desea seguir en 
uno de los siguientes estados:
 • Cuando el modo de enfoque es el modo MF 

o durante el enfoque manual mediante una 
pulsación, y Focus >Touch Function in MF 
(página 43) está ajustado en Tracking AF 
en el menú Shooting

 • Cuando el modo del enfoque está el modo 
AF o durante el enfoque automático (AF) 
mediante una pulsación

[Nota]
Especificar un objetivo mediante un toque no está 
disponible cuando Touch Operation (página 63) en el 
menú Technical está ajustado en Off.
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Especificación por la selección del marco de 
reconocimiento del sujeto
Mueva el cursor de selección del sujeto 
(destacado en naranja) al sujeto que 
desea seguir usando el selector múltiple 
(página 4) y presione el selector múltiple.

Otros marcos de 
reconocimiento de 
sujeto (gris)

Marco de 
seguimiento

Cursor de selección de sujeto (naranja)

[Consejos]
 • También puede cambiar el objetivo que desea seguir 

durante el AF de seguimiento en tiempo real.
 • Si se pulsa un botón asignable (página 106) con 

la función LCD Focus Magnifier asignada durante 
el AF de seguimiento en tiempo real, el estado de 
seguimiento se mantiene y el enfoque se amplía. 
Sin embargo, no puede especificar un objetivo para 
seguir durante la ampliación del enfoque.

[Nota]
Durante el enfoque manual, no es posible iniciar el 
seguimiento mediante la selección del marco de 
reconocimiento del sujeto.

Detención de AF de seguimiento en 
tiempo real

Detención mediante un toque
Toque el botón  (detención de 
seguimiento AF en tiempo real) que se 
muestra en la parte superior izquierda del 
panel táctil.

[Consejo]
El AF se seguimiento en tiempo real se detendrá en los 
siguientes casos:

 – Cuando el interruptor FOCUS o el control AUTO/
MAN del objetivo esté cambiado

 – Cuando se cambia el modo de enfoque
 – Cuando se ejecuta la ayuda del enfoque 

automático
 – Cuando se cambia el ajuste de área de enfoque o 

la acción de AF de reconocimiento del sujeto
 – Cuando se pulsa un botón asignable con Push AF/

Push MF asignado
 – Cuando el objetivo de seguimiento no está dentro 

de la pantalla de filmación o cuando el sujeto está 
fuera del enfoque durante unos segundos

Notas sobre la filmación

 • Puede que en las siguientes situaciones 
resulte difícil enfocar al sujeto:

 • En condiciones de poca luz o 
retroiluminación

 • Cuando el sujeto se encuentra en 
sombra

 • Cuando el sujeto está muy fuera de 
enfoque

Es posible que en las siguientes situaciones 
resulte difícil enfocar a los ojos cuando la 
cámara reconoce ojos:

 • Cuando los ojos están cerrados
 • Cuando los ojos están tapados por pelo, 

etc.
 • Cuando la persona lleva anteojos (gafas 

de sol)
Hay también otras situaciones en las que 
quizás no sea posible enfocar al sujeto.

 • Cuando la cámara no puede enfocar en la 
parte que desea priorizar (por ejemplo, los 
ojos del sujeto), es posible que enfoque 
automáticamente en otras partes que 
reconozca como la cabeza o el cuerpo del 
sujeto.

 • Incluso cuando se muestra un marco de 
reconocimiento del sujeto blanco alrededor 
de la cara u otra parte del sujeto, es posible 
que la cámara enfoque automáticamente en 
la otra parte que desee priorizar, como los 
ojos del sujeto.

 • Es posible que al sujeto no se le reconozca 
cuando solo haya una parte del sujeto 
dentro del ángulo de visión.
 – Cuando solo estén visibles las manos y los 
pies de una persona o animal

 – Cuando una parte del sujeto esté oculta y 
no se pueda ver, etc.

 • Es posible que, en determinadas 
condiciones, la cámara reconozca 
accidentalmente otros objetos como el 
sujeto designado.
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Ajuste del brillo
Puede ajustar el brillo mediante la regulación 
del diafragma, la ganancia, la velocidad 
del obturador y el nivel de luz con los 
filtros ND. También puede realizar ajustes 
automáticamente.
El nivel deseado para el ajuste de brillo 
automático se establece con Auto Exposure 
>Level (página 41) en el menú Shooting del 
menú completo. También puede asignar Auto 
Exposure Level a un botón asignable o al dial 
asignable (página 106).

[Nota]
La ganancia no puede ajustarse en el modo Cine EI. 
La sensibilidad base está fija. Asimismo, el brillo no 
puede ajustarse automáticamente con la velocidad del 
obturador. Se puede ajustar automáticamente el brillo 
con el disfragma o el filtro ND.

Selección de la sensibilidad base

Puede seleccionar entre dos tipos de 
sensibilidad base en la unidad.
En el modo Cine EI, puede ajustar la ISO base 
en ISO 3200 o ISO 800 mediante ISO/Gain/EI 
>Base ISO (página 39) en el menú Shooting 
del menú completo.
Se recomienda seleccionar ISO 800 en 
condiciones de iluminación normales e 
ISO 3200 en condiciones de poca luz.
En el modo Custom, puede ajustar la 
sensibilidad base en High o Low mediante 
ISO/Gain/EI >Base Sensitivity (página 39) 
en el menú Shooting del menú completo.
Se recomienda seleccionar Low en 
condiciones de iluminación normales y High 
en condiciones de poca luz.

[Consejo]
También puede asignar Base ISO/Sensitivity a un botón 
asignable (página 106).

Ajuste del diafragma

Puede ajustar el diafragma para ajustar el 
brillo.

[Nota]
Si se acopla un objetivo con montura PL, no se admite 
el control del diafragma desde la unidad ni el control 
remoto.

Ajuste automático del diafragma

Esta función ajusta el brillo según el sujeto. 
Se necesita un objetivo compatible con 
diafragma automático.

1 Si se acopla un objetivo con interruptor 
Auto Iris, coloque el interruptor en AUTO.

2 Muestre el menú directo Auto Iris 
(página 106) y seleccione Auto.

 [Nota]
Cuando se acopla un objetivo con montura PL, 
Auto Iris se establece en Off.

 [Consejo]
También puede asignar Auto Iris a un botón 
asignable (página 106).

Ajuste manual del diafragma

1 Muestre el menú directo Auto Iris 
(página 106) y seleccione Manual.

2 Muestre el menú directo Iris 
(página 106) para que el valor del 
diafragma se muestre en un fondo blanco.

3 Gire el dial multifunción para ajustar el 
valor.

 [Consejos]
 • También puede operar el dial multifunción como 

un dial IRIS (página 106) asignando la función 
IRIS al dial multifunción.

 • También puede asignar la función IRIS a un dial 
asignable del control remoto (página 106).

 • En un objetivo con un anillo de diafragma, es 
posible realizar los ajustes manuales a través de 
dicho anillo.

Ajuste temporal de forma automática

Pulse el botón asignable (página 106) 
asignado con la función Push Auto Iris para 
ajustar automáticamente el diafragma 
mientas está pulsado el botón.
El diafragma volverá al ajuste anterior cuando 
suelte el botón.

[Notas]
 • Cuando el interruptor Auto Iris del objetivo se ajusta 

en MANUAL, las funciones Auto Iris y Push Auto Iris 
de la unidad no tendrán ningún efecto. Los ajustes 
manuales del diafragma en la unidad tampoco 
tendrán ningún efecto.

 • Push Auto Iris no se puede ejecutar cuando Iris 
>Bokeh Control (página 41) en el menú Shooting 
está ajustado en On.

Ajuste del índice de exposición

En el modo Cine EI, se presupone que la salida 
de vídeo con la LUT del monitor establecida 
en Off se graba como la señal principal. Al 
cambiar el brillo de la imagen con la LUT del 
monitor establecida en On para que coincida 
con el valor EI, puede comprobar el resultado 
del ajuste de la sensibilidad de exposición en 
la postproducción a la vez que filma.
Puede cambiar el valor de EI con ISO/Gain/
EI >Exposure Index (página 39) en el menú 
Shooting del menú completo.

[Nota]
Cuando grabe en Cine EI, es recomendable que 
mantenga el ajuste Exposure Index constante. Si 
modifica el ajuste Exposure Index, es posible que 
sea muy difícil conseguir la corrección de brillo en la 
postproducción, por lo que puede resultar imposible 
reproducir el estado en el que la imagen se filmó 
originalmente.

Ajuste de la ganancia

En el modo Custom, puede ajustar la ganancia 
para ajustar el brillo.

Ajuste automático de la ganancia

Muestre el menú directo AGC (página 106) y 
seleccione Auto.

[Consejos]
 • También puede realizar los mismos ajustes 

configurando Auto Exposure >AGC (página 41) en 
el menú Shooting en On.

 • También puede asignar AGC a un botón asignable 
(página 106).

Ajuste manual de la ganancia

Puede controlar la ganancia cuando desee 
ajustar la exposición con un ajuste de 
diafragma fijo, o bien cuando desee evitar que 
la ganancia aumente debido al AGC.

1 Muestre el menú directo AGC 
(página 106) y seleccione Manual.

2 Muestre el menú directo Gain Value 
(página 106) y establezca la ganancia.

[Consejos]
 • Puede cambiar el valor predeterminado de ganancia 

con ISO/Gain/EI >ISO/Gain (página 39) en el menú 
Shooting del menú completo.

 • También puede asignar la función Push AGC a un 
botón asignable y activar AGC de forma temporal 
manteniendo pulsado el botón.

[Nota]
Push AGC no se puede ejecutar cuando Iris >Bokeh 
Control (página 41) en el menú Shooting del menú 
completo está ajustado en On.
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Ajuste del obturador

Puede ajustar el obturador para ajustar el 
brillo.

Ajuste automático del obturador

Muestre el menú directo Auto Shutter 
(página 106) y seleccione Auto para ajustar 
la velocidad o el ángulo del obturador 
automáticamente en respuesta al brillo de la 
imagen.

[Consejo]
También puede realizar los mismos ajustes configurando 
Auto Exposure >Auto Shutter (página 42) en el menú 
Shooting del menú completo en On.

Ajuste manual del obturador

1 Muestre el menú directo Shutter Speed 
Value o Shutter Angle Value 
(página 106) para que el valor del 
obturador se muestre en un fondo blanco.

2 Gire el dial multifunción para ajustar el 
valor del obturador.

[Consejos]
 • Para ajustar el tiempo de exposición para que 

coincida con el intervalo de fotogramas, seleccione 
Off en el paso 1.

 • También puede ajustar el ángulo y la frecuencia 
(página 40).

Ajuste del nivel de luz (filtro ND)

En condiciones donde la luz es demasiado 
fuerte, puede ajustar el brillo adecuado si 
cambia el filtro ND.
La unidad posee dos modos de filtro ND. 
Puede alternar entre los dos modos con el 
interruptor ND STEP/VARIABLE.

LOCK

MFAF

ND STEP ND VARIABLE

FULL MENU

ND ON

1 2

3

CLEAR

DISP

MENU

BACK

REC

B

C

A

Ajuste en el modo Step

Ajuste el interruptor ND STEP/VARIABLE (A) 
a la posición STEP y ajuste el filtro en uno de 
los siguientes ajustes con los botones arriba/
abajo de ND FILTER POSITION (B).
Puede definir el modo de visualización 
utilizado para expresar la transmitancia de 
luz a través del filtro ND mediante ND Filter 
>Display Mode (página 40) en el menú 
Shooting del menú completo.  
 •  Cuando se establece en Optical Density: 

Clear (sin filtro ND), 0.6, 0.9, 1.2, 1.5, 1.8 o 2.1.
 • Cuando se establece en Transmittance: 

Clear (sin filtro ND), 1/4, 1/8, 1/16, 1/32, 1/64 
o 1/128.

Ajuste en el modo variable

Ajuste el interruptor ND STEP/VARIABLE (A) 
en la posición VARIABLE. Cambie el filtro entre 
CLEAR y ON a través de los botones arriba/
abajo de ND FILTER POSITION (B).

Ajuste automático del nivel de luz
Puede activar Auto ND Filter para habilitar el 
ajuste de exposición automática con el filtro 
ND.

1 Presione el botón [+] de los botones 
subir/bajar ND FILTER POSITION (B) para 
activar la operación del filtro ND.

2 Muestre el menú directo Auto ND Filter 
(página 106) y seleccione Auto.

Ajuste manual del nivel de luz

1 Presione el botón [+] de los botones 
subir/bajar ND FILTER POSITION (B) para 
activar la operación del filtro ND.

2 Muestre el menú directo Auto ND Filter 
(página 106) y seleccione Manual.

3 Gire el dial ND VARIABLE (C) para ajustar la 
transmitancia del filtro.

[Consejo]
También puede asignar la función ND Filter a un dial 
asignable (página 106).

Ajuste temporal de forma automática
Puede asignar la función Push Auto ND a un 
botón asignable (página 106) y activar Auto 
ND Filter de forma temporal manteniendo 
pulsado el botón. Al soltar el botón, se vuelve 
a desactivar la función Auto ND Filter.
Presione el botón [+] de los botones subir/
bajar ND FILTER POSITION (B) para activar la 
operación del filtro ND.

[Notas]
 • La modificación del ajuste Display Mode puede 

cambiar la densidad actual del filtro ND.
 • Cuando el filtro ND se cambia a través de CLEAR 

durante el disparo, el marco del filtro ND se muestra, 
es posible que aparezca en la imagen un reflejo 
de la luz del sensor de detección morada y que el 
sonido de funcionamiento se incluya en el audio. La 
luz del sensor y los sonidos de funcionamiento no 
se reflejarán en el vídeo cuando el cambio se haya 
completado.

 •  Push Auto ND no se puede ejecutar cuando Iris 
>Bokeh Control (página 41) en el menú Shooting 
está ajustado en On.

[Consejos]
 • Puede establecer el filtro en CLEAR girando el dial ND 

VARIABLE (C) hacia abajo desde ND 0.6. Si gira el dial 
hacia arriba desde CLEAR, se establece ND 0.6. Puede 
deshabilitar esta acción usando ND Dial >CLEAR with 
Dial (página 63) en el menú Technical del menú 
completo.

 • También puede asignar ND Filter Position a un botón 
asignable (página 106) y pulsar el botón en lugar 
de utilizar los botones arriba/abajo de ND FILTER 
POSITION para cambiar el ajuste.  
Modo Step: Clear  0.6  0.9  …  Clear… 
Modo Variable: Clear  On  Clear…

 • También puede asignar la función Auto ND Filter a un 
botón asignable (página 106) y pulsar el botón para 
activar y desactivar Auto ND Filter.

 • Cuando se filma un sujeto con mucha luz, un cierre 
excesivo del diafragma puede causar borrosidad 
por difracción, lo que hace que la imagen empiece a 
desenfocarse (un fenómeno habitual en las cámaras 
de vídeo). Puede suprimir este efecto para obtener 
mejores resultados en la filmación con el filtro ND.
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Ajuste de colores naturales (balance de blancos)
Puede seleccionar el modo de ajuste que 
mejor se adapte a las condiciones de 
filmación.

ATW (localización automática del 
balance de blancos)

Esta función ajusta el balance de blancos 
automáticamente en el nivel adecuado.
El balance de blancos se ajusta 
automáticamente cuando la temperatura de 
color de la fuente de luz cambia.
Muestre el menú directo del balance de 
blancos (página 106) y establezca ATW en 
On.
Puede seleccionar la velocidad de ajuste 
(cinco pasos) mediante White Setting >ATW 
Speed (página 43) en el menú Shooting del 
menú completo.

[Consejos]
 •  También puede establecer White >ATW (página 42) 

en On en el menú Shooting del menú completo o 
mediante un botón asignable (página 106) con la 
función ATW asignada.

 • Puede congelar el ajuste del balance de blancos 
actual si asigna la función ATW Hold a un botón 
asignable (página 106) y pulsa el botón asignable 
para pausar temporalmente el modo ATW.

[Notas]
 • ATW no se puede utilizar en el modo Cine EI.
 • Tal vez no sea posible ajustar el color adecuado con 

ATW, según las condiciones de iluminación y del 
sujeto.  
Ejemplos:
 – Cuando un único color domina el sujeto, como por 

ejemplo el cielo, el mar, la tierra o las flores.
 – Cuando el sujeto está iluminado por una fuente de 

luz cuya temperatura del color es extremadamente 
alta o extremadamente baja.

 Si no se puede obtener el efecto adecuado porque 
la velocidad de corrección automática de ATW es 
demasiado lenta o por cualquier otro motivo, utilice el 
balance automático de blancos.

Ajuste manual del balance de 
blancos

Cuando ATW On esté seleccionada: 
Seleccione el icono  en el menú 
directo (página 106) y seleccione W:A, 
W:B o W:C.

Cuando ATW Off esté seleccionada: 
Seleccione W:A, W:B o W:C en el menú 
directo.

 • W:A: posición de memoria A
 • W:B: posición de memoria B
 • W:C: posición de memoria C

Seleccione la posición memoria A/B/C en la 
pantalla Home (página 26).

[Consejo]
También puede seleccionar la memoria a través de 
White >White Select (página 42) en el menú Shooting 
del menú completo.

Puede definir cada posición de memoria a 
través de los siguientes métodos.
 • Cambio del valor preestablecido 

predeterminado
 • Cambio de la temperatura del color y del 

tinte
 • Utilización del balance automático de 

blancos

Cambio del valor preestablecido 
predeterminado

Cuando seleccione W:A, W:B o W:C en el 
menú directo (página 106), se muestra lo 
siguiente.
Cine EI:
5500K±00
4300K±00
3200K±00
Custom:
6300K±00
5600K±00
4300K±00
3200K±00

La selección de un valor actualiza el ajuste 
para la posición de memoria actual.

Cambio de la temperatura del color

1 Muestre el menú directo Color Temp. o 
Tint (página 106) para que se muestre 
en un fondo blanco.

2 Gire el dial multifunción para ajustar el 
valor.

[Consejo]
También puede establecer la temperatura de color en 
la pantalla Home (página 26) o utilizar White >Color 
Temp, Tint, R-Gain, y B-Gain (página 42) en el menú 
Shooting del menú completo.

Utilización del balance automático de 
blancos

El balance de blancos que se guardará en 
la posición de memoria A/B/C se configura 
automáticamente.

1 Seleccione la posición de memoria A,  
B o C.

2 Coloque un papel blanco (u otro objeto) 
en un lugar con la misma fuente de 
iluminación y condiciones que el sujeto y, 
a continuación, utilice el zoom para 
acercarse al papel y así mostrar blanco en 
la pantalla.

3 Ajuste el brillo.
Ajuste el diafragma con el procedimiento 
descrito en “Ajuste manual del diafragma” 
(página 100).

4 Seleccione W:A, W:B o W:C en el menú 
directo y, a continuación, seleccione AWB.
 • El resultado del ajuste de balance 

de blancos automático se guarda 
en la posición de memoria (A, B o C) 
seleccionada en el paso 1.

 • Si el balance automático de blancos se 
ejecuta en el modo ATW, el resultado se 
hereda y se reanuda ATW al finalizar el 
ajuste automático. Esto es útil cuando 
desea ajustar el balance de blancos 
muy rápidamente, independientemente 
del ajuste de ATW Speed.

[Consejo]
También puede ejecutar el balance de blancos 
automático desde la pantalla Home (página 26), con 
White >Auto White Balance (página 42) en el menú 
Shooting del menú completo o a través de un botón 
asignable (página 106) con la función Auto White 
Balance asignada.

[Nota]
Si el ajuste no se realiza correctamente, aparecerá 
un mensaje de error en la pantalla durante unos tres 
segundos. Si el mensaje de error continúa después 
de varios intentos repetidos de ajuste del balance 
de blancos, póngase en contacto con su servicio de 
asistencia técnica de Sony.
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Uso de la estabilización de la imagen
Puede activar la estabilización de la imagen 
para suprimir la borrosidad en la misma 
provocada por el movimiento de la mano 
durante la filmación.
También puede realizar la estabilización de 
la imagen de manera automática o manual, 
según el objetivo acoplado.

[Nota]
La estabilización de la imagen no se puede usar cuando 
De-Squeeze >Ratio (página 57) está ajustado en 1.3× 
o 2.0× en el menú Monitoring.

Activación de la estabilización de 
la imagen

Los elementos de configuración variarán en 
función de si se ha acoplado un adaptador de 
montura PL.

Cuando un adaptador de montura PL 
está acoplado

Defina Image Stabilization >PL Stabilization 
(página 45) en High o Low en el menú 
Shooting del menú completo.
 • Low: efectúa la estabilización de la imagen 

cuando se filma vídeo en condiciones 
relativamente estables.

 • High: efectúa una estabilización de imagen 
mejorada en comparación con la opción 
Low.

Para filmar sin utilizar la función de 
estabilización de la imagen, defina PL 
Stabilization en Off. En este caso, se 
recomienda el uso de un trípode.

Cuando un adaptador de montura PL no 
está acoplado

Defina Image Stabilization >SteadyShot 
(página 45) en Active o Standard en el 
menú Shooting del menú completo.
 • Standard: efectúa la estabilización de 

la imagen cuando se filma vídeo en 
condiciones relativamente estables.

 • Active: efectúa una estabilización de 
imagen mejorada en comparación con la 
opción Standard.

Para filmar sin utilizar la función de 
estabilización de la imagen, defina SteadyShot 
en Off. En este caso, se recomienda el uso de 
un trípode.

[Notas]
 • Puede establecer la estabilización de la imagen en 

Active (o High) cuando Rec Format >Imager Scan 
Mode (página 46) en el menú Project del menú 
completo se encuentra en S35 5.8K 17:9 o S35 5.8K 
16:9.

 • Active (o High) no se pueden ajustar en los casos 
siguientes.
 – Cuando Rec Format >Codec (página 46) está 

configurado en X-OCN en el menú Project
 – Cuando S&Q Motion >Setting (página 44) está 

ajustado en On en el menú Shooting

Ajuste automático de la distancia 
focal

La distancia focal para la estabilización de la 
imagen se establece de manera automática en 
base a la información obtenida del objetivo.
Para establecer automáticamente la distancia 
focal para la estabilización de la imagen, 
defina Image Stabilization >Stabilization 
Adjustment (página 45) en Auto en el menú 
Shooting del menú completo.

Ajuste manual de la distancia focal

Puede establecer manualmente la distancia 
focal para la estabilización de la imagen.
Para establecer manualmente la distancia 
focal para la estabilización de la imagen, 
defina Image Stabilization >Stabilization 
Adjustment (página 45) en Manual en 
el menú Shooting del menú completo y 
establezca la distancia focal.
Establezca la distancia focal a través de Image 
Stabilization >Focal Length (página 45) en 
el menú Shooting del menú completo. Puede 
establecer una distancia focal en el rango de 
8 mm a 1000 mm.
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Especificación del audio que se va a grabar
Puede especificar el audio que se va a grabar 
con los conectores de entrada, interruptores y 
diales de la unidad.

Interruptores de selección y conectores 
de entrada de audio externa

Conector INPUT 1 (página 5)
Conector INPUT 2 (página 5)
Zapata de interfaces múltiples (cuando el asa 
opcional con zapata MI está acoplada)
Interruptor INPUT 1 (LINE/MIC/MIC+48V) 
(página 5)
Interruptor INPUT 2 (LINE/MIC/MIC+48V) 
(página 5)

Interruptores para ajustar el nivel de 
audio

Interruptor CH1 (AUTO/MAN) (página 4)
Interruptor CH2 (AUTO/MAN) (página 4)
Dial AUDIO LEVEL (CH1) (página 4)
Dial AUDIO LEVEL (CH2) (página 4)

Pantalla de estado Audio

Selección del dispositivo de 
entrada de audio

1 Configure la entrada de audio con CH1/
CH2/CH3/CH4 >Source (página 30) en 
la pantalla de estado Audio o con Audio 
Input >CH1 Input Select en CH4 Input 
Select (página 60) en el menú Audio 
del menú completo.

 [Notas]
 • En los modos Interval Rec y Slow & Quick Motion 

no se graba audio.
 • La unidad tiene un micrófono de narración 

integrado para grabar sonido ambiental. Se 
puede usar para realizar la sincronización con 
otros equipos. En tales casos, especifique 
Internal MIC.

 • Cuando CH1 Input Select y CH2 Input Select 
están ajustados en Internal MIC, el nivel de 
grabación de audio de CH1 y CH2 se ajusta con 
el dial AUDIO LEVEL (CH1) (página 4). Cuando 
CH3 Input Select y CH4 Input Select están 
ajustados en Internal MIC, el nivel de grabación 
de audio de CH3 y CH4 se ajusta con CH3 Input 
Level (página 60).

2 Seleccione la fuente de entrada de audio.
Ajuste los interruptores INPUT 1/INPUT 2 
(LINE/MIC/MIC+48V) de acuerdo con los 
dispositivos conectados a los conectores 
INPUT 1/INPUT 2 respectivamente.

Dispositivo conectado Posición del 
interruptor

Fuente externa de audio 
(por ejemplo, mezclador)

LINE

Micrófono dinámico, 
micrófono con batería

MIC

Micrófono con 
alimentación fantasma de 
+48 V

MIC+48V

 • Si selecciona MIC+48V y conecta un 
micrófono que no sea compatible con 
fuentes de +48 V, es posible que dañe 
el dispositivo conectado. Compruebe el 
ajuste antes de conectar el dispositivo.

 • Si le preocupa el ruido en conectores 
que no tengan un dispositivo 
conectado, ajuste los interruptores 
INPUT1/INPUT2 (LINE/MIC/MIC+48V) 
correspondientes en LINE.

Ajuste automático del nivel de 
grabación de audio

Ajuste los interruptores CH1/CH2 (AUTO/
MAN) para que los canales se ajusten 
automáticamente en AUTO.
Para CH3/CH4, ajuste el control del nivel 
de audio en la pantalla de estado Audio 
(página 30), o bien ajuste Audio Input 
>CH3 Level Control y CH4 Level Control en 
el menú Audio del menú completo en Auto 
(página 60).

Ajuste manual del nivel de 
grabación de audio

Utilice el siguiente procedimiento para ajustar 
el nivel de grabación de audio de CH1/CH2.

1 Ajuste los interruptores CH1/CH2 (AUTO/
MAN) para que los canales se ajusten 
automáticamente en MAN.

2 Durante la filmación o en espera, gire los 
diales AUDIO LEVEL (CH1)/(CH2) hasta los 
canales correspondientes para ajustar el 
nivel de audio.
 • Para CH3/CH4, ajuste el control del nivel 

de audio con CH3/CH4 (página 30) 
en la pantalla de estado Audio, o bien 
con Audio Input >CH3 Level Control o 
CH4 Level Control en el menú Audio 
del menú completo, en Manual y, 
a continuación, ajuste el nivel de 
grabación de audio con CH3 Input Level 
o CH4 Input Level.

 • Puede ajustar los niveles de CH1 a CH4 
como grupo. Puede ajustar el nivel de 
grabación usando un dial asignable 
(página 106) asignado con la función 
Audio Input Level, la pantalla de estado 
Audio o Audio Input >Audio Input Level 
en el menú Audio del menú completo.

[Consejo]
La pantalla de estado Audio resulta cómoda para 
comprobar el nivel de entrada de audio (página 30).

[Notas]
 • Es posible que los ajustes de Audio Input Level 

estén desactivados, en función de la combinación 
de ajustes del menú Audio. Para obtener más 
información, consulte el diagrama en la página 137.

 • La unidad admite combinaciones de diferentes 
ajustes. Para obtener más información, consulte el 
diagrama en la página 137.
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Adición de conectores de entrada 
de audio

Puede conectar a la unidad hasta cuatro 
canales de los dispositivos de audio XLR al 
mismo tiempo si acopla un asa (opcional) 
equipada con una zapata MI y un adaptador 
XLR K3M-XLR (opcional).
Conecte el adaptador XLR a la zapata de 
interfaces múltiples de un asa (opcional) 
equipada con una zapata MI y ajuste CH3 
>Source en Shoe CH1 y CH4 >Source en 
Shoe CH2 en la pantalla de estado Audio 
(página 30). También puede ajustar Audio 
Input >CH3 Input Select en CH1 y CH4 Input 
Select en Show CH2 en el menú Audio del 
menú completo.
Las funciones de la unidad que se solapen se 
desactivarán para los canales en los que el 
adaptador de XLR se haya seleccionado como 
la entrada. Utilice los interruptores y los diales 
del adaptador de XLR para realizar los ajustes.

[Notas]
 • La unidad admite la interfaz de audio digital de 2 

canales del XLR-K3M.
 • Si Audio Input >CH3 Level y CH4 Level se han 

establecido en Audio Input Level en el menú Audio, el 
Audio Input Level de la unidad se multiplicará por el 
nivel que se haya ajustado en el adaptador de XLR.  
Audio Input Level también se habilita cuando el dial 
del adaptador de XLR está ajustado en AUTO.  
Cuando se especifique “Through”, el audio se grabará 
en el nivel que se haya ajustado con el adaptador de 
XLR (página 138).
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Funciones útiles

Funcionamiento del menú directo

Cuando la pantalla de filmación se muestra en 
el monitor LCD, puede verificar el estado de la 
unidad y seleccionar y cambiar directamente 
la configuración que se muestra en la pantalla.
Estos son los elementos que pueden 
configurarse.
 • Auto Focus Mode
 • Steady Shot
 • Auto Exposure Mode
 • Auto Exposure Level
 • ND Filter Position
 • Auto ND Filter
 • ND Filter Value
 • Auto Iris
 • Iris Value
 • AGC
 • Gain Value
 • ISO Value
 • EI Gain
 • Base ISO/Sensitivity
 • ECS
 • Auto Shutter
 • Shutter Speed Value
 • Shutter Angle Value
 • ATW
 • Auto White Balance
 • Color Temp.
 • Tint
 • Preset White Select
 • Scene File
 • S&Q Motion Frame Rate

1 Presione el dial multifunción o un botón 
asignable asignado con la función Direct 
Menu.
Solo los elementos en la pantalla que se 
pueden configurar con el menú directo se 
pueden seleccionar con el cursor naranja.

2 Gire el dial multifunción para mover el 
cursor hasta el elemento del menú que se 
desea ajustar y, a continuación, pulse el 
dial multifunción.
Se muestra un menú o el elemento sobre 
un fondo blanco.

3 Gire el dial multifunción para seleccionar 
un ajuste y, a continuación, pulse el dial 
multifunción.
El menú o el fondo blanco desaparece y 
se muestra el nuevo ajuste con un cursor 
naranja.
Pulse de nuevo el botón asignable al que 
se ha asignado Direct Menu o espere 3 
segundos sin realizar ninguna acción para 
cerrar el menú directo.

 [Consejos]
 • Los ajustes directos también se pueden 

configurar manteniendo presionado cada uno 
de los botones de función.

 • Cuando los elementos se muestran sobre un 
fondo blanco, el dial multifunción se puede usar 
como un dial asignable.

 • El selector múltiple (página 4) también se 
puede utilizar para operaciones de selección.

Botones/diales asignables

La unidad posee los botones asignables 
ASSIGN del 1 al 3 y ASSIGN del 7 al 11  
(página 5, 5, 6, 9) a los que es 
posible asignar funciones.
También puede asignar funciones al dial 
multifunción (página 4) de la unidad y 
al dial asignable del control remoto de la 
empuñadura (opcional). Los botones ASSIGN 
del 4 al 6 se encuentran en el control remoto 
de la empuñadura (opcional) o RM-30BP 
(opcional).

Cambio de función de los botones

Utilice Assignable Button (página 49) en el 
menú Project del menú completo.
Puede visualizar las funciones asignadas 
en la pantalla de estado Assignable Button 
(página 31).

Las funciones se asignan a cada botón 
asignable de manera predeterminada de 
fábrica
Botón 1 Off
Botón 2 Off
Botón 3 Off
Botón 4 LCD Focus Magnifier
Botón 5 Direct Menu
Botón 6 Off
Botón 7 Off
Botón 8 Off
Botón 9 Off
Botón 10 Off
Botón 11 Off
Botón Focus Hold Focus Hold

Funciones asignables a botones
 • Off
 • Base ISO/Sensitivity
 • AGC
 • Push AGC
 • ND Filter Position
 • Auto ND Filter
 • Push Auto ND
 • Iris (botón de función)
 • Auto Iris
 • Push Auto Iris
 • Bokeh Control
 • Auto Shutter
 • Auto Exposure Level
 • Backlight
 • Spotlight
 • Auto White Balance
 • ATW
 • ATW Hold
 • AF Speed/Sens.

 • Focus Setting
 • Subject Recognition AF
 • Push AF/Push MF
 • Focus Hold
 • LCD Focus Magnifier
 • Output Focus Magnifier
 • S&Q Motion
 • LUT On/Off
 • LUT On/Off
 • Image Stabilization
 • Crop Select
 • Rec
 • Picture Cache Rec
 • Rec Review
 • Clip Flag OK
 • Clip Flag NG
 • Clip Flag Keep
 • Color Bars
 • DURATION/TC/U-BIT
 • Display
 • Lens Info
 • Video Signal Monitor
 • Marker
 • LCD Monitor Adjust
 • LCD Monitor Mode
 • Gamma Display Assist
 • Peaking
 • Zebra
 • Volume
 • Clips
 • Touch Operation
 • Handle Zoom
 • Auto Upload (Proxy)
 • Direct Menu
 • User Menu
 • Menu
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Cambio de función de los diales

También puede cambiar la función al dial 
multifunción de la unidad y al dial asignable 
del control remoto de la empuñadura 
(opcional).

Para el dial multifunción, ajuste usando Multi 
Function Dial (página 51) >Default Function 
en el menú Project.
Iris se asigna de manera predeterminada de 
fábrica.

Funciones asignables al dial multifunción
 • Off
 • ISO/Gain/EI
 • IRIS
 • Auto Exposure Level
 • Audio Input Level

[Nota]
El ajuste se desactiva mientras se muestra el menú.

Para el dial asignable, ajuste usando 
Assignable Dial (página 51) en el menú 
Project del menú completo.
En la configuración predeterminada de fábrica, 
IRIS está asignado a todas las funciones.

[Consejo]
El dial asignable de la unidad RM-30BP (opcional) sigue 
la configuración Grip/Remote Dial.

Funciones asignables al dial asignable
 • Off
 • ISO/Gain/EI
 • ND Filter
 • IRIS
 • Auto Exposure Level
 • Audio Input Level
 • Multi Function Dial

Puede visualizar las funciones asignadas 
en la pantalla de estado Assignable Button 
(página 31).

Movimiento a cámara lenta y 
rápida

Cuando Rec Format >Imager Scan Mode 
(página 46) en el menú Project del menú 
completo se ajusta en los siguientes valores, 
puede especificar valores diferentes para la 
velocidad de fotogramas de filmación y la 
velocidad de fotogramas de reproducción.

Modo de escaneado 
de la cámara

Velocidad de fotograma

FF 8.6K 17:9 1–30

FF 8.6K 16:9

FFc 6K 17:9 1–60

FFc 6K 16:9

S35 5.8K 17:9

S35 5.8K 16:9

S35c 4K 17:9 1–60, 100, 120

Puede activar/desactivar el modo Slow & 
Quick Motion presionando un botón asignable 
(página 106) asignado con la función S&Q 
Motion.
Puede establecer la velocidad de fotogramas 
para la grabación manteniendo presionado el 
botón.

[Consejo]
También puede configurar el modo mediante Rec 
Function en la pantalla de estado Project y S&Q Motion 
en el menú Shooting del menú completo.

[Notas]
 • La función Slow & Quick Motion no se puede ajustar 

durante la grabación, la reproducción ni durante la 
visualización de la pantalla de clips.

 • La grabación automática no es compatible con el 
modo Slow & Quick Motion.

 • Las funciones de diafragma automático y obturador 
automático se desactivan en el modo Slow & Quick 
Motion.

 • Para determinados objetivos, puede que haya 
un límite superior en la velocidad de fotogramas 
en función de la combinación con el formato de 
grabación.

 • El enfoque automático tiene las siguiente limitaciones 
en el modo Slow & Quick Motion.
 – Limitaciones derivadas del modelo del objetivo, 

la frecuencia del sistema y la velocidad de 
fotogramas de filmación

Objetivo 
Sony

Frecuencia del 
sistema

Disponibilidad 
de AF

SEL16F28 59.94/29.97/ 
23.98

30, 60, 120, 240 
fps admitidos

50.00/25.00 25, 50, 100, 200 
fps admitidos

24.00 No admitido

Grabación de vídeo de manera 
intermitente (Interval Rec)

La función Interval Rec de la unidad le permite 
capturar vídeos time-lapse en la memoria 
interna de la unidad. Esta función es una 
manera efectiva de filmar sujetos que se 
mueven lentamente.
Al iniciar la grabación, la unidad graba 
automáticamente un número especificado 
de fotogramas en un intervalo de tiempo 
especificado.

Intervalo de filmación (Interval Time)

Número de fotogramas en una toma
(Number of Frames)

Cuando Interval Rec está activado, la luz de 
vídeo del HVL-LBPC (opcional) se enciende 
automáticamente antes de que comience la 
grabación, lo que le permite grabar imágenes 
con una iluminación y unas condiciones de 
temperatura de color estables (función de 
preiluminación).

[Notas]
 • Solo se puede utilizar una función de grabación 

especial al mismo tiempo, como la grabación Interval 
Rec.

 • Si se activa otro modo de grabación especial mientras 
se está utilizando Interval Rec, se desactivará 
automáticamente Interval Rec.

 • El modo Interval Rec se desactiva automáticamente 
después de cambiar los ajustes del sistema, como el 
formato de vídeo.

 • No se pueden cambiar los ajustes de Interval Rec 
durante la grabación o la reproducción, ni cuando se 
muestre la pantalla de clips.
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Para ajustar Interval Rec

Seleccione Rec Function >Interval Rec en la 
pantalla de estado Project y configure los 
ajustes Number of Frames y Interval Time.
Si utiliza la luz de vídeo del HVL-LBPC 
(opcional), ajuste el intervalo de tiempo 
para encender la luz de vídeo antes de que 
comience la grabación en Interval Rec >Pre-
Lighting en el menú Project, si es necesario.

[Consejo]
También puede configurar el modo mediante Interval 
Rec (página 48) en el menú Project del menú 
completo.

[Notas]
 • Es necesaria un asa (opcional) equipada con una 

zapata MI para utilizar una luz HVL-LBPC.
 • Si desea encender la luz de vídeo antes de que 

comience la grabación, ajuste el interruptor de la luz 
de vídeo en AUTO. La luz de vídeo se enciende y se 
apaga automáticamente en función del ajuste de 
Video Light Set (página 65) en el menú Technical.

 • Si enciende la luz de vídeo, esta siempre estará 
iluminada (la luz de vídeo no se encenderá/apagará 
automáticamente).

 • Si la luz de vídeo está configurada para que se 
apague durante un período de 5 segundos o menos, 
la luz de vídeo no se apagará.

La unidad sale del modo Interval Rec cuando 
se apaga, pero se mantienen los ajustes 
de Number of Frames, Interval Time y Pre-
Lighting. No es necesario volver a ajustarlos la 
próxima vez que filme en el modo Interval Rec.

Para filmar utilizando Interval Rec

Pulse el botón REC (inicio/parada de 
grabación) para comenzar a grabar. “Int Rec” 
y “Int Stby” aparecen de manera alterna en 
el monitor LCD.
Si está utilizando la función de preiluminación, 
la luz de vídeo se enciende antes de que 
comience la grabación.

Para detener la filmación

Detenga la grabación.
Cuando la filmación finalice, los datos de 
vídeo almacenados en la memoria hasta ese 
punto se graban en el soporte.

Para salir del modo Interval Rec

Realice una de las siguientes acciones.
 • Apague la unidad.
 • En el modo de espera de grabación, ajuste 

Rec Function en una opción distinta de 
Interval Rec en la pantalla de estado Project.

Asimismo, el modo Interval Rec se desactivará 
automáticamente cuando se reinicie la unidad.

Limitaciones durante la grabación

 • No se graba el audio.
 • No es posible revisar la grabación (Rec 

Review).

Si la unidad se apaga durante la 
grabación

 • Si el interruptor de alimentación de la 
unidad está ajustado en la posición Off, se 
accede al soporte durante varios segundos 
para grabar las imágenes almacenadas 
en la memoria hasta ese momento y, a 
continuación, la alimentación se apaga 
automáticamente.

 • Si la unidad deja de recibir alimentación 
porque se ha extraído la batería, se ha 
desconectado el cable de alimentación 
de CC o se ha apagado la alimentación 
desde el adaptador de CA, es posible que 
se pierdan los datos de audio y de vídeo 
filmados hasta ese punto (10 segundos 
como máximo). Se debe tener cuidado al 
cambiar la batería.

Grabación de imágenes en 
memoria intermedia (Picture 
Cache Rec)

La función Picture Cache Rec le permite 
capturar vídeo de forma retroactiva cuando 
empieza a grabar manteniendo una memoria 
intermedia interna de imágenes de una 
duración específica durante la filmación.
Ajuste Picture Cache Rec en On en la pantalla 
de estado Project y establezca el tamaño de la 
memoria intermedia.

Ajuste de Cache 
Size

Tiempo en la memoria 
intermedia (aproximado)

Short 5 segundos

Medium 10 segundos

Long 20 segundos

Max Valor máximo o cada 
formato de grabación

[Consejos]
 • El tiempo en la memoria intermedia puede ser 

inferior, dependiendo del formato de velocidad de 
fotogramas de disparo y grabación. Compruebe 
la visualización en la parte inferior derecha de la 
pantalla de configuración del tamaño de la memoria 
intermedia.

 • También puede configurar el modo mediante Picture 
Cache Rec (página 48) en el menú Project del 
menú completo.

 • También puede activar o desactivar Picture Cache Rec 
mediante un botón asignable (página 106).

[Notas]
 • Picture Cache Rec no se puede utilizar en 

combinación con Interval Rec, la grabación 
simultánea en 2 ranuras o la grabación de proxy. 
Cuando Picture Cache Rec está en On, estas otras 
funciones se apagan de forma forzosa.

 • El modo Picture Cache Rec no se puede seleccionar 
mientras se graba o cuando Rec Review está en 
proceso.

 • Cuando Picture Cache Rec está activado, el código de 
tiempo se grabará en el modo Free Run aunque esté 
ajustado en Regen o Rec Run (página 55).

 • Es posible que el ajuste de Output Format no se 
pueda configurar en el modo Picture Cache Rec. Si 
esto sucede, ajuste temporalmente Picture Cache Rec 
en Off y, a continuación, cambie el ajuste.

Inicio de Picture Cache Rec

Cuando Picture Cache Rec está en On, 
“Cache” aparece en el monitor LCD.
Cuando pulsa el botón REC (inicio/parada 
de grabación), la grabación comienza y el 
vídeo se graba en las tarjetas de memoria a 
partir del vídeo almacenado en la memoria 
intermedia.

Para salir de Picture Cache Rec

Desactive el ajuste Picture Cache Rec en la 
pantalla de estado Project o pulse un botón 
asignable que tenga asignada la función 
Picture Cache Rec.

[Notas]
 • El cambio del formato de grabación o el aspecto 

básico borra el vídeo de la memoria intermedia 
almacenado hasta ese punto y comienza a almacenar 
vídeo nuevo. En consecuencia, la grabación de 
memoria intermedia de imágenes no es posible antes 
de cambiar el formato, aunque empiece a grabar 
inmediatamente después de cambiar el formato.

 • Si Picture Cache Rec se activa/desactiva 
inmediatamente después de insertar una tarjeta de 
memoria, los datos de la memoria intermedia pueden 
no grabarse en la tarjeta.

 • El vídeo se almacena en la memoria intermedia 
cuando la función Picture Cache Rec está activada. No 
se almacena en la memoria media el vídeo anterior a 
la activación de la función.

 • El vídeo no se almacena en la memoria intermedia 
durante el acceso a una tarjeta de memoria, como 
durante la reproducción, Rec Review o la visualización 
de la pantalla de clips. Durante ese intervalo, la 
grabación de memoria intermedia de imágenes de 
vídeo no es posible.
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Grabación en la tarjetas de 
memoria A y B simultáneamente 
(2-slot Simul Rec)

Puede grabar simultáneamente en las tarjetas 
de memoria A y B ajustando Simul Rec 
(página 30) en la pantalla de estado Project 
o Simul Rec >Setting (página 47) en el 
menú Project del menú completo en On.

Monitor de señal de vídeo

Puede establecer el tipo de señal de vídeo que 
desea visualizar en el monitor LCD en forma 
de onda, vectorscopio o histograma mediante 
Display On/Off >Video Signal Monitor 
(página 58) en el menú Monitoring.
La línea naranja indica el valor establecido del 
nivel de cebra.
También puede asignar la función Video 
Signal Monitor a un botón asignable 
(página 106).

Visualización del destino del monitor

En el modo Cine EI, la configuración de 
la gama de colores (página 86) o la 
información de configuración de la LUT del 
monitor (página 44) se muestra en la parte 
superior derecha del monitor de señal de 
vídeo para indicar el destino del monitor.

Look

Función Gamma Display Assist

En el modo Custom (página 86) cuando 
Target Display esté configurada en HDR(HLG), 
podrá establecer Gamma Display Assist* en la 
pantalla de estado Monitoring en On para ver 
una pantalla asistida en el visor que facilite el 
disparo en HDR.
* También puede configurar la función mediante 

Gamma Display Assist >Ajustando (página 59) en 
el menú Monitoring del menú completo.

Breathing Compensation

Puede ajustar si desea realizar la Breathing 
Compensation de un objetivo con montura 
E mediante Lens >Breathing Compensation 
(página 65) en el menú Technical del menú 
completo.
Esta función corrige el fenómeno en el que 
se producen cambios en el ángulo de visión 
a medida que va variando la posición del 
enfoque.
Al ejecutar Breathing Compensation, se 
recorta electrónicamente una parte de la 
imagen para mantener un ángulo constante 
de visión para que el fenómeno de Breathing 
no aparezca.

[Notas]
 • Al activar Breathing Compensation, es posible que el 

ángulo de visión y la calidad de la imagen cambien 
ligeramente.

 • En función del objetivo, puede que no sea posible 
corregir el cambio del ángulo de visión al activar 
Breathing Compensation.

 • La compensación no es posible cuando se coloca un 
objetivo que no admite Breathing Compensation.

 • Esta función está ajustada en Off (fija) en las 
siguientes circunstancias.
 – Cuando Lens >Distortion Comp. del menú Technical 

está ajustado en Off
 – Cuando S&Q Motion >Setting en el menú Shooting 

está On

 – Cuando Rec Format >Imager Scan Mode 
(página 46) en el menú Project no está 
establecido en S35 5.8K 17:9/S35 5.8K 16:9.

 – Cuando Rec Format >Codec (página 46) en el 
menú Project está establecido en X-OCN(LT)

Ajuste del bokeh (función de 
control del bokeh)

Puede ajustar fácilmente el grado de bokeh 
vinculando ND Filter y Gain al funcionamiento 
del iris.

Activación/desactivación de la función 
de control del bokeh

Esta función solamente se puede activar al 
ajustar la exposición manualmente. Defina el 
filtro ND a modo variable y el iris, la ganancia, 
el obturador y el filtro ND en el ajuste manual.
También puede activar/desactivar la función 
de control del bokeh mediante Iris >Bokeh 
Control (página 41) en el menú Shooting 
del menú completo.
Cuando la función de control del bokeh está 
ajustada en On, se muestra un icono  en 
los indicadores de filtro ND y ganancia. 

[Consejo]
También puede asignar la función de control del 
bokeh a un botón asignable (página 106) y activar o 
desactivar la función de control del bokeh con el botón.

Ajuste del grado de bokeh

1 Ajuste la función de control del bokeh en 
On.

2 Abra por completo el diafragma.

3 Ajuste el filtro ND en 1/128.

4 Establezca la ganancia en 0 dB y utilice la 
iluminación para ajustar la exposición.

5 Ajuste el enfoque.

6 Ajuste el iris.
El grado de bokeh cambiará.

[Consejos]
 • Cuando la función de control del bokeh está ajustada 

en On, el filtro ND y la ganancia funcionan a la 
vez para compensar los cambios en la exposición 
provocados por el ajuste del iris, lo cual le permitirá 
cambiar el grado de bokeh.

 • El control del bokeh se vincula en primer lugar al filtro 
ND como respuesta al accionamiento del iris. Si ND 
Filter no se puede seguir cambiando, se vincula Gain.

 • En modo MF, es recomendable abrir en primer lugar 
el iris y, a continuación, ajustar el enfoque.

 • Si utiliza el filtro ND automático en lugar de la función 
de control del bokeh, el grado del filtro ND seguirá el 
cambio producido en el brillo del sujeto.

Visualización durante la operación de 
vinculación de la ganancia

Cuando la función de control del bokeh está 
ajustada en On, es posible que la ganancia 
cambie a medida que se ajusta el iris.
Cuando el vínculo de la ganancia está activo 
y la ganancia cambia, se muestra un mensaje 
en la parte superior de la pantalla y parpadea 
el icono  en el indicador Gain. 

[Notas]
 • Esta función solamente está habilitada en objetivos 

de montura E que se pueden comunicar con la 
unidad.

 • El efecto máximo de esta función puede obtenerse 
mediante el anillo del iris en un objetivo de montura 
E de Sony.

 • Es posible que el aspecto varíe en función de la 
velocidad de funcionamiento, del objetivo, de los 
ajustes de captura y del sujeto, y también es posible 
que cambie el brillo. Es altamente recomendable 
realizar una prueba de la cámara antes de empezar 
a filmar.
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 • Es posible que el brillo cambie cuando la dirección 
de funcionamiento del iris cambie, como al abrir el 
iris después de cerrarlo o al cerrar el iris después de 
abrirlo. En este caso, establezca un ajuste ligeramente 
superior al requerido de antemano y, a continuación, 
bájelo ligeramente, compruebe el brillo y comience 
a filmar.  
Por ejemplo, si desea abrir el iris a una apertura F8 y 
desenfocar el fondo, primero cierre la apertura más 
allá de F8, vuelva a F8, compruebe el brillo y comience 
a filmar.

 • Realice las operaciones de control del bokeh 
lentamente. Si necesita acelerar el funcionamiento, 
intente ajustar gradualmente mientras comprueba los 
cambios en la imagen.

 • La calidad de la imagen con control del bokeh no está 
garantizada en todas las condiciones de filmación.

 • La función de control del bokeh se desactiva cuando 
se produce alguna de las siguientes operaciones.
 – Cuando la unidad se apaga
 – Cuando se ajusta Iris, Gain, Shutter o ND Filter en 

Auto
 – Al cambiar el modo de disparo
 – Cuando ND Filter está ajustado en modo Clear o 

Step
 – Al extraer el objetivo
 – Al reiniciar la unidad, por ejemplo, tras cambiar la 

frecuencia

Ajuste de visualización de 
eliminación de la compresión

Puede filmar con un objetivo anamórfico para 
crear contenidos de imágenes con tamaño 
cinemascope.
Configure la visualización de eliminación 
de la compresión para que coincida con la 
ampliación del objetivo anamórfico; de este 
modo, podrá emitir imágenes en la salida 
SDI, en la salida HDMI y en el monitor LCD 
que estén ajustadas a la misma relación de 
aspecto que cuando se visualiza directamente 
al sujeto.

Puede ajustar la visualización de eliminación 
de la compresión desde De-Squeeze 
(página 57) en el menú Monitoring del 
menú completo.

[Nota]
Cuando la relación de eliminación de la compresión se 
establece en 2.0×, el monitor de forma de onda (VSM) 
también detecta las partes del lado izquierdo/derecho 
que no se muestran.
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Grabación de proxy
Puede grabar un clip proxy en una tarjeta SD 
al mismo tiempo que graba en una tarjeta 
CFexpress.

Para obtener información detallada sobre las tarjetas de 
memoria compatibles, formatear las tarjetas de memoria 
y verificar la capacidad restante, consulte “Comprobación 
del tiempo de grabación restante” (página 20).

Configuración antes de la 
filmación

1 Ajuste Proxy Rec (página 30) en la 
pantalla de estado Project o Proxy Rec 
>Setting (página 47) en el menú Project 
del menú completo en On.

2 Coloque la tarjeta SD en la ranura para 
tarjetas SD (página 4) con la etiqueta 
orientada hacia arriba.

[Nota]
Proxy Rec no se puede establecer en On al mismo 
tiempo que S&Q Motion o Interval Rec. Cuando Proxy 
Rec se establece en On, estos otros modos de grabación 
se establecen de forma forzada en Off.

Grabación de un proxy

Presione el botón REC (inicio/parada de 
grabación) para iniciar la grabación después 
de completar la configuración necesaria para 
el disparo.

[Notas]
 • Si la unidad está apagada o si se extrae la tarjeta 

de memoria mientras se está accediendo a esta, no 
se podrá garantizar la integridad de los datos de la 
tarjeta. Es posible que se pierdan todos los datos 
grabados en la tarjeta de memoria. Asegúrese de que 
el indicador de acceso a la tarjeta de memoria esté 
siempre apagado antes de apagar la unidad o extraer 
la tarjeta de memoria.

 • Asegúrese de que la tarjeta de memoria no se salga 
al introducirla o extraerla.

Para salir, detenga la grabación.

Ajuste del canal de audio para la 
grabación proxy

Seleccione Proxy Rec >Audio Channel 
(página 47) en el menú Project del menú 
completo y configure el canal de audio para la 
grabación de datos proxy.

Acerca del archivo grabado

La extensión del nombre del archivo es “.mp4”.
El código de tiempo también se graba 
simultáneamente.

Destino del almacenamiento del 
archivo grabado

El archivo grabado se almacenará en el 
siguiente directorio:

Soporte de 
grabación

Ruta de acceso a la 
carpeta

Tarjeta SD /PRIVATE/PXROOT/Clip

Acerca del nombre del archivo

El nombre de archivo consiste en el nombre 
del clip grabado en la tarjeta de memoria + el 
sufijo “S03”.
Para obtener más información sobre los 
nombres de clips, consulte Clip Name Format 
(página 55) en el menú TC/Media del menú 
completo.

[Nota]
Cuando se rompe el enlace entre un clip original y un 
clip de proxy, se crea un clip de proxy con el código de 
tiempo al principio de la grabación como el nombre del 
clip.
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Conexión de dispositivos de grabación y monitores externos
Para mostrar imágenes de grabación 
o reproducción en un monitor externo, 
seleccione la señal de salida de la unidad y 
utilice un cable adecuado para conectar el 
monitor.
También puede conectar dispositivos de 
grabación, como una videograbadora y grabar 
la señal de salida desde la unidad.
Puede mostrar las distintas informaciones 
de estado y el menú en un monitor HDMI 
externo. Ajuste Info. Disp. (página 30) en 
la pantalla de estado Monitoring u Output 
Display (página 57) en el menú Monitoring 
del menú completo en On según la señal que 
se enviará al monitor. Cuando el códec se 
establezca en X-OCN, también podrá mostrar 
las distintas informaciones en un monitor SDI 
en lugar de en un monitor HDMI.

[Nota]
Tenga en cuenta lo siguiente cuando conecte un 
monitor o dispositivo de grabación externo a la unidad. 
Si no lo hace, podría producirse el flujo de grandes 
corrientes en los circuitos internos de la unidad, lo que 
podría dañar los componentes electrónicos.
1. Acerca de los cables de CC 

Utilice cables de CC con baja impedancia de línea 
GND para conectar un monitor externo y dispositivos 
de grabación.

2. Comprobación de la diferencia de potencial 
Antes del uso, asegúrese de que no hay diferencia 
de potencial entre los dispositivos conectados y la 
unidad.
(1) Desconecte de la unidad todos los dispositivos 

conectados como, por ejemplo, un monitor 
externo y dispositivos de grabación.  
Compruebe que el cable coaxial de 75 Ω, HDMI y 
otros cables no están conectados.

(2) Conecte los cables de CC de todos los dispositivos 
conectados y de la unidad y, a continuación, 
encienda la alimentación de cada uno de los 
dispositivos y de la unidad.

(3) Utilice un dispositivo de comprobación o de 
otro tipo para confirmar que no hay diferencia 
de potencial entre la unidad y cada uno de los 
dispositivos conectados.

Si hay diferencia de potencial, es posible que la 
impedancia de la línea GND de uno de los cables de 
CC sea alta. Sustituya dichos cables por otros con una 
impedancia de línea GND baja, según sea necesario, 
para eliminar cualquier diferencia de potencial.

3. Conexión y secuencia de encendido 
Conecte cada uno de los cables y encienda los 
dispositivos en el siguiente orden.
(1) Apague la alimentación de la unidad, el monitor 

externo, los dispositivos de grabación y el resto de 
dispositivos.

(2) Conecte los cables de CC de todos los dispositivos.
(3) Conecte el cable coaxial de 75 Ω, HDMI y otros 

cables.
(4) Encienda la alimentación de todos los dispositivos 

conectados y, a continuación, la de la unidad.
Para obtener más información, póngase en contacto con 
el servicio de asistencia técnica de Sony.

Conectores SDI OUT 1/2 (tipo BNC)

El conector SDI OUT 1 puede emitir señales SDI 
de hasta 12G.
El conector SDI OUT 2 puede emitir señales SDI 
de hasta 3G.
Configure el formato de salida con el menú 
Monitoring (página 57).
Utilice un cable coaxial de 75 Ω disponible en 
el mercado para realizar la conexión.

[Notas]
 •  Durante la grabación X-OCN, la salida SDI no se 

admite si la salida HDMI está activada.
 •  Compruebe que la conexión a tierra entre la unidad 

y el dispositivo externo es segura antes de conectar 
la alimentación. (Le recomendamos que encienda la 
unidad y el dispositivo externo después de conectar 
un cable coaxial de 75 Ω).  
Si conecta un dispositivo externo a la unidad mientras 
está encendida, conéctelo a la unidad después de 
conectar un cable coaxial de 75 Ω al dispositivo 
externo.

 • Durante la grabación X-OCN, los metadatos no se 
graban en tiempo real.

Inicio de una grabación en la unidad y 
en el dispositivo externo 
simultáneamente

Con la salida de señal SDI habilitada, ajuste 
SDI/HDMI Rec Control (página 48) >Setting 
en el menú Project del menú completo en 
SDI/HDMI Remote I/F o Parallel Rec para 
habilitar la salida de una señal de activación 
REC hacia el dispositivo externo conectado 
en el conector SDI OUT. Esto sincronizará la 
grabación en el dispositivo externo con la 
unidad.

[Notas]
 • Si el dispositivo externo conectado no es compatible 

con la señal de activación REC, el dispositivo no se 
podrá utilizar.

 • Solo se emite la señal de activación REC cuando no 
hay ningún soporte insertado en ese momento.

 • La opción Parallel Rec no se puede seleccionar 
cuando la grabación X-OCN está ajustada.

Conector HDMI OUT (conector tipo A)

Configure el formato de salida con el menú 
Monitoring (página 57) del menú completo.

Inicio de una grabación en la unidad y 
en el dispositivo externo 
simultáneamente

Con la salida de señal HDMI habilitada, ajuste 
HDMI TC Out >Setting (página 55) en el 
menú TC/Media del menú completo en On y 
SDI/HDMI Rec Control >Setting (página 48) 
en el menú Project en SDI/HDMI Remote I/F 
o Parallel Rec para habilitar la salida de una 
señal de activación REC hacia el dispositivo 
externo conectado en el conector HDMI OUT. 
Esto sincronizará la grabación en el dispositivo 
externo con la unidad.

[Notas]
 • Si el dispositivo externo conectado no es compatible 

con la señal de activación REC, el dispositivo no se 
podrá utilizar.

 • Cuando se ajusta en SDI/HDMI Remote I/F, solo se 
emite la señal de activación REC cuando no hay 
ningún soporte de grabación insertado en ese 
momento.

 • La opción Parallel Rec no se puede seleccionar 
cuando la grabación X-OCN está ajustada.

6. Conexión de dispositivos externos
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Cuando filme utilizando varias unidades, las 
unidades se pueden sincronizar con una señal 
de referencia específica o código de tiempo 
a través del conector REF IN/REF OUT de las 
unidades.

Sincronización de la fase de las 
señales de vídeo (Genlock)

Establezca el interruptor de selección TC/
REF IN/OUT (página 6) de la unidad en la 
posición IN y envíe una señal de referencia al 
conector REF IN/REF OUT (página 7) para 
activar Genlock.
Las señales de referencia que se pueden usar 
dependen de la frecuencia del sistema del 
formato de grabación seleccionado.

Frecuencia del 
sistema del 
formato de 
grabación

Señales de referencia de 
entrada admitidas

59.94P 1920×1080 59.94i 
720×486 59.94i

50P 1920×1080 50i 
720×576 50i

29.97P 1920×1080 59.94i 
720×486 59.94i

25P 1920×1080 50i 
720×576 50i

24P 1920×1080 48i (24PsF)
1920×1080 24P

23.98P 1920×1080 47.95i (23.98PsF)
1920×1080 23.98P

[Notas]
 • Si la señal de referencia es inestable, no podrá 

alcanzarse el Genlock.
 • La portadora secundaria no se sincroniza.

Bloqueo del código de tiempo en 
otros dispositivos

Ajuste la unidad que proporciona el código 
de tiempo en un modo en el que la salida 
del código de tiempo siga funcionando (por 
ejemplo, Free Run o Clock).

1 Ajuste Timecode (página 55) en el 
menú TC/Media de la siguiente manera:
Mode: Preset
Run: Free Run

2 Pulse el botón asignable (página 106) 
con la función DURATION/TC/U-BIT 
asignada para mostrar el código de 
tiempo en la pantalla.

3 Compruebe que el interruptor de 
selección TC/REF IN/OUT (página 6) 
esté en la posición IN y, a continuación, 
suministre una señal de vídeo de 
referencia HD o SD al conector REF IN/REF 
OUT y un código de tiempo de referencia 
al conector TC IN/TC OUT.

El generador de códigos de tiempo de la 
unidad se bloqueará con el código de tiempo 
de referencia y “EXT-LK” aparecerá en la 
pantalla.
Después de que hayan transcurrido diez 
segundos desde el bloqueo del código de 
tiempo, el estado de bloqueo externo se 
mantendrá incluso si se desconecta la fuente 
externa de códigos de tiempo.

[Notas]
 • Compruebe que el código de tiempo de referencia 

suministrado y la señal de vídeo de referencia se 
encuentran en una relación de fase que cumple con 
los estándares de código de tiempo SMPTE.

 • Cuando se utiliza el bloqueo externo, el código de 
tiempo obtendrá el bloqueo con el código de tiempo 
externo de forma instantánea y el valor de este 
código de tiempo externo aparecerá en el área de 
visualización de datos. Sin embargo, no comience a 
grabar inmediatamente. Espere unos segundos antes 
de comenzar a grabar hasta que el generador de 
sincronización se estabilice.

 • Si la frecuencia de la señal de vídeo de referencia y 
la frecuencia de fotogramas de la unidad no son las 
mismas, no se producirá un bloqueo y la unidad no 
funcionará correctamente. En ese caso, el código de 
tiempo no se bloqueará correctamente con el código 
de tiempo externo.

 • Si la fuente externa del código de tiempo está 
desconectada, es posible que el código de tiempo 
cambie un fotograma por hora con respecto al código 
de tiempo de referencia.

Para liberar el bloqueo externo

Cambie el ajuste Timecode en el menú TC/
Media.
La sincronización externa también se libera si 
se cambia la frecuencia del sistema y cuando 
comienza a grabar en un modo de grabación 
especial (movimiento a cámara lenta y rápida 
o Interval Rec).

Sincronización del código de 
tiempo de otro dispositivo con el 
código de tiempo de la unidad

Establezca el ajuste del código de tiempo de 
la unidad en un modo en el que la salida del 
código de tiempo siga actualizándose (por 
ejemplo, Free Run o Clock).

1 Ajuste el código de tiempo de la unidad 
mediante Timecode (página 55) en el 
menú TC/Media.

2 Compruebe que el interruptor de 
selección TC/REF IN/OUT (página 6) 
esté ajustado en la posición OUT y 
conecte el conector TC IN/TC OUT y el 
conector REF IN/REF OUT al conector de 
entrada de código de tiempo y al conector 
de entrada de la señal de referencia, 
respectivamente, del dispositivo que 
desea sincronizar.

Sincronización externa
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Gestión/Edición de clips con un ordenador

Conexión con un cable USB

Uso de un lector de tarjetas (opcional)

Conecte un lector de tarjetas CFexpress Tipo 
B o un lector de tarjetas SD a un ordenador 
mediante un cable USB e introduzca una 
tarjeta de memoria en la ranura del lector de 
tarjetas. La tarjeta de memoria se reconocerá 
como una unidad de extensión del ordenador. 
En ordenadores compatibles, puede importar 
clips a alta velocidad utilizando el modo de 
almacenamiento masivo de la unidad.

Uso del modo de almacenamiento 
masivo

[Nota]
El modo de almacenamiento masivo no se puede utilizar 
cuando USB Tethering >Setting está ajustado en On en 
el menú Network del menú completo. Ajústelo en Off.

Conecte la unidad con un cable USB e 
inserte una tarjeta de memoria en la ranura 
para tarjeta A o B. La tarjeta de memoria se 
reconoce como una unidad de extensión de 
ordenador.

1 Conecte el conector USB-C (página 5) 
o el ordenador con un cable USB.

2 Encienda la unidad.
En el monitor LCD aparecerá un mensaje 
que le preguntará si desea activar las 
conexiones USB.

 [Notas]
 •  No realice las siguientes operaciones si el 

indicador de acceso se ilumina en rojo.
 – Apagado o desconexión del cable de 

alimentación
 – Extraer la tarjeta de memoria
 – Desconectar el cable USB

 • El mensaje de confirmación de la conexión USB 
no se muestra si en esos momentos aparece 
otro mensaje de confirmación o de proceso en 
curso, por ejemplo, cuando se formatea o se 
restaura un tarjeta de memoria.  
El mensaje de confirmación se mostrará cuando 
finalice el formateo o la restauración. El mensaje 
de confirmación de USB tampoco se muestra 
mientras aparece la pantalla de propiedades 
del clip. El mensaje se mostrará cuando el 
procesamiento finalice o cuando vuelva a la 
pantalla de clips.

3 Gire el dial multifunción para seleccionar 
Execute.

4 En Windows, compruebe que la tarjeta se 
ha añadido como un disco extraíble en la 
ventana “Mi Equipo”.
En Mac, compruebe que se crea una 
carpeta “NO NAME” o “Untitled” (editable) 
en el escritorio.

[Notas]
 • No realice las siguientes operaciones si el indicador 

de acceso se ilumina en rojo.
 – Apagado o desconexión del cable de alimentación
 – Extraer la tarjeta de memoria
 – Desconectar el cable USB

 • No se garantiza el funcionamiento en todos los 
ordenadores.

Uso de un sistema de edición no 
lineal

En un sistema de edición no lineal, es 
necesario disponer de software de edición 
(opcional) que sea compatible con los 
formatos grabados por la unidad.
Utilice el software específico de aplicaciones 
para guardar previamente los clips que desee 
editar en el disco duro del ordenador.
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Precauciones de uso
Lea esta sección junto con la información 
proporcionada en el documento “Antes de 
utilizar esta unidad”.

Utilización y almacenamiento

No someta la unidad a golpes fuertes

El mecanismo interno se puede dañar y el 
cuerpo de la cámara se puede deformar.

No cubra la unidad durante el 
funcionamiento

Por ejemplo, si se coloca una tela sobre la 
unidad puede acumularse un calor excesivo 
en el interior.

Después de su uso

Apague la unidad.

Antes de guardar la videocámara 
durante un período prolongado

Extraiga la batería.

No deje la unidad con el objetivo 
apuntando al sol

La luz solar directa puede entrar a través del 
objetivo, concentrarse en la unidad y producir 
un incendio.

Transporte

 • Extraiga las tarjetas de memoria antes de 
transportar la unidad.

 • Si se envía la unidad por carretera, mar, aire 
u otro servicio de transporte, hágalo en el 
embalaje original de la unidad.

Mantenimiento de la unidad

Si la carcasa de la unidad está sucia, 
límpiela con un paño suave y seco. En casos 
extremos, utilice un paño humedecido con un 
detergente neutro y, a continuación, séquela.
No utilice disolventes orgánicos, como alcohol 
o diluyente, puesto que pueden producir 
decoloración u otros daños en el acabado de 
la unidad.
Evite limpiarla con un equipo de aire a alta 
presión, por ejemplo, una aspiradora de polvo, 
ya que podría dañar los componentes ópticos.

En caso de problemas de 
funcionamiento

Si experimenta problemas con la unidad, 
póngase en contacto con su distribuidor Sony.

Ventilador

El ventilador es un consumible y, como tal, 
debe sustituirse periódicamente.
Si utiliza la unidad a temperatura ambiente, 
el ciclo de sustitución normal será de 5 años 
aproximadamente. Sin embargo, el ciclo de 
sustitución representa solamente una directriz 
general y no constituye ninguna garantía de 
la vida útil de este componente. Para obtener 
más información acerca de la sustitución de 
componentes, póngase en contacto con el 
distribuidor.

Condensador electrolítico

La vida útil del condensador electrolítico 
es de unos 5 años con las temperaturas de 
funcionamiento habituales y un uso normal 
(8 horas al día, 25 días al mes).
Si el uso supera la frecuencia normal indicada, 
es posible que la vida útil se vea reducida en 
consecuencia.

Nota acerca del terminal de la 
batería

El terminal de la batería de esta unidad (el 
conector para baterías y adaptadores de CA) 
es un componente consumible.
Puede que la unidad no funcione 
correctamente si los contactos del terminal 
de la batería están doblados o deformados 
debido a algún golpe o a vibraciones o si se 
han corroído debido a un uso prolongado en 
el exterior.
Se recomienda realizar inspecciones 
periódicas para que la unidad continúe 
funcionando correctamente y para prolongar 
su vida útil. Contacte con el servicio 
de asistencia técnica de Sony o con el 
responsable de ventas para obtener más 
información sobre las inspecciones.

Ubicaciones de uso y 
almacenamiento

Guárdela en un lugar estable y ventilado.
Evite utilizar o guardar la unidad en los 
siguientes lugares.

 • En entornos excesivamente calientes o fríos 
(rango de temperatura de funcionamiento: 
de 0 °C a 40 °C)  
Recuerde que, en verano, en climas cálidos, 
la temperatura dentro de un coche con las 
ventanas subidas puede superar fácilmente 
los 50 °C.

 • En lugares húmedos o polvorientos.
 • Lugares donde la unidad pueda estar 

expuesta a la lluvia
 • Lugares sujetos a vibraciones violentas
 • Cerca de campos magnéticos potentes
 • Cerca de emisoras de radio o TV que 

generen campos electromagnéticos 
intensos.

 • En directa exposición al sol o cerca de 
fuentes de calor durante tiempo prolongado

Cómo evitar interferencias 
electromagnéticas procedentes de 
dispositivos de comunicación portátiles

El uso de teléfonos móviles y otros 
dispositivos de comunicación cerca de esta 
unidad puede producir averías e interferencias 
con las señales de audio y vídeo.
Es recomendable que los dispositivos de 
comunicación portátiles que se encuentren 
cerca de esta unidad estén apagados.

Nota sobre los rayos láser

Los rayos láser pueden dañar el sensor de 
imagen CMOS. Si filma una escena que 
incluya un rayo láser, evite que este se 
dirija directamente al objetivo de la unidad. 
Específicamente, los rayos láser de alta 
potencia procedentes de los dispositivos 
médicos o de otros dispositivos podrían 
causar daños debido a los efectos de la luz 
reflejada y la luz dispersa.
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Acerca de las pantallas

 • No deje las pantallas expuestas a la luz solar 
directa, ya que de esta forma podría dañar 
las pantallas.

 • No empuje ni mueva las pantallas por 
la fuerza, ni coloque objetos sobre 
ellas, ya que podría provocar un fallo 
de funcionamiento como por ejemplo 
irregularidades en la imagen, etc.

 • Las pantallas podrían calentarse durante 
su uso. Este fenómeno no es un fallo de 
funcionamiento.

Paneles LCD

El panel LCD de esta unidad ha sido fabricado 
con tecnología de alta precisión y ofrece 
un índice de píxeles funcionales de al 
menos el 99,99%. Por ello, es posible que 
quede una pequeña proporción de píxeles 
“atascados”, o bien siempre apagados (negro), 
siempre encendidos (rojo, verde o azul), o 
parpadeando. Además, tras un período de uso 
prolongado, esos píxeles “atascados” pueden 
ir apareciendo espontáneamente debido a las 
características físicas de la pantalla de cristal 
líquido.
Esto no significa que la unidad funcione mal.
Tenga en cuenta que dichos problemas no 
producen efectos en los datos grabados.

Condensación

Si la unidad se lleva de repente de un lugar 
frío a uno cálido o si la temperatura ambiente 
sufre un aumento repentino, es posible que 
se acumule humedad en la superficie exterior 
o interior de la unidad. Este fenómeno se 
conoce como condensación. Si se produce 
condensación, apague la unidad y espere a 
que se evapore antes de ponerla en marcha. 
No utilice la unidad en ese estado, ya que 
podría dañarla.

Fenómenos del sensor de imagen 
CMOS de la cámara

[Nota]
Los siguientes fenómenos que podrían producirse en 
las imágenes están relacionados con los sensores de 
imagen. No indican que exista una avería.

Motas blancas

Aunque los sensores de imágenes se fabrican 
con tecnologías de alta precisión, es posible 
que se generen pequeñas motas blancas en 
la pantalla en casos excepcionales producidas 
por rayos cósmicos, etc.
Están relacionadas con el principio de los 
sensores de imágenes y no se trata de una 
avería.
Las motas blancas suelen verse especialmente 
en las siguientes situaciones:
 • cuando se utiliza la unidad con una 

temperatura ambiente elevada
 • cuando se ha elevado la ganancia 

(sensibilidad)

Parpadeo

Si captura imágenes bajo la luz producida por 
lámparas fluorescentes, lámparas de sodio, 
lámparas de vapor de mercurio o LED, es 
posible que la pantalla parpadee o que los 
colores varíen.

Nota sobre la pantalla

Las imágenes de la pantalla del visor y las 
salidas pueden verse distorsionadas al realizar 
las siguientes operaciones:

 – Cambiar el formato de vídeo
 – Cambiar la velocidad de fotogramas FPS
 – Cuando se aplica Genlock

Fragmentación de archivos

Si las imágenes no se pueden grabar/
reproducir correctamente, intente formatear 
el soporte de grabación. Cuando se repite 
la grabación/reproducción de una imagen 
con un soporte de grabación específico 
durante un periodo prolongado, es posible 
que los archivos del soporte se fragmenten, 
y no se realice correctamente la grabación/
el almacenamiento. En ese caso, realice una 
copia de seguridad de los clips en el soporte 
y formatee el soporte desde Format Media 
(página 56) el menú TC/Media del menú 
completo.

No poner este producto cerca de 
aparatos médicos 

Este producto (incluyendo los accesorios) 
tiene un imán (o imanes) que puede interferir 
con marcapasos, válvulas de derivación 
programables para el tratamiento de la 
hidrocefalia, o con otros aparatos médicos. 
No ponga el producto cerca de personas que 
utilicen dichos aparatos médicos. Consulte con 
su médico antes de utilizar este producto si 
utiliza cualquiera de dichos aparatos médicos.

Precauciones de seguridad

 • SONY NO SE HACE RESPONSABLE POR 
DAÑOS DE NINGÚN TIPO DEBIDOS 
A LA OMISIÓN DE LAS MEDIDAS 
DE SEGURIDAD ADECUADAS EN 
DISPOSITIVOS DE TRANSMISIÓN, FUGAS 
DE DATOS INEVITABLES DERIVADAS DE LAS 
ESPECIFICACIONES DE TRANSMISIÓN O 
PROBLEMAS DE SEGURIDAD DE CUALQUIER 
TIPO.

 • Según el tipo de entorno operativo, es 
posible que terceras partes no autorizadas 
puedan acceder a la unidad a través de 
la red. Cuando conecte la unidad a la 
red, confirme siempre que la red está 
correctamente protegida.

 • Es posible que terceros no autorizados 
situados cerca de las señales puedan 
interceptar sin saberlo contenidos 
de la comunicación. Cuando utilice la 
comunicación LAN inalámbrica, aplique 
correctamente las medidas de seguridad 
para proteger los contenidos de la 
comunicación.
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 • Cuando conecte este producto a una red, 
conéctelo mediante un sistema con función 
de protección como, por ejemplo, un 
router o un firewall. Si se conecta sin dicha 
protección, pueden producirse problemas 
de seguridad.

 • Desde el punto de vista de la seguridad, 
al utilizar la unidad conectada a la red, 
se recomienda encarecidamente acceder 
a la ventana de control a través de un 
navegador web y modificar la limitación de 
acceso de los valores predeterminados de 
fábrica (página 66).  
Asimismo, se recomienda cambiar la 
contraseña periódicamente.

 • No visite otros sitios web con el navegador 
web mientras ajuste la configuración o justo 
después. El navegador web recuerda los 
ajustes de inicio de sesión, por lo que debe 
cerrarlo al completar la configuración para 
evitar que terceros no autorizados utilicen 
la unidad o para evitar la instalación de 
programas maliciosos.
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Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 1920×1080P (Level A)).

[Notas]
 • La resolución del formato de salida está limitada por la configuración de Rec Format >Frequency, Codec y Video Format en el menú Project del menú completo (página 46).
 • La imagen no se emite si se configura una resolución superior a la de la imagen de reproducción.

Formatos de salida del conector SDI OUT/HDMI OUT

Ajuste de frecuencia del sistema
(Rec Format >Frequency en el menú Project)

Configuración del códec
(Rec Format >Codec en el menú Project)

Resolución de grabación Formato de salida (Output Format en el menú Monitoring)

SDI1 SDI2 HDMI

50/59.94Hz X-OCN LT (6K 17:9)
(5K 17:9)
(4.3K 17:9)
(4K 17:9)

1920×1080P(A) 1920×1080P(A) –

– – 4096×2160P

– – 1920×1080P

– – 1920×1080i

(6K 16.9)
(5K 16:9)
(4.3K 16:9)
(4K 16:9)

1920×1080P(A) 1920×1080P(A) –

– – 3840×2160P

– – 1920×1080P

– – 1920×1080i

XAVC Intra 4096×2160
(17:9)

4096×2160P1) 2048×1080P(A)1) 4096×2160P1)

4096×2160P1) 2048×1080P(A)1) 1920×1080P1)

4096×2160P1) 2048×1080P(A)1) 1920×1080i1)

1920×1080P(A) 1920×1080P(A) 1920×1080P

1920×1080P(A) 1920×1080P(A) 1920×1080i

1920×1080P(B) 1920×1080P(B) 1920×1080P

1920×1080P(B) 1920×1080P(B) 1920×1080i

1920×1080i 1920×1080i 1920×1080i

Limitaciones y formatos de salida
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Ajuste de frecuencia del sistema
(Rec Format >Frequency en el menú Project)

Configuración del códec
(Rec Format >Codec en el menú Project)

Resolución de grabación Formato de salida (Output Format en el menú Monitoring)

SDI1 SDI2 HDMI

50/59.94Hz XAVC Intra
XAVC Long

3840×2160
(16:9)

3840×2160P 1920×1080P(A) 3840×2160P

3840×2160P 1920×1080P(A) 1920×1080P

3840×2160P 1920×1080P(A) 1920×1080i

1920×1080P(A) 1920×1080P(A) 1920×1080P

1920×1080P(A) 1920×1080P(A) 1920×1080i

1920×1080P(B) 1920×1080P(B) 1920×1080P

1920×1080P(B) 1920×1080P(B) 1920×1080i

1920×1080i 1920×1080i 1920×1080i

XAVC Intra
XAVC Long

1920×1080
(16:9)

1920×1080P(A) 1920×1080P(A) 1920×1080P

1920×1080P(A) 1920×1080P(A) 1920×1080i

1920×1080P(B) 1920×1080P(B) 1920×1080P

1920×1080P(B) 1920×1080P(B) 1920×1080i

1920×1080i 1920×1080i 1920×1080i

– – 720×480P, 720×576P

25/29.97Hz X-OCN LT (8K 17:9)
(6K 17:9)
(5K 17:9)
(4.3K 17:9)
(4K 17:9)

1920×1080P 1920×1080P –

– – 4096×2160P

– – 1920×1080P

(8K 16:9)
(6K 16:9)
(5K 16:9)
(4.3K 16:9)
(4K 16:9)

1920×1080P 1920×1080P –

– – 3840×2160P

– – 1920×1080P

XAVC H-I HQ
XAVC H-I SQ

8192×4320
(17:9)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

XAVC H-I HQ
XAVC H-I SQ
XAVC H-L

7680×4320
(16:9)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i
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Ajuste de frecuencia del sistema
(Rec Format >Frequency en el menú Project)

Configuración del códec
(Rec Format >Codec en el menú Project)

Resolución de grabación Formato de salida (Output Format en el menú Monitoring)

SDI1 SDI2 HDMI

25/29.97Hz XAVC Intra 4096×2160
(17:9)

4096×2160P1) 2048×1080P1) 4096×2160P1)

4096×2160P1) 2048×1080P1) 1920×1080P1)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

XAVC Intra
XAVC Long

3840×2160
(16:9)

3840×2160P 1920×1080P 3840×2160P

3840×2160P 1920×1080P 1920×1080P

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

XAVC Intra
XAVC Long

1920×1080
(16:9)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

23.98Hz X-OCN LT (8K 17:9)
(6K 17:9)
(5K 17:9)
(4.3K 17:9)
(4K 17:9)

1920×1080P 1920×1080P –

– – 4096×2160P

– – 1920×1080P

(8K 16:9)
(6K 16:9)
(5K 16:9)
(4.3K 16:9)
(4K 16:9)

1920×1080P 1920×1080P –

– – 3840×2160P

– – 1920×1080P

XAVC H-I HQ
XAVC H-I SQ

8192×4320
(17:9)

1920×1080P 1920×1080P 1920×1080P

XAVC H-I HQ
XAVC H-I SQ
XAVC H-L

7680×4320
(16:9)

1920×1080P 1920×1080P 1920×1080P

XAVC Intra 4096×2160
(17:9)

4096×2160P1) 2048×1080P1) 4096×2160P1)

4096×2160P1) 2048×1080P1) 1920×1080P1)

1920×1080P 1920×1080P 1920×1080P

XAVC Intra
XAVC Long

3840×2160
(16:9)

3840×2160P 1920×1080P 3840×2160P

3840×2160P 1920×1080P 1920×1080P

1920×1080P 1920×1080P 1920×1080P

XAVC Intra
XAVC Long

1920×1080
(16:9)

1920×1080P 1920×1080P 1920×1080P
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Ajuste de frecuencia del sistema
(Rec Format >Frequency en el menú Project)

Configuración del códec
(Rec Format >Codec en el menú Project)

Resolución de grabación Formato de salida (Output Format en el menú Monitoring)

SDI1 SDI2 HDMI

24 Hz X-OCN LT (8K 17:9)
(6K 17:9)
(5K 17:9)
(4.3K 17:9)
(4K 17:9)

1920×1080P 1920×1080P –

– – 4096×2160P

– – 1920×1080P

XAVC H-I HQ
XAVC H-I SQ

8192×4320
(17:9)

1920×1080P 1920×1080P 1920×1080P

XAVC Intra 4096×2160
(17:9)

4096×2160P1) 2048×1080P1) 4096×2160P1)

1920×1080P 1920×1080P 1920×1080P

1) No se puede seleccionar si el tamaño de la cámara (Imager Scan Mode) es S35c 4K 17:9 y la velocidad de fotogramas es 100 fps o superior cuando se filma en el modo Slow & Quick Motion.
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Tiempo de grabación/reproducción del clip
En las siguientes tablas se muestra el tiempo de grabación/reproducción cuando se utilizan tarjetas de memoria de 960 GB Sony CFexpress Tipo B VPG400 (unidad: minutos).

[Nota]
Los tiempos de grabación y reproducción son para la grabación continua como un solo clip. El tiempo real puede ser inferior, dependiendo del número de clips grabados. El tiempo de grabación/reproducción puede variar en función de las 
condiciones de uso y las características de la memoria.

Imager Scan 
Mode

Frequency Codec

X-OCN (LT) XAVC H-I HQ 
8192×4320

XAVC H-I HQ 
7680×4320

XAVC H-I SQ 
8192×4320

XAVC H-I SQ 
7680×4320

XAVC H-L 
7680×4320

XAVC-I 
4096×2160

XAVC-I 
3840×2160

XAVC-I 
1920×1080

XAVC-L 
3840×2160

XAVC-L 
1920×1080

FF 8.6K 17:9 23 74 130 – 194 – – – – – – –

24 74 130 – 193 – – – – – – –

25 71 125 – 186 – – – – – – –

29 59 104 – 155 – – – – – – –

50 – – – – – – – – – – –

59 – – – – – – – – – – –

FF 8.6K 16:9 23 69 – 130 – 194 239 – – – – –

24 – – – – – – – – – – –

25 66 – 125 – 186 239 – – – – –

29 55 – 104 – 155 238 – – – – –

50 – – – – – – – – – – –

59 – – – – – – – – – – –

FFc 6K 17:9 23 150 – – – – – 494 – – – –

24 150 – – – – – 493 – – – –

25 144 – – – – – 473 – – – –

29 120 – – – – – 397 – – – –

50 72 – – – – – 241 – – – –

59 60 – – – – – 201 – – – –

FFc 6K 16:9 23 140 – – – – – – 494 1207 1145 2121

24 – – – – – – – – – – –

25 135 – – – – – – 473 985 1140 2106

29 112 – – – – – – 397 981 1127 2070

50 67 – – – – – – 241 512 756 1939

59 56 – – – – – – 201 510 745 1878

S35 5.8K 17:9 23 165 – – – – – 494 – – – –

24 164 – – – – – 493 – – – –

25 158 – – – – – 473 – – – –

29 132 – – – – – 397 – – – –

50 79 – – – – – 241 – – – –

59 66 – – – – – 201 – – – –
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Imager Scan 
Mode

Frequency Codec

X-OCN (LT) XAVC H-I HQ 
8192×4320

XAVC H-I HQ 
7680×4320

XAVC H-I SQ 
8192×4320

XAVC H-I SQ 
7680×4320

XAVC H-L 
7680×4320

XAVC-I 
4096×2160

XAVC-I 
3840×2160

XAVC-I 
1920×1080

XAVC-L 
3840×2160

XAVC-L 
1920×1080

S35 5.8K 16:9 23 154 – – – – – – 494 1207 1145 2121

24 – – – – – – – – – – –

25 148 – – – – – – 473 985 1140 2106

29 124 – – – – – – 397 981 1127 2070

50 74 – – – – – – 241 512 756 1939

59 62 – – – – – – 201 510 745 1878

S35c 4K 17:9 23 323 – – – – – 494 – – – –

24 323 – – – – – 493 – – – –

25 310 – – – – – 473 – – – –

29 259 – – – – – 397 – – – –

50 156 – – – – – 241 – – – –

59 130 – – – – – 201 – – – –
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Resolución de problemas

Fuente de alimentación

Síntoma Causa Solución

La unidad no se enciende. La batería no está colocada y 
no se está suministrando 
alimentación al conector DC 
IN.

Coloque una batería (página 14) o 
conecte la videocámara a la 
alimentación de CA con un adaptador 
de CA (página 14).

La batería está 
completamente agotada.

Sustituya la batería por una batería 
cargada por completo (página 14).

El suministro de 
alimentación se corta 
durante el funcionamiento.

La batería se agota por 
completo.

Sustituya la batería por una batería 
cargada por completo (página 14).

La batería se agota muy 
rápido.

La temperatura ambiente es 
muy baja.

Esto se debe a las características de la 
batería y no es un defecto.

No se ha cambiado la batería 
de forma adecuada.

Sustituya la batería (página 14).
Si la batería se agota pronto, incluso 
después de haberla cargado por 
completo, es posible que haya llegado 
al final de su vida útil. Sustitúyala por 
una nueva.

Grabación/reproducción

Síntoma Causa Solución

La grabación no comienza al 
pulsar el botón REC (inicio/
parada de grabación).

La tarjeta de memoria está 
llena.

Sustituya la tarjeta de memoria por otra 
con espacio suficiente.

Es necesario restablecer la 
tarjeta de memoria.

Restaure la tarjeta de memoria 
(página 20).

No se puede grabar audio. Los diales AUDIO LEVEL 
(CH1/CH2) están establecidos 
al nivel mínimo.

Ajuste los niveles de grabación de 
audio con los diales AUDIO LEVEL (CH1/
CH2) (página 104).

El sonido grabado está 
distorsionado.

El nivel de audio es 
demasiado alto.

Ajuste los niveles de grabación de 
audio con los diales AUDIO LEVEL (CH1/
CH2) (página 104).

Síntoma Causa Solución

El sonido grabado tiene un 
alto nivel de ruido.

El nivel de audio es 
demasiado bajo.

Ajuste los niveles de grabación de 
audio con los diales AUDIO LEVEL (CH1/
CH2) (página 104).
Cuando se selecciona un micrófono 
externo, ajuste también la 
configuración de Audio Input >INPUT 
MIC Reference (página 60) en el 
menú Audio del menú completo.

No se pueden reproducir los 
clips.

Se está editando el clip. No se pueden reproducir los clips si ha 
modificado los nombres o las carpetas 
de archivo o si el clip se está utilizando 
en un ordenador. No se trata de un fallo 
de funcionamiento.

Se está grabando el clip en 
otro dispositivo.

Los clips grabados en otros dispositivos 
pueden no reproducirse o mostrarse en 
un tamaño incorrecto. No se trata de un 
fallo de funcionamiento.

Dispositivos externos

Síntoma Solución

El ordenador no reconoce la 
unidad.

Desconecte el cable USB del ordenador y vuelva a conectarlo de 
forma segura.

Desconecte el cable USB del ordenador, reinícielo y vuelva a seguir 
los pasos en el orden correcto.

Conecte el ordenador y la unidad insertando un cable USB en el 
conector USB-C o el conector USB/múltiple.

No se pueden cargar los clips en 
el ordenador.

Desconecte el cable USB del ordenador, reinicie la unidad y vuelva 
a conectarlo.

Debe instalarse el software de aplicación para cargar los clips en 
su ordenador (página 114).
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Conexión LAN inalámbrica

[Nota]
Las obstrucciones y la interferencia electromagnética entre la unidad y el punto de acceso de LAN inalámbrico o el 
dispositivo del terminal, o bien el entorno ambiental (tal como los materiales de la pared) podrían acortar el rango 
de comunicación o impedir las conexiones por completo. Si experimenta estos problemas, verifique el estado de 
conexión/comunicación tras mover la unidad a una nueva ubicación o tras acercarla al punto de acceso/dispositivo 
del terminal.

Síntoma Solución

El dispositivo del terminal no 
puede acceder a la unidad.

 • Compruebe la conexión LAN inalámbrica (dirección IP, etc.).
 • Es posible que el ajuste de comunicación entre el punto de 

acceso y el cliente no sea válido. Para obtener más información, 
remítase a las instrucciones del punto de acceso.

No puede iniciar sesión en la 
unidad.

Compruebe el nombre de usuario y la contraseña establecidos.

Conexión a Internet

Síntoma Solución

Fallo al cargar un archivo. Es posible que el nombre de usuario y la contraseña del servidor 
no sean correctos.
Introduzca el nombre de usuario y la contraseña correctos.

La carga de archivos no está 
disponible.

Es posible que las condiciones de la señal sean deficientes.
Desplácese a otra ubicación e inténtelo de nuevo.

Al usar el Filtro ND

Síntoma Solución

El filtro ND no se mueve. Puede mover manualmente el filtro a la posición Clear mediante el 
siguiente procedimiento.

1 Establezca el interruptor ND STEP/VARIABLE (página 5) en la posición STEP y pulse hacia 
abajo el botón arriba/abajo ND FILTER POSITION (página 5) para que se encienda el 
testigo ND CLEAR.

2 Apague la unidad.

3 Retire la tapa redonda (2 ubicaciones) de la parte inferior.

4 Introduzca un destornillador en el orificio (2 ubicaciones) y gírelo en el sentido contrario a las 
agujas del reloj.
 • Para mover el filtro ND hasta la posición Clear, gírelo en el sentido contrario a las agujas 

del reloj. Siga girándolo hasta llegar a la posición Clear.
 • Utilice un destornillador de ø2,4 mm de diámetro o menos. La profundidad de inserción 

del destornillador es de unos 3,0 cm.

Orificio para el desatornillador 
(con la tapa quitada)

[Notas]
 • No utilice el procedimiento anterior durante el funcionamiento normal. Solo debe utilizar este procedimiento si no 

puede mover el filtro ND. El filtro ND puede sufrir daños si se utiliza este procedimiento durante el funcionamiento 
normal.

 • Después de utilizar el procedimiento anterior, consulte a un centro de servicio de Sony para que le reparen la 
unidad.

 • Aunque siga apareciendo un mensaje de error después de realizar el procedimiento anterior, podrá filmar.
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Advertencias de funcionamiento
Si en la unidad se genera un estado de funcionamiento, advertencia o precaución que requiere 
confirmación, aparece un mensaje en el monitor LCD, la lámpara indicadora/indicador de 
grabación empieza a parpadear y se emite una advertencia acústica.
El pitido de advertencia se emite desde los auriculares conectados a la toma de auriculares.

Mensajes de error

La unidad dejará de funcionar cuando se genere uno de los siguientes tipos de pantalla.

Pantalla de error en el 
monitor LCD

Sonido de 
advertencia

Lámpara 
indicadora/
indicador 
de 
grabación

Causa y solución

E + Código de error Continuo Parpadeo 
rápido

La unidad puede estar defectuosa.
Apague la unidad y compruebe si existe algún 
problema con los dispositivos, cables o soportes 
conectados. Si el error continúa cuando se vuelve 
a encender la unidad, póngase en contacto con su 
representante del servicio técnico de Sony.
(Si no se puede desconectar la alimentación 
estableciendo el interruptor de alimentación en la 
posición  (Standby), retire la batería o la fuente 
DC IN).
Es posible que no aparezca una pantalla de error 
o un sonido de advertencia dependiendo del 
estado de la unidad.

Mensajes de advertencia

Siga las instrucciones proporcionadas si se muestran los siguientes mensajes.

Pantalla de 
advertencia en el 
monitor LCD

Sonido de 
advertencia

Lámpara 
indicadora/
indicador 
de 
grabación

Causa y solución

Battery Near End Intermitente Parpadea La capacidad restante de la batería se está 
agotando.
Recárguela en cuanto pueda.

Battery End Continuo Parpadeo 
rápido

La batería se ha agotado. La grabación se 
desactiva.
Detenga el funcionamiento y sustituya la batería.

Temperature High Intermitente Parpadea La temperatura interna es elevada.
Apague la unidad y deje que se enfríe antes de 
volver a ponerla en marcha.

Media Temperature 
High

Intermitente Parpadea La temperatura de la tarjeta CFexpress es elevada.
Sustituya la tarjeta o deje que se enfríe antes de 
volverla a utilizar.

Voltage Low Intermitente Parpadea La tensión de DC IN es baja (nivel 1). Compruebe la 
fuente de alimentación.

Insufficient Voltage Continuo Parpadeo 
rápido

La tensión de DC IN es demasiado baja (nivel 2). 
La grabación se desactiva.
Conecte a una fuente de alimentación distinta.

Media Near Full Intermitente Parpadea La capacidad restante de la tarjeta de memoria se 
está agotando.
Sustitúyala en cuanto pueda.

Media Full Continuo Parpadeo 
rápido

Los clips no se pueden grabar o copiar porque no 
queda capacidad en la tarjeta de memoria.
Sustitúyala inmediatamente.

Clips Near Full Intermitente Parpadea El número de clips adicionales que pueden 
grabarse en la tarjeta de memoria está 
alcanzando valores bajos.
Sustitúyala en cuanto pueda.

Clips Full Continuo Parpadeo 
rápido

Se ha alcanzado el número máximo de clips que 
pueden grabarse en la tarjeta de memoria.
No se pueden grabar o copiar más clips. 
Sustitúyala inmediatamente.
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Pantalla de 
advertencia en el 
monitor LCD

Sonido de 
advertencia

Lámpara 
indicadora/
indicador 
de 
grabación

Causa y solución

Last Clip Recording Intermitente Parpadea El clip que está grabando actualmente es el 
último que puede grabar, ya que ha alanzado el 
número máximo de clips.
Prepare una tarjeta de memoria nueva.

Media(A)1) Life Near 
End

Intermitente Parpadea La tarjeta de memoria está llegando al final de su 
vida útil. Sustitúyala en cuanto pueda.

Media(A)1) Life End Continuo Parpadeo 
rápido

La tarjeta de memoria ha llegado al final de su 
vida útil. Sustitúyala inmediatamente.

Media(A)1) Near Full Intermitente Parpadea Al utilizar la función Simul Rec

Media(A)1) Full Continuo Parpadeo 
rápido

Al utilizar la función Simul Rec

Media(A)1) Clips Near 
Full

Intermitente Parpadea Al utilizar la función Simul Rec

Media(A)1) Clips Full Continuo Parpadeo 
rápido

Al utilizar la función Simul Rec

Media(A)1) Last Clip 
Rec

Intermitente Parpadea Al utilizar la función Simul Rec

Transfer Jobs Near 
Full

– – El número de trabajos de transferencia de 
archivos FTP que se pueden registrar está 
disminuyendo.

Transfer Jobs Full – – El número de trabajos de transferencia de 
archivos FTP que se pueden registrar ha 
alcanzado el límite superior. Para añadir otro 
trabajo, elimine trabajos que no necesite. 2)

1) Se muestra “Media (B)” para la tarjeta de la ranura B.
2) Puede seleccionar y eliminar trabajos seleccionando File Transfer >View Job List (página 68) en el menú Network 

del menú completo. También puede borrar trabajos de la lista de trabajos en la aplicación Monitor & Control.

Mensajes de precaución y de funcionamiento

Es posible que los siguientes mensajes de precaución y funcionamiento aparezcan en el 
centro de la pantalla. Siga las instrucciones proporcionadas para resolver el problema.

Mensaje de pantalla Causa y solución

Battery Error
Please Change Battery

Se ha detectado un error en la batería.
Sustitúyala por una batería normal.

Backup Battery End
Please Change

La capacidad de la batería de reserva es insuficiente.
Cargue la batería de reserva.

Unknown Media(A)1)

Please Change
Se ha insertado una tarjeta de memoria que se ha 
particionado o contiene más clips de los que la unidad puede 
gestionar.
La tarjeta no puede usarse en la unidad y debe reemplazarse.

Cannot Use Media(A)1)

Unsupported File System
Se ha introducido una tarjeta que utiliza otro sistema de 
archivos o una tarjeta sin formatear.
La tarjeta no puede usarse en la unidad y debe reemplazarse 
o formatearse utilizando la unidad.

Media Error
Media (A) 1) Needs to be Restored

Se ha producido un error en la tarjeta de memoria y se debe 
restaurar.
Restaure la tarjeta de memoria.

Media Error
Cannot Record to Media(A)1)

Es posible que la tarjeta de memoria esté dañada y ya no se 
puede utilizar para la grabación.
La reproducción puede ser posible, por tanto, se recomienda 
copiar y sustituir la tarjeta de memoria.

Media Error
Cannot Use Media(A)1)

Es posible que la tarjeta de memoria esté dañada y ya no se 
puede utilizar para la grabación ni la reproducción.
La tarjeta no puede usarse en la unidad y debe reemplazarse.

Media(A)1) Error
Recording Halted
Playback Halted

La grabación o la reproducción se han detenido por un error 
en la tarjeta de memoria.
Si el problema continúa, reemplace la tarjeta de memoria.

Media Reached Rewriting Limit
Change Media (A) 1)

La tarjeta de memoria ha llegado al final de su vida útil.
Realice una copia de seguridad y sustituya la tarjeta 
inmediatamente. Si continúa utilizando la tarjeta, es posible 
que no pueda grabar o reproducir.
Para obtener más información, consulte las instrucciones de 
funcionamiento de la tarjeta de memoria.

The specified address is invalid. La dirección especificada no es válida.
Compruebe que el ajuste sea correcto.

Cannot Use Specified Port Number El número de puerto especificado no es válido.
Compruebe que el ajuste sea correcto.
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Mensaje de pantalla Causa y solución

Fan Stopped El ventilador incorporado se ha detenido.
Evite utilizar el camcorder con temperaturas elevadas, 
desconecte la alimentación y póngase en contacto con el 
servicio de asistencia técnica de Sony.

LENS Error Se detectó un error en la comunicación I/F del objetivo al 
conectar un objetivo con soporte E.
Verifique el estado de conexión con el objetivo con montura E.

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

Se detectó un accesorio incompatible.
El único accesorio de terminal múltiple compatible con la 
unidad es el control remoto de la empuñadura suministrado.

Failed. Este error puede aparecer si no se puede obtener una 
dirección con el ajuste DHCP fijado en On.
Compruebe los ajustes de servidor de DHCP.

Addition of auto upload job failed. Se ha alcanzado el número máximo de trabajos de 
transferencia.
Borre los trabajos no deseados. Es posible que el ajuste de 
destino de carga automática para clips originales o clips de 
proxy también sea incorrecto. Compruebe que el ajuste sea 
correcto.

<SSID>Not found. No se pudo encontrar la red (punto de acceso) con el <SSID> 
especificado.
Compruebe que el ajuste sea correcto.

<SSID>Authentication Failed Fallo de autenticación de conexión en la red (punto de acceso) 
con el <SSID> especificado.
Compruebe que la contraseña y el resto de ajustes sean 
correctos.

An IP address conflict has occurred. 
Please check the network settings.

Existe un conflicto en las direcciones de red de LAN 
inalámbrica, LAN con cable o anclaje USB.
Cambie la dirección de forma manual o cambie los ajustes del 
router de red.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

La dirección IP del modo de punto de acceso de LAN 
inalámbrica se cambió debido a un conflicto con las 
direcciones de red del modo de punto de acceso de LAN 
inalámbrica, LAN con cable o anclaje USB.
Compruebe la configuración de la dirección IP.

1) Se muestra “Media (B)” para la tarjeta de la ranura B.
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Elementos guardados en Files

Elementos configurados en el menú completo

Sí: el elemento se guarda.
No: el elemento no se guarda.
–: no guardado (ajuste temporal)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Sí No

ISO/Gain Sí No

Exposure Index Sí No

Shockless Gain Sí No

Base Sensitivity Sí No

Base ISO Sí No

ND Filter Display Mode Sí No

Shutter Mode Sí No

Shutter Speed On/Off Sí No

Shutter Speed Sí No

Shutter Angle Sí No

ECS On/Off Sí No

ECS Frequency Sí No

Iris Bokeh Control No –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Sí No

Mode Sí No

Speed Sí No

Auto ND Filter Sí No

AGC Sí No

AGC Limit Sí No

AGC Point Sí No

Auto Shutter Sí No

A.SHT Limit Sí No

A.SHT Point Sí No

Auto Iris Sí No

Clip High light Sí No

Detect Window Sí No

Detect Window Indication Sí No

Custom Width Sí No

Custom Height Sí No

Custom H Position Sí No

Custom V Position Sí No

White White Select Sí No

Auto White Balance – –

ATW Sí No

Color Temp Sí No

Tint Sí No

R Gain Sí No

B Gain Sí No

Preset White Select – –

White Setting Shockless White Sí No

ATW Speed Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Focus AF Transition Speed Sí No

AF Subj. Shift Sens. Sí No

Focus Area Sí No

Subject Recognition AF Sí No

Touch Function in MF Sí No

AF Assist Sí No

S&Q Motion Setting Sí No

Frame Rate Sí No

LUT On/Off SDI/HDMI Sí No

SDI Sí No

LCD/Proxy/Stream Sí No

LCD/HDMI/Px/Stream Sí No

Noise Suppression Setting(Custom) Sí No

Level(Custom) Sí No

Setting(Cine EI) Sí –

Level(Cine EI) Sí –

Flicker Reduce Mode Sí No

Frequency Sí No

Image Stabilization SteadyShot Sí No

PL Stabilization Sí No

Stabilization Adjustment Sí No

Focal Length Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Base Setting Shooting Mode Sí –

Target Display Sí –

Rec Format Frequency Sí No

Imager Scan Mode Sí No

Codec Sí No

Video Format Sí No

Cine EI Setting Color Gamut Sí –

Embed LUT File Sí No

Simul Rec Setting Sí No

Proxy Rec Setting Sí No

Audio Channel Sí No

Interval Rec Setting No No

Interval Time Sí No

Number of Frames Sí No

Pre-Lighting Sí No

Picture Cache Rec Setting Sí No

Cache Size Sí No

Cache Rec Time – –

SDI/HDMI Rec Control Setting Sí No

Assignable Button <1> Sí No

<2> Sí No

<3> Sí No

<4> Sí No

<5> Sí No

<6> Sí No

<7> Sí No

<8> Sí No

<9> Sí No

<10> Sí No

<11> Sí No

Focus Hold Button Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Assignable Dial Grip/Remote Dial Sí No

Grip Dial Direction Sí No

Multi Function Dial Default Function Sí No

User File Load from UTILITY SD – –

Save to UTILITY SD – –

File ID No No

Load Customize Data Sí No

Load White Data Sí No

All File Load from UTILITY SD – –

Load from Cloud(Private) – –

Load from Cloud(Share) – –

Save to UTILITY SD – –

Save to Cloud(Private) – –

Save to Cloud(Share) – –

File ID Sí No

Load Network Data No No

Paint/Look Scene File Recall – –

Store – –

Delete – –

Preset Recall – –

Base Look Select Sí Sí

Delete – –

Delete All – –

Import from Utility SD – –

Import from Cloud(Private) – –

Import from Cloud(Share) – –

Input Sí –

Output Sí –

AE Level Offset Sí –

Reset Paint Settings Reset without Base Look – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint/Look Black Master Black Sí Sí

R Black Sí Sí

B Black Sí Sí

Knee Setting Sí Sí

Auto Knee Sí Sí

Point Sí Sí

Slope Sí Sí

Detail Setting Sí Sí

Level Sí Sí

H/V Ratio Sí Sí

B/W Balance Sí Sí

Limit Sí Sí

Crispening Sí Sí

High Light Detail Sí Sí

Matrix User Matrix Sí Sí

User Matrix Level Sí Sí

User Matrix Phase Sí Sí

User Matrix R-G Sí Sí

User Matrix R-B Sí Sí

User Matrix G-R Sí Sí

User Matrix G-B Sí Sí

User Matrix B-R Sí Sí

User Matrix B-G Sí Sí

Multi Matrix Setting Sí Sí

Reset – –

Axis No No

Hue Sí Sí

Saturation Sí Sí
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

TC/Media Timecode Mode Sí No

Run Sí No

Setting No No

Reset – –

TC Format Sí No

TC Display Display Select Sí No

Users Bit Mode Sí No

Setting No No

HDMI TC Out Setting Sí No

Clip Name Format Camera ID No No

Reel Number No No

Camera Position No No

XAVC Root Folder Name Sí No

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Utility SD – –

Monitoring Output Format SDI1 Sí No

SDI2 Sí No

HDMI Sí No

REF No No

De-Squeeze Ratio Sí No

SDI (X-OCN) Sí No

HDMI (FHD Output) Sí No

LCD Monitor Sí No

Output Display SDI Sí No

HDMI Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Focus Mode Sí No

Focus Position Sí No

Network Status Sí No

File Transfer Status Sí No

Rec/Play Status Sí No

SDI/HDMI Rec Control Sí No

Tally Sí No

Battery Remain Sí No

Zoom Position Sí No

Image Stabilization Sí No

Media Status Sí No

Lens Info Sí No

Look Name Sí No

UWP RF Level Sí No

Focus Area Indicator Sí No

Subject Recognition Frame Sí No

Clip Name Sí No

Video Level Warning Sí No

Timecode Sí No

Gamma Display Assist Sí No

Video Signal Monitor Sí No

Imager Scan Mode Sí No

Frame Rate Sí No

Rec Format Sí No

Rec Look Sí No

Level Gauge Sí No

Audio Level Meter Sí No

Auto Exposure Mode Sí No

Auto Exposure Level Sí No

ND Filter Sí No

Iris Sí No

ISO/Gain/EI Sí No

Base ISO/Sensitivity Sí No

Shutter Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off White Balance Sí No

Clip Number Sí No

Notice Message Sí No

Marker Setting Sí No

Color Sí No

Center Marker Sí No

Safety Zone Sí No

Safety Area Sí No

Aspect Marker Sí No

Aspect Mask Sí No

Aspect Safety Zone Sí No

Aspect Safety Area Sí No

Aspect Select Sí No

Custom Aspect Ratio Sí No

Guide Frame Sí No

100% Marker Sí No

User Box Sí No

User Box Width Sí No

User Box Height Sí No

User Box H Position Sí No

User Box V Position Sí No

LCD Monitor Setting Brightness Sí No

Color Mode Sí No

Gamma Display Assist Setting Sí No

Peaking Setting Sí No

Peaking Level Sí No

Color Sí No

Zebra Setting Sí No

Zebra1 Level Sí No

Zebra1 Aperture Level Sí No

Zebra2 Level Sí No

Focus Magnifier Focus Mag Button Target Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 Input Select Sí No

CH2 Input Select Sí No

CH3 Input Select Sí No

CH4 Input Select Sí No

INPUT1 MIC Reference Sí No

INPUT2 MIC Reference Sí No

Line Input Reference Sí No

Reference Level Sí No

CH1 Wind Filter Sí No

CH2 Wind Filter Sí No

CH3 Wind Filter Sí No

CH4 Wind Filter Sí No

CH3 Level Control Sí No

CH4 Level Control Sí No

CH3 Input Level Sí No

CH4 Input Level Sí No

Audio Input Level Sí No

Limiter Mode Sí No

CH1&2 AGC Mode Sí No

CH3&4 AGC Mode Sí No

AGC Spec Sí No

1kHz Tone on Color Bars Sí No

CH1 Level Sí No

CH2 Level Sí No

CH3 Level Sí No

CH4 Level Sí No

Audio Output Monitor CH Sí No

Volume No No

Headphone Out Sí No

Alarm Level Sí No

HDMI Output CH Sí No

SDI Output CH (X-OCN) Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Clip 
Operations

Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Clips Caption Sí –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Color Bars Setting No No

Type Sí No

ND Dial CLEAR with Dial Sí No

Rec/Tally Rec/Tally Sí No

Rec Start/Stop Beep Sí No

LOCK Switch Setting with Rec Button Sí No

with Hand Grip Remote Sí No

with LCD Monitor Sí No

Funcionamiento táctil Setting Sí No

Rec Review Setting Sí No

Zoom Zoom Type Sí No

Handle Zoom Setting Sí No

High Sí No

Low Sí No

Menu Settings User Menu Only Sí No

User Menu with Lock No No

Menu Page On/Off Project Sí No

Audio Sí No

Monitoring Sí No

Assignable Button Sí No

Battery Sí No

Media Sí No

Network Sí No

File Transfer Sí No

Fan Control Setting Sí No

Lens PL-Mt Interface Position Sí No

Zoom Ring Direction Sí No

Shading Compensation Sí No

Chroma Aberration Comp. Sí No

Distortion Comp. Sí No

Breathing Compensation Sí No

Distance Display Sí No

Zoom Position Display Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Video Light Set Video Light Set Sí No

APR APR – –

Camera Battery Alarm Near End:Info Battery Sí No

End:Info Battery Sí No

Near End:Sony Battery Sí No

End:Sony Battery Sí No

Near End:Other Battery Sí No

End:Other Battery Sí No

Detected Battery No No

Camera DC IN Alarm DC Low Voltage1 Sí No

DC Low Voltage2 Sí No

Network Network Setup Setup for Mobile App – –

User Name No No

Input Password No No

Generate Password No No

Show Authentication – –

LAN Type Select Sí No

Wireless LAN WPS – –

MAC Address – –

AP Mode Settings Channel Sí No

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Sí No

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password No No

DHCP Sí No

IP Address Sí No

Subnet Mask Sí No

Gateway Sí No

DNS Auto Sí No

Primary DNS Server Sí No

Secondary DNS Server Sí No

Manual Register

SSID Sí No

Security Sí No

Password No No

DHCP Sí No

IP Address Sí No

Subnet Mask Sí No

Gateway Sí No

DNS Auto Sí No

Primary DNS Server Sí No

Secondary DNS Server Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Camera Remote Control Sí No

Detail Settings

DHCP Sí No

IP Address Sí No

Subnet Mask Sí No

Gateway Sí No

DNS Auto Sí No

Primary DNS Server Sí No

Secondary DNS Server Sí No

MAC Address – –

USB Tethering Setting Sí No

Camera Remote Control Sí No

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload Sí No

Auto Upload (Proxy) Sí No

Default Upload Server Sí No

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Sí No

Service Sí No

Host Name Sí No

Port Sí No

User Name No No

Password No No

Passive Mode Sí No

Destination Directory Sí No

Using Secure Protocol Sí No

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Maintenance Language Select Sí No

Clock Set Time Zone Sí No

Date Mode Sí No

12h/24h Sí No

Date No No

Time No No

All Reset Reset – –

Reset without Network – –

Hours Meter Hours(System) – –

Hours(Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –
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Diagramas de bloques
Consulte los elementos relacionados en “Especificación del audio que se va a grabar” (página 104) y “Menú User” (página 37).

Audio Input (CH1&CH2)

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 − 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 − 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 − 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

* Ajústelo en Manual cuando el audio entre desde el adaptador XLR.
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Audio Input (CH3&CH4)

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 − 99

CH4

[CH4 Input Level]
0 − 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 − 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
* Ajústelo en Manual cuando el audio entre desde el adaptador XLR.
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Audio Output (X-OCN)

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[SDI Output CH (X-OCN)]
CH1/CH2, CH3/CH4

[Output Format]
SDI1, SDI2, HDMI

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 − 50

[Alarm Level]
0 − 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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Audio Output (XAVC)

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 − 50

[Alarm Level]
0 − 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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Actualización del software del objetivo de montura E
Puede actualizar el software de un objetivo de 
montura E con la unidad.
Consulte el sitio web del objetivo para saber 
qué objetivos pueden actualizarse y cuál es el 
firmware correspondiente.

Comprobación de la versión

1 Acople un objetivo de montura E a la 
unidad (página 18).

2 Seleccione Version en el menú 
Maintenance del menú completo para 
que se muestre Lens Version Number 
(página 70).
El número de versión del software del 
objetivo de montura E aparecerá en el 
lateral.

Actualización del software

Ajuste la unidad en el modo de 
almacenamiento masivo (página 114).
Actualice el software siguiendo el 
procedimiento suministrado con el software 
del objetivo.
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Licencias

Licencia de la cartera de patentes 
de MPEG-4 AVC

LOS CONSUMIDORES PUEDEN UTILIZAR ESTE 
PRODUCTO BAJO LA AUTORIZACIÓN DE 
LA LICENCIA DE LA CARTERA DE PATENTES 
DE AVC PARA SU USO PERSONAL O PARA 
OTROS USOS, POR LOS CUALES NO SE RECIBE 
REMUNERACIÓN ALGUNA EN CASO DE
(i) CODIFICAR VÍDEO DE CONFORMIDAD CON 

EL ESTÁNDAR DE AVC (“VÍDEO AVC”) Y/O
(ii) DESCODIFICAR VÍDEO AVC CODIFICADO 

POR UN CONSUMIDOR COMO PARTE DE 
UNA ACTIVIDAD PERSONAL Y/U OBTENIDO 
DE UN PROVEEDOR DE VÍDEO CON LICENCIA 
PARA PROPORCIONAR VÍDEO AVC.

NO SE OTORGA NINGÚN TIPO DE LICENCIA 
O NO EXISTE NINGUNA LICENCIA IMPLÍCITA 
PARA NINGÚN OTRO USO. PUEDE OBTENER 
INFORMACIÓN ADICIONAL EN MPEG LA, L.L.C. 
CONSULTE HTTP://WWW.MPEGLA.COM

Obtención del software con la 
licencia GPL/LGPL

Este producto utiliza un software al que 
se aplica la licencia GPL/LGPL. Recuerde 
que tiene derecho a acceder, modificar y 
redistribuir código fuente de estos programas 
de software bajo las condiciones de la licencia 
GPL/LGPL.
El código fuente se proporciona en Internet. 
Utilice la siguiente URL y siga las instrucciones 
de descarga.
https://oss.sony.net/Products/Linux/

Le rogamos que no se ponga en contacto con 
nosotros acerca de los contenidos del código 
fuente.

Las licencias (en inglés) se registran en la 
memoria interna del producto.
Establezca una conexión de almacenamiento 
masivo entre el producto y un ordenador para 
leer las licencias en la carpeta “PMHOME” - 
“LICENSE”.

CONTRATO DE LICENCIA DE 
USUARIO FINAL

Last Updated: 2022-9

IMPORTANT:
BEFORE USING THE SOFTWARE, PLEASE READ 
THIS END USER LICENSE AGREEMENT (“EULA”) 
CAREFULLY. BY USING THE SOFTWARE YOU 
ARE AGREEING TO BE BOUND BY THE TERMS 
OF THIS EULA. IF YOU DO NOT AGREE TO THE 
TERMS OF THIS EULA, YOU MAY NOT USE THE 
SOFTWARE.

This EULA is a legal agreement between (i) 
you and any entity you represent (collectively 
“you”) and (ii) Sony Corporation (“SONY”). 
This EULA governs your rights and obligations 
regarding the product software of SONY 
and/or its third party licensors (including 
SONY’s affiliates) and their respective 
affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”), together with any updates/
upgrades, any printed, on-line or other 
electronic documentation for such software 
and any data files, each provided by SONY or 
the THIRD-PARTY SUPPLIERS, or created by 
operation of such software (collectively, the 
“SOFTWARE”). 

Notwithstanding the foregoing, any software 
in the SOFTWARE having a separate end 
user license agreement (including, but not 
limited to, GNU General Public license and 

Lesser/Library General Public License) shall be 
covered by such applicable separate end user 
license agreement in lieu of the terms of this 
EULA to the extent required by such separate 
end user license agreement (“EXCLUDED 
SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The 
SOFTWARE is protected by copyright and other 
intellectual property laws and international 
treaties. 

COPYRIGHT
All right and title in and to the SOFTWARE 
(including, but not limited to, any images, 
photographs, animation, video, audio, 
music, text and “applets” and other content 
incorporated into the SOFTWARE) is owned 
by SONY or one or more of the THIRD-PARTY 
SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited, non-exclusive, 
personal, non-transferable license to use the 
SOFTWARE solely in connection with your 
compatible device (including, but not limited 
to, SONY’s products which the SOFTWARE 
is embedded in or bundled with) (“DEVICE”) 
solely in accordance with this EULA and 
the usage instructions as may be made 
available to you by SONY or the THIRD-PARTY 
SUPPLIERS. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title 
and interest (including, but not limited to, 
all intellectual property rights) in and to the 
SOFTWARE that this EULA does not specifically 
grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, 
attempt to derive source code, modify, reverse 
engineer, decompile, or disassemble any of 
the SOFTWARE, whether in whole or in part, 

or create any derivative works from or of the 
SOFTWARE unless such derivative works are 
intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any 
digital rights management functionality 
of the SOFTWARE. You may not bypass, 
modify, defeat or circumvent any of the 
functions or protections of the SOFTWARE 
or any mechanisms operatively linked to 
the SOFTWARE. You may not separate any 
individual component of the SOFTWARE 
for use on more than one DEVICE unless 
expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any 
trademarks or notices on the SOFTWARE. 
You may not share, distribute, rent, lease, 
sublicense, assign, transfer or sell the 
SOFTWARE. You may not use the SOFTWARE 
in connection with violation of laws, 
regulations, court decisions or other legally 
binding dispositions by a public authority or 
public policy, or infringement of the rights 
or legally protected interests (including, but 
not limited to, intellectual and other property 
rights, rights to trade secrets, honors, privacy 
and publicity) of SONY, each of the THIRD-
PARTY SUPPLIERS or any third parties. The 
software, network services or other products 
other than the SOFTWARE upon which the 
SOFTWARE’S performance depends might be 
modified, interrupted or discontinued at the 
discretion of the suppliers (software suppliers, 
service suppliers, or SONY). SONY and such 
suppliers do not warrant that the SOFTWARE, 
network services, contents or other products 
will continue to be available, or will operate 
without interruption or modification. You shall 
not, nor shall you instruct or permit, procure, 
enable or request any third party (including 
your users, third party personnel or other 
personnel, staff or contractors) to, take any 
action designed or intended to: (i) use the 
SOFTWARE (or any part thereof) in any manner 
or for any purpose that is inconsistent with 
this EULA; (ii) introduce to the SOFTWARE 

https://oss.sony.net/Products/Linux/
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any “back door,” “drop dead device,” “time 
bomb,” “Trojan horse,” “virus,” or “worm” (as 
such terms are commonly understood in the 
software industry) or any other equivalent 
code, files, scripts, agents, programs, software 
routine or instructions designed or intended to 
disrupt, disable, harm or otherwise impede in 
any manner the operation of the SOFTWARE or 
any device or system owned or controlled by 
you or any third party, or which otherwise may 
damage or destroy any data or file (“Malicious 
Code”); (iii) interfere with the proper working 
of the SOFTWARE; (iv) circumvent, disable, 
or interfere with security-related features 
of the SOFTWARE or features that prevent 
or restrict use, access to, or copying the 
SOFTWARE, or that enforce limitations on use 
of the SOFTWARE; or (v) impose (or which 
may impose, in your sole discretion) an 
unreasonable or disproportionately large load 
on the SOFTWARE.

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license 
grant, you acknowledge that the SOFTWARE 
may include EXCLUDED SOFTWARE. Certain 
EXCLUDED SOFTWARE may be covered by 
open source software licenses (“Open Source 
Components”), which means any software 
licenses approved as open source licenses by 
the Open Source Initiative or any substantially 
similar licenses, including but not limited to 
any license that, as a condition of distribution 
of the software licensed under such license, 
requires that the distributor make the software 
available in source code format. If and to 
the extent disclosure is required, please visit 
oss.sony.net/Products/Linux or other SONY-
designated web site for a list of applicable 
OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the 
applicable terms and conditions governing 
its use. Such terms and conditions may be 

changed by the applicable third party at any 
time without liability to you. To the extent 
required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will 
apply in lieu of the terms of this EULA. To the 
extent the terms of the licenses applicable 
to EXCLUDED SOFTWARE prohibit any of the 
restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will 
not apply to such EXCLUDED SOFTWARE. To 
the extent the terms of the licenses applicable 
to Open Source Components require SONY 
to make an offer to provide source code in 
connection with the SOFTWARE, such offer is 
hereby made.

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used 
by you to view, store, process and/or use 
content created by you and/or third parties. 
Such content may be protected by copyright, 
other intellectual property laws, and/or 
agreements. You agree to use the SOFTWARE 
only in compliance with all such laws and 
agreements that apply to such content. You 
acknowledge and agree that SONY may take 
appropriate measures to protect content 
stored, processed or used by the SOFTWARE. 
Such measures include, but are not limited 
to, refusal to accept your request to enable 
backup and restoration of content through 
certain SOFTWARE features, and termination 
of this EULA in the event of your illegitimate 
use of the SOFTWARE.

CONTENT SERVICE
PLEASE ALSO NOTE THAT THE SOFTWARE MAY 
BE DESIGNED TO BE USED WITH CONTENT 
AVAILABLE THROUGH ONE OR MORE CONTENT 
SERVICES (“CONTENT SERVICE”). USE OF THE 
SERVICE AND THAT CONTENT IS SUBJECT TO 
THE TERMS OF SERVICE OF THAT CONTENT 
SERVICE. IF YOU DECLINE TO ACCEPT THOSE 

TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree 
that certain content and services available 
through the SOFTWARE may be provided 
by third parties over which SONY has no 
control. WHERE CONTENT SERVICE IS NOT 
UNDER SONY’S CONTROL, SONY SHALL NOT 
BE LIABLE IN RESPECT OF ANY DAMAGES (OR 
OTHER LIABILITY) RELATED TO SUCH CONTENT 
SERVICE. USE OF THE CONTENT SERVICE 
REQUIRES AN INTERNET CONNECTION. THE 
CONTENT SERVICE MAY BE MODIFIED OR 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to 
certain SOFTWARE features may require an 
Internet connection for which you are solely 
responsible. Further, you are solely responsible 
for payment of any fees associated with 
your Internet connection, including but not 
limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may 
be limited or restricted depending on the 
capabilities, bandwidth or technical limitations 
of your Internet connection and service. The 
provision, quality and security of such Internet 
connectivity are your responsibility or that of 
the third party providing such service. You are 
solely responsible in the event any Malicious 
Code introduced in the SOFTWARE because of 
or through, your internet connections.

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export 
and re-export restrictions and regulations of 
the area or country in which you reside or 
use the SOFTWARE, and not to transfer, or 
authorize the transfer, of the SOFTWARE to a 
prohibited country or otherwise in violation of 
any such restrictions or regulations. 

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is 
not designed, manufactured or intended for 
use or resale as on-line control equipment 
in hazardous environments requiring fail-
safe performance, such as in the operation 
of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, 
direct life support machines, or weapons 
systems, in which the failure of the SOFTWARE 
could lead to death, personal injury, or severe 
physical or environmental damage (“HIGH 
RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective 
affiliates specifically disclaim any express or 
implied warranty, duty or condition of fitness 
for HIGH RISK ACTIVITIES. 

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the 
SOFTWARE is at your sole risk and that you 
are responsible for use of the SOFTWARE. 
The SOFTWARE is provided “AS IS,” without 
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, SONY 
and each of the THIRD-PARTY SUPPLIERS 
shall be collectively referred to as “SONY”) 
EXPRESSLY DISCLAIM ALL WARRANTIES, 
DUTIES OR CONDITIONS, EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, QUALITY, 
FITNESS FOR A PARTICULAR PURPOSE, 
ACCURACY, TITLE AND NONINFRINGEMENT. 
WITHOUT LIMITING THE GENERALITY OF THE 
FOREGOING, SONY DOES NOT WARRANT OR 
MAKE ANY CONDITIONS OR REPRESENTATIONS 
(A) THAT THE FUNCTIONS CONTAINED IN 
ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE 
UPDATED, (B) THAT THE OPERATION OF ANY 
OF THE SOFTWARE WILL BE CORRECT OR 
ERROR-FREE OR THAT ANY DEFECTS WILL 
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BE CORRECTED, (C) THAT THE SOFTWARE 
WILL NOT DAMAGE ANY OTHER SOFTWARE, 
HARDWARE OR DATA, (D) THAT ANY 
SOFTWARE, NETWORK SERVICES (INCLUDING 
THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE 
SOFTWARE’S PERFORMANCE DEPENDS WILL 
CONTINUE TO BE AVAILABLE, UNINTERRUPTED, 
TIMELY, SECURE OR UNMODIFIED, (E) THAT 
THE SOFTWARE OR ANY EQUIPMENT, SYSTEM 
OR NETWORK ON WHICH THE SOFTWARE IS 
USED (INCLUDING THE DEVICE) WILL BE FREE 
OF VULNERABILITY TO INTRUSION OR ATTACK 
AND (F) REGARDING THE USE OR THE RESULTS 
OF THE USE OF THE SOFTWARE IN TERMS OF 
ITS CORRECTNESS, ACCURACY, RELIABILITY, OR 
OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SONY OR AN AUTHORIZED 
REPRESENTATIVE OF SONY SHALL CREATE 
A WARRANTY, DUTY OR CONDITION OR IN 
ANY WAY INCREASE THE SCOPE OF THIS 
WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST 
OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION. SOME JURISDICTIONS DO 
NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THESE EXCLUSIONS MAY 
NOT APPLY TO YOU TO THE EXTENT THEY ARE 
CONTRARY TO APPLICABLE LAW OF YOUR 
JURISDICTION.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, 
SONY and each of the THIRD-PARTY 
SUPPLIERS shall be collectively referred to 
as “SONY”) SHALL NOT BE LIABLE FOR ANY 
INCIDENTAL, INDIRECT, SPECIAL, EXEMPLARY 
OR CONSEQUENTIAL LOSS OR DAMAGES 
FOR BREACH OF ANY EXPRESS OR IMPLIED 
WARRANTY, BREACH OF CONTRACT, 
NEGLIGENCE, STRICT LIABILITY OR UNDER 

ANY OTHER LEGAL THEORY RELATED TO THE 
SOFTWARE, INCLUDING, BUT NOT LIMITED 
TO, ANY DAMAGES ARISING OUT OF LOSS OF 
PROFITS, LOSS OF REVENUE, LOSS OF DATA, 
LOSS OF USE OF THE SOFTWARE OR ANY 
ASSOCIATED HARDWARE, DOWN TIME AND 
USER’S TIME, EVEN IF ANY OF THEM HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH 
LOSSES OR DAMAGES. IN ANY CASE, EACH 
AND ALL OF THEIR AGGREGATE LIABILITY 
UNDER ANY PROVISION OF THIS EULA SHALL 
BE LIMITED TO THE GREATER OF (i) THE 
AMOUNT ACTUALLY PAID FOR THE SOFTWARE, 
SONY’S PRODUCT WHICH THE SOFTWARE IS 
EMBEDDED IN OR BUNDLED WITH AND/OR 
SONY’S SERVICE TO WHICH THE SOFTWARE 
IS DEDICATED OR (ii) THE FIXED AMOUNT 
AGREED IN WRITING BETWEEN SONY AND 
YOU. SOME JURISDICTIONS DO NOT ALLOW 
SUCH EXCLUSIONS OR LIMITATIONS OF 
LIABILITY, SO THE ABOVE EXCLUSIONS OR 
LIMITATIONS MAY NOT APPLY TO YOU TO THE 
EXTENT THEY ARE CONTRARY TO APPLICABLE 
LAW OF YOUR JURISDICTION.

INDEMNITY
Except as prohibited by applicable law, you 
agree to indemnify and hold harmless SONY 
and the THIRD-PARTY SUPPLIERS and their 
respective affiliates, officers and employees, 
from any loss, claim or demand, including 
reasonable attorneys' fees, made by any third 
party due to or arising out of your use of the 
SOFTWARE and/or the DEVICE (including, 
without limitation, any software vulnerability 
caused by such use), your violation of this 
EULA or your failure to fulfill your responsibility 
under this EULA.

AUTOMATIC UPDATE FEATURE 
From time to time, SONY or the THIRD-
PARTY SUPPLIERS may automatically 
update or otherwise modify the SOFTWARE, 
including, but not limited to, for purposes 

of enhancement of security functions, error 
correction and improvement of functions, 
at such time as you interact with SONY’s 
or third parties’ servers, or otherwise. Such 
updates or modifications may delete or 
change the nature of features or other 
aspects of the SOFTWARE, including, but not 
limited to, functions you may rely upon. You 
acknowledge and agree that such activities 
may occur at SONY’s sole discretion and that 
SONY may condition continued use of the 
SOFTWARE upon your complete installation or 
acceptance of such update or modifications. 
Any updates/modifications shall be deemed 
to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By 
acceptance of this EULA, you consent to such 
update/modification. 

FORCE MAJEURE
SONY shall not be liable for any delay or failure 
to perform resulting from causes outside 
its reasonable control, including, but not 
limited to, fire, floods, storms, earthquakes, 
epidemics, acts of God, war, terrorism, riots, 
insurrection, embargos, acts of civil, military 
or governmental authorities, nuclear or other 
accidents, explosions, strikes or shortages of 
transportation facilities, fuel, energy, labor or 
materials.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY 
This EULA (and SONY’s applicable privacy 
policy separately presented to you, if any), as 
amended and modified from time to time, 
constitute the entire agreement(s) between 
you and SONY with respect to the SOFTWARE. 
The failure of SONY to exercise or enforce 
any right or provision of this EULA shall not 
constitute a waiver of such right or provision. 
If any part of this EULA is held invalid, illegal, 
or unenforceable, that provision shall be 
enforced to the maximum extent permissible 
so as to maintain the intent of this EULA, and 

the other parts will remain in full force and 
effect. 

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts 
for the International Sale of Goods shall 
not apply to this EULA. This EULA shall be 
governed by the laws of Japan, without 
regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be 
subject to the exclusive venue of the Tokyo 
District Court in Japan, and the parties hereby 
consent to the venue and jurisdiction of such 
courts. The foregoing does not apply to you to 
the extent applicable law of your jurisdiction 
restricts or prohibits such agreements.

EQUITABLE REMEDIES
Notwithstanding anything contained in this 
EULA to the contrary, you acknowledge and 
agree that any violation of or non-compliance 
with this EULA by you will cause irreparable 
harm to SONY, for which monetary damages 
would be inadequate, and you consent to 
SONY obtaining any injunctive or equitable 
relief that SONY deems necessary or 
appropriate in such circumstances. SONY may 
also take any legal and technical remedies 
to prevent violation of and/or to enforce this 
EULA, including, but not limited to, immediate 
termination of your use of the SOFTWARE, if 
SONY believes in its sole discretion that you 
are violating or intend to violate this EULA. 
These remedies are in addition to any other 
remedies SONY may have at law, in equity or 
under contract.

TERMINATION
Without prejudice to any of its other rights, 
SONY may suspend your access or use of the 
SOFTWARE and/or terminate this EULA if you 
fail to comply with any of its terms. In case of 
such termination, you must: (i) cease all use, 
and destroy any copies, of the SOFTWARE; (ii) 
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comply with the requirements in the section 
below entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND 
ANY OF THE TERMS OF THIS EULA AT ITS 
SOLE DISCRETION BY POSTING NOTICE ON 
A SONY DESIGNATED WEB SITE, BY EMAIL 
NOTIFICATION TO AN EMAIL ADDRESS 
PROVIDED BY YOU, BY PROVIDING NOTICE AS 
PART OF THE PROCESS IN WHICH YOU OBTAIN 
UPGRADES/UPDATES OR BY ANY OTHER 
LEGALLY RECOGNIZABLE FORM OF NOTICE. 
If you do not agree to the amendment, you 
should promptly contact SONY for instructions. 
Your continued use of the SOFTWARE after 
the effective date of any such notice shall be 
deemed your agreement to be bound by such 
amendment. 

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express 
intended third-party beneficiary of, and shall 
have the right to enforce, each provision of 
this EULA with respect to the software of such 
party.

YOUR ACCOUNT RESPONSIBILITIES
Should you return your DEVICE to its place 
of purchase, sell or otherwise transfer your 
DEVICE, or if this EULA is terminated, you 
are responsible for and must, if reasonably 
possible, uninstall the SOFTWARE from the 
DEVICE and delete any and all accounts 
you may have established on DEVICE or 
are accessible through the SOFTWARE. You 
are solely responsible for maintaining the 
confidentiality of any accounts you have with 
SONY or third parties and any usernames and 
passwords associated with your use of the 
DEVICE.

Should you have any questions concerning 
this EULA, you may contact SONY by writing 

to SONY at the applicable contact address for 
each area or country.

Licencias de software de código 
abierto

En base a los contratos de licencia entre Sony 
y los propietarios del copyright del software, 
este producto utiliza software libre.
Para cumplir los requisitos de los propietarios 
del copyright del software, Sony se ve 
obligado a informarle acerca del contenido de 
estas licencias.
Las licencias (en inglés) se registran en la 
memoria interna del producto.
Establezca una conexión de almacenamiento 
masivo entre el producto y un ordenador para 
leer las licencias en la carpeta “PMHOME” - 
“LICENSE”.

Si utiliza un Mac, es posible que la carpeta 
“PMHOME” - “LICENSE” no esté accesible.
Para ver los archivos, utilice un ordenador que 
no sea Mac o visite la siguiente URL.
https://oss.sony.net/License/MPC-2610/

https://oss.sony.net/License/MPC-2610/
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Especificaciones

General

Peso

 Aprox. 2,9 kg (cuerpo, adaptador de montura 

PL)

 Aprox. 2,4 kg (solo cuerpo, sin el adaptador 

de montura PL)

Dimensiones

 Consulte la página 148.

Requisitos de alimentación

 12 V CC (de 11 V a 17 V)

Consumo de energía

 Consumo de energía nominal de la unidad: 

aprox. 50,0 W (objetivo, 6K 17:9, 

59.94P, grabación X-OCN LT, 

ventilador automático, sin control 

remoto de la empuñadura ni 

dispositivos periféricos)

 Consumo de energía máximo de la unidad: 

aprox. 66,0 W (objetivo, 6K 17:9, 

59.94P, grabación X-OCN LT, 

ambiente 40 ºC, filtro ND (1/4), 

grabación de proxy activada, Wi-

Fi activada, ventilador automático, 

incluido el control remoto de la 

empuñadura y los dispositivos 

periféricos)

Temperatura de funcionamiento

 De 0 °C a 40 °C

Temperatura de almacenamiento

 De –20 °C a +60 °C

Tiempo de funcionamiento continuo

 Aprox. 100 minutos (cuando se utiliza BP-

GL95B)

Formato de grabación (vídeo)

 X-OCN(LT)

 XAVC H Intra HQ

 XAVC H Intra SQ

 XAVC H Long

 XAVC Intra

 XAVC Long

Formato de grabación (audio)

 LPCM de 24 bits, 48 kHz, 4 canales

Velocidad de fotogramas de grabación

 X-OCN(LT)

  FF 8.6K 17:9 

29.97P, 25P, 24P, 23.98P

  FF 8.6K 16:9

   29.97P, 25P, 23.98P

  FFc 6K 17:9/S35 5.8K 17:9/S35c 4K 17:9

   59.94P, 50P, 29.97P, 25P, 24P, 

23.98P

  FFc 6K 16:9/S35 5.8K 16:9

   59.94P, 50P, 29.97P, 25P, 23.98P

 XAVC H Intra HQ

  8192×4320/29.97P, 25P, 24P, 23.98P

  7680×4320/29.97P, 25P, 23.98P

 XAVC H Intra SQ

  8192×4320/29.97P, 25P, 24P, 23.98P

  7680×4320/29.97P, 25P, 23.98P

 XAVC H Long

  7680×4320/29.97P, 25P, 23.98P

 XAVC Intra

  4096×2160/59.94P, 50P, 29.97P, 25P, 

24P, 23.98P

  3840×2160/1920×1080/59.94P, 50P, 

29.97P, 25P, 23.98P

 XAVC Long

  3840×2160/1920×1080/59.94P, 50P, 

29.97P, 25P, 23.98P

Tiempo de grabación/reproducción

 Consulte la página 122.

Sección de la cámara

Elemento de imagen

 Sensor de imagen CMOS de un solo chip 

equivalente a fotograma 

completo de 35 mm

Número de píxeles

 57,0M (total)

Auto focus

 Método de detección: detección de fase / 

detección de contraste

Filtros ND internos

 CLEAR: OFF

 ND linealmente variable: de 0.6 (1/4) a 2.1 

(1/128)

Sensibilidad ISO

 ISO 800/3200 (modo Cine EI, fuente de luz 

D55)

Montura del objetivo

 Montura PL (con adaptador de montura PL)

 Montura E (sin adaptador de montura PL)

Distancia focal del plano de montaje

 Montura PL: 52 mm

 Montura E: 18 mm

Latitud

 16 paradas

Velocidad del obturador

 De 1/8000 s a 64F (23.98P)

Ángulo del obturador

 De 5,6° a 360°, de 2 a 64 fotogramas

Balance de blancos

 De 2000 K a 15000 K

Gain

 De –3 dB a +18 dB (incrementos de 1 dB)

Sección de audio

Frecuencia de muestreo

 48 kHz

Cuantificación

 24 bits

Respuesta en frecuencia

 Modo MIC de la entrada XLR: de 20 Hz a 

20 kHz (±3 dB o menos)

 Modo LINE de la entrada XLR: de 20 Hz a 

20 kHz (±3 dB o menos)

Rango dinámico

 Modo MIC de la entrada XLR: 80 dB (típico)

 Modo LINE de la entrada XLR: 90 dB (típico)

Distorsión

 Modo MIC de la entrada XLR: 0,08% o inferior 

(nivel de entrada de –40 dBu)

 Modo LINE de la entrada XLR: 0,08% o inferior 

(nivel de entrada de +14 dBu)

Altavoz integrado

 Monoaural

Micrófono interno

 Monoaural

Sección de entrada/salida

Entradas
INPUT 1/2:

 Tipo XLR, 3 contactos, hembra

 Conmutable entre LINE / MIC / MIC+48V

 MIC: de –30 dBu a –80 dBu de referencia

TC IN:

 Tipo BNC

REF IN:

 Tipo BNC
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Salidas
SDI OUT 1:

 Tipo BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), 

HD-SDI 

SDI OUT 2:

 Tipo BNC, 3G-SDI (Level A/B), HD-SDI

Auriculares (minitoma estéreo):

 –16 dBu (salida del nivel de referencia, 

volumen máximo del monitor, 

carga de 16 Ω)

HDMI:

 Tipo A, 19 contactos

TC OUT:

 Tipo BNC

REF OUT:

 Tipo BNC

Otras
DC IN:

 Tipo XLR, 4 terminales (macho) (1), de 11 V a 

17 V

REMOTE:

 Tipo subminitoma de 3 polos y 2,5 mm

Conector del control remoto de la empuñadura:

 Minitoma de 4 polos y 3,5 mm

USB-C:

 USB 3.2 Gen 1

VF:

 Específico de 40 contactos

Conector de red:

 Tipo RJ45

Conector del asa:

 Específico de 40 contactos

Sección de visualización

Visor (LCD)
Tamaño de la pantalla

 Diagonal de 8,8 cm (3,5 pulgadas)

Relación de aspecto

 16:9

Número de píxeles

 1280 (H) × 720 (V)

Sección de la ranura multimedia

Ranura para tarjetas CFexpress Tipo B (2)

Ranura para tarjetas Utility SD (1) 

LAN inalámbrica

Estándares compatibles*

 IEEE 802.11a/b/g/n/ac (modelo WW279317)

 IEEE 802.11b/g/n (modelo WW057783)

Banda de frecuencia*

 2,4 GHz/5 GHz (modelo WW279317)

 2,4 GHz (modelo WW057783)
* Consulte la chapa de identificación situada en la 

parte inferior de la unidad.

Protocolos de seguridad compatibles

 WEP/WPA-PSK/WPA2-PSK

Método de conexión

 Wi-Fi Protected Setup™ (WPS)/Manual

Método de acceso

 Modo de infraestructura

Accesorios suministrados

Asa (con brazo para el visor) (1)

Tornillos de montaje del asa (4)

Monitor LCD (1)

Lupa del visor (1)

Adaptador de montaje del visor (1)

Arandela (circular) (1)

Arandela (1/3 de arco) (15)

Tapa de montura E (1) 

Tapa de montura PL (1)

Antes de utilizar esta unidad (1)

Folleto de la garantía (1)

El diseño y las especificaciones están sujetos a 
cambios sin previo aviso.

Notas
 • Haga siempre un ensayo de grabación 

y verifique que se grabó bien. SONY NO 
SE HACE RESPONSABLE POR DAÑOS DE 
NINGÚN TIPO, INCLUYENDO PERO NO 
LIMITADO A LA COMPENSACIÓN O PAGO 
POR FALLO EN HACER CUALQUIER TIPO 
DE CONTENIDO DE GRABACIÓN POR 
MEDIO DE ESTA UNIDAD O SU SOPORTE DE 
GRABACIÓN O CUALQUIER OTRO SOPORTE 
O SISTEMA DE ALMACENAMIENTO.

 • Verifique siempre que esta unidad 
funciona correctamente antes de utilizarla. 
SONY NO SE HACE RESPONSABLE POR 
DAÑOS DE NINGÚN TIPO, INCLUYENDO 
ENTRE OTROS LA COMPENSACIÓN O 
EL REEMBOLSO POR LA PÉRDIDA DE 
GANANCIAS PRESENTES O FUTURAS 
DEBIDO AL FALLO DE ESTA UNIDAD, YA SEA 
DURANTE LA VIGENCIA DE LA GARANTÍA 
O DESPUÉS DEL VENCIMIENTO DE LA 
GARANTÍA, O POR CUALQUIER OTRA 
RAZÓN.

 • SONY NO SE HACE RESPONSABLE POR 
RECLAMACIONES DE NINGÚN TIPO 
REALIZADAS POR USUARIOS DE ESTA 
UNIDAD O POR TERCEROS.

 • SONY NO SE HACE RESPONSABLE 
POR LA PÉRDIDA, LA REPARACIÓN O 
LA REPRODUCCIÓN DE CUALQUIER 
DATO GRABADO EN EL SISTEMA 
DE ALMACENAMIENTO INTERNO, 
SOPORTES DE GRABACIÓN O CUALQUIER 
OTRO SOPORTE O SISTEMA DE 
ALMACENAMIENTO.

 • SONY NO SE HACE RESPONSABLE DE LA 
FINALIZACIÓN NI DE LA INTERRUPCIÓN, 
POR LA CIRCUNSTANCIA QUE FUERA, DE 
CUALQUIER SERVICIO RELACIONADO CON 
ESTA UNIDAD.



7. Apéndice: Especificaciones148

Dimensiones exteriores

Parte superior/delantera/trasera/lado de interruptores del operador

14

2,3

73

3×UNC 3/8-16, 
profundidad: 14

M2, profundidad: 3,9 
(escariado ø5,3, profundidad: 1,9)

6×UNC 3/8-16, profundidad: 10

8×UNC 1/4-20, 
profundidad: 103×UNC 1/4-20, 

profundidad: 9

6×M3, profundidad: 6

6×UNC 1/4-20, 
profundidad: 9

UNC 3/8-16, 
profundidad: 7

142,5

2712

70

14464,6

66,85

41,85 50 50

50 50

9

18
30,75 20 20

30 30

84

50,6

33,4

2×M3, profundidad: 5

2×M3, 
profundidad: 5

Unidad: mm

218,1 184,25

212,5

13,5 UNC 1/4-20, 
profundidad: 9

2×M3, 
profundidad: 5

62 29 25 20

20

6,05

59,1

145,7
25

7,4

12,5

12,5

7,4

25
50
25

184

50 50 75

50 5041,85

66,85

65,4

73

69
58,6 58,6

86,5

69,5
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Parte inferior/lado de conectores

Unidad: mm25
25
25

1,5

34,6

4×UNC 3/8-16, 
profundidad: 9

4×UNC 1/4-20, 
profundidad: 9

2×M3, 
profundidad: 5

25
25
25

14
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Marcas comerciales

 • Los términos HDMI y HDMI High-
Definition Multimedia Interface, y el 
Logotipo HDMI son marcas comerciales 
o marcas registradas de HDMI Licensing 
Administrator, Inc. en los Estados Unidos y 
en otros países.

 • USB-C es una marca comercial registrada de 
USB Implementers Forum.

 • Todos los nombres del sistema y de 
productos son marcas comerciales o marcas 
registradas de sus respectivos propietarios. 
Los elementos registrados como marca no 
están señalados con los símbolos ® o ™ en 
este documento.
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